
Information
Using the Reference
Installing TrueType Fonts
Service Information
Advice for Plotter Output
Using Digitizers

Menu Commands
File Menu >
Edit Menu >
Configure Menu >
Shape Menu >
Draw Menu >
Geometry Menu >
Trimming Menu >
Dimension Menu >
Library Menu >
Extra Menu >
Help Menu >

Other Commands >

Screen Elements
Main Window
Panel
Drawing Window
Ruler
Status Window
Symbol Window
Toolbox
Selection Window
Popup Menu

Dialog Boxes
User Identification
File Selection
Details
Color Selection
Standard-Color Selection
Basic Properties
Extended Properties
General Message
General Entry



Command-Specific Dialog Boxes >

Miscellaneous
Keyboard Assignments

...for View and Zoom

...for Selection and Identification

...for Clipboard

...for Settings

...for Point Entry

...for Object Identification
Default Assignment

Command Identifiers
Important File Extensions
WIN.INI and TSTEK3.INI



File Menu
New Drawing
Open Drawing
Merge Drawing

Objects
Standard Elements
Other Elements

Save Drawing
Save Drawing as
Save Elements as
Drawing List
Miscellaneous

Destroy Drawing
Create Duplicate
Load Duplicate
Autosave

Convert Drawing
Print Drawing
Control Panel
Exit



New Drawing (File Menu)
This command starts a new drawing. Any previously loaded drawing is removed (after confirmation) 
from memory. 

The new drawing is based on the elements in the drawing TSTEK3.T3G (or the relevant user-dependent 
file in a multiple user environment). The file has no name until saved; the drawing name (UNTITLED) 
is shown in the title bar.

The drawing details (see Drawing Details) are blank except for the details of the date and author. 

Note: If the elements upon which new drawings are based are to be altered, use the command Save 
Elements as Default. The next new drawing will then be automatically based on these elements.
To replace the current elements with those from another drawing or add the elements from another 
drawing to the current one, use the command Merge Drawing>Other Elements.

Related command:
No related commands



Open Drawing (File Menu)
This command opens an existing drawing (loads it into memory). The File Selection Dialog appears, 
where the drawing to be loaded can be chosen.

Tek Illustrator files usually have the extension T3G. Files created by CAD/DRAW Professional 2 with the
extension T2G can also be loaded.

Before the chosen drawing is loaded, the current drawing, if any, is removed (after confirmation) from 
memory. After this, the chosen drawing is loaded and displayed. Initially, a page view is displayed.

If the drawing contains symbols which are not currently in memory, an attempt will be made to load them 
from the relevant library. If a symbol can not be loaded, the instance will be shown as a text label. As 
soon as the symbol becomes available the instance will be displayed correctly. The same goes for Tek 
Illustrator's own fonts if no available substitute has been specified with the Fonts command.

If the drawing can not be loaded successfully, a new blank drawing is started (see New Drawing).

Related command:
Drawing List



Merge Drawing>Objects (File Menu)
Using this command, objects, blocks and instances can be merged into the current drawing from another 
file. The other file is chosen from the File Selection Dialog.

Tek Illustrator drawings usually have the extension T3G. However, objects, instances and blocks can be 
loaded from drawings created with CAD/DRAW Professional 2 which have the extension T2G.

When merging blocks, conflicts can arise. Because blocks are identified by their names, the name must 
only be used once within a drawing. If the drawing to be merged contains blocks with names which are 
already in use, they cannot be loaded. 

Note: Because the appearance of an object depends on the pen settings, line pattern and layer, merged 
objects can look very different from their original appearance. The current pen, line pattern and layer 
settings may be quite different from those used in the original drawing, 

Related commands:
Merge Drawing>Standard Elements
Merge Drawing>Other Elements



Merge Drawing>Standard Elements (File Menu)
This command can be used to replace or merge standard elements in the current drawing. The standard 
elements are those elements (zoom areas, line patterns, pens, coordinate systems, layers, blocks, objects 
and geometry) saved in the file TSTEK3.T3G and used when starting a new drawing (or, in the case of 
multi-user operation the user-specific file -??????-.T3G).

This command is particularly useful if changed standard elements have to be added to existing drawings.

To do this, the Load Elements Dialog appears, where the elements and working mode can be chosen.

When merging blocks, conflicts can arise. As blocks are identified by their names, each name must only 
be used once in a drawing. blocks in the drawing to be merged with names already in use in the other 
drawing cannot be merged.

Note: Because the appearance of an object depends on the active pen settings, line patterns and layer, the 
merged object's appearance may be very different from the original.

Related commands:
Merge Drawing>Objects
Merge Drawing>Other Elements



Merge Drawing>Other Elements (File Menu)
This command can be used to replace elements from the current drawing (zoom sections, line patterns, 
pens, coordinate systems, layers, blocks, objects and geometry) with elements from another file or add 
those elements to the current drawing.

This command is particularly useful if elements from one drawing have to be transferred to another 
drawing.

To do this, the Load Elements Dialog appears, where the elements and working mode can be chosen., 
followed by the File Selection Dialog where the drawing file to be used can be chosen.

When merging blocks, conflicts can arise. As blocks are identified by their names, each name must only 
be used once in a drawing. blocks in the drawing to be merged with names already in use in the other 
drawing cannot be merged.

Note: Because the appearance of an object depends on the active pen settings, line patterns and layer, the 
merged object's appearance may be very different from the original.

Related commands:
Merge Drawing>Objects
Merge Drawing>Standard Elements



Save Drawing (File Menu)
This command saves the current drawing, if it already has a name. If the drawing has not yet been saved, 
i.e. if the title bar shows (UNTITLED) then this calls the command Save Drawing as instead.

Before saving, a dialog appears asking whether or not to overwrite the existing file. This helps to avoid 
the accidental overwriting of important data.

Note: Drawing files do not contain Undo and Redo information, which are only available as long as the 
drawing remains in memory.

Related commands:
Save Drawing as
Save Elements as



Save Drawing as (File Menu)
This command saves the current drawing in a given file. The File Selection Dialog appears in which the 
file to be used can be specified.

Tek Illustrator drawing files usually have the extension T3G, although other extensions can be used, 
which can cause confusion.

If you choose to save a drawing which already has a name, a dialog will appear asking whether the new 
file name should become the current drawing name. In this case, every time the Save Drawing command 
is used the drawing is saved in the new file. The new drawing name is shown in the title bar.

Note: Drawing files do not contain Undo and Redo information, which are only available as long as the 
drawing remains in memory.

Related commands:
Save Drawing
Save Elements as



Save Elements as (File Menu)
This command is used to save elements from the current drawing in a new drawing file. Most elements 
(zoom areas, line patterns, pens, coordinate systems, layers) are saved by default. To choose which other 
elements to save, the Save Elements dialog appears, where the other elements to be saved can be chosen.

The File Selection Dialog then appears in which the drawing file to be used can be chosen.

Tek Illustrator drawing files normally have the extension T3G. However other extensions can be used, 
which easily leads to confusion.

Note: If the current elements are to be saved without the additional objects, blocks and geometry as 
standard elements, the Save Elements as Default can be used.

Related commands:
Save Drawing
Save Drawing as



Drawing List (File Menu)
This command calls a list of drawings. The list contains up to 14 of the last-used drawing files. If an entry
is chosen from the list, the corresponding drawing is loaded.

Before loading the chosen drawing, the current drawing (after a suitable warning) is removed from 
memory. After that, the chosen drawing is loaded and displayed. To start with, a page view is shown.

If the drawing contains instances of symbols which are not currently in memory, then an attempt will be 
made to load them from the relevant libraries. If a symbol cannot be loaded, it is shown in text form. As 
soon as the symbol becomes available the instance will be shown correctly. The same goes for Tek 
Illustrator's own fonts as long as no substitute font has been specified with the Fonts command.

If the drawing cannot be loaded successfully, a new drawing is started in a similar way to choosing the 
command New Drawing.

Note: The drawing list is saved automatically and is available as soon as the program is restarted. If the 
first entry from the list is chosen, the last-open drawing is loaded.

Related command:
Open Drawing



Miscellaneous>Erase Drawing (File Menu)
This command removes the current drawing from memory and erases the drawing file from the hard disk.
It is particularly useful during the maintenance of drawing collections.

A confirmation dialog appears first. If confirmed, then the current drawing is removed from memory and 
the associated drawing file is deleted from the hard disk.

Afterwards, a new drawing is started (New Drawing).

Warning! This command is final and can not be undone using the Undo command. The drawing file is 
deleted and permanently lost.

Related command:
No related commands



Miscellaneous>Create Duplicate (File Menu)
This command creates a duplicate of the current drawing. A file with the same name as the current 
drawing's file name but with the extension DUP is created. This command can only be used if the current 
drawing already has a name.

If a duplicate with the same name already exists, then a warning appears to avoid accidental overwriting 
of files.

Apart from the extension, a duplicate file is a " normal" drawing. They can be loaded as a duplicate using 
the command Miscellaneous>Load Duplicate or like any other drawing using the command Open 
Drawing.

Note: A duplicate of a drawing should be created, for example, if some variant of the current drawing is 
to be tried out or operations are to be carried out which will change the drawing drastically and which can
not be undone using the Undo command.

Related commands:
Miscellaneous>Load Duplicate
Miscellaneous>Autosave
Save Drawing



Miscellaneous>Load Duplicate (File Menu)
This command loads a duplicate of the current drawing. Duplicate files can be created with the commands
Miscellaneous>Create Duplicate and Miscellaneous>Autosave.

The duplicate must have the same name as the file in which the current drawing is saved except that the 
extension is DUP. This command can only be used if the current drawing already has a name.

Before loading the duplicate, the current drawing is removed from memory. After a warning message has 
been displayed, the duplicate is loaded and displayed. To begin with, a page view is always shown.

If the drawing contains instances of symbols which are not currently in memory, then an attempt will be 
made to load them from the relevant libraries. If a symbol cannot be loaded, it is shown in text form. As 
soon as the symbol becomes available the instance will be shown correctly. The same goes for Tek 
Illustrator's own fonts as long as no substitute font has been specified with the Fonts command.

If the duplicate can not be loaded successfully, then a new drawing is started as if the command New 
Drawing had been carried out.

Related commands:
Miscellaneous>Create Duplicate
Miscellaneous>Autosave
Open Drawing



Miscellaneous>Autosave (File Menu)
This command customizes the autosave function. This is done with the Autosave dialog.

After a time interval has elapsed, the program works out whether the drawing has altered since the last 
save. If this is the case an autosave is activated. A dialog appears which can be used to cancel the 
autosave if it is not required on this occasion.

Autosave only works when Tek Illustrator is working in the foreground and no dialog is open. The 
elapsed time is however measured and an autosave is carried out at the latest when the dialog is closed or 
Tek Illustrator is activated again.

Related commands:
Miscellaneous>Create Duplicate
Miscellaneous>Load Duplicate
Save Drawing



Convert Drawing (File Menu)
This command calls one of the available converters. A list of the available converters appears. The list 
shows all the programs in the CNV-path= section of WIN.INI. This is normally the CONVERT 
subdirectory of the Tek Illustrator directory.

The conversion programs have a name which indicates the file types they convert from and to. It should 
always follow this pattern:

AAA_BBB.EXE

AAA is the extension of the source file format and BBB is the extension of the target file format. For a 
more complete explanation see Important File Extensions.

After a converter is chosen from the list, it is started. The converters are freestanding programs which can 
be used separately from Tek Illustrator. Each converter may work in a different way.

In general, a converter will allow you to convert one file, or all the files in a directory. Large collections 
of drawings can be converted quickly in this way. Some converters also allow you to specify conversion 
parameters.

For further information, refer to the descriptions of the individual converters. Each converter 
AAA_BBB.EXE has a corresponding Write file called AAA_BBB.WRI, which can be read and/or printed
out using Windows' Write accessory.

Note: The file converters work on a file basis, i.e. they read a file, convert it, and then write the result to a
new file. They can not be used to read a foreign file format directly into Tek Illustrator. The file must be 
converted first and then loaded with a suitable command (e.g. Open drawing).

Related command:
No related commands



Print Drawing (File Menu)
This command is used to print a drawing or part of a drawing. Any output device for which a driver is 
installed can be used.

Choosing the command calls the Print Drawing Dialog, in which the print settings can be specified.

If only certain objects are to be printed, they must be selected before choosing this command, using for 
example the command Select>Identification. The "Selection Only" check box can then be enabled.

Important! If you use an HPGL-Plotter with the HPPLOT.DRV driver supplied by Microsoft (or 
Hewlett-Packard and Micrografx), you must read the text Notes for Plotter Output! It contains notes on 
the correct use of such a plotter with Tek Illustrator.

Related command:
No related commands



Control Panel (File Menu)
This command calls Windows' Control Panel, from which the default output device can be chosen.

More information can be found in your Windows documentation and the Control Panel's Help file.

Related command:
No related commands



Exit (File Menu)
This command closes Tek Illustrator. If unsaved work is still in memory, you are given the option of 
saving the work or not.

If Save Settings on Exit has been enabled, the current settings are saved.

If Save Symbol Window on Exit has been enabled, the contents of the symbol window are saved.

All windows for which the "Save Position" entry in their system menu is enabled, have their position (and
possibly their size) saved. In addition, information on which windows are displayed is also saved. The 
same goes for the menu bar.

These settings are restored when the program is next started. If Multi-User Mode is enabled, then the 
information is written to the users' file and is applied next time the same user starts the program.

Related command:
No related commands



Edit Menu
Undo
Redo
Erase Undo Information
Cut
Copy
Paste
Copy to File
Paste from File
Bitmap

Display
Parameters
Remove
Export

Comment
Draw
Parameters

Drawing Details



Undo (Edit Menu)
This command can be used to undo the last operation carried out. It can be used with all commands which
create, alter or delete objects, instances or geometry objects. For example, the following commands, 
among others, can be undone:

Shape>Edit Properties
Shape>Move Objects>Standard
Draw>Line>Standard
Trimming>Trim Object>Cut Out
Dimension>Hatch Objects>Union
Library>Insert Symbol / Block

Some operations cannot be undone. These are mainly operations which alter settings or definitions, as 
well as alterations to blocks and symbols. These are examples of operations which cannot be undone:

File>New Drawing
Configuration>Set Origin
Configuration>Settings>Output
Library>Generate Symbol / Block
Library>Clean up Blocks

Successive operations can also be undone. The maximum number of undoable operations depends on the 
"Undo Steps" setting in the command System Configuration>Memory and Monitor.

Note: The undo information needed to undo operations is not saved along with the drawing, i.e. it is lost 
when the drawing is saved.

Related commands:
Redo
Erase Undo Information



Redo (Edit Menu)
This command redoes an operation canceled with the Undo command. It can only be carried out 
immediately after an undo. If another operation has been carried out after the undo, you cannot redo the 
undone operation.

Several undone commands can be redone. Successive operations can also be undone. The maximum 
number of redoable operations depends on the "Undo Steps" setting in the command System 
Configuration>Memory and Monitor.

Note: The undo information needed to undo and redo operations is not saved along with the drawing, i.e. 
it is lost when the drawing is saved.

Related commands:
Undo
Erase Undo Information



Erase Undo Information (Edit Menu)
This command removes the current undo information from memory. Undo information is generated every
time you carry out an operation which can be undone using the Undo command.

The size of the undo information depends on the number of objects which have been altered at the same 
time. If a large number of objects have been altered, then a memory bottleneck can arise. In this case, you 
should consider erasing the undo information.

The larger the maximum number of undo levels, the more undo information is generated. If you often get 
memory shortages when working with large numbers of objects, then you should either increase the 
available object memory or reduce the number of undo levels (see System Configuration>Memory and 
Monitor).

Note: The undo information needed to undo operations is not saved along with the drawing, i.e. it is lost 
when the drawing is saved.

Related commands:
Undo
Redo



Cut (Edit Menu)
This command copies objects to the Windows Clipboard and then deletes them from the drawing.

1. Choose objects
The objects to be cut must be chosen. Any number of objects can be chosen. This can be done using 
several methods, which can be combined with each other:

Objects can be chosen, as for identification, by simply clicking on their outlines. If several 
objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the help of 
which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two opposite 
corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

After choosing the objects, they are copied to the clipboard and remain there until new data is copied to 
the clipboard, which can also be done from other applications.

The original objects in the drawing are deleted without a further warning. If needed, they can be restored 
using Undo. This does not affect the contents of the clipboard.

Note: The objects are placed on the clipboard in two different formats. The first format is the usual Tek 
Illustrator (TVG 3.0) drawing format, which contains information about objects and instances. In 
addition, there is no loss of quality when using Tek Illustrator. At present, this format can only be used by 
Tek Illustrator and is ignored by other applications.
The second format is Windows Metafile Format (WMF). This format can be used by most current 
applications. The data are created as if for printing, i.e. the output pen properties are used. In addition, the 
current settings set with Settings>Output are used so that you can influence what is copied to the 
clipboard.

Related commands:
Copy
Paste



Copy (Edit Menu)
This command copies selected objects to the Windows Clipboard.

1. Choose objects
The objects to be copied must be chosen. Any number of objects can be chosen. This can be done 
using several methods, which can be combined with each other:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

After choosing the objects, they are copied to the clipboard, where they remain until new data is written 
to the clipboard, which can also be done by other Windows applications.

Note: The objects are placed on the clipboard in two different formats. The first format is the usual Tek 
Illustrator (TVG 3.0) drawing format, which contains information about objects and instances. In 
addition, there is no loss of quality when using Tek Illustrator. At present, this format can only be used by 
Tek Illustrator and is ignored by other applications.
The second format is Windows Metafile Format (WMF). This format can be used by most current 
applications. The data are created as if for printing, i.e. the output pen properties are used. In addition, the 
current settings set with Settings>Output are used so that you can influence what is copied to the 
clipboard.

Related commands:
Cut
Paste
Copy to File



Paste (Edit Menu)
This command pastes the contents of the Windows Clipboard into the current drawing. This process can 
use two different formats.

If the Clipboard contains data in Windows Metafile Format (WMF), these are converted to objects and 
inserted into the drawing. Text and bitmap data within the metafile data will however be ignored.

If the Clipboard contains data in Tek Illustrator (TVG 3.0) format, these are used instead of the WMF 
data. All objects, instances and blocks are inserted into the current drawing.

Conflicts can arise when inserting blocks. As blocks are identified by their names, each name must be 
unique within a drawing. If blocks in the clipboard have names already in use in the current drawing, then
they cannot be pasted.

The pasted objects and instances are marked internally as if they had been selected. Because of this, they 
can quickly be selected by using the F11 Key if, for example, they are to be moved or scaled.

Note: As the appearance of an object depends on the current pen, line pattern and layer settings, the 
appearance of pasted objects may be different to their original appearance. The current pen, line pattern 
and layer settings may be very different to those in the original drawing.

Related commands:
Cut
Copy
Paste from File



Copy to File (Edit Menu)
This command is used to save selected objects to a WMF file

1. Choose objects
The objects to be copied must be chosen. Any number of objects can be chosen. This can be done 
using several methods, which can be combined with each other.

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

After choosing the objects, a File Selection Dialog appears, where you can choose the name for the WMF 
file where the chosen objects will be saved.

Note: The data are created as if for printing, i.e. the output pen properties are used. In addition, the 
current settings set with Settings>Output are used so that you can influence what is copied to the WMF 
file.

Related command
Paste from File



Paste from File (Edit Menu)
This command pastes objects from a Windows Metafile Format (WMF) file in to the current drawing. A 
File Selection Dialog, dialog appears, from which the relevant WMF file can be chosen.

After this, the data from this file are converted into objects and pasted into the current drawing. 
Information about text and bitmap graphics will, however, be ignored.

The pasted objects will be marked internally as if they had been selected. If, for example, these objects 
are to be moved or scaled they can be selected quickly and easily using the F11 Key.

Related command
Copy to File



Bitmap>Display (Edit Menu)
This command loads a Windows bitmap (BMP) into memory and displays it on screen. It calls a File 
Selection Dialog, in which the required BMP file can be chosen.

The bitmap is then loaded into memory, and if needed, adjusted to the color depth of the monitor. The 
type and quality of the adjustment depends largely on the screen driver in use.

After the bitmap has successfully been loaded and modified, the Bitmap>Parameters command is called 
so that the bitmap display parameters can be specified.

Note: Optionally, a displayed bitmap may be used or ignored during output (i.e. to the printer, Clipboard, 
a metafile or another bitmap). Use the Settings>Output command to set this option. By default, bitmaps 
are used.

Related command
Bitmap>Export



Bitmap>Parameters (Edit Menu)
This command can be used to set the display parameters for the current bitmap. It is only available if a 
bitmap has already been loaded using the Bitmap>Display command.

The Bitmap Display dialog appears, where the parameters can be altered.

The bitmap is displayed in the drawing's background; that is, it will be obscured by objects and instances. 
If more than one drawing window is visible, then the bitmap is only displayed in window 1.

Note: Bitmap display only functions when the drawing in window 1 is undistorted and the zoom is not 
extreme. If one pixel from the bitmap would be larger than 64 screen pixels or smaller than 1/64 screen 
pixels, then the bitmap will not be displayed.

Affected command:
Bitmap>Display



Bitmap>Remove (Edit Menu)
This command removes any bitmap graphic currently in memory from memory. Afterwards it cannot be 
displayed or output.

Before removal, a dialog appears in which you are asked to confirm that you wish to remove the bitmap. 
This helps avoid accidental removal.

Related command
Bitmap>Display



Bitmap>Export (Edit Menu)
This command can be used to export a drawing to a bitmap. It makes use of the DIB.DRV driver, supplied
with and installed by Tek Illustrator.

After choosing the command, the Export Bitmap dialog appears, where the export parameters can be 
specified.

If only a few objects from the drawing are to be exported, then they must be selected before the command
is chosen, for example using the command Select>Identification. The "Selection Only" check box can 
then be enabled.

Related command
Bitmap>Display



Comment>Draw (Edit Menu)
This command is used to insert a comment

1. Insert reference point
The comment's reference point can be inserted by clicking the mouse at any point within the drawing.

Optionally, the position of the reference point may be specified using coordinates. To do this, press 
either F8 or ENTER, and enter either absolute or polar coordinates in the dialog. For further 
information, see Function Keys>Direct Input (F8).

2. Enter Target Point
The Target Point, the center of the comment field can be inserted by clicking the mouse at any point 
within the drawing.

Optionally, the position of the reference point may be specified using coordinates. To do this, press 
either F8 or ENTER, and enter either absolute, polar or relative (relative to the reference point) 
coordinates in the dialog. For further information, see Function Keys>Direct Input (F8).

After entering the target point, a dialog appears into which a comment of up to 250 characters can be 
typed.

Note: The appearance of all the comments can be set using the command 
Comment>ParametersIDM_EDIT_COMMENT_PARAM. Comments can only be viewed on screen. 
They cannot be printed out or exported in any way.

Related command
No related commands



Comment>Parameters (Edit Menu)
This command can be used to set the display parameters for comments. This is done with the Comment 
Parameters dialog.

Altering these parameters changes the display properties of both existing and new comments.

Affected command:
Comment>Draw



Drawing Details (Edit Menu)
This command can be used to view and edit the current drawing's details. This is done via the Details 
dialog.

Related commands:
Save Drawing
Save Drawing as
Save Elements as



Configure Menu
Page Formats
Layers

Edit
Defaults

Coordinate systems
Edit
Set Origin

Pens
Edit
Defaults
Line Patterns

Zoom
Section
Overview
Page
Original Size
Factor
Named Areas
Previous Zoom
Set Center
Double Zoom
Halve Zoom

Save Elements as Default
Window

Enlarge Window 2
Enlarge Window 3
Enlarge Window 4

Display Status Window
Display Toolbox
Program Status
System Configuration

Memory and Monitor
Paths
Multi-User Mode

Settings
Display
Screen
Output
Plotter
Colors
Time Format
Change Key Assignment
Display Key Assignment
Mouse Button Usage



Open
Save As
Details
Save as Default

Save Settings on Exit
Command Queue



Page Formats (Configure Menu)
This command can be used to view and alter the current page format. This is done from the Page Formats 
dialog.

Altering the page format does not affect the drawing objects. The screen is however redrawn to give an 
overview of the new page.

Usually, the size of the page is shown on screen by a violet-colored dashed line. This can be turned off 
using the command Settings>Display.

Related command:
No related commands



Layers>Edit (Configure Menu)
This command can be used to manage the current drawing's layers. You can define, alter, delete or make a
different layer the current layer.

This is done from the Edit Layers dialog. The layer which is selected when this dialog is closed becomes 
the current layer.

Related command:
No related commands



Layers>Defaults (Configure Menu)
This command can be used to set the default layer for certain types of objects in the current drawing. 
These default layers make it easier to allocate various types of objects to different layers automatically

The default layers are specified from the Layer Defaults dialog.

Affected Commands:
Marking
Division>Distance
Division>Object
Division>Array
Trim Surface>Generate Surface
Dimension Line>Straight
Dimension Line>Curved
Dimension>Length, Points
Dimension>Length, Object
Dimension>Length, Object - Point
Dimension>Length, Object - Object
Dimension>Radius, Points
Dimension>Radius, Object
Dimension>Diameter, Points
Dimension>Diameter, Object
Dimension>Angle, Points
Dimension>Angle, Line Line
Dimension>Angle, Circle Part
Dimension>Arc Length, Points
Dimension>Arc Length, Circle Parts
Dimension>Coordinates
Calculate>Area
Calculate>Perimeter / Length
Text>Single Line
Text>Multiple Lines
Hatch Objects>Union (A+B)
Hatch Objects>Intersection (A×B)
Hatch Objects>Difference (A-B)
Symbol / Block>Insert



Coordinate Systems>Edit (Configure Menu)
This command can be used to manage the coordinate systems in the current drawing. They can be 
defined, altered, deleted or made active.

This is done from the Define Coordinate Systems dialog. The coordinate system active when the dialog is 
closed becomes the active coordinate system.

Related command:
No related commands



Coordinate Systems>Set Origin (Configure Menu)
This command positions the origin of the active window's coordinate system.

1. Enter position
The origin's position can be entered by clicking the mouse pointer anywhere in the drawing.

Optionally, the position can be specified with coordinates. Press the F8 key or the ENTER key. 
Absolute or polar coordinates can now be entered. For further information, see Function Keys>Direct 
Input (F8).

After entering the position, the coordinate system's origin moves to this point. The origin position mode 
of this coordinate system is set to "Specified Position".

Note: Setting the origin position cannot be undone using the Undo command.

Related command:
Coordinate Systems>Edit



Pens>Edit (Configure Menu)
This command can be used to manage the pens in the current drawing. They can be defined, altered, 
deleted or made active.

This is done from the Define Pens dialog. The pen which is selected when this dialog is closed becomes 
the active pen.

Related command:
No related commands



Pens>Defaults (Configure Menu)
This command can be used to alter the default pen used for drawing certain types of objects in the current 
drawing. This makes it easier to automatically draw certain types of object with the same pen.

This is done from the Pen Defaults dialog in which the default pens for certain object types can be 
specified.

Affected Commands:
Dimension Line>Straight
Dimension Line>Curved
Dimension>Length, Points
Dimension>Length, Object
Dimension>Length, Object - Point
Dimension>Length, Object - Object
Dimension>Radius, Points
Dimension>Radius, Object
Dimension>Diameter, Points
Dimension>Diameter, Object
Dimension>Angle, Points
Dimension>Angle, Line Line
Dimension>Angle, Circle Part
Dimension>Arc Length, Points
Dimension>Arc Length, Circle Parts
Dimension>Coordinates
Calculate>Area
Calculate>Perimeter / Length
Text>Single Line
Text>Multiple Lines



Pens>Line Pattern (Configure Menu)
This command can be used to manage the line patterns in the current drawing. They can be defined, 
altered and deleted

This is done from the Define Line Pattern dialog.

Related command:
No related commands



Zoom>Section (Configure Menu)
This command changes the area displayed in the active drawing window so that a given rectangular area 
is displayed at the maximum possible size.

1. Section: Enter corner point 1
The first corner point of the section can be entered by clicking the mouse at any point within the 
drawing.

Alternately, you can enter specific coordinates. To do this press F8 or ENTER. You can now enter 
absolute or polar coordinates. For more information on entering coordinates, see Function 
Keys>Direct Input (F8).

2. Section: Enter corner point 2
The second corner point of the section can be entered by clicking the mouse at any point within the 
drawing.

Alternately, you can enter specific coordinates. To do this press F8 or ENTER. You can now enter 
absolute, polar, or relative (to the first corner point) coordinates. For more information on entering 
coordinates, see Function Keys>Direct Input (F8).

After entering the two corner points, the display is recalculated and redrawn.

These alterations to the visible section and the zoom factor can be canceled with the command 
Zoom>Previous Zoom

Note: The current zoom factor used for each drawing window is normally shown in the lower left corner 
of the drawing window , under the page symbol. It is expressed as a percentage of the original page size.

Related commands:
Zoom>Overview
Zoom>Page
Zoom>Original Size
Zoom>Factor
Zoom>Set Center
Zoom>Double Zoom
Zoom>Halve Zoom



Zoom>Overview (Configure Menu)
This command alters the area displayed in the current drawing window so that you can see all of the 
drawing's objects and instances.

If there is currently no object on the screen, then a page overview is displayed.

These alterations to the visible section and the zoom factor can be canceled with the command 
Zoom>Previous Zoom

Note: The current zoom factor used for each drawing window is normally shown in the lower left corner 
of the drawing window , under the page symbol. It is expressed as a percentage of the original page size.

Related commands:
Zoom>Section
Zoom>Page
Zoom>Original Size
Zoom>Factor
Zoom>Set Center
Zoom>Double Zoom
Zoom>Halve Zoom



Zoom>Page (Configure Menu)
You can use this command so that you can see the whole page as large as possible in the current drawing 
window.

These alterations to the visible section and the zoom factor can be canceled with the command 
Zoom>Previous Zoom.

Note: The current zoom factor used for each drawing window is normally shown in the lower left corner 
of the drawing window , under the page symbol. It is expressed as a percentage of the original page size.

Related commands:
Zoom>Section
Zoom>Overview
Zoom>Original Size
Zoom>Factor
Zoom>Set Center
Zoom>Double Zoom
Zoom>Halve Zoom



Zoom>Original Size (Configure Menu)
This command changes the zoom level used for the current drawing window so that all objects and 
instances appear at their original size.

So that the original size can be worked out exactly, the visible screen size must be configured first using 
the command System Configuration>Memory and Monitor.

These alterations to the visible section and the zoom factor can be canceled with the command 
Zoom>Previous Zoom

Note: The current zoom factor used for each drawing window is normally shown in the lower left corner 
of the drawing window , under the page symbol. It is expressed as a percentage of the original page size 
(100% in this case).

Related commands:
Zoom>Section
Zoom>Overview
Zoom>Page
Zoom>Factor
Zoom>Set Center
Zoom>Double Zoom
Zoom>Halve Zoom



Zoom>Factor (Configure Menu)
This command can be used to specify a zoom factor for the current drawing window. It calls a small 
dialog box, in which the factor to be used (between 0.00000000001 and 10000000000) is entered.

These alterations to the visible section and the zoom factor can be canceled with the command 
Zoom>Previous Zoom.

Note: The current zoom factor used for each drawing window is normally shown in the lower left corner 
of the drawing window , under the page symbol. It is expressed as a percentage of the original page size.

Related commands:
Zoom>Section
Zoom>Overview
Zoom>Page
Zoom>Original Size
Zoom>Set Center
Zoom>Double Zoom
Zoom>Halve Zoom



Zoom>Named Areas (Configure Menu)
This command is used to manage the current drawing's zoom areas. They can be defined, deleted or 
loaded. A zoom area specifies a certain area of the drawing and is used to change quickly and easily 
between one part of a drawing and another.

Zoom areas are managed from the Named Zoom Areas dialog.

If the visible zoom area, and therefore the zoom factor, is changed by using this command, the change can
be canceled using the command Zoom>Previous Zoom.

Note: The current zoom factor used for each drawing window is normally shown in the lower left corner 
of the drawing window , under the page symbol. It is expressed as a percentage of the original page size.

Related command:
No related commands



Zoom>Previous Zoom (Configure Menu)
This command restores the previous view of the current drawing window. The last 20 changes to the view
(changes to the zoom factor, scrolling, etc.) are saved separately for each visible window.

Note: If this command is carried out using NUM ÷ key on the numeric keypad, then the command applies
to the window over which the mouse pointer or crosshair is located, which may not be the active drawing 
window.

Related command:
No related commands



Zoom>Set Center (Configure Menu)
This command moves the position over which the mouse pointer or crosshair is located to the center of 
the drawing window.

If the visible section, and therefore the zoom factor, is changed by using this command, the change can be
canceled using the command Zoom>Previous Zoom.

Note: This command is designed to be carried out using the NUM × key on the numeric keypad as the 
crosshair position only makes sense then. It is included in the menu so that it can be assigned to a 
different key.

Related commands:
Zoom>Section
Zoom>Overview
Zoom>Page
Zoom>Original Size
Zoom>Factor
Zoom>Double Zoom
Zoom>Halve Zoom



Zoom>Double Zoom (Configure Menu)
This command doubles the size of the view in the active window, i.e. it doubles the zoom factor.

If the visible section, and therefore the zoom factor, is changed by using this command, the change can be
canceled using the command Zoom>Previous Zoom.

Note: If this command is carried out using the NUM + key on the numeric keypad, it will apply to the 
window over which the mouse pointer or crosshair is located, which may not be the active drawing 
window. In this case, the area around the current crosshair position is altered.

Related commands:
Zoom>Section
Zoom>Overview
Zoom>Page
Zoom>Original Size
Zoom>Factor
Zoom>Set Center
Zoom>Halve Zoom



Zoom>Halve Zoom (Configure Menu)
This command reduces the view in the active window by a factor of two, i.e. the zoom factor is halved.

If the visible section, and therefore the zoom factor, is changed by using this command, the change can be
canceled using the command Zoom>Previous Zoom.

Note: If this command is carried out using the NUM - key on the numeric keypad, it will apply to the 
window over which the mouse pointer or crosshair is located, which may not be the active drawing 
window. In this case, the section around the current crosshair position is altered.

Related commands:
Zoom>Section
Zoom>Overview
Zoom>Page
Zoom>Original Size
Zoom>Factor
Zoom>Set Center
Zoom>Double Zoom



Save Elements as Default (Configure Menu)
This command saves the current drawing elements as the defaults. These elements are: page format, 
layers, coordinate systems, pens, line patterns and zoom sections.

The elements are saved in the file TSTEK3.T3G (or in the appropriate user file, when in multi-user mode)
They are used as the basic settings whenever a new drawing is started, or they can be merged into an 
existing drawing using the command Merge Drawing>Standard Elements.

Note: If the elements are to be saved in a named file, to differentiate element groups, the command Save 
Elements as can be used.

Related commands:
Save Drawing
Save Elements as



Window>Enlarge Window 2 (Configure Menu)
This command can be used to enlarge the second drawing window. The effect is to swap the first (initially,
the largest) and second drawing windows.

As the height/width relationship of all drawing windows is the same, the visible drawing area remains the 
same, but the zoom factor of both windows may change.

Note: The information for restoring the previous zoom levels is adjusted for both windows.

Related commands:
Window>Enlarge Window 3
Window>Enlarge Window 4



Window>Enlarge Window 3 (Configure Menu)
This command can be used to enlarge the third drawing window. The effect is to swap the first (initially, 
the largest) and third drawing windows.

As the height/width relationship of all drawing windows is the same, the visible drawing area remains the 
same, but the zoom factor of both windows may change.

Note: The information for restoring the previous zoom levels is adjusted for both windows.

Related commands:
Window>Enlarge Window 2
Window>Enlarge Window 4



Window>Enlarge Window 4 (Configure Menu)
This command can be used to enlarge the fourth drawing window. The effect is to swap the first (initially, 
the largest) and fourth drawing windows.

As the height/width relationship of all drawing windows is the same, the visible drawing area remains the 
same, but the zoom factor of both windows may change.

Note: The information for restoring the previous zoom levels is adjusted for both windows.

Related commands:
Window>Enlarge Window 2
Window>Enlarge Window 3



Display Status Window (Configure Menu)
This command turns display of the Status Window on or off

The Status Window is displayed automatically as soon as the Function Keys>Direct Input (F8) command 
is chosen.

Note: The Status Windows status is saved when the program is closed. In multi-user mode, this 
information is saved for each user.

Related commands:
Display Toolbox
Display Symbol Window
Settings>Screen



Display Toolbox (Configure Menu)
This command turns display of the Toolbox on or off.

Note: The Toolbox's status is saved when the program is closed. In multi-user mode, this information is 
saved for each user.

Related commands:
Display Status Window
Display Symbol Window
Settings>Screen



Program Status (Configure Menu)
The current program status can be called with this command. The information appears in the Program 
Status dialog.

Related command:
About Tek Illustrator



System Configuration>Memory and Monitor (Configure Menu)
This command can be used to configure all parts of the system concerned with memory and the monitor. 
This is done from the Memory and Monitor dialog.

If values in this dialog are altered which affect the monitor or the size of the buttons in the panel, the 
whole Tek Illustrator working area is redrawn.

If values which affect memory management are altered, then the memory is reorganized. The current 
memory content is temporarily stored on the hard disk.

Note: These values are saved when the program is closed. In multi-user mode, this information is saved 
for each user.

Affected command:
No directly affected command



System Configuration>Paths (Configure Menu)
This command can be used to set the default paths. The default paths tell the program where to look for 
certain important files. These directories are used as initial directories in the File Selection Dialog.

The Standard Paths dialog, in which the default paths can be specified, appears.

Note: The paths specified here are saved permanently, even after the program is closed. In multi-user 
mode, different settings are saved for each user.

Affected command:
No directly affected command



System Configuration>Multi-User Mode (Configure Menu)
This command turns multi-user mode on or off.

If multi-user mode is on, the User Identification dialog appears during every program start where the 
individual user can log in.

In multi-user mode settings are maintained for each user. Each user has individual settings and 
configuration files (settings (INF), system configuration (INI), default elements (T3G) and symbol lists 
(SYM) ),so that two users cannot interfere with each others settings.

User-dependent files have the names -??????-, where ?????? is the user's contraction. Each user must have
at least INI and T3G files.

Affected command:
No directly affected command



Settings>Display (Configure Menu)
This command can be used to alter the settings which influence screen display. This is done from the 
Display Settings dialog.

The settings changed here only affect the display of the elements in the drawing. They have no effect on 
output to a printer or plotter, the clipboard, a metafile or bitmap.

Affected command:
No directly affected command



Settings>Screen (Configure Menu)
This command can be used to alter the settings relating to the division of the screen and the accuracy of 
screen operations. This is done from the Screen Settings dialog.

These settings only affect the display or output of drawing elements. None of the elements are directly 
altered. The transformation precision does however affect the accuracy of Objects generated with certain 
commands.

Affected Commands:
Print Drawing
Cut
Copy
Copy to File
Export
Trim Object>Resolve Completely
Trim Surface>Union (A=A+B)
Trim Surface>Intersection (A=A×B)
Trim Surface>Difference(A=A-B)
Trim Surface>Generate Surface
Transform Object to>Curve
Transform Object to>Surface
Transform Object to>Eraser
Calculate>Area
Calculate>Perimeter / Length



Settings>Output (Configure Menu)
This command can be used to alter settings which influence the appearance of the drawing when it is 
output. This is done from the Output Settings dialog.

These settings only affect the output of the drawing on a printer or plotter, to the clipboard, a bitmap or a 
metafile. They do not affect any drawing elements or the way in which the elements are displayed in the 
drawing window.

Note: Erasers are created by overpainting the foreground with the background color. The fill color 
specified in the output properties for the output section is used whenever output is not to the screen. This 
color is also effective if the output section is not output!

Affected Commands:
Print Drawing
Cut
Copy
Copy to File
Export



Settings>Plotter (Configure Menu)
This command can be used to alter the settings which can affect the drawing when it is output to a printer 
or a plotter. This is done via the Plotter Settings dialog.

The "Pen Adaptation active" check box should only be checked if output is to a plotter whose plotter 
driver does not select pens correctly.

These settings only affect output to a printer or plotter, not to the clipboard, a bitmap or metafile. They do 
not alter any of the elements in the drawing and do not affect their display on screen.

Important! If you are using an HPGL plotter and the HPPLOT.DRV driver supplied by Microsoft or by 
Hewlett-Packard or Micrografx, you should read the Notes for Plotter Output, which contains important 
tips on using such a plotter with Tek Illustrator.

Affected command:
Print Drawing



Settings>Colors (Configure Menu)
This command can be used to alter the colors used to display screen elements. This is done from the Color
Settings dialog.

These settings affect the display of the window on the screen and the Display of some drawing elements 
within the drawing window. They do not directly affect any of the drawing elements and do not affect 
output to a printer or plotter, the clipboard, a bitmap or a metafile.

Affected command:
No directly affected command



Settings>Time Format (Configure Menu)
This command can be used to set the format used for time and date details. A dialog box with a list of 
possible formats appears. The formats show how the current time and date would appear as examples.

The format is used for all time and date details in drawings and libraries and also for printing time/date 
details in headers and footers.

Affected command:
No directly affected command



Settings>Change Key Assignment (Configure Menu)
This command can be used to assign commands to keys. To do this, the command which is to be assigned 
to a key is displayed.

1. Select Command
The command which is to be assigned to a key must be selected. The command can be selected by 
any valid method, i.e. from the menus, the text menu, the pop-up menu, the toolbox or via an existing 
shortcut key.
When selecting with a shortcut key, submenus continue to be displayed in a "normal" way, i.e. a 
submenu cannot be assigned directly to a key. To do this, the "Complete Submenu" checkbox must be
enabled in the dialog which appears.

After selecting the command, the Change Key Assignment dialog appears, where the key to which the 
command is to be allocated can be chosen.

Affected command:
No directly affected command



Settings>Display Key Assignments (Configure Menu)
This command can be used to display the current key assignments. Individual key assignments can be 
deleted, and in addition the default key assignments can be restored.

To display and edit key assignments the Display Key Assignment dialog appears.

Affected command:
No directly affected command



Settings>Mouse Button Usage (Configure Menu)
This command can be used to specify the function of the right hand and (on three-button mice) the center 
buttons. In particular you can choose between the use of the graphical pop-up menu or the text menu.

The Mouse Button Usage Settings dialog appears to enable the mouse button functions to be specified.

Affected Commands:
Control Keys>Middle Mouse Button
Control Keys>Right Mouse Button



Settings>Open (Configure Menu)
This command can be used to open existing settings files, that is, to load them into memory and make 
them active. The setting file to be used is chosen from a File Selection Dialog.

Note: Settings files contain all the directly altered settings and the status of the larger dialogs. This 
includes the contents of the Toolbox and the current settings of the following dialogs:

Autosave
Comment Parameters
Display Settings
Screen Settings
Output Settings
Plotter Settings
Color Settings
Mouse Button Settings
Display Key Assignments
Geometry
Division
Fonts
Define Hatching Types
Insert Symbol / Block
Generate Symbol / Block
Edit Symbol / Block
Copy Symbol / Block
Generate Parts List
Symbol Window Parameters
Choose Color

Related commands:
Settings>Save As
Settings>Save as Default
Save Settings on Exit



Settings>Save As (Configure Menu)
This command can be used to save the current settings in a settings file so that they can be loaded again 
later.

A File Selection Dialog appears, in which the name of the file to be saved can be entered. After this, the 
Details dialog appears in which the details of the settings file can be altered.

Note: Settings files contain all the directly altered settings and the status of the larger dialogs. This 
includes the contents of the Toolbox and the current settings of the following dialogs:

Autosave
Comment Parameters
Display Settings
Screen Settings
Output Settings
Plotter Settings
Color Settings
Mouse Button Settings
Display Key Assignments
Geometry
Division
Fonts
Define Hatching Types
Insert Symbol / Block
Generate Symbol / Block
Edit Symbol / Block
Copy Symbol / Block
Generate Parts List
Symbol Window Parameters
Choose Color

Related commands:
Settings>Open
Settings>Save as Default
Save Settings on Exit



Settings>Details (Configure Menu)
This command can be used to view and edit the current settings. To do this, the Details dialog appears.

Related command:
Settings>Save As



Settings>Save as Default (Configure Menu)
This command can be used to save the current settings as the default, used the next time the program is 
started.

The current settings are saved in the file TSTEK3.INF (or in multi-user mode the user file -??????-.INF). 
If this file already exists, a warning appears so as to avoid the accidental overwriting of the defaults.

Note: Settings files contain all the directly altered settings and the status of the larger dialogs. This 
includes the contents of the Toolbox and the current settings of the following dialogs:

Autosave
Comment Parameters
Display Settings
Screen Settings
Output Settings
Plotter Settings
Color Settings
Mouse Button Settings
Display Key Assignments
Geometry
Division
Fonts
Define Hatching Types
Insert Symbol / Block
Generate Symbol / Block
Edit Symbol / Block
Copy Symbol / Block
Generate Parts List
Symbol Window Parameters
Choose Color

Related command:
Settings>Open
Settings>Save As
Save Settings on Exit



Save Settings on Exit (Configure Menu)
This command tells the program to save the current settings as the default on exit. These settings are then 
used the next time the program is started.

The current settings are saved in the file TSTEK3.INF (or the individual user files -??????-.INF for multi-
user operation.).

Note: This function has been provided because users asked for it. However, we recommend that it is not 
used, but instead to save settings as required using the command Settings>Save as Default. By 
automatically saving settings, it is often the case that unwanted changes to the settings are saved.

Related command:
Settings>Open
Settings>Save As
Settings>Save as Default



Command Queue (Configure Menu)
This command calls a list of the last 14 commands used, enabling quick and easy access to them.

The command queue works in the same way as the normal text menu. Individual entries can appear with a
tick against them (if the corresponding function is active) or grayed out (if the command is not currently 
available).

Note: The command queue is always empty when the program is started, and fills up only when 
commands are executed.

Related command:
No related commands



Shape Menu
Erase Drawing
Center Drawing

Horizontal
Vertical
Both

Edit Properties
Edit Text
Delete Objects
Move / Copy Objects

Standard
Perpendicular
Parallel
Relative

Scale Objects
Factors
Proportional
Non-Proportional
Reference Distance

Rotate Objects
Center
Arbitrary

Reflect Objects
Horizontal
Vertical
Line

Distort Objects
Horizontal
Vertical

Center Objects
Page, Horizontal
Page, Vertical
Page, Both
Frame, Horizontal
Frame, Vertical
Frame, Both

Group
Create Group
Ungroup

Change Order
To Back
Behind Object
Before Object
To Front





Erase Drawing (Shape Menu)
This command can be used to delete all objects and instances from the drawing. Blocks, if present, are 
unaffected. 

The objects and instances are deleted without confirmation being required. If needed they can be restored 
using the Undo command.

If geometry objects are present when this command is called, then the program asks if they should be 
deleted as well.

Note: The duplicate function does not work with this command, i.e. all objects are deleted even if the 
duplicate function is active.

Related commands:
Delete Objects
Edit Geometry>Erase Identification
Edit Geometry>Erase, Complete



Center Drawing>Horizontal (Shape Menu)
This command can be used to center all of the drawings objects and instances horizontally on the page. To
do this, they are moved so that the distance to the left edge of the page is the same as the distance to the 
right edge of the page. All selected objects are treated as a single item, that is they are all moved by the 
same amount.

If geometry objects are present when this command is called, the program asks whether they should be 
moved as well.

If the duplicate function is active when this command is chosen (e.g. if the CTRL key is held down) a 
copy of the selected objects is generated and the copy is centered.

Related commands:
Center Drawing>Vertical
Center Drawing>Both
Center Objects>Page, Horizontal
Center Objects>Page, Vertical
Center Objects>Page, Both
Center Objects>Page, Horizontal
Center Objects>Page, Vertical
Center Objects>Page, Both
Edit Geometry>Move



Center Drawing>Vertical (Shape Menu)
This command can be used to center all of the drawings objects and instances vertically on the page. To 
do this, they are moved so that the distance to the top of the page is the same as the distance to the bottom
of the page. All selected objects are treated as a single item, that is they are all moved by the same 
amount.

If geometry objects are present when this command is called, the program asks whether they should be 
moved as well.

If the duplicate function is active when this command is chosen (e.g. if the CTRL key is held down) a 
copy of the selected objects is generated and the copy is centered.

Related commands:
Center Drawing>Horizontal
Center Drawing>Both
Center Objects>Page, Horizontal
Center Objects>Page, Vertical
Center Objects>Page, Both
Center Objects>Page, Horizontal
Center Objects>Page, Vertical
Center Objects>Page, Both
Edit Geometry>Move



Center Drawing>Both (Shape Menu)
This command can be used to center all of the drawings objects and instances horizontally and vertically 
on the page. To do this, they are moved so that the distance to the left edge of the page is the same as the 
distance to the right edge of the page, and the distance from the top of the page is the same as the distance
from the bottom of the page. All selected objects are treated as a single item, that is they are all moved by 
the same amount.

If geometry objects are present when this command is called, the program asks whether they should be 
moved as well.

If the duplicate function is active when this command is chosen (e.g. if the CTRL key is held down) a 
copy of the selected objects is generated and the copy is centered.

Related commands:
Center Drawing>Horizontal
Center Drawing>Vertical
Center Objects>Page, Horizontal
Center Objects>Page, Vertical
Center Objects>Page, Both
Center Objects>Page, Horizontal
Center Objects>Page, Vertical
Center Objects>Page, Both
Edit Geometry>Move



Edit Properties (Shape Menu)
This command can be used to edit the properties of existing objects and instances. In addition, all object-
specific parameters can be changed. This is done separately for each property, although several objects 
can be changed at the same time.

1. Choose objects
Choose the objects whose properties are to be altered. Any number of objects can be chosen. This can 
be done with various methods, which can be used on their own or in combination with one another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

After choosing the objects, the Edit Properties dialog appears in which the object properties can be 
viewed and altered.

If object-specific settings (e.g. text or dimension parameters) are altered, the change is applied to all 
selected objects of the same type. For example, if the size of a "Single Line Text" object is changed, this 
change is applied to all single line text objects but not to multiple-line or dimension text.

If the duplicate function is active, a copy of the chosen objects is created and the copy is altered. This 
means that a copy with entirely different parameters can be created.

Related command:
Edit Text



Edit Text (Shape Menu)
This command can be used to edit existing text objects of all types - single line text, multiple line text, 
dimension text and comments.

1. Identify text object
An object is identified by clicking on its outline. If more than one object outline lies at the spot 
clicked on, a small dialog appears at the bottom of the screen, from which the correct object can be 
chosen.

After identifying the object one of the following dialogs appears in which the text can be edited:
Editing Single Line Text
Editing Multiple Line Text
Dimension and Tolerances
Coordinates and Tolerances

Related commands:
Edit Properties
Edit Dimension>Update



Delete Objects (Shape Menu)
This command can be used to delete selected objects and instances from the drawing.

1. Choose objects
The objects to be deleted must be chosen. Any number of objects can be chosen. This can be done 
with various methods, which can be used on their own or in combination with one another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

After choosing the objects, they are deleted without further confirmation being needed. If needed, they 
can be restored using the Undo command.

Note: The duplicate function has no effect on this command, that is, the objects are still deleted if the 
duplicate function is active.

Related commands:
Erase Drawing
Edit Geometry>Erase Identification
Edit Geometry>Erase, Complete



Move / Copy Objects>Standard (Shape Menu)
This command can be used to move or copy objects and instances in the drawing. The movement can be 
in any direction and is specified using two reference points.

1. Choose objects
The objects to be moved or copied must be chosen first. Any number of objects can be chosen. This 
can be done with various methods, which can be used on their own or in combination with one 
another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

2. Enter reference point
The reference point for the movement can be entered by clicking the mouse anywhere in the drawing.

Optionally, specific coordinates can be used. To do this, press F8 or ENTER. You can now enter 
absolute or polar coordinates. For further information on entering coordinates, see Function 
Keys>Direct Input (F8).

3. Enter target point
The target point for the movement can be entered by clicking the mouse anywhere in the drawing.

Optionally, specific coordinates can be used. To do this, press F8 or ENTER. Now absolute, relative 
or polar coordinates can be entered. Relative values are based on the previously entered reference 
point. For further information on entering coordinates, see Function Keys>Direct Input (F8).

If the duplicate function is active during target point entry (for example if the CTRL key was held down), 
a copy of the chosen objects is generated and moved. In this way objects can be copied.

Related commands:
Move / Copy Objects>Perpendicular
Move / Copy Objects>Parallel



Move / Copy Objects>Relative
Edit Geometry>Move
Multiple Copy>Rotation
Multiple Copy>Gradual



Move / Copy Objects>Perpendicular (Shape Menu)
This command can be used to move or copy objects and instances. The movement can only be 
perpendicular to a reference object.

1. Choose objects
The objects to be moved or copied must be chosen first. Any number of objects can be chosen. This 
can be done with various methods, which can be used on their own or in combination with one 
another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

2. Identify reference object
Any part of an existing object can be identified as a reference object. This can be a side of a rectangle,
the arc of an ellipse segment or an arc within a surface.
Identify the reference object by clicking on it with the mouse. If several possible objects lie near the 
position clicked on, a small dialog appears at the bottom of the screen from which the correct object 
can be chosen.

The identified object is referred to as the "Reference Object".

If an ellipse part is identified then the point at which the object was identified (the "ID-Point") is 
important. If a perpendicular is dropped onto an ellipse, it can end on either side of the ellipse. The 
point nearer to the ID-Point is used as the perpendiculars end point (see graphic).



3. Enter reference point
The reference point for the movement can be entered by clicking the mouse anywhere in the drawing. 
A perpendicular is dropped from this point to the reference object.

The target point can then be placed on the line between the reference point and the foot of the 
perpendicular. This line, the "Reference line" is displayed.

Optionally, specific coordinates can be used. To do this, press F8 or ENTER. You can now enter 
absolute or polar coordinates. For further information on entering coordinates, see Function 
Keys>Direct Input (F8).

4. Enter target point
The target point for the movement can be entered by clicking the mouse anywhere in the drawing. A 
perpendicular is dropped from here to the reference line to work out the target point for the 
movement.

Optionally, specific coordinates can be used. To do this, press F8 or ENTER. Now absolute, relative 
or polar coordinates can be entered. Relative values are based on the previously entered reference 
point.
In addition, you can enter a length. This shows the size of the move in the direction of the reference 
line beginning from a previously entered start point. To do this, a small arrow appears in the status 
window during direct entry. This indicates the orientation of the length measurement. A positive value
"pushes" in the direction of the arrow. A negative value "pushes" in the opposite direction to the 
arrow. For further information on entering coordinates, see Function Keys>Direct Input (F8).

If the duplicate function is active during target point entry (for example if the CTRL key was held down), 
a copy of the chosen objects is generated and moved. In this way objects can be copied.

Related commands:
Move / Copy Objects>Standard
Move / Copy Objects>Parallel
Move / Copy Objects>Relative
Edit Geometry>Move



Move / Copy Objects>Parallel (Shape Menu)
This command can be used to move or copy objects within a drawing. Movement can only take place 
parallel to a reference object.

1. Choose objects
The objects to be moved or copied must be chosen first. Any number of objects can be chosen. This 
can be done with various methods, which can be used on their own or in combination with one 
another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

2. Identify reference object
Any part of an existing object can be used as a reference object. This can be an edge of a rectangle or 
an arc within a surface. Ellipses and ellipse parts cannot be identified.
Identify the reference object by clicking on it with the mouse. If several possible objects lie near the 
position clicked on, a small dialog appears at the bottom of the screen from which the correct object 
can be chosen.

The identified object is referred to as the "Reference Object".

3. Enter reference point
The reference point for the movement can be entered by clicking the mouse anywhere in the drawing.
If the previously identified reference object is a line then the reference point determines the position 
of a line which runs parallel to the reference object. This line is displayed and referred to as the 
"Reference line". If however the reference object is a circle or circle part, then it determines the 
position of a circle concentric to the original circle (the "Reference circle"). The target point can then 
be placed on the reference line/circle.

Optionally, specific coordinates can be used. To do this, press F8 or ENTER. You can now enter 
absolute or polar coordinates. For further information on entering coordinates, see Function 
Keys>Direct Input (F8).



4. Enter target point
The target point for the movement can be entered by clicking the mouse anywhere in the drawing. A 
perpendicular is dropped from this point to the reference line or reference circle to work out the target
point for the movement.

Optionally, specific coordinates can be used. To do this, press F8 or ENTER. Now absolute, relative 
or polar coordinates can be entered. Relative values are based on the previously entered reference 
point.
Depending on the type of the reference object, there are further entry possibilities. If the reference 
object is a line, a length can be entered. This gives the size of the movement in the direction of the 
reference line, beginning from a specified starting point. To do this, an arrow appears in the status 
window during input. It shows the orientation for the length value. A positive value gives movement 
in the direction of the arrow and a negative value gives movement in the opposite direction.
In all other cases an angle, measured from the reference circles center, can be entered. The angle can 
be given relative to the reference point angle. For further information on entering coordinates, see 
Function Keys>Direct Input (F8).

If the duplicate function is active during target point entry (for example if the CTRL key is held down) 
then a copy of the chosen objects is created and the copy is moved. In this way objects can be copied.

Related commands:
Move / Copy Objects>Standard
Move / Copy Objects>Perpendicular
Move / Copy Objects>Relative
Edit Geometry>Move



Move / Copy Objects>Relative (Shape Menu)
This command can be used to move or copy objects or instances in the drawing. The movement is 
specified numerically.

1. Choose objects
The objects to be moved or copied must be chosen first. Any number of objects can be chosen. This 
can be done with various methods, which can be used on their own or in combination with one 
another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

2. Enter horizontal and vertical movement
After choosing the objects, a dialog appears in which the amount of horizontal and vertical movement
can be entered. The duplicate function can be briefly turned on by enabling the "Duplicate" check 
box.

If the duplicate function is on when the amount of movement is entered, a copy of the chosen objects is 
created and the copy is moved. In this way objects can be copied.

Related commands:
Move / Copy Objects>Standard
Move / Copy Objects>Perpendicular
Move / Copy Objects>Parallel
Edit Geometry>Move
Multiple Copy>Rotation
Multiple Copy>Gradual



Scale Objects>Factors (Shape Menu)
This command can be used to scale objects and instances in the drawing (i.e. change their size). The 
scaling is done with respect to the center of the frame surrounding the objects.

1. Choose objects
The objects to be scaled have to be chosen. Any number of objects can be chosen. This can be done 
with various methods, which can be used on their own or in combination with one another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

2. Enter horizontal and vertical factors
After choosing the objects, a dialog appears where the horizontal and vertical scaling factors can be 
entered. In addition the duplicate function can be briefly turned on by checking the "Duplicate" 
checkbox.

If the duplicate function is active when the scaling factors are entered, then a copy of the chosen objects is
made and scaled. Scaled copies of objects can be made like this.

Note: Some objects cannot in principle be scaled unproportionally. Above all, these are circles and circle 
parts, and also surfaces which contain circular arcs. If you try to scale such an object unproportionally, a 
message apppears which warns that you must first convert the circles and circle parts to ellipses and 
ellipse parts. This allows you to cancel the operation, without actually making the changes.

Related commands:
Scale Objects>Proportional
Scale Objects>Non-Proportional
Scale Objects>Reference Distance
Edit Geometry>Scale



Scale Objects>Proportional (Shape Menu)
This command can be used to scale (i.e. change the size of) objects and instances in the drawing. The 
objects are so scaled (and moved) that they fit into a specified rectangular area. The scaling is 
proportional, i.e. the horizontal and vertical scaling factors are the same.

1. Choose objects
The objects to be scaled have to be chosen. Any number of objects can be chosen. This can be done 
with various methods, which can be used on their own or in combination with one another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

2. Area: Enter corner point 1
The first corner point of the area can be specified by clicking the mouse button anywhere in the 
drawing.

Optionally, specific coordinates can be used. To do this, press F8 or ENTER. You can now enter 
absolute or polar coordinates. For further information on entering coordinates, see Function 
Keys>Direct Input (F8).

3. Area: Enter corner point 2
The second corner point of the area can be specified by clicking the mouse button anywhere in the 
drawing.

Optionally, specific coordinates can be used. To do this, press F8 or ENTER. Now absolute, relative 
or polar coordinates can be entered. Relative values are based on the previously entered corner point. 
For further information on entering coordinates, see Function Keys>Direct Input (F8).

If the duplicate function is active during entry of the areas second corner point (for example if the CTRL 
key is held down), a copy of the chosen objects is created and then moved and scaled. In this way, objects 
can be copied and scaled at the same time.



Related commands:
Scale Objects>Factors
Scale Objects>Non-Proportional
Scale Objects>Reference Distance
Edit Geometry>Scale



Scale Objects>Non-Proportional (Shape Menu)
This command can be used to scale objects and instances (i.e. change their sizes) in the drawing. The 
objects are scaled and moved so that they fit in a given rectangular area. The scaling is not proportional, 
that is the horizontal and vertical scaling factors can be different.

1. Choose objects
The objects to be scaled have to be chosen. Any number of objects can be chosen. This can be done 
with various methods, which can be used on their own or in combination with one another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

2. Area: Enter corner point 1
The first corner point of the area can be specified by clicking the mouse button anywhere in the 
drawing.

Optionally, specific coordinates can be used. To do this, press F8 or ENTER. You can now enter 
absolute or polar coordinates. For further information on entering coordinates, see Function 
Keys>Direct Input (F8).

3. Area: Enter corner point 2
The second corner point of the area can be specified by clicking the mouse button anywhere in the 
drawing.

Optionally, specific coordinates can be used. To do this, press F8 or ENTER. Now absolute, relative 
or polar coordinates can be entered. Relative values are based on the previously entered corner point. 
For further information on entering coordinates, see Function Keys>Direct Input (F8).

If the duplicate function is active during entry of the areas second corner point (for example if the CTRL 
key is held down), a copy of the chosen objects is created and then moved and scaled. In this way, objects 
can be copied and scaled at the same time.



Note: Some objects cannot in principle be scaled unproportionally. Above all, these are circles and circle 
parts, and also surfaces which contain circular arcs. If you try to scale such an object unproportionally, a 
message apppears which warns that you must first convert the circles and circle parts to ellipses and 
ellipse parts. This allows you to cancel the operation, without actually making the changes.

Related commands:
Scale Objects>Factors
Scale Objects>Proportional
Scale Objects>Reference Distance
Edit Geometry>Scale



Scale Objects>Reference Distance (Shape Menu)
This command can be used to scale objects and instances in the drawing, that is to change their size. The 
objects are scaled in such a way that that a specified reference length has a given size. The scaling is 
proportional, that is, the horizontal and vertical scaling factors are the same. The scaling is performed in 
relation to the center of a frame surrounding the objects.

This command is particularly useful for matching objects to a particular scale. If the "Original" length of 
at least one length in the drawing is known, then the whole drawing can be brought to the correct size 
without further calculation.

1. Choose objects
The objects to be scaled have to be chosen. Any number of objects can be chosen. This can be done 
with various methods, which can be used on their own or in combination with one another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

2. Enter starting point
The starting point for the reference distance can be entered by clicking with the mouse anywhere in 
the drawing.

Optionally, specific coordinates can be used. To do this, press F8 or ENTER. You can now enter 
absolute or polar coordinates. For further information on entering coordinates, see Function 
Keys>Direct Input (F8).

3. Enter end point
The end point for the reference distance can be entered by clicking with the mouse anywhere in the 
drawing.

Optionally, specific coordinates can be used. To do this, press F8 or ENTER. Absolute, relative or 
polar coordinates can now be entered. Relative coordinates are based on the previously entered 
starting point. For further information on entering coordinates, see Function Keys>Direct Input (F8).



4. Enter length
After entering the reference distance a dialog appears in which the desired length for the previously 
entered reference distance can be entered.

If the duplicate function is active during length entry, then a copy of the chosen objects is created and the 
copy is scaled. This method can be used to create a ready scaled copy of objects.

Related commands:
Scale Objects>Factors
Scale Objects>Proportional
Scale Objects>Non-Proportional
Edit Geometry>Scale



Rotate Objects>Center (Shape Menu)
This command can be used to rotate objects and instances in the drawing. The rotation is carried out in 
relation to the center of a frame surrounding the objects.

1. Choose objects
The objects to be rotated must be chosen. Any number of objects can be chosen. This can be done 
with various methods, which can be used on their own or in combination with one another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

2. Enter angle of rotation
After choosing the objects, a dialog appears in which the desired angle of rotation can be entered. In 
addition the duplicate function can be briefly activated by checking the "Duplicate" check box.

If the duplicate function was turned on during angle entry, then a rotated copy of the objects is created. 
This is a way to create a copy of the objects which is already rotated.

Related commands:
Rotate Objects>Arbitrary
Edit Geometry>Rotate



Rotate Objects>Arbitrary (Shape Menu)
This command can be used to rotate objects and instances in the drawing. The center of rotation and the 
angle are both specified by point entry.

1. Choose objects
The objects to be rotated must be chosen. Any number of objects can be chosen. This can be done 
with various methods, which can be used on their own or in combination with one another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

2. Enter reference point
The reference point, i.e. the center of rotation, can be entered by clicking the mouse anywhere in the 
drawing.

Optionally, specific coordinates can be used. To do this, press F8 or ENTER. You can now enter 
absolute or polar coordinates. For further information on entering coordinates, see Function 
Keys>Direct Input (F8).

3. Enter angle
The rotation angle can be entered by clicking the mouse anywhere in the drawing. Its position relative
to the center of rotation determines the angle.

Optionally, specific coordinates can be used. To do this, press F8 or ENTER. Absolute, relative or 
polar coordinates can be entered.
You can also enter a value which gives the rotation angle. For further information on entering 
coordinates, see Function Keys>Direct Input (F8).

If the duplicate function is on during angle entry (for example because the CTRL key was held down), 
then a copy of the chosen objects is created and rotated. Rotated copies of objects can be created like this.

Related commands:



Rotate Objects>Center
Edit Geometry>Rotate



Reflect Objects>Horizontal (Shape Menu)
This command can be used to reflect objects and instances in the drawing horizontally. The reflection 
takes place about the central vertical axis of the frame surrounding the chosen objects.

1. Choose objects
The objects to be reflected must be chosen. Any number of objects can be chosen. This can be done 
with various methods, which can be used on their own or in combination with one another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

If the duplicate function is active when the last object is identified, (for example because the CTRL key is
held down), then a copy of the chosen objects is created and reflected horizontally. Reflected copies of 
objects can be created like this.

Related commands:
Reflect Objects>Vertical
Reflect Objects>Line



Reflect Objects>Vertical (Shape Menu)
This command can be used to reflect objects and instances in the drawing vertically. The reflection takes 
place about the central horizontal axis of the frame surrounding the chosen objects.

1. Choose objects
The objects to be reflected must be chosen. Any number of objects can be chosen. This can be done 
with various methods, which can be used on their own or in combination with one another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

If the duplicate function is active when the last object is identified, (for example because the CTRL key is
held down), then a copy of the chosen objects is created and reflected vertically. Reflected copies of 
objects can be created like this.

Related commands:
Reflect Objects>Horizontal
Reflect Objects>Line



Reflect Objects>Line (Shape Menu)
This command can be used to reflect objects and instances in the drawing. The reflection takes place 
about a specified line.

1. Choose objects
The objects to be reflected must be chosen. Any number of objects can be chosen. This can be done 
with various methods, which can be used on their own or in combination with one another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

3. Identify reference line
Any existing straight line can be used as the reference line. This can also be a side of a rectangle or a 
leg of a circle segment.
Click the mouse on the line to identify it. If more than one line lies at the spot clicked on, a small 
dialog appears at the bottom of the screen, from which the correct line can be chosen.

If the duplicate function is active while the reference line is identified, (for example because the CTRL 
key is held down), then a copy of the chosen objects is created and reflected. Reflected copies of objects 
can be created like this.

Related commands:
Reflect Objects>Horizontal
Reflect Objects>Vertical



Distort Object>Horizontal (Shape Menu)
This command can be used to distort objects and instances in the drawing horizontally. The distortion 
takes place relative to a specified reference point.

1. Choose objects
The objects to be distorted must be chosen. Any number of objects can be chosen. This can be done 
with various methods, which can be used on their own or in combination with one another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

2. Enter reference point
The reference point for the distortion can be specified by clicking the mouse anywhere in the 
drawing.

Optionally, specific coordinates can be used. To do this, press F8 or ENTER. You can now enter 
absolute or polar coordinates. For further information on entering coordinates, see Function 
Keys>Direct Input (F8).

3. Enter angle
The distortion angle can be specified by clicking the mouse anywhere in the drawing. The angle is 
determined by this points position relative to the reference point.

Optionally, specific coordinates can be used. To do this, press F8 or ENTER. Absolute, relative or 
polar coordinates can then be entered.
You can also enter a value which gives the distortion angle. For further information on entering 
coordinates, see Function Keys>Direct Input (F8).

If the duplicate function is active during angle entry (for example if the CTRL key is kept held down) 
then a copy of the chosen objects is created and distorted. Distorted copies of objects can be made like 
this.



Note: Some objects cannot in principle be distorted. Above all, these are circles and circle parts, and also 
surfaces which contain circular arcs. If you try to distort such an object, a message apppears which warns 
that you must first convert the circles and circle parts to ellipses and ellipse parts. This allows you to 
cancel the operation, without actually making the changes.

Related command:
Distort Object>Vertical



Distort Object>Vertical (Shape Menu)
This command can be used to distort objects and instances in the drawing vertically. The distortion takes 
place relative to a specified reference point.

1. Choose objects
The objects to be distorted must be chosen. Any number of objects can be chosen. This can be done 
with various methods, which can be used on their own or in combination with one another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

2. Enter reference point
The reference point for the distortion can be specified by clicking the mouse anywhere in the 
drawing.

Optionally, specific coordinates can be used. To do this, press F8 or ENTER. You can now enter 
absolute or polar coordinates. For further information on entering coordinates, see Function 
Keys>Direct Input (F8).

3. Enter angle
The distortion angle can be specified by clicking the mouse anywhere in the drawing. The angle is 
determined by this points position relative to the reference point.

Optionally, specific coordinates can be used. To do this, press F8 or ENTER. Absolute, relative or 
polar coordinates can then be entered.
You can also enter a value which gives the distortion angle. For further information on entering 
coordinates, see Function Keys>Direct Input (F8).

If the duplicate function is active during angle entry (for example if the CTRL key is kept held down) 
then a copy of the chosen objects is created and distorted. Distorted copies of objects can be made like 
this.



Note: Some objects cannot in principle be distorted. Above all, these are circles and circle parts, and also 
surfaces which contain circular arcs. If you try to distort such an object, a message apppears which warns 
that you must first convert the circles and circle parts to ellipses and ellipse parts. This allows you to 
cancel the operation, without actually making the changes.

Related command:
Distort Object>Horizontal



Center Objects>Page, Horizontal (Shape Menu)
This command can be used to center objects and instances horizontally on the page. They are moved 
horizontally so that they are the same distance from the left and right edges of the page. All chosen 
objects and instances are treated as a single item, i.e. they are all moved by the same amount.

1. Choose objects
All the objects to be centered have to be chosen. Any number of objects can be chosen. This can be 
done with various methods, which can be used on their own or in combination with one another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

If the duplicate function is active when the last object is chosen, then a copy of the chosen objects is made
and moved. Centered copies of objects can be made like this.

Related commands:
Center Objects>Page, Vertical
Center Objects>Page, Both
Center Objects>Page, Horizontal
Center Objects>Page, Vertical
Center Objects>Page, Both
Center Drawing>Horizontal
Center Drawing>Vertical
Center Drawing>Both



Center Objects>Page, Vertical (Shape Menu)
This command can be used to center objects and instances vertically on the page. They are moved 
vertically so that they are the same distance from the top and bottom of the page. All chosen objects and 
instances are treated as a single item, i.e. they are all moved by the same amount.

1. Choose objects
All the objects to be centered have to be chosen. Any number of objects can be chosen. This can be 
done with various methods, which can be used on their own or in combination with one another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

If the duplicate function is active when the last object is chosen, then a copy of the chosen objects is made
and moved. Centered copies of objects can be made like this.

Related commands:
Center Objects>Page, Horizontal
Center Objects>Page, Both
Center Objects>Page, Horizontal
Center Objects>Page, Vertical
Center Objects>Page, Both
Center Drawing>Horizontal
Center Drawing>Vertical
Center Drawing>Both



Center Objects>Page, Both (Shape Menu)
This command can be used to center objects and instances horizontally and vertically on the page. They 
are moved horizontally so that they are the same distance from the left and right edges and the top and 
bottom of the page. All chosen objects and instances are treated as a single item, i.e. they are all moved by
the same amount.

1. Choose objects
All the objects to be centered have to be chosen. Any number of objects can be chosen. This can be 
done with various methods, which can be used on their own or in combination with one another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

If the duplicate function is active when the last object is chosen, then a copy of the chosen objects is made
and moved. Centered copies of objects can be made like this.

Related commands:
Center Objects>Page, Horizontal
Center Objects>Page, Vertical
Center Objects>Page, Horizontal
Center Objects>Page, Vertical
Center Objects>Page, Both
Center Drawing>Horizontal
Center Drawing>Vertical
Center Drawing>Both



Center Objects>Frame, Horizontal (Shape Menu)
This command can be used to center objects and instances horizontally relative to a rectangular frame. 
They are moved horizontally so that they are the same distance from the left and right edges of the frame. 
All chosen objects and instances are treated as a single item, i.e. they are all moved by the same amount.

1. Choose objects
All the objects to be centered have to be chosen. Any number of objects can be chosen. This can be 
done with various methods, which can be used on their own or in combination with one another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

2. Area: Enter corner point 1
The first corner point of the frame can be entered by clicking the mouse anywhere in the drawing.

Optionally, specific coordinates can be used. To do this, press F8 or ENTER. You can now enter 
absolute or polar coordinates. For further information on entering coordinates, see Function 
Keys>Direct Input (F8).

3. Area: Enter corner point 2
The second corner point of the frame can be entered by clicking the mouse anywhere in the drawing.

Optionally, specific coordinates can be used. To do this, press F8 or ENTER. Now absolute, relative 
or polar coordinates can be entered. Relative values are based on the previously entered corner point. 
For further information on entering coordinates, see Function Keys>Direct Input (F8).

If the duplicate function is active during entry of the second corner point (for example, because the CTRL
key was held down) a copy of the chosen objects is created and the copy is centered. This is how to copy 
objects centered.

Related commands:
Center Objects>Page, Horizontal



Center Objects>Page, Vertical
Center Objects>Page, Both
Center Objects>Page, Vertical
Center Objects>Page, Both
Center Drawing>Horizontal
Center Drawing>Vertical
Center Drawing>Both



Center Objects>Frame, Vertical (Shape Menu)
This command can be used to center chosen objects vertically with respect to a specified rectangular 
frame. They are moved horizontally so that they are the same distance from the top and bottom of the 
frame. All chosen objects and instances are treated as a single unit, that is they are all moved by the same 
amount.

1. Choose objects
All the objects to be centered have to be chosen. Any number of objects can be chosen. This can be 
done with various methods, which can be used on their own or in combination with one another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

2. Area: Enter corner point 1
The first corner point of the frame can be entered by clicking the mouse anywhere in the drawing.

Optionally, specific coordinates can be used. To do this, press F8 or ENTER. You can now enter 
absolute or polar coordinates. For further information on entering coordinates, see Function 
Keys>Direct Input (F8).

3. Area: Enter corner point 2
The second corner point of the frame can be entered by clicking the mouse anywhere in the drawing.

Optionally, specific coordinates can be used. To do this, press F8 or ENTER. Now absolute, relative 
or polar coordinates can be entered. Relative values are based on the previously entered corner point. 
For further information on entering coordinates, see Function Keys>Direct Input (F8).

If the duplicate function is active during entry of the second corner point (for example, because the CTRL
key was held down) a copy of the chosen objects is created and the copy is centered. This is how to copy 
objects centered.

Related commands:



Center Objects>Page, Horizontal
Center Objects>Page, Vertical
Center Objects>Page, Both
Center Objects>Page, Horizontal
Center Objects>Page, Both
Center Drawing>Horizontal
Center Drawing>Vertical
Center Drawing>Both



Center Objects>Frame, Both (Shape Menu)
This command can be used to center chosen objects both horizontally and vertically with respect to a 
specified rectangular frame. They are moved horizontally so that they are the same distance from the left 
and right of the frame and vertically so that they are the same distance from the top and bottom of the 
frame. All chosen objects and instances are treated as a single unit, that is they are all moved by the same 
amount.

1. Choose objects
The objects to be centered must be chosen. Any number of objects can be chosen. This can be done 
with various methods, which can be used on their own or in combination with one another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

2. Area: Enter corner point 1
The first corner point of the frame can be entered by clicking the mouse anywhere in the drawing.

Optionally, specific coordinates can be used. To do this, press F8 or ENTER. You can now enter 
absolute or polar coordinates. For further information on entering coordinates, see Function 
Keys>Direct Input (F8).

3. Area: Enter corner point 2
The second corner point of the frame can be entered by clicking the mouse anywhere in the drawing.

Optionally, specific coordinates can be used. To do this, press F8 or ENTER. Now absolute, relative 
or polar coordinates can be entered. Relative values are based on the previously entered corner point. 
For further information on entering coordinates, see Function Keys>Direct Input (F8).

If the duplicate function is active during entry of the second corner point (for example, because the CTRL
key was held down) a copy of the chosen objects is created and the copy is centered. This is how to copy 
objects centered.



Related commands:
Center Objects>Page, Horizontal
Center Objects>Page, Vertical
Center Objects>Page, Both
Center Objects>Page, Horizontal
Center Objects>Page, Vertical
Center Drawing>Horizontal
Center Drawing>Vertical
Center Drawing>Both



Group>Create Group (Shape Menu)
This command can be used to combine objects and instances into a group, which will then be treated as a 
single item.

1. Choose objects
The objects which are to be grouped must be chosen. Any number of objects can be chosen. This can 
be done with various methods, which can be used on their own or in combination with one another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

A group is then made from the chosen objects. To do this, a block containing these objects is generated. 
The block has a unique name, which is however not normally relevant when working with the group. The 
chosen objects are then replaced with an instance of the block. In principle, a group is a block.

One change occurs when creating a group. The objects which a group consists of are always constructed 
one after another - they make up a single unit. The order in which the objects in the group are built up 
compared to the other objects and instanced in the drawing may change.

Groups can be nested, that is a group may itself contains groups. Ungrouping is done step by step so that 
sub-groups remain intact.

Note: Tek Illustrator automatically maintains groups, but only when loading and saving drawings. If all 
pointers to a group are deleted, then that group is deleted at the latest when the drawing is saved. If it has 
to be used again, then it can be inserted with the command Symbol / Block>Insert. Groups are stored in 
the "#G" folder of the library "*". Their names however are not very helpful and so the selection of 
groups has to be done by displaying them.

Related command:
Group>Ungroup
Symbol / Block>Create (Insertion Point)
Symbol / Block>Create (Frame)





Group>Ungroup (Shape Menu)
This command can be used to break up groups. Their objects are then treated as individual objects again

1. Choose objects
The groups to be broken up must be chosen. Any number of objects can be chosen. This can be done 
with various methods, which can be used on their own or in combination with one another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

All of the groups contained in the chosen groups are broken up; all other objects remain unchanged. Only 
the topmost layer in each group is broken up, so if a group is nested (i.e. it contains more groups) the sub-
groups or instances of blocks and symbols are maintained.

Note: Tek Illustrator automatically maintains groups, but only when loading and saving drawings. If all 
pointers to a group are deleted, then that group is deleted at the latest when the drawing is saved. If it has 
to be used again, then it can be inserted with the command Symbol / Block>Insert. Groups are stored in 
the "#G" folder of the library "*". Their names however are not very helpful and so the selection of 
groups has to be done by displaying them.

Related commands:
Group>Create Group
Trim Object>Resolve Completely
Text>Resolve
Resolve Instances



Change Order>To Back (Shape Menu)
This command can be used to move instances and objects to the start of the object list, so that they are 
drawn first and therefore lie in the background.

The internal order of the chosen objects remains unchanged.

1. Choose objects
The objects whose position in the list is to be changed must be chosen. Any number of objects can be 
chosen. This can be done with various methods, which can be used on their own or in combination 
with one another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

If the duplicate function is active when the last object is chosen, then a copy of the chosen objects is made
and moved to the start of the list.

Related commands:
Change Order>Behind Object
Change Order>Before Object
Change Order>To Front



Change Order>Behind Object (Shape Menu)
This command can be used to move instances and objects to a position in front of another object, so that 
they are drawn before it and therefore lie in its background.

The internal order of the chosen objects remains unchanged.

1. Choose objects
The objects whose position in the list is to be changed must be chosen. Any number of objects can be 
chosen. This can be done with various methods, which can be used on their own or in combination 
with one another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

2. Identify object
The reference object is identified by clicking on its outline. If more than one line lies at the spot 
clicked on, a small dialog appears at the bottom of the screen, from which the correct line can be 
chosen.

If the duplicate function is active during identification of the reference object (for example, because the 
CTRL key was held down), a copy of the chosen objects is moved in the list.

Related commands:
Change Order>To Back
Change Order>In Front of Object
Change Order>To Front



Change Order>Before Object (Shape Menu)
This command can be used to move instances and objects to a position in the list after another object, so 
that they are drawn after it and therefore lie in its foreground.

The internal order of the chosen objects remains unchanged.

1. Choose objects
The objects whose position in the list is to be changed must be chosen. Any number of objects can be 
chosen. This can be done with various methods, which can be used on their own or in combination 
with one another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

2. Identify object
The reference object is identified by clicking on its outline. If more than one object outline lies at the 
spot clicked on, a small dialog appears at the bottom of the screen, from which the correct object can 
be chosen.

If the duplicate function is active during identification of the reference object (for example, because the 
CTRL key was held down), a copy of the chosen objects is moved in the list.

Related commands:
Change Order>To Back
Change Order>Behind Object
Change Order>To Front



Change Order>To Front (Shape Menu)
This command can be used to move objects and instances to the end of the object list so that they are 
drawn last and therefore lie at the front of the drawing.

The internal order of the chosen objects remains unchanged.

1. Choose objects
The objects whose position in the list is to be changed must be chosen. Any number of objects can be 
chosen. This can be done with various methods, which can be used on their own or in combination 
with one another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

If the duplicate function is active during selection, a copy of the chosen objects is generated and pushed to
the end of the list.

Related commands:
Change Order>To Back
Change Order>Behind Object
Change Order>Before Object
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Line>Standard (Draw Menu)
This command is used to draw a line.

1. Enter start point
The start point can be entered by clicking the mouse anywhere in the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

2. Enter end point
The end point of the line can be entered by clicking the mouse anywhere in the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered. Relative coordinates relate to the previously entered start 
point. For further information on coordinate entry, see Function Keys>Direct Input (F8).

The line is assigned to the current layer. In addition, it contains a reference to the current pen.

Related commands:
Line>On Straight Line
Line>Horizontal
Line>Vertical
Line>Mid-Perpendicular
Line>Perpendicular
Line>Parallel, Variable
Line>Parallel, Fixed
Line>Angle to Line
Line>Bisector of Angle



Line>On Straight Line (Draw Menu)
This command creates a line which runs along an extension of an existing line or on a geometry line.

1. Identify reference line
Any line in an existing object can be identified as a reference line, including a side of a rectangle or a 
circle segment leg.

The line is identified by clicking on it with the mouse. If several possible lines lie close to the position
clicked on, a small dialog appears near the bottom of the screen, from which the correct line can be 
chosen.

After the line has been identified, a straight line which shows the extension of the identified line 
appears. This is the "Reference Line".

2. Enter start point
The start point can be entered by clicking the mouse anywhere in the drawing. A perpendicular is 
dropped from this position to the reference line to determine the start point of the new line.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

3. Enter end point
The end point of the line can be entered by clicking the mouse anywhere in the drawing. A 
perpendicular is dropped from this position to the reference line to determine the end point of the new
line.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
In addition, it is possible to enter a length. This gives the length of the line from a previously entered 
start point. To do this a small arrow appears in the left of the status window. This shows the 
orientation for the length details. If you enter a positive value, the line will be drawn from the start 
point in the direction of the arrow. A negative value draws a line in the opposite direction to the arrow.
For further information on coordinate entry, see Function Keys>Direct Input (F8).

The line is assigned to the current layer. In addition, it contains a reference to the current pen.

Related commands:
Line>Standard
Line>Horizontal
Line>Vertical
Line>Mid-Perpendicular
Line>Perpendicular
Line>Parallel, Variable
Line>Parallel, Fixed
Line>Angle to Line
Line>Bisector of Angle



Line>Horizontal (Draw Menu)
This command draws a horizontal line. "Horizontal" refers to the position of the line in relation to the 
page, not the view. If the drawing is displayed rotated, then the line will also be displayed rotated.

1. Enter start point
The start point can be entered by clicking the mouse anywhere in the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

After entering the start point, a straight line running horizontally through the start point appears. This 
is referred to as the "Reference straight line".

2. Enter end point
The end point of the line can be entered by clicking the mouse anywhere in the drawing. A 
perpendicular is dropped from this position to the reference straight line to determine the end point of 
the new line.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
In addition, it is possible to enter a length. This gives the length of the line from a previously entered 
start point. To do this, a small arrow appears at the left of the status window during direct entry. This 
shows the orientation for the length details. If you enter a positive value, the line will be drawn from 
the start point in the direction of the arrow. A negative value draws a line in the opposite direction to 
the arrow. For further information on coordinate entry, see Function Keys>Direct Input (F8).

The line is assigned to the current layer. In addition, it contains a reference to the current pen.

Related commands:
Line>Standard
Line>On Straight Line
Line>Vertical
Line>Mid-Perpendicular
Line>Perpendicular
Line>Parallel, Variable
Line>Parallel, Fixed
Line>Angle to Line
Line>Bisector of Angle



Line>Vertical (Draw Menu)
This command draws a vertical line. "Vertical" refers to the position of the line in relation to the page, not 
the view. If the drawing is displayed rotated, then the line will also be displayed rotated.

1. Enter start point
The start point can be entered by clicking the mouse anywhere in the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

After entering the start point, a straight line running vertically through the start point appears. This is 
referred to as the "Reference straight line".

2. Enter end point
The end point of the line can be entered by clicking the mouse anywhere in the drawing. A 
perpendicular is dropped from this position to the reference straight line to determine the end point of 
the new line.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
In addition, it is possible to enter a length. This gives the length of the line from a previously entered 
start point. To do this, a small arrow appears at the left of the status window during direct entry. This 
shows the orientation for the length details. If you enter a positive value, the line will be drawn from 
the start point in the direction of the arrow. A negative value draws a line in the opposite direction to 
the arrow. For further information on coordinate entry, see Function Keys>Direct Input (F8).

The line is assigned to the current layer. In addition, it contains a reference to the current pen.

Related commands:
Line>Standard
Line>On Straight Line
Line>Horizontal
Line>Mid-Perpendicular
Line>Perpendicular
Line>Parallel, Variable
Line>Parallel, Fixed
Line>Angle to Line
Line>Bisector of Angle



Line>Mid-Perpendicular (Draw Menu)
This command draws a line which runs along the mid-perpendicular of another line. This line is drawn so 
that it appears as a right angle in "normal" view. If working with a distorted view (e.g. an isometric view) 
then the visible angle will not be 90 degrees.

1. Identify reference line
Any line in an existing object can be identified as a reference line, including a side of a rectangle or a 
circle segment leg. Geometry lines cannot be identified as they have no "middle".
The line is identified by clicking on it with the mouse. If several possible lines lie close to the position
clicked on, a small dialog appears near the bottom of the screen, from which the correct line can be 
chosen.

After identification a straight line appears which runs along the mid-perpendicular of the identified 
line. This is referred to as the "Reference Straight Line".

2. Enter start point
The start point can be entered by clicking the mouse anywhere in the drawing. A perpendicular is 
dropped from this point to the reference straight line to determine the new line's start point.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

3. Enter end point
The end point of the line can be entered by clicking the mouse anywhere in the drawing. A 
perpendicular is dropped from this position to the reference straight line to determine the end point of 
the new line.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
In addition, it is possible to enter a length. This gives the length of the line from a previously entered 
start point. To do this, a small arrow appears at the left of the status window during direct entry. This 
shows the orientation for the length details. If you enter a positive value, the line will be drawn from 
the start point in the direction of the arrow. A negative value draws a line in the opposite direction to 
the arrow. For further information on coordinate entry, see Function Keys>Direct Input (F8).

The line is assigned to the current layer. In addition, it contains a reference to the current pen.

Related commands:
Line>Standard
Line>On Straight Line
Line>Horizontal
Line>Vertical
Line>Perpendicular
Line>Parallel, Variable
Line>Parallel, Fixed
Line>Angle to Line
Line>Bisector of Angle



Line>Perpendicular (Draw Menu)
This command draws a line which is perpendicular to another line, geometry line, circle, geometry circle 
or ellipse. This line is drawn so that it appears as a right angle in "normal" view. If working with a 
distorted view (e.g. an isometric view) then the visible angle will not be 90 degrees.

Only one end point of the line is specified, the other is already given as perpendicular base point. If a 
perpendicular is to be drawn where both end points are to be specified, use the command Line>Angle to 
Line instead.

1. Identify reference object
Any part of an existing object can be used as a reference object. This can be a rectangle side, the arc 
of an ellipse segment or a circular arc within a surface.
Click on the relevant object (part object) with the mouse to identify it. If several objects lie very close
to the point clicked on, then a small dialog appears at the bottom of the screen, with the help of which
the correct object can be chosen.

The identified object is referred to as the "Reference Object". After identification a straight line 
showing the line of the perpendicular appears. This is referred to as the "Reference Straight Line"

2. Enter reference point
The position of the perpendicular (and the start of the line) are determined by a reference point 
through which the reference straight line should run. This reference point can be entered by clicking 
the mouse at any point within the drawing. A perpendicular is dropped from this position to the 
reference object, to determine the new line's start point.

If a circle is identified as the reference object, then the position of the reference point determines on 
which side of the reference circle the perpendicular's start point should be. The intersection of the 
reference straight line and the reference circle nearer the reference point is used as the start point.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
If a circle is identified as the reference object, then you can enter an angle. This indicates the direction
of the reference straight line. For further information on coordinate entry, see Function Keys>Direct 
Input (F8).

3. Enter end point
The end point of the line can be entered by clicking the mouse anywhere in the drawing. A 
perpendicular is dropped from this position to the reference straight line to determine the end point of 
the new line.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
In addition, it is possible to enter a length. This shows the length of the line beginning from the 
previously entered start point. To do this, a small arrow appears at the left of the status window during
direct entry. This shows the orientation for the length details. If you enter a positive value, the line 
will be drawn from the start point in the direction of the arrow. A negative value draws a line in the 
opposite direction to the arrow. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

The line is assigned to the current layer. In addition, it contains a reference to the current pen.



Related commands:
Line>Standard
Line>On Straight Line
Line>Horizontal
Line>Vertical
Line>Mid-Perpendicular
Line>Parallel, Variable
Line>Parallel, Fixed
Line>Angle to Line
Line>Bisector of Angle



Line>Parallel, Variable (Draw Menu)
This command draws a line which runs parallel to another line or geometry line.

The suffix "Variable" indicates that the distance between the lines is not determined numerically, but by 
entering the start point. To use a fixed distance, use the command Line>Parallel, Fixed.

1. Identify reference line
Any line in an existing object can be identified as a reference line, including a side of a rectangle or a 
circle segment leg.
The line is identified by clicking on it with the mouse. If several possible lines lie close to the position
clicked on, a small dialog appears near the bottom of the screen, from which the correct line can be 
chosen.

After identification a straight line appears which runs parallel to the identified line and moves with 
the mouse. This line is referred to as the "Reference Straight Line".

2. Enter start point
The start point can be entered by clicking the mouse anywhere in the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

After entering the start point the reference straight line runs through the start point and does not move
with the mouse any more.

3. Enter end point
The end point of the line can be entered by clicking the mouse anywhere in the drawing. A 
perpendicular is dropped from this position to the reference straight line to determine the end point of 
the new line.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
In addition, it is possible to enter a length. This gives the length of the line from a previously entered 
start point. To do this, a small arrow appears at the left of the status window during direct entry. This 
shows the orientation for the length details. If you enter a positive value, the line will be drawn from 
the start point in the direction of the arrow. A negative value draws a line in the opposite direction to 
the arrow. For further information on coordinate entry, see Function Keys>Direct Input (F8).

The line is assigned to the current layer. In addition, it contains a reference to the current pen.

Related commands:
Line>Standard
Line>On Straight Line
Line>Horizontal
Line>Vertical
Line>Mid-Perpendicular
Line>Perpendicular
Line>Parallel, Fixed
Line>Angle to Line



Line>Bisector of Angle



Line>Parallel, Fixed (Draw Menu)
This command draws a line which runs parallel to another line or a geometry line.

The suffix "Fixed" shows that the distance between the two lines is a specific, fixed distance entered via a
dialog. If the numeric value of the distance is not known, and the distance is to be specified implicitly by 
using the mouse to enter the start point, then the command Line>Parallel, Variable should be used instead.

1. Enter distance
After choosing the command, a dialog appears into which the distance can be entered. This distance 
remains valid until either another command is chosen, or the command is restarted by choosing 
Restart Command (+ESC) or the key combination SHIFT+ESC.

2. Identify reference line
Any line in an existing object can be identified as a reference line, including a side of a rectangle or a 
circle segment leg.
The line is identified by clicking on it with the mouse. If several possible lines lie close to the position
clicked on, a small dialog appears near the bottom of the screen, from which the correct line can be 
chosen.

After identification a straight line which runs parallel to the identified line and moves when the 
mouse is moved close to the identified line. This line is referred to as the "Reference Straight Line".

3. Enter start point
The start point can be entered by clicking the mouse anywhere in the drawing. The reference straight 
line always snaps to the same side of the identified line as the crosshair. A perpendicular is dropped to
the reference straight line to determine the start point of the new line.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).
After entering the start point the reference straight line runs through the start point and does not move
any more.

4. Enter end point
The end point of the line can be entered by clicking the mouse anywhere in the drawing. A 
perpendicular is dropped from this position to the reference straight line to determine the end point of 
the new line.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
In addition, it is possible to enter a length. This gives the length of the line from a previously entered 
start point. To do this, a small arrow appears at the left of the status window during direct entry. This 
shows the orientation for the length details. If you enter a positive value, the line will be drawn from 
the start point in the direction of the arrow. A negative value draws a line in the opposite direction to 
the arrow. For further information on coordinate entry, see Function Keys>Direct Input (F8).

The line is assigned to the current layer. In addition, it contains a reference to the current pen.

Related commands:
Line>Standard



Line>On Straight Line
Line>Horizontal
Line>Vertical
Line>Mid-Perpendicular
Line>Perpendicular
Line>Parallel, Variable
Line>Angle to Line
Line>Bisector of Angle



Line>Angle to Line (Draw Menu)
This command draws a line which runs at a specific angle to a line or geometry line.

1. Enter angle
After choosing this command, a dialog appears into which the angle to be used can be entered. This 
angle remains valid until either a new command is chosen or the current command is restarted using 
Restart Command (+ESC) or the key combination SHIFT+ESC.

2. Identify reference line
Any line in an existing object can be identified as a reference line, including a side of a rectangle or a 
circle segment leg.
The line is identified by clicking on it with the mouse. If several possible lines lie close to the position
clicked on, a small dialog appears near the bottom of the screen, from which the correct line can be 
chosen.

After identification a straight line appears which runs at the previously entered angle to the identified 
line and moves with the mouse. This line is referred to as the "Reference Straight Line".

3. Enter start point
The start point can be entered by clicking the mouse anywhere in the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).
After entering the start point the reference straight line runs through the start point and does not move
with the mouse any more.

After entering the start point the reference straight line runs through the start point and does not move
with the mouse any more.

4. Enter end point
The end point of the line can be entered by clicking the mouse anywhere in the drawing. A 
perpendicular is dropped from this position to the reference straight line to determine the end point of 
the new line.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
In addition, it is possible to enter a length. This gives the length of the line from a previously entered 
start point. To do this, a small arrow appears at the left of the status window during direct entry. This 
shows the orientation for the length details. If you enter a positive value, the line will be drawn from 
the start point in the direction of the arrow. A negative value draws a line in the opposite direction to 
the arrow. For further information on coordinate entry, see Function Keys>Direct Input (F8).

The line is assigned to the current layer. In addition, it contains a reference to the current pen.

Related commands:
Line>Standard
Line>On Straight Line
Line>Horizontal
Line>Vertical



Line>Mid-Perpendicular
Line>Perpendicular
Line>Parallel, Variable
Line>Parallel, Fixed
Line>Bisector of Angle



Line>Bisector of Angle (Draw Menu)
This command draws a line which runs along the bisector of the angle between two lines or geometry 
lines.

1. Identify reference line 1
Any line in an existing object can be identified as a reference line. This can also be a side of a 
rectangle or a leg of a circular segment.
The line is identified by clicking on it with the mouse. If several possible lines lie close to the position
clicked on, a small dialog appears near the bottom of the screen, from which the correct line can be 
chosen.

The position at which the line was identified (the "ID Point") is important for the rest of the 
procedure. Together with the position at which the second line is identified,    it determines which of 
the two possible angle bisectors should be used (see below).

2. Identify reference line 2
Any line in an existing object can be identified as the second reference line. This can also be a side of 
a rectangle or a leg of a circular segment.
The line is identified by clicking on it with the mouse. If several possible lines lie close to the position
clicked on, a small dialog appears near the bottom of the screen, from which the correct line can be 
chosen.

The position at which the line was identified (the "ID Point") is important for the rest of the 
procedure. Together with the position at which the first line is identified, it determines which of the 
two possible angle bisectors should be used (see graphic).

After identification of the second line a straight line which runs through the ID point determining the 
angle bisectors appears. This line is referred to as the "Reference Straight Line".

3. Enter start point
The start point can be entered by clicking the mouse anywhere in the drawing. A perpendicular is 
dropped from this point to the reference straight line to determine the new line's start point.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

4. Enter end point
The end point of the line can be entered by clicking the mouse anywhere in the drawing. A 
perpendicular is dropped from this position to the reference straight line to determine the end point of 
the new line.



Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
In addition, it is possible to enter a length. This gives the length of the line from a previously entered 
start point. To do this, a small arrow appears at the left of the status window during direct entry. This 
shows the orientation for the length details. If you enter a positive value, the line will be drawn from 
the start point in the direction of the arrow. A negative value draws a line in the opposite direction to 
the arrow. For further information on coordinate entry, see Function Keys>Direct Input (F8).

The line is assigned to the current layer. In addition, it contains a reference to the current pen.

Related commands:
Line>Standard
Line>On Straight Line
Line>Horizontal
Line>Vertical
Line>Mid-Perpendicular
Line>Perpendicular
Line>Parallel, Variable
Line>Parallel, Fixed
Line>Angle to Line



Line>Center Cross (Draw Menu)
This command draws two lines, one horizontal and one vertical. Their mid-points cross at the center of an
identified circle or ellipse.

This command is particularly useful to draw center crosses for drilled holes and other construction 
elements.

1. Identify reference circle / ellipse
Any circle or ellipse which exists independently or as part of another object can be identified as a 
reference object. This can also be the arc of an ellipse segment or a circular arc within a surface.
Click on the relevant object (part object) with the mouse to identify it. If several objects lie very close
to the point clicked on, then a small dialog appears at the bottom of the screen, with the help of which
the correct object can be chosen.

2. Enter point
The length of both lines is determined by a point which lies on the outline of a circle tangent to both 
lines. This point can be entered by clicking with the mouse anywhere within the drawing. A 
perpendicular is dropped from this position to the reference straight line to determine the end point of 
the new line.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
You can also enter a specific radius. This gives the radius of the circle tangent to both lines. This is 
always a circle, even if an ellipse was identified beforehand. For further information on coordinate 
entry, see Function Keys>Direct Input (F8).

The two lines are assigned to the current layer. You also see a reference to the currently active pen.

Related commands:
Line>Horizontal
Line>Vertical



Line>Polyline (Draw Menu)
This command draws a polyline. A polyline is an open series of connected lines.

1. Enter start point
The start point of a polyline can be entered by clicking the mouse anywhere within the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

2. Enter point
After entering the start point, several points can be entered, one after another. The polyline begins at 
the start point and runs through all the subsequently-entered points. These points can be entered by 
clicking the mouse at any point in the drawing for each point.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
You can also enter the length and/or angle of the next section relative to the previous section. This is 
an easy way, for example, to enter bends with a given angle. For further information on coordinate 
entry, see Function Keys>Direct Input (F8).

Polyline input is ended by clicking the right mouse button. Unlike most other commands, this does 
not lead to the previous entry being ignored; instead the polyline is inserted into the drawing. If 
required, this can be undone using the Undo command.

A polyline can consist of up to 1000    sections. If this limit is reached during point entry, no further points
can be entered.

A polyline is stored internally as a curve. It can be manipulated using the same commands as can be used 
on curves.

The curve created is assigned to the current layer. It also contains a reference to the current pen.

Note: All point entries can be undone step by step using Function Keys>Previous Point (ESC)    or by 
pressing the ESC key. This enables incorrect entries to easily be corrected without having to enter the 
entire polygon again.

Related commands:
Curve
Surface
Spline
Polygon>Arbitrary
Freehand Line>Draw



Line>Equidistant (Draw Menu)
This command generates a line equidistant to a specified object. An equidistant line is a line which is the 
same distance from all points of the reference object. In the simplest case this is a line parallel to another 
line or a circle concentric with another circle.

1. Enter distance
After choosing the command, a dialog appears into which the distance can be entered. This distance 
remains valid until either another command is chosen, or the command is restarted by choosing 
Restart Command (+ESC) or the key combination SHIFT+ESC.

The distance must be practical. For example, you cannot draw an equidistant larger than 10 mm 
within a circle with a radius of 10 mm.

2. Identify object
Any object consisting of "normal" elements can be identified as a reference object. These are lines, 
circles and circle parts, ellipses and elliptical arcs as well as all objects consisting of these elements. 
The objects are always treated as a whole. Some elements, for example text, dimensions and 
instances, cannot be used.
An object is identified by clicking on it. If more than one object lies at the point clicked on, then a 
small dialog appears at the bottom of the screen, with the help of which the correct object can be 
chosen.

The identified object is referred to as the "Reference Object".

3. Enter reference point
After identifying the reference object a point is entered which determines on which side of the 
reference object the equidistant should be drawn (see graphic).

4. Round corners?
When drawing an equidistant for an object made up of several sections, after entering the reference 
point a window appears to ask whether or not the corners should be rounded or not (see graphic).

Because of the definition of equidistants (the same distance from all points), all corners must 
theoretically be rounded. In many cases this is not required, and therefore this procedure is provided.



There are also situations in which only one of the two options ("rounded" or "not rounded") functions.
This often the case when there are pointed transitions between lines and circular arcs.

Equidistants are stored internally in different forms, according to the reference object's type. Lines create 
lines, circles create circles. All other object types create curves (open outlines) or surfaces (closed 
outlines).

The object is allocated to the current layer. It also contains a reference to the current pen.

Notes: If a line equidistant to a surface containing Bézier curves is created, there may be (extreme) 
inaccuracies. During the calculation of the equidistant line, the Bézier curve is treated as a polyline with 
three sections (Start point -Angel point 1 - Angel Point 2 - End point). If the Bézier curve is relatively 
short and flat, this simplification is not usually very effective.

This command does not work with text in either Tek Illustrator's own format or TrueType-format. To draw
a line equidistant to text, it must first be converted to curves or surfaces using the command 
Text>Resolve. An equidistant line can then be created (see Graphic)

The problem with Bézier curves described above doe not arise with TrueType fonts as the Bézier curves 
in TrueType fonts are relatively short and flat. However, rounded corners should always be used in order 
to make the result look smoother.

Related commands:
Line>Parallel, Variable
Line>Parallel, Fixed
Circle>Concentric
Circular Arc>Concentric to Circle
Circular Arc>Concentric to Circle Part 



Tangent>Object - Point (Draw Menu)
This command draws a line which begins at a given point and ends tangential to a circle or ellipse.

1. Identify reference circle / ellipse
Any circle or ellipse which exists independently or as part of another object can be identified as a 
reference object. This can also be the arc of an ellipse segment or a circular arc within a surface.
Click on the relevant object (part object) with the mouse to identify it. If several objects lie very close
to the point clicked on, then a small dialog appears at the bottom of the screen, with the help of which
the correct object can be chosen.

The position at which the object is identified (the "ID point") is important for the rest of the process. 
If a tangent is placed on a curve or ellipse it can go on either side. The tangent point used as the end 
of the line is the one nearest to the ID point (see graphic).

2. Enter point
The start point of the tangent can be entered by clicking the mouse anywhere in the drawing. A 
tangent is drawn from this point to the reference object.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

This command does not work if the point is inside the object or on its outline; in this case, input is not
allowed.

The line is assigned to the current layer. In addition, it contains a reference to the current pen.

Related commands:
Tangent>Object - Point, Horizontal
Tangent>Object - Point, Vertical
Tangent>Object - Point - End-Point
Tangent>Angle - Object - End-Point
Tangent>Object - Object



Tangent>Object - Point, Horizontal (Draw Menu)
This command draws a horizontal line which ends tangential to a circle or ellipse. "Horizontal" refers to 
the position relative to the page, not the view. If the drawing is shown rotated on screen, then the line will 
also be shown rotated.

1. Identify reference circle / ellipse
Any circle or ellipse which exists independently or as part of another object can be identified as a 
reference object. This can also be the arc of an ellipse segment or a circular arc within a surface.
Click on the relevant object (part object) with the mouse to identify it. If several objects lie very close
to the point clicked on, then a small dialog appears at the bottom of the screen, with the help of which
the correct object can be chosen.

The position at which the object was identified (the "ID point") affects the rest of the command. If a 
horizontal tangent is placed on a circle or an ellipse, this can occur at the top or the bottom. The line 
will end at the tangent point which is closer to the ID point (see graphic).

After identifying the object, a straight line appears which runs horizontally and is tangent to the 
identified object. This line is referred to as the "Reference Straight Line".

2. Enter point
The end point of the tangent can be entered by clicking the mouse anywhere in the drawing. A 
perpendicular is dropped from this position to the reference straight line to determine the tangent's 
end point.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
In addition, it is possible to enter a length. This gives the length of the line beginning from the tangent
point. To do this, a small arrow appears at the left of the status window during direct entry. This 
shows the orientation for the length details. If you enter a positive value, the line will be drawn from 
the start point in the direction of the arrow. A negative value draws a line in the opposite direction to 
the arrow. For further information on coordinate entry, see Function Keys>Direct Input (F8).

The line is assigned to the current layer. In addition, it contains a reference to the current pen.

Related commands:
Tangent>Object - Point
Tangent>Object - Point, Vertical
Tangent>Object - Point - End-Point
Tangent>Angle - Object - End-Point
Tangent>Object - Object





Tangent>Object - Point, Vertical (Draw Menu)
This command draws a vertical line which ends tangential to a circle or ellipse. "Vertical" refers to the 
position relative to the page, not the view. If the drawing is shown rotated on screen, then the line will 
also be shown rotated.

1. Identify reference circle / ellipse
Any circle or ellipse which exists independently or as part of another object can be identified as a 
reference object. This can also be the arc of an ellipse segment or a circular arc within a surface.
Click on the relevant object (part object) with the mouse to identify it. If several objects lie very close
to the point clicked on, then a small dialog appears at the bottom of the screen, with the help of which
the correct object can be chosen.

The position at which the object was identified (the "ID point") affects the rest of the command. If a 
vertical tangent is placed on a circle or an ellipse, this can occur at the left or the right. The line will 
end at the tangent point which is closer to the ID point (see graphic).

After identifying the object, a straight line appears which runs vertically and is tangent to the 
identified object.

2. Enter point
The end point of the tangent can be entered by clicking the mouse anywhere in the drawing. A 
perpendicular is dropped from this position to the reference straight line to determine the tangent's 
end point.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
In addition, it is possible to enter a length. This gives the length of the line beginning from the tangent
point. To do this, a small arrow appears at the left of the status window during direct entry. This 
shows the orientation for the length details. If you enter a positive value, the line will be drawn from 
the start point in the direction of the arrow. A negative value draws a line in the opposite direction to 
the arrow. For further information on coordinate entry, see Function Keys>Direct Input (F8).

The line is assigned to the current layer. In addition, it contains a reference to the current pen.

Related commands:
Tangent>Object - Point
Tangent>Object - Point, Horizontal
Tangent>Object - Point - End-Point
Tangent>Angle - Object - End-Point
Tangent>Object - Object





Tangent>Object - Point - End-Point (Draw Menu)
This command draws a line on a straight line running through a given point and being tangent to a circle 
or ellipse.

1. Identify reference circle / ellipse
Any circle or ellipse which exists independently or as part of another object can be identified as a 
reference object. This can also be the arc of an ellipse segment or a circular arc within a surface.
Click on the relevant object (part object) with the mouse to identify it. If several objects lie very close
to the point clicked on, then a small dialog appears at the bottom of the screen, with the help of which
the correct object can be chosen.

The position at which the object is identified (the "ID point") affects the rest of the command. If a 
vertical tangent is placed on a circle or an ellipse, this can occur at the left or the right. The line will 
end at the tangent point which is closer to the ID point (see graphic).

2. Enter point
T<he point through which the tangent should run, can be entered by clicking the mouse anywhere in 
the drawing. A tangent is drawn from this point to the identified object.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

After entering the point, a straight line appears which runs through the point and is tangent to the 
identified object. This line is referred to as the "Reference Straight Line".

3. Enter start point
The start point can be entered by clicking the mouse anywhere in the drawing. A perpendicular is 
dropped from this point to the reference straight line to determine the new line's start point.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

4. Enter end point
The end point of the line can be entered by clicking the mouse anywhere in the drawing. A 
perpendicular is dropped from this position to the reference straight line to determine the end point of 
the new line.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.



In addition, it is possible to enter a length. This gives the length of the line from a previously entered 
start point. To do this, a small arrow appears at the left of the status window during direct entry. This 
shows the orientation for the length details. If you enter a positive value, the line will be drawn from 
the start point in the direction of the arrow. A negative value draws a line in the opposite direction to 
the arrow. For further information on coordinate entry, see Function Keys>Direct Input (F8).

The line is assigned to the current layer. In addition, it contains a reference to the current pen.

Related commands:
Tangent>Object - Point
Tangent>Object - Point, Horizontal
Tangent>Object - Point, Vertical
Tangent>Angle - Object - End-Point
Tangent>Object - Object



Tangent>Angle - Object - End-Point (Draw Menu)
This command draws a line along a straight line which is tangent to a given circle or ellipse at a particular
angle.

1. Enter angle
After choosing this command, a dialog appears into which the angle to be used can be entered. This 
angle remains valid until either a new command is chosen or the current command is restarted using 
Restart Command (+ESC) or the key combination SHIFT+ESC.

2. Identify reference circle / ellipse
Any circle or ellipse which exists independently or as part of another object can be identified as a 
reference object. This can also be the arc of an ellipse segment or a circular arc within a surface.
Click on the relevant object (part object) with the mouse to identify it. If several objects lie very close
to the point clicked on, then a small dialog appears at the bottom of the screen, with the help of which
the correct object can be chosen.

The position at which the object is identified (the "ID point") affects the rest of the command. If a 
tangent is placed at a particular angle to a circle or an ellipse, it can be placed on either side of the 
ellipse/circle. The line will end at the tangent point which is closer to the ID point (see graphic).

After identification of the object, a straight line appears which runs at a specified angle and is tangent 
to the identified object. This line is referred to as the "Reference Straight Line".

3. Enter start point
The start point can be entered by clicking the mouse anywhere in the drawing. A perpendicular is 
dropped from this point to the reference straight line to determine the new line's start point.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

4. Enter end point
The end point of the line can be entered by clicking the mouse anywhere in the drawing. A 
perpendicular is dropped from this position to the reference straight line to determine the end point of 
the new line.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
In addition, it is possible to enter a length. This gives the length of the line from a previously entered 
start point. To do this, a small arrow appears at the left of the status window during direct entry. This 
shows the orientation for the length details. If you enter a positive value, the line will be drawn from 



the start point in the direction of the arrow. A negative value draws a line in the opposite direction to 
the arrow. For further information on coordinate entry, see Function Keys>Direct Input (F8).

The line is assigned to the current layer. In addition, it contains a reference to the current pen.

Related commands:
Tangent>Object - Point
Tangent>Object - Point, Horizontal
Tangent>Object - Point, Vertical
Tangent>Object - Point - End-Point
Tangent>Object - Object



Tangent>Object - Object (Draw Menu)
This command draws a line which ends tangential to two circles or ellipses.

1. Identify reference circle / ellipse 1
Any circle or ellipse which exists independently or as part of another object can be identified as the 
first reference object. This can also be the arc of an ellipse segment or a circular arc within a surface.
Click on the relevant object (part object) with the mouse to identify it. If several objects lie very close
to the point clicked on, then a small dialog appears at the bottom of the screen, with the help of which
the correct object can be chosen.

The position at which the object is identified (the "ID point") affects the rest of the command. There 
are up to four possibilities when drawing a tangent between two circles. Together with a second ID 
point, this ID point determines which of the four possible tangents are drawn (see below).

2. Identify reference circle / ellipse 2
Any circle or ellipse which exists independently or as part of another object can be identified as the 
second reference object. This can also be the arc of an ellipse segment or a circular arc within a 
surface.
Click on the relevant object (part object) with the mouse to identify it. If several objects lie very close
to the point clicked on, then a small dialog appears at the bottom of the screen, with the help of which
the correct object can be chosen.

The position at which the object is identified (the "ID point") affects the rest of the command. There 
are up to four possibilities when drawing a tangent between two circles. Together with the first ID 
point, this ID point determines which of the four possible tangents are drawn (see graphic).

If one circle or ellipse lies wholly inside another, it is not possible to work out a line tangent to both 
circles, and a corresponding error message appears.

The line is assigned to the current layer. In addition, it contains a reference to the current pen.

Related commands:
Tangent>Object - Point
Tangent>Object - Point, Horizontal
Tangent>Object - Point, Vertical
Tangent>Object - Point - End-Point
Tangent>Angle - Object - End-Point



Polygon>Triangle (Draw Menu)
This command draws an arbitrary surface with three corners (a triangle).

1. Enter corner point 1
The first corner point of the triangle can be entered by clicking the mouse anywhere in the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

2. Enter corner point 2
The second corner point of the triangle can be entered by clicking the mouse anywhere in the 
drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered. Relative coordinates relate to the previously entered corner 
point. For further information on coordinate entry, see Function Keys>Direct Input (F8).

3. Enter corner point 3
The third corner point of the triangle can be entered by clicking the mouse anywhere in the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered. Relative coordinates relate to the previously entered corner 
point. For further information on coordinate entry, see Function Keys>Direct Input (F8).

The surface is assigned to the current layer. It also contains a reference to the current pen.

Related commands:
Polygon>Quadrangle
Polygon>Parallelogram
Polygon>Rectangle
Polygon>Arbitrary
Surface



Polygon>Quadrangle (Draw Menu)
This command draws an arbitrary surface with four corners.

1. Enter corner point 1
The first corner point of the quadrangle can be entered by clicking the mouse anywhere in the 
drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

2. Enter corner point 2
The second corner point of the quadrangle can be entered by clicking the mouse anywhere in the 
drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered. Relative coordinates relate to the previously entered corner 
point. For further information on coordinate entry, see Function Keys>Direct Input (F8).

3. Enter corner point 3
The third corner point of the quadrangle can be entered by clicking the mouse anywhere in the 
drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered. Relative coordinates relate to the previously entered corner 
point. For further information on coordinate entry, see Function Keys>Direct Input (F8).

4. Enter corner point 4
The fourth corner point of the quadrangle can be entered by clicking the mouse anywhere in the 
drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered. Relative coordinates relate to the previously entered corner 
point. For further information on coordinate entry, see Function Keys>Direct Input (F8).

The corner points can be positioned so that the sides of the quadrangle overlap. The surface is still 
handled correctly by the program.

The surface is assigned to the current layer. It also contains a reference to the current pen.

Related commands:
Polygon>Triangle
Polygon>Parallelogram
Polygon>Rectangle
Polygon>Arbitrary
Surface



Polygon>Parallelogram (Draw Menu)
This command draws a parallelogram. A parallelogram is a quadrangle in which the opposite sides are 
parallel. It can also be seen as a distorted rectangle.

The parallelogram is particularly useful when working in isometric and dimetric views. If a rectangle is to
be drawn in either of these view, then it must  be done with this command and not with 
Polygon>Rectangle because the result on screen is not right-angled.

1. Enter corner point 1
The first corner point of the parallelogram can be entered by clicking the mouse anywhere in the 
drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

2. Enter corner point 2
The second corner point of the parallelogram can be entered by clicking the mouse anywhere in the 
drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered. Relative coordinates relate to the previously entered corner 
point. For further information on coordinate entry, see Function Keys>Direct Input (F8).

3. Enter corner point 3
The third corner point of the parallelogram can be entered by clicking the mouse anywhere in the 
drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered. Relative coordinates relate to the previously entered corner 
point. For further information on coordinate entry, see Function Keys>Direct Input (F8).

The fourth corner point is calculated so that the opposite sides are parallel.

The surface is assigned to the current layer. It also contains a reference to the current pen.

Related commands:
Polygon>Triangle
Polygon>Quadrangle
Polygon>Rectangle
Polygon>Arbitrary
Surface



Polygon>Rectangle (Draw Menu)
This command draws a rectangle. A rectangle is a quadrangle where each side is at right angles to the 
adjacent side, and is therefore a special type of parallelogram. This command always draws a rectangle 
whose sides are horizontal and vertical. Horizontal and vertical refers to the position relative to the page, 
not the view. If the drawing is rotated, the sides are displayed rotated as well.

If a rectangle is to be drawn when working in isometric or dimetric view, this must be done using the 
command Polygon>Parallelogram and not this command, as the result on the page is not  right-angled.

1. Enter corner point 1
The first corner point of the rectangle can be entered by clicking the mouse at any point within the 
drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

2. Enter corner point 2
The first corner point of the rectangle can be entered by clicking the mouse at any point within the 
drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered. Relative coordinates are based on the previously entered 
corner point. By using relative coordinates, a rectangle of a specific size can easily be drawn. For 
further information on coordinate entry, see Function Keys>Direct Input (F8).

The two other corners are positioned automatically so that the adjacent sides form right angles.

The surface is assigned to the current layer. It also contains a reference to the current pen.

Related commands:
Polygon>Triangle
Polygon>Quadrangle
Polygon>Parallelogram
Polygon>Arbitrary
Surface



Polygon>Arbitrary (Draw Menu)
This command draws an arbitrary polygon. A polygon is a closed sequence of connected lines.

1. Enter start point
The start point of the polygon can be entered by clicking the mouse anywhere in the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

2. Enter point
After entering the start point, more points can be entered. The polygon begins at the start point, runs 
through all the subsequently-entered points and ends at the start point. These points can be entered by 
clicking the mouse anywhere in the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
In addition, you can specify the length and/or angle of the next section relative to the previous one. 
This makes it easy , for example, to enter sections at a specific angle. For further information on 
coordinate entry, see Function Keys>Direct Input (F8).

Polygon entry is ended by clicking the right mouse button. In contrast to most other commands this 
does not lead to the last entry being ignored but instead inserts the polygon. This can be undone using 
the Undo command.

A polygon can have up to 1000 segments. If this limit is reached during entry, then further point entry is 
not allowed.

A polygon is stored internally as a surface. It can be manipulated using the same commands as surfaces.

The surface is assigned to the current layer. It also contains a reference to the current pen.

Note: All point entries can be undone step by step using Function Keys>Previous Point (ESC)    or by 
pressing the ESC key. This makes it easy to correct mistakes without having to re-enter the whole 
polygon.

Related commands:
Polygon>Triangle
Polygon>Quadrangle
Polygon>Parallelogram
Polygon>Rectangle
Surface
Curve
Line>Polyline



Polyeder>Standard (Draw Menu)
This command draws a polyeder. A polyeder is a regular polygon whose corner points all lie on an 
imaginary circle. A polyeder is, as a result, a closed sequence of joined lines.

A polyeder is specified by entering the center and radius of the imaginary circle on which its corners lie.

1. Enter number of sides
After choosing the command, a dialog appears in which the desired number of sides can be entered. 
Values between 3 and 99 inclusive are allowed. This number of sides remains valid until either a new 
command is chosen or the current command is restarted using Restart Command (+ESC) or the key 
combination SHIFT+ESC.

2. Enter center point
The center point of the imaginary circle can be entered by clicking the mouse button anywhere in the 
drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

3. Enter radius
The radius of the imaginary circle can be entered by clicking the mouse button at any point in the 
drawing through which the circle should run.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
You can also enter a specific radius. This shows the radius of the circle. For further information on 
coordinate entry, see Function Keys>Direct Input (F8).

4. Enter angle
After specifying the imaginary circle, the polyeder can be rotated. To do this, the angle (measured 
from the center of the circle) at which the first corner of the polyeder should lie. The angle can be 
entered by clicking the mouse at any point in the drawing. The position of this point relative to the 
center determines the angle.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
You can also enter an angle directly into a dialog. This shows the angle at which the first corner of the
polyeder should lie. For further information on coordinate entry, see Function Keys>Direct Input 
(F8).

A polyeder is stored internally as a surface. It can be manipulated with the same commands as a surface.

The surface is assigned to the current layer. It also contains a reference to the current pen.

Related commands:
Polyeder>On Circle
Polyeder>Circumcircle
Polyeder>Diameter
Polyeder>Side Length - Center



Polyeder>Inner Radius - Center
Surface



Polyeder>On Circle (Draw Menu)
This command draws a polyeder. A polyeder is a regular polygon whose corner points all lie on an 
imaginary circle. A polyeder is, as a result, a closed sequence of joined lines.

The polyeder is determined by identifying a reference circle which determines the imaginary circle on 
which all of the corner points lie.

1. Enter number of sides
After choosing the command, a dialog appears in which the desired number of sides can be entered. 
Values between 3 and 99 inclusive are allowed. This number of sides remains valid until either a new 
command is chosen or the current command is restarted using Restart Command (+ESC) or the key 
combination SHIFT+ESC.

2. Identify reference circle
Any circle which exists independently or as part of another object can be identified as the reference 
object. This can also be the arc of a circular segment or a circular arc within a surface.
Click on the relevant object (part object) with the mouse to identify it. If several objects lie very close
to the point clicked on, then a small dialog appears at the bottom of the screen, with the help of which
the correct object can be chosen.

3. Enter angle
After specifying the imaginary circle, the polyeder can be rotated. To do this, the angle (measured 
from the center of the circle) at which the first corner of the polyeder should lie. The angle can be 
entered by clicking the mouse at any point in the drawing. The position of this point relative to the 
center determines the angle.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
You can also enter an angle directly into a dialog. This shows the angle at which the first corner of the
polyeder should lie. For further information on coordinate entry, see Function Keys>Direct Input 
(F8).

A polyeder is stored internally as a surface. It can be manipulated with the same commands as a surface.

The surface is assigned to the current layer. It also contains a reference to the current pen.

Related commands:
Polyeder>Standard
Polyeder>Circumcircle
Polyeder>Diameter
Polyeder>Side Length - Center
Polyeder>Inner Radius - Center
Surface



Polyeder>Circumcircle (Draw Menu)
This command draws a polyeder. A polyeder is a regular polygon whose corner points all lie on an 
imaginary circle. A polyeder is, as a result, a closed sequence of joined lines.

The polyeder is calculated by entering three points through which the imaginary circle, on which all the 
corners lie, runs.

1. Enter number of sides
After choosing the command, a dialog appears in which the desired number of sides can be entered. 
Values between 3 and 99 inclusive are allowed. This number of sides remains valid until either a new 
command is chosen or the current command is restarted using Restart Command (+ESC) or the key 
combination SHIFT+ESC.

2. Enter point 1 on circle
The first point through which the imaginary circle should run can be entered by clicking the mouse at 
any point within the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

3. Enter point 2 on circle
The second point through which the imaginary circle should run can be entered by clicking the mouse
at any point within the drawing.
Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered. Relative coordinates relate to the previously entered point. 
For further information on coordinate entry, see Function Keys>Direct Input (F8).

4. Enter point 3 on circle
The third point through which the imaginary circle should run can be entered by clicking the mouse at
any point within the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered. Relative coordinates relate to the previously entered point. 
For further information on coordinate entry, see Function Keys>Direct Input (F8).

5. Enter angle
After specifying the imaginary circle, the polyeder can be rotated. To do this, the angle (measured 
from the center of the circle) at which the first corner of the polyeder should lie. The angle can be 
entered by clicking the mouse at any point in the drawing. The position of this point relative to the 
center determines the angle.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
You can also enter an angle directly into a dialog. This shows the angle at which the first corner of the
polyeder should lie. For further information on coordinate entry, see Function Keys>Direct Input 
(F8).

A polyeder is stored internally as a surface. It can be manipulated with the same commands as a surface.



The surface is assigned to the current layer. It also contains a reference to the current pen.

Related commands:
Polyeder>Standard
Polyeder>On Circle
Polyeder>Diameter
Polyeder>Side Length - Center
Polyeder>Inner Radius - Center
Surface



Polyeder>Diameter (Draw Menu)
This command draws a polyeder. A polyeder is a regular polygon whose corner points all lie on an 
imaginary circle. A polyeder is, as a result, a closed sequence of joined lines.

The polyeder is calculated from two points which indicate the endpoints of the diameter of the imaginary 
circle on which the polyeder's corners lie.

1. Enter number of sides
After choosing the command, a dialog appears in which the desired number of sides can be entered. 
Values between 3 and 99 inclusive are allowed. This number of sides remains valid until either a new 
command is chosen or the current command is restarted using Restart Command (+ESC) or the key 
combination SHIFT+ESC.

2. Enter point 1 on circle
The first point through which the imaginary circle should run can be entered by clicking the mouse at 
any point within the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

3. Enter point 2 on circle
The second point through which the imaginary circle should run can be entered by clicking the mouse
at any point within the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered. Relative coordinates relate to the previously entered point. 
For further information on coordinate entry, see Function Keys>Direct Input (F8).

4. Enter angle
After specifying the imaginary circle, the polyeder can be rotated. To do this, the angle (measured 
from the center of the circle) at which the first corner of the polyeder should lie. The angle can be 
entered by clicking the mouse at any point in the drawing. The position of this point relative to the 
center determines the angle.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
You can also enter an angle directly into a dialog. This shows the angle at which the first corner of the
polyeder should lie. For further information on coordinate entry, see Function Keys>Direct Input 
(F8).

A polyeder is stored internally as a surface. It can be manipulated with the same commands as a surface.

The surface is assigned to the current layer. It also contains a reference to the current pen.

Related commands:
Polyeder>Standard
Polyeder>On Circle
Polyeder>Circumcircle
Polyeder>Side Length - Center



Polyeder>Inner Radius - Center
Surface



Polyeder>Side Length - Center (Draw Menu)
This command draws a polyeder. A polyeder is a regular polygon whose corner points all lie on an 
imaginary circle. A polyeder is, as a result, a closed sequence of joined lines.

The polyeder is calculated by entering the desired side length and the center of the imaginary circle on 
which all the corners lie.

1. Enter side length and number of sides
After choosing the command, a dialog appears in which the desired number of sides and their length 
can be entered. Values between 3 and 99 inclusive are allowed. This number of sides remains valid 
until either a new command is chosen or the current command is restarted using Restart Command 
(+ESC) or the key combination SHIFT+ESC.

2. Enter center point
The center point of the imaginary circle can be entered by clicking the mouse button anywhere in the 
drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

3. Enter angle
After specifying the imaginary circle, the polyeder can be rotated. To do this, the angle (measured 
from the center of the circle) at which the first corner of the polyeder should lie. The angle can be 
entered by clicking the mouse at any point in the drawing. The position of this point relative to the 
center determines the angle.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
You can also enter an angle directly into a dialog. This shows the angle at which the first corner of the
polyeder should lie. For further information on coordinate entry, see Function Keys>Direct Input 
(F8).

A polyeder is stored internally as a surface. It can be manipulated with the same commands as a surface.

The surface is assigned to the current layer. It also contains a reference to the current pen.

Related commands:
Polyeder>Standard
Polyeder>On Circle
Polyeder>Circumcircle
Polyeder>Diameter
Polyeder>Inner Radius - Center
Surface



Polyeder>Inner Radius - Center (Draw Menu)
This command draws a polyeder. A polyeder is a regular polygon whose corner points all lie on an 
imaginary circle. A polyeder is, as a result, a closed sequence of joined lines.

The polyeder is calculated by entering the desired inner radius and center of the imaginary circle on 
which all the corners lie. The inner radius gives the radius of the largest circle which lies within the 
polyeder and touches its side.

The inner radius is exactly half of the usual width for six-sided screw heads. If the plan view of a six-
sided screw with an 8 mm width is to be drawn, 4 mm should be entered as the inner radius.

1. Enter number of sides and inner radius
After choosing the command a dialog appears in which the number of sides and inner radius for the 
polyeder can be entered. A number of sides between 3 and 99 can be entered. The number of sides 
and the inner radius remain valid until a new command is chosen or the current command is restarted 
using Restart Command (+ESC) or the key combination SHIFT+ESC.

2. Enter center point
The center point of the imaginary circle can be entered by clicking the mouse button anywhere in the 
drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

3. Enter angle
After specifying the imaginary circle, the polyeder can be rotated. To do this, the angle (measured 
from the center of the circle) at which the first corner of the polyeder should lie. The angle can be 
entered by clicking the mouse at any point in the drawing. The position of this point relative to the 
center determines the angle.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
You can also enter an angle directly into a dialog. This shows the angle at which the first corner of the
polyeder should lie. For further information on coordinate entry, see Function Keys>Direct Input 
(F8).

A polyeder is stored internally as a surface. It can be manipulated with the same commands as a surface.

The surface is assigned to the current layer. It also contains a reference to the current pen.

Related commands:
Polyeder>Standard
Polyeder>On Circle
Polyeder>Circumcircle
Polyeder>Diameter
Polyeder>Side Length - Center
Surface



Circle>Standard (Draw Menu)
This command draws a circle. The circle is determined by entering its center and radius.

If a circle is to be drawn while working in isometric or dimetric views, this  must be done with the 
command Ellipse>Distorted because the result on the page is not circular but elliptical.

1. Enter center point
The center point of the circle can be entered by clicking the mouse anywhere in the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

2. Enter radius
The radius of the circle can be entered by clicking the mouse anywhere in the drawing at a point 
through which the circle should run.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
You can also enter a specific radius. This gives the radius of the circle. For further information on 
coordinate entry, see Function Keys>Direct Input (F8).

The circle is assigned to the current layer. In addition, it contains a reference to the current pen.

Related commands:
Circle>On Circle
Circle>Circumcircle
Circle>Diameter
Circle>Incircle
Circle>Concentric
Circle>Tangential
Circle>Line - Line - Line
Circle>Radius - Point - Point
Circle>Radius - Object - Point
Circle>Radius - Object - Object



Circle>On Circle (Draw Menu)
This command draws a circle based on another circle or a circle part.

This command is especially useful if a geometry circle is to be transferred into the drawing. It can also be 
used to draw a circle over an existing circle part.

If a circle is to be drawn while working in isometric or dimetric views, this  must be done with the 
command Ellipse>Distorted because the result on the page is not circular but elliptical.

1. Identify reference circle
Any circle which exists independently or as part of another object can be identified as the reference 
object. This can also be the arc of a circular segment or a circular arc within a surface.
Click on the relevant object (part object) with the mouse to identify it. If several objects lie very close
to the point clicked on, then a small dialog appears at the bottom of the screen, with the help of which
the correct object can be chosen.

The circle is assigned to the current layer. In addition, it contains a reference to the current pen.

Related commands:
Circle>Standard
Circle>Circumcircle
Circle>Diameter
Circle>Incircle
Circle>Concentric
Circle>Tangential
Circle>Line - Line - Line
Circle>Radius - Point - Point
Circle>Radius - Object - Point
Circle>Radius - Object - Object



Circle>Circumcircle (Draw Menu)
This command draws a circle. The circle is calculated by entering three points through which it should 
run. This is the same as calculating the circle surrounding a triangle.

If a circle is to be drawn while working in isometric or dimetric views, this  must be done with the 
command Ellipse>Distorted because the result on the page is not circular but elliptical.

1. Enter point 1 on circle
The first point through which the circle should run can be entered by clicking the mouse anywhere 
within the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

2. Enter point 2 on circle
The second point through which the circle should run can be entered by clicking the mouse anywhere 
within the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered. Relative coordinates relate to the previously entered point. 
For further information on coordinate entry, see Function Keys>Direct Input (F8).

3. Enter point 3 on circle
The third point through which the circle should run can be entered by clicking the mouse anywhere 
within the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered. Relative coordinates relate to the previously entered point. 
For further information on coordinate entry, see Function Keys>Direct Input (F8).

The circle is assigned to the current layer. In addition, it contains a reference to the current pen.

Related commands:
Circle>Standard
Circle>On Circle
Circle>Diameter
Circle>Incircle
Circle>Concentric
Circle>Tangential
Circle>Line - Line - Line
Circle>Radius - Point - Point
Circle>Radius - Object - Point
Circle>Radius - Object - Object



Circle>Diameter (Draw Menu)
This command draws a circle. The circle is calculated by entering two points, one at either end of its 
diameter.

If a circle is to be drawn while working in isometric or dimetric views, this  must be done with the 
command Ellipse>Distorted because the result on the page is not circular but elliptical.

1. Enter point 1 on circle
The first point through which the circle should run can be entered by clicking the mouse anywhere 
within the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

2. Enter point 2 on circle
The second point through which the circle should run can be entered by clicking the mouse anywhere 
within the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered. Relative coordinates relate to the previously entered point. 
For further information on coordinate entry, see Function Keys>Direct Input (F8).

The circle is assigned to the current layer. In addition, it contains a reference to the current pen.

Related commands:
Circle>Standard
Circle>On Circle
Circle>Circumcircle
Circle>Incircle
Circle>Concentric
Circle>Tangential
Circle>Line - Line - Line
Circle>Radius - Point - Point
Circle>Radius - Object - Point
Circle>Radius - Object - Object



Circle>Incircle (Draw Menu)
This command draws a circle. The circle is calculated from the positions of the corner points of a triangle 
which it should lie within.

If the sides of the triangle are known, then the command Circle>Line - Line - Line can be used instead.

If a circle is to be drawn while working in isometric or dimetric views, this  must be done with the 
command Ellipse>Distorted because the result on the page is not circular but elliptical.

1. Enter corner point 1
The first corner point of the triangle can be entered by clicking the mouse anywhere within the 
drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

2. Enter corner point 2
The second corner point of the triangle can be entered by clicking the mouse anywhere within the 
drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered. Relative coordinates relate to the last-entered corner point. 
For further information on coordinate entry, see Function Keys>Direct Input (F8).

3. Enter corner point 3
The first corner point of the triangle can be entered by clicking the mouse anywhere within the 
drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered. Relative coordinates relate to the last-entered corner point. 
For further information on coordinate entry, see Function Keys>Direct Input (F8).

The circle is assigned to the current layer. In addition, it contains a reference to the current pen.

Related commands:
Circle>Standard
Circle>On Circle
Circle>Circumcircle
Circle>Diameter
Circle>Concentric
Circle>Tangential
Circle>Line - Line - Line
Circle>Radius - Point - Point
Circle>Radius - Object - Point
Circle>Radius - Object - Object



Circle>Concentric (Draw Menu)
This command draws a circle concentric with another circle or circle part.

If a circle is to be drawn while working in isometric or dimetric views, this  must be done with the 
command Ellipse>Distorted because the result on the page is not circular but elliptical.

1. Identify reference circle
Any circle which exists independently or as part of another object can be identified as the reference 
object. This can also be the arc of a circular segment or a circular arc within a surface.
Click on the relevant object (part object) with the mouse to identify it. If several objects lie very close
to the point clicked on, then a small dialog appears at the bottom of the screen, with the help of which
the correct object can be chosen.

2. Enter radius
The radius of the circle can be entered by clicking the mouse anywhere in the drawing at a point 
through which the circle should run.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
You can also enter a specific radius. This gives the radius of the circle. The radius can be given 
relative to the radius of the reference circle. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

The circle is assigned to the current layer. In addition, it contains a reference to the current pen.

Related commands:
Circle>Standard
Circle>On Circle
Circle>Circumcircle
Circle>Diameter
Circle>Incircle
Circle>Tangential
Circle>Line - Line - Line
Circle>Radius - Point - Point
Circle>Radius - Object - Point
Circle>Radius - Object - Object



Circle>Tangential (Draw Menu)
This command draws a circle which has a given center and is tangent to another line (or geometry line), 
circle (or geometry circle) or ellipse.

If a circle is to be drawn while working in isometric or dimetric views, this  must be done with the 
command Ellipse>Distorted because the result on the page is not circular but elliptical.

1. Identify reference object
Any part of an existing object can be used as a reference object. This can be a rectangle side, the arc 
of an ellipse segment or a circular arc within a surface.
Click on the relevant object (part object) with the mouse to identify it. If several objects lie very close
to the point clicked on, then a small dialog appears at the bottom of the screen, with the help of which
the correct object can be chosen.

The identified object is referred to as the "Reference Object". After identification, a straight line 
appears on which the circle's center point will lie. This is referred to as the "Reference Straight Line"

2. Enter reference point
The position of the circle and the tangent opines of the objects can be entered by clicking the mouse 
at any point within the drawing. A perpendicular is dropped from this point to the reference object to 
calculate the tangent points.

If a circle is identified as the reference object, the position of the reference point determines on which 
side of the reference circle the tangent point should lie. The intersection of the reference straight line 
with the reference circle nearer to the reference point is used.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
If a circle is identified as the reference object, then you can enter an angle. This indicates the direction
of the reference straight line. For further information on coordinate entry, see Function Keys>Direct 
Input (F8).

3. Enter center point
The center point of the circle can be entered by clicking the mouse anywhere in the drawing. A 
perpendicular is dropped from this point to the reference straight line to work out the center of the 
circle.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
You can also enter a specific radius. This gives the radius of the circle. For further information on 
coordinate entry, see Function Keys>Direct Input (F8).

The circle is assigned to the current layer. In addition, it contains a reference to the current pen.

Related commands:
Circle>Standard
Circle>On Circle
Circle>Circumcircle
Circle>Diameter
Circle>Incircle



Circle>Concentric
Circle>Line - Line - Line
Circle>Radius - Point - Point
Circle>Radius - Object - Point
Circle>Radius - Object - Object



Circle>Line - Line - Line (Draw Menu)
This command draws a circle which is tangent to three lines or geometry lines.

If a circle is to be drawn while working in isometric or dimetric views, this  must be done with the 
command Ellipse>Distorted because the result on the page is not circular but elliptical.

1. Identify reference line 1
Any line in an existing object can be identified as the first reference line. This can also be a side of a 
rectangle or a leg of a circular segment.
The line is identified by clicking on it with the mouse. If several possible lines lie close to the position
clicked on, a small dialog appears near the bottom of the screen, from which the correct line can be 
chosen.

The position at which the line is identified (the "ID point") does not affect the rest of the command. 
Because there are four possible results, choosing them based on the position of the ID points would 
be too complicated.

2. Identify reference line 2
Any line in an existing object can be identified as the second reference line. This can also be a side of 
a rectangle or a leg of a circular segment.
The line is identified by clicking on it with the mouse. If several possible lines lie close to the position
clicked on, a small dialog appears near the bottom of the screen, from which the correct line can be 
chosen.

3. Identify reference line 3
Any line in an existing object can be identified as the third reference line. This can also be a side of a 
rectangle or a leg of a circular segment.
The line is identified by clicking on it with the mouse. If several possible lines lie close to the position
clicked on, a small dialog appears near the bottom of the screen, from which the correct line can be 
chosen.

4. Select object
After identifying all three reference lines, all the possible circles are calculated (the graphic shows 
one possible set of results).

The 'right' circle can then be chosen with the help of the small dialog which appears at the bottom of 
the screen. Only one circle can be chosen at a time.

If all three reference lines are parallel to one another, then a circle can not be worked out and an error 
message appears. However the calculation is possible if only two of the reference lines are parallel.

The circle is assigned to the current layer. In addition, it contains a reference to the current pen.



Related commands:
Circle>Standard
Circle>On Circle
Circle>Circumcircle
Circle>Diameter
Circle>Incircle
Circle>Concentric
Circle>Tangential
Circle>Radius - Point - Point
Circle>Radius - Object - Point
Circle>Radius - Object - Object



Circle>Radius - Point - Point (Draw Menu)
This command draws a circle with a given radius and which runs through two points.

If a circle is to be drawn while working in isometric or dimetric views, this  must be done with the 
command Ellipse>Distorted because the result on the page is not circular but elliptical.

1. Enter radius
After choosing this command a dialog appears in which the radius of the circle can be entered. This 
radius remains valid until either a new command is chosen or the current command is restarted using 
Restart Command (+ESC) or the key combination SHIFT+ESC.

2. Enter point 1
The first point through which the circle should run can be entered by clicking the mouse anywhere in 
the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

3. Enter point 2
The second point through which the circle should run can be entered by clicking the mouse anywhere 
in the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered. Relative coordinates relate to the previously entered point. 
For further information on coordinate entry, see Function Keys>Direct Input (F8).

4. Select object
After entering both points, both possible circles are calculated (the graphic shows one possible set of 
results).

The 'right' circle can then be chosen with the help of the small dialog which appears at the bottom of 
the screen. Only one circle can be chosen at a time.

If the two points are further apart than twice the radius, it is not possible to calculate the circle, and an 
error message appears.

The circle is assigned to the current layer. In addition, it contains a reference to the current pen.

Related commands:
Circle>Standard



Circle>On Circle
Circle>Circumcircle
Circle>Diameter
Circle>Incircle
Circle>Concentric
Circle>Tangential
Circle>Line - Line - Line
Circle>Radius - Object - Point
Circle>Radius - Object - Object



Circle>Radius - Object - Point (Draw Menu)
This command draws a circle with a given radius which is tangent to a given line (or geometry line) and a
given circle (or geometry circle) and runs through a given point.

If a circle is to be drawn while working in isometric or dimetric views, this  must be done with the 
command Ellipse>Distorted because the result on the page is not circular but elliptical.

1. Enter radius
After choosing this command a dialog appears in which the radius of the circle can be entered. This 
radius remains valid until either a new command is chosen or the current command is restarted using 
Restart Command (+ESC) or the key combination SHIFT+ESC.

2. Identify reference object
Any part of an existing object can be identified as a reference object. This can be a side of a rectangle 
or a circular arc within a surface. Ellipses and ellipse parts can not be identified.
Click on the relevant object (part object) with the mouse to identify it. If several objects lie very close
to the point clicked on, then a small dialog appears at the bottom of the screen, with the help of which
the correct object can be chosen.

The identified object is referred to as the "Reference Object".

The position at which the object was identified (the "ID point") has no effect on the rest of the 
command. Because there are up to four possible results it would be too complicated to make a choice 
on the basis of the ID point's position.

3. Enter point
The point through which the circle should run can be entered by clicking the mouse at any point 
within the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

4. Select object
After identifying the reference object and entering the point, then all the possible circles are 
calculated (the graphic shows one possible result).

One of the circles can be chosen with the help of a small dialog which appears near the bottom of the 
screen. Only one circle can be chosen.

If the points are further than twice the radius from the object then the circles can not be calculated. In this 
case an error message appears.



The circle is assigned to the current layer. In addition, it contains a reference to the current pen.

Related commands:
Circle>Standard
Circle>On Circle
Circle>Circumcircle
Circle>Diameter
Circle>Incircle
Circle>Concentric
Circle>Tangential
Circle>Line - Line - Line
Circle>Radius - Point - Point
Circle>Radius - Object - Object



Circle>Radius - Object - Object (Draw Menu)
This command draws a circle with a given radius which is tangent to two specified lines (or geometry 
lines) or circles (or geometry circles)

If a circle is to be drawn while working in isometric or dimetric views, this  must be done with the 
command Ellipse>Distorted because the result on the page is not circular but elliptical.

1. Enter radius
After choosing this command a dialog appears in which the radius of the circle can be entered. This 
radius remains valid until either a new command is chosen or the current command is restarted using 
Restart Command (+ESC) or the key combination SHIFT+ESC.

2. Identify reference object 1
Any part of an existing object can be identified as the first reference object. This can be a side of a 
rectangle or a circular arc within a surface. Ellipses and ellipse parts can not be identified.
Click on the relevant object (part object) with the mouse to identify it. If several objects lie very close
to the point clicked on, then a small dialog appears at the bottom of the screen, with the help of which
the correct object can be chosen.

The identified object is referred to as the "Reference Object".

The position at which the object was identified (the "ID point") has no effect on the rest of the 
command.    As there are up to eight possible results, a choice based on the position of the ID point 
would be too complex.

3. Identify reference object 2
Any part of an existing object can be identified as the second    reference object. This can be a side of 
a rectangle or a circular arc within a surface. Ellipses and ellipse parts can not be identified.
Click on the relevant object (part object) with the mouse to identify it. If several objects lie very close
to the point clicked on, then a small dialog appears at the bottom of the screen, with the help of which
the correct object can be chosen.

The identified object is referred to as the "Reference Object".

4. Select object
After identifying both reference objects, all the possible circles are calculated (the graphic shows one 
possible resulting group).

One of the circles can be chosen with the help of a small dialog which appears near the bottom of the 
screen. Only one circle can be chosen.

If the distance between the objects is more than double the radius or if two parallel lines are identified, the
circles cannot be calculated and an error message appears.



The circle is assigned to the current layer. In addition, it contains a reference to the current pen.

Related commands:
Circle>Standard
Circle>On Circle
Circle>Circumcircle
Circle>Diameter
Circle>Incircle
Circle>Concentric
Circle>Tangential
Circle>Line - Line - Line
Circle>Radius - Point - Point
Circle>Radius - Object - Point



Circular Arc>Standard (Draw Menu)
This command draws a standard circular arc. The circular arc is specified by entering the center, radius, 
start and end points.

If a circular arc is to be drawn while working in isometric or dimetric view, then the command 
Ellipse>Arc, Distorted must be used, because the result on the page is elliptical not circular.

1. Enter center point
The center of the arc can be entered by clicking the mouse anywhere in the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

2. Enter radius
The radius of the arc can be entered by clicking the mouse anywhere in the drawing at a point through
which the arc should run.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
You can also enter a specific radius. This gives the radius for the circular arc. For further information 
on coordinate entry, see Function Keys>Direct Input (F8).

3. Enter start angle
The arc's start angle can be entered by clicking the mouse anywhere in the drawing. The position of 
this point relative to the center determines the start angle.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
You can also enter an angle directly into a dialog. This gives the arc's start angle. For further 
information on coordinate entry, see Function Keys>Direct Input (F8).

4. Enter end angle
The arc's end angle can be entered by clicking the mouse anywhere in the drawing. The position of 
this point relative to the center determines the end angle.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
You can also enter an angle directly into a dialog. This gives the end angle of the arc. The angle can 
also be given relative to the previously entered start angle. For further information on coordinate 
entry, see Function Keys>Direct Input (F8).

The appearance of the arc is affected by the current arc direction setting. This is set using the 
command Function Keys>Arc Direction(F2), with the F2 key or the button in the panel. If the arc 
direction is positive, then the arc is drawn in a mathematically positive direction (i.e. anticlockwise) 
from the start angle to the end angle. If the arc direction is negative, then the arc is drawn in a 
mathematically negative direction (i.e. clockwise) from the start angle to the end angle (see graphic).



The appearance of the arc is show while it is being entered and changes immediately if the current arc
direction is changed.

The arc is assigned to the current layer. In addition, it contains a reference to the current pen.

The arc direction settings of existing arcs are not affected by changes to the current arc direction. To 
change the arc direction of an existing arc, use the command Transform Object to>Invert.

Related commands:
Circular Arc>On Circle
Circular Arc>Circumcircle
Circular Arc>Concentric to Circle
Circular Arc>Concentric to Circle Part 
Circular Arc>Radius - Point - Point
Circular Arc>Radius - Object - Point
Circular Arc>Radius - Object - Object
Circular Sector>Standard
Circular Segment>Standard



Circular Arc>On Circle (Draw Menu)
This command draws a circular arc on top of an existing circle. The arc is determined by identifying a 
circle and entering the start and end angles.

This command is particularly useful if a circular arc is to be drawn on a geometry element. In this case, 
the geometry circle must be identified and then the start and end angles are used as intersections within 
the geometry.

If a circular arc is to be drawn while working in isometric or dimetric view, then the command 
Ellipse>Arc, Distorted must be used, because the result on the page is elliptical not circular.

1. Identify reference circle
Any circle which exists independently or as part of another object can be identified as the reference 
object. This can also be the arc of a circular segment or a circular arc within a surface.
Click on the relevant object (part object) with the mouse to identify it. If several objects lie very close
to the point clicked on, then a small dialog appears at the bottom of the screen, with the help of which
the correct object can be chosen.

2. Enter start angle
The arc's start angle can be entered by clicking the mouse anywhere in the drawing. The position of 
this point relative to the center determines the start angle.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
You can also enter an angle directly into a dialog. This gives the arc's start angle. For further 
information on coordinate entry, see Function Keys>Direct Input (F8).

3. Enter end angle
The arc's end angle can be entered by clicking the mouse anywhere in the drawing. The position of 
this point relative to the center determines the end angle.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
You can also enter an angle directly into a dialog. This gives the end angle of the arc. The angle can 
also be given relative to the previously entered start angle. For further information on coordinate 
entry, see Function Keys>Direct Input (F8).

The appearance of the arc is affected by the current arc direction setting. This is set using the 
command Function Keys>Arc Direction(F2), with the F2 key or the button in the panel. If the arc 
direction is positive, then the arc is drawn in a mathematically positive direction (i.e. anticlockwise) 
from the start angle to the end angle. If the arc direction is negative, then the arc is drawn in a 
mathematically negative direction (i.e. clockwise) from the start angle to the end angle (see graphic).



The appearance of the arc is show while it is being entered and changes immediately if the current arc
direction is changed.

The arc is assigned to the current layer. In addition, it contains a reference to the current pen.

The arc direction settings of existing arcs are not affected by changes to the current arc direction. To 
change the arc direction of an existing arc, use the command Transform Object to>Invert.

Related commands:
Circular Arc>Standard
Circular Arc>Circumcircle
Circular Arc>Concentric to Circle
Circular Arc>Concentric to Circle Part 
Circular Arc>Radius - Point - Point
Circular Arc>Radius - Object - Point
Circular Arc>Radius - Object - Object
Circular Sector>On Circle
Circular Segment>On Circle



Circular Arc>Circumcircle (Draw Menu)
This command draws a circular arc which ends at two given points and runs through a third.

If a circular arc is to be drawn while working in isometric or dimetric view, then the command 
Ellipse>Arc, Distorted must be used, because the result on the page is elliptical not circular.

1. Enter start point
The start point can be entered by clicking at any point in the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

2. Enter end point
The end point can be entered by clicking at any point in the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered. Relative coordinates relate to the previously entered start 
point. For further information on coordinate entry, see Function Keys>Direct Input (F8).

3. Enter point on arc
The third point through which the circular arc should run, can be entered with the mouse by clicking 
anywhere in the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered. Relative values refer to the previously entered end point. For
further information on coordinate entry, see Function Keys>Direct Input (F8).

The appearance of the arc is not dependent on the current arc direction, as the arc direction is 
determined implicitly by the position of the third point.

The arc is assigned to the current layer. In addition, it contains a reference to the current pen.

The arc direction settings of existing arcs are not affected by changes to the current arc direction. To 
change the arc direction of an existing arc, use the command Transform Object to>Invert.

Related commands:
Circular Arc>Standard
Circular Arc>On Circle
Circular Arc>Concentric to Circle
Circular Arc>Concentric to Circle Part 
Circular Arc>Radius - Point - Point
Circular Arc>Radius - Object - Point
Circular Arc>Radius - Object - Object



Circular Arc>Concentric to Circle (Draw Menu)
This command draws a circular arc which is concentric with another circle. The arc is determined by 
identifying the circle and entering the radius, start and end angles.

If a circular arc is to be drawn while working in isometric or dimetric view, then the command 
Ellipse>Arc, Distorted must be used, because the result on the page is elliptical not circular.

1. Identify reference circle
Any circle which exists independently or as part of another object can be identified as the reference 
object. This can also be the arc of a circular segment or a circular arc within a surface.
Click on the relevant object (part object) with the mouse to identify it. If several objects lie very close
to the point clicked on, then a small dialog appears at the bottom of the screen, with the help of which
the correct object can be chosen.

2. Enter radius
The radius of the arc can be entered by clicking the mouse anywhere in the drawing at a point through
which the arc should run.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
You can also enter a specific radius. This gives the radius of the circle. The radius can be given 
relative to the radius of the reference circle. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

3. Enter start angle
The arc's start angle can be entered by clicking the mouse anywhere in the drawing. The position of 
this point relative to the center determines the start angle.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
You can also enter an angle directly into a dialog. This gives the arc's start angle. For further 
information on coordinate entry, see Function Keys>Direct Input (F8).

4. Enter end angle
The arc's end angle can be entered by clicking the mouse anywhere in the drawing. The position of 
this point relative to the center determines the end angle.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
You can also enter an angle directly into a dialog. This gives the end angle of the arc. The angle can 
also be given relative to the previously entered start angle. For further information on coordinate 
entry, see Function Keys>Direct Input (F8).

The appearance of the arc is affected by the current arc direction setting. This is set using the 
command Function Keys>Arc Direction(F2), with the F2 key or the button in the panel. If the arc 
direction is positive, then the arc is drawn in a mathematically positive direction (i.e. anticlockwise) 
from the start angle to the end angle. If the arc direction is negative, then the arc is drawn in a 
mathematically negative direction (i.e. clockwise) from the start angle to the end angle (see graphic).



The appearance of the arc is show while it is being entered and changes immediately if the current arc
direction is changed.

The arc is assigned to the current layer. In addition, it contains a reference to the current pen.

The arc direction settings of existing arcs are not affected by changes to the current arc direction. To 
change the arc direction of an existing arc, use the command Transform Object to>Invert.

Related commands:
Circular Arc>Standard
Circular Arc>On Circle
Circular Arc>Circumcircle
Circular Arc>Concentric to Circle Part 
Circular Arc>Radius - Point - Point
Circular Arc>Radius - Object - Point
Circular Arc>Radius - Object - Object



Circular Arc>Concentric to Circle Part  (Draw Menu)
This command draws a circular arc which runs concentric to another circular arc. After identifying the 
other circular arc, the arc is determined by entering its radius.

If a circular arc is to be drawn while working in isometric or dimetric view, then the command 
Ellipse>Arc, Distorted must be used, because the result on the page is elliptical not circular.

1. Identify reference circle part
Any circle part which exists independently or within other objects can be identified as a reference 
object. This can also be the arc of a circular segment or a circular arc within a surface.
Click on the relevant object (part object) with the mouse to identify it. If several objects lie very close
to the point clicked on, then a small dialog appears at the bottom of the screen, with the help of which
the correct object can be chosen.

2. Enter radius
The radius of the arc can be entered by clicking the mouse anywhere in the drawing at a point through
which the arc should run.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
You can also enter a specific radius. This gives the radius of the circle. The radius can be entered 
relative to the reference circle part's radius. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

The start and end angle as well as the arc direction are taken from the reference circle part.

The arc is assigned to the current layer. In addition, it contains a reference to the current pen.

The arc direction settings of existing arcs are not affected by changes to the current arc direction. To 
change the arc direction of an existing arc, use the command Transform Object to>Invert.

Related commands:
Circular Arc>Standard
Circular Arc>On Circle
Circular Arc>Circumcircle
Circular Arc>Concentric to Circle
Circular Arc>Radius - Point - Point
Circular Arc>Radius - Object - Point
Circular Arc>Radius - Object - Object



Circular Arc>Radius - Point - Point (Draw Menu)
This command draws a circular arc which has a given radius and ends at two given points.

If a circular arc is to be drawn while working in isometric or dimetric view, then the command 
Ellipse>Arc, Distorted must be used, because the result on the page is elliptical not circular.

1. Enter radius
After choosing this command, a dialog appears in which a radius for the circular arc can be entered. 
This radius remains valid until a new command is chosen or the current command is restarted using 
Restart Command (+ESC) or the key combination SHIFT+ESC.

2. Enter point 1
The first point, which the circular arc should end at, can be entered by clicking the mouse anywhere 
within the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

3. Enter point 2
The second point, which the circular arc should end at, can be entered by clicking the mouse 
anywhere within the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered. Relative values refer to the previously entered, first point. 
For further information on coordinate entry, see Function Keys>Direct Input (F8).

4. Select object
After both points have been entered, all the possible circular arcs are calculated (the graphic shows 
one possible result).

These are offered for choice. To do this, a small dialog from which the correct arc can be chosen, 
appears at the bottom of the screen. Only one circular arc can be chosen at a time.

If the distance between the two points is more than twice the radius, then the circular arc can not be 
calculated. In this case, an error message appears.

The arc is assigned to the current layer. In addition, it contains a reference to the current pen.

The arc direction settings of existing arcs are not affected by changes to the current arc direction. To 
change the arc direction of an existing arc, use the command Transform Object to>Invert.



Related commands:
Circular Arc>Standard
Circular Arc>On Circle
Circular Arc>Circumcircle
Circular Arc>Concentric to Circle
Circular Arc>Concentric to Circle Part 
Circular Arc>Radius - Object - Point
Circular Arc>Radius - Object - Object



Circular Arc>Radius - Object - Point (Draw Menu)
This command draws a circular arc which has a given radius, begins tangent to a given line (or geometry 
line) or circle (or geometry circle) and ends at a given point.

If a circular arc is to be drawn while working in isometric or dimetric view, then the command 
Ellipse>Arc, Distorted must be used, because the result on the page is elliptical not circular.

1. Enter radius
After choosing this command, a dialog appears in which a radius for the circular arc can be entered. 
This radius remains valid until a new command is chosen or the current command is restarted using 
Restart Command (+ESC) or the key combination SHIFT+ESC.

2. Identify reference object
Any part of an existing object can be identified as a reference object. This can be the side of a 
rectangle or a circular arc within a surface. Ellipses and ellipse parts can not be identified.
Click on the relevant object (part object) with the mouse to identify it. If several objects lie very close
to the point clicked on, then a small dialog appears at the bottom of the screen, with the help of which
the correct object can be chosen.

The identified object is referred to as the "Reference Object".

The position at which the object was identified (the "ID point") has no effect on the rest of the 
command. As there are up to eight possible results, it would be too complicated to make a choice on 
the basis of the ID point.

3. Enter point
The point at which the arc should end can be entered by clicking the mouse anywhere in the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

4. Select object
After identifying the reference object and entering the point, all the possible arcs are calculated (the 
graphic shows one possible result).

These are offered for choice. To do this, a small dialog from which the correct arc can be chosen, 
appears at the bottom of the screen. Only one circular arc can be chosen at a time.

If the distance from the point to the object is more than double the radius, then the arc can not be 
calculated. In this case, an error message appears.



The arc is assigned to the current layer. In addition, it contains a reference to the current pen.

The arc direction settings of existing arcs are not affected by changes to the current arc direction. To 
change the arc direction of an existing arc, use the command Transform Object to>Invert.

Related commands:
Circular Arc>Standard
Circular Arc>On Circle
Circular Arc>Circumcircle
Circular Arc>Concentric to Circle
Circular Arc>Concentric to Circle Part 
Circular Arc>Radius - Point - Point
Circular Arc>Radius - Object - Object



Circular Arc>Radius - Object - Object (Draw Menu)
This command draws a circle which has a given radius and is tangent to two given lines (or geometry 
lines) or circles (or geometry circles).

If a circular arc is to be drawn while working in isometric or dimetric view, then the command 
Ellipse>Arc, Distorted must be used, because the result on the page is elliptical not circular.

1. Enter radius
After choosing this command, a dialog appears in which a radius for the circular arc can be entered. 
This radius remains valid until a new command is chosen or the current command is restarted using 
Restart Command (+ESC) or the key combination SHIFT+ESC.

2. Identify reference object 1
Any part object in an existing object can be identified as the first reference object. This can be a side 
of a rectangle or a circular arc within a surface. Ellipses and ellipse parts can not be identified.
Click on the relevant object (part object) with the mouse to identify it. If several objects lie very close
to the point clicked on, then a small dialog appears at the bottom of the screen, with the help of which
the correct object can be chosen.

The identified object is referred to as the "Reference Object".

The position at which the object was identified (the "ID point") has no effect on the rest of the 
command. As there are up to eight possible results, it would be too complicated to make a choice on 
the basis of the ID point's position.

3. Identify reference object 2
Any part object in an existing object can be identified as the second reference object. This can be a 
side of a rectangle or a circular arc within a surface. Ellipses and ellipse parts can not be identified.
Click on the relevant object (part object) with the mouse to identify it. If several objects lie very close
to the point clicked on, then a small dialog appears at the bottom of the screen, with the help of which
the correct object can be chosen.

The identified object is referred to as the "Reference Object".

4. Select object
After identifying both reference objects, all possible circular arcs are calculated (the graphic shows 
one possible set of results).

These are offered for choice. To do this, a small dialog from which the correct arc can be chosen, 
appears at the bottom of the screen. Only one circular arc can be chosen at a time.

If the distance between the two objects is more than double the radius, or if two parallel lines are 
identified, it is not possible to calculate the circular arc.



The arc is assigned to the current layer. In addition, it contains a reference to the current pen.

The arc direction settings of existing arcs are not affected by changes to the current arc direction. To 
change the arc direction of an existing arc, use the command Transform Object to>Invert.

Related commands:
Circular Arc>Standard
Circular Arc>On Circle
Circular Arc>Circumcircle
Circular Arc>Concentric to Circle
Circular Arc>Concentric to Circle Part 
Circular Arc>Radius - Point - Point
Circular Arc>Radius - Object - Point



Circular Sector>Standard (Draw Menu)
This command draws a standard circular sector. The circular sector is determined by entering the center, 
radius, start and end angles.

If a circular arc is to be drawn while working in isometric or dimetric view, then the command 
Ellipse>Arc, Distorted must be used, because the result on the page is elliptical not circular.

1. Enter center point
The center of the circular sector can be entered by clicking the mouse anywhere in the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

2. Enter radius
The radius of the circular sector can be entered by clicking the mouse anywhere in the drawing at a 
point through which the circle should run.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
You can also enter a specific radius. This gives the radius of the circular sector. For further 
information on coordinate entry, see Function Keys>Direct Input (F8).

3. Enter start angle
The start angle can be entered by clicking the mouse anywhere in the drawing. The position of this 
point relative to the center determines the start angle.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
You can also enter an angle directly into a dialog. This gives the start angle for the sector. For further 
information on coordinate entry, see Function Keys>Direct Input (F8).

4. Enter end angle
The end angle can be entered by clicking the mouse anywhere in the drawing. The position of this 
point relative to the center determines the end angle.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
You can also enter an angle directly into a dialog. This gives the end angle of the sector. The angle 
can also be given relative to the previously entered start angle. For further information on coordinate 
entry, see Function Keys>Direct Input (F8).

The appearance of the circular sector is determined by the current arc direction setting. This is set 
using the command Function Keys>Arc Direction(F2), with the F2 key or the button in the panel. If 
the arc direction is positive, the circular sector is drawn in a mathematically positive sense (i.e. anti-
clockwise) from the start angle to the end angle. If the arc direction is negative, the circular sector is 
drawn in a mathematically negative sense (i.e. clockwise) from the start angle to the end angle (see 
graphic).



The sector's final appearance is shown during entry and changes immediately if the arc direction is 
changed during entry.

The circular sector is assigned to the current layer. In addition, it contains a reference to the current pen.

The arc direction saved in the sector is not changed if the current arc direction is changed later. To change 
the arc direction of an existing sector, use the command Transform Object to>Invert.

Related commands:
Circular Sector>On Circle
Circular Arc>Standard
Circular Segment>Standard



Circular Sector>On Circle (Draw Menu)
This command draws a circular sector on top of an existing circle. The sector is determined by identifying
a reference circle and entering start and end angles.

This command is particularly useful if a circular sector is to be added on top of geometry elements. In this
case, the geometry circle has to be identified, and the start and end angles are snapped to as intersections 
in the geometry.

If a circular sector has to be drawn while working in isometric or dimetric view, the command 
Ellipse>Sector, Distorted must be used as the result on the page is not circular.

1. Identify reference circle
Any circle which exists independently or as part of another object can be identified as the reference 
object. This can also be the arc of a circular segment or a circular arc within a surface.
Click on the relevant object (part object) with the mouse to identify it. If several objects lie very close
to the point clicked on, then a small dialog appears at the bottom of the screen, with the help of which
the correct object can be chosen.

2. Enter start angle
The start angle can be entered by clicking the mouse anywhere in the drawing. The position of this 
point relative to the center determines the start angle.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
You can also enter an angle directly into a dialog. This gives the start angle for the sector. For further 
information on coordinate entry, see Function Keys>Direct Input (F8).

3. Enter end angle
The end point of a circular sector can be entered by clicking anywhere in the drawing. The position of
this point relative to the center determines the end angle.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
You can also enter an angle directly into a dialog. This gives the end angle of the sector. The angle 
can also be given relative to the previously entered start angle. For further information on coordinate 
entry, see Function Keys>Direct Input (F8).

The appearance of the circular sector is determined by the current arc direction setting. This is set 
using the command Function Keys>Arc Direction(F2), with the F2 key or the button in the panel. If 
the arc direction is positive, the circular sector is drawn in a mathematically positive sense (i.e. anti-
clockwise) from the start angle to the end angle. If the arc direction is negative, the circular sector is 
drawn in a mathematically negative sense (i.e. clockwise) from the start angle to the end angle (see 
graphic).



The sector's final appearance is shown during entry and changes immediately if the arc direction is 
changed during entry.

The circular sector is assigned to the current layer. In addition, it contains a reference to the current pen.

The arc direction saved in the sector is not changed if the current arc direction is changed later. To change 
the arc direction of an existing sector, use the command Transform Object to>Invert.

Related commands:
Circular Sector>Standard
Circular Arc>On Circle
Circular Segment>On Circle



Circular Segment>Standard (Draw Menu)
This command draws a circular segment. The segment is determined by entering the center, radius, start 
and end angles.

If a circular segment has to be drawn while working in isometric or dimetric view, the command 
Ellipse>Segment, Distorted must be used as the result on the page is elliptical, not circular.

1. Enter center point
The center of the circular segment can be entered with the mouse by clicking anywhere in the 
drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

2. Enter radius
The radius of the circular segment can be entered with the mouse by clicking anywhere in the 
drawing at a point through which the circle should run.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
You can also enter a specific radius. This gives the radius for the circular segment. For further 
information on coordinate entry, see Function Keys>Direct Input (F8).

3. Enter start angle
The start angle for the circular segment can be entered with the mouse by clicking anywhere in the 
drawing. The position of this point relative to the center determines the start angle.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
You can also enter an angle directly into a dialog. This gives the start angle of the circular segment. 
For further information on coordinate entry, see Function Keys>Direct Input (F8).

4. Enter end angle
The end angle for the circular segment can be entered with the mouse by clicking anywhere in the 
drawing. The position of this point relative to the center determines the end angle.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
You can also enter an angle directly into a dialog. This gives the end angle of the circular segment. 
The angle can also be given relative to the previously entered start angle. For further information on 
coordinate entry, see Function Keys>Direct Input (F8).

The appearance of the circular segment is determined by the current arc direction setting. This is set 
using the command Function Keys>Arc Direction(F2), with the F2 key or the button in the panel. If 
the arc direction is positive, the circular segment is drawn in a mathematically positive sense (i.e. 
anti-clockwise) from the start angle to the end angle. If the arc direction is negative, the circular 
segment is drawn in a mathematically negative sense (i.e. clockwise) from the start angle to the end 
angle (see graphic).



The eventual appearance of the circular segment is shown during its entry and changes immediately if
the arc direction is changed during entry.

The segment is assigned to the current layer. It also contains a reference to the current pen.

The arc direction saved in the segment is independent of the current arc direction. To alter the arc 
direction of an existing segment, use the command Transform Object to>Invert.

Related commands:
Circular Segment>On Circle
Circular Arc>Standard
Circular Sector>Standard



Circular Segment>On Circle (Draw Menu)
This command draws a circular segment on top of an existing circle. The segment is determined by 
identifying a circle and entering start and end angles.

This command is particularly useful if a circular segment is to be drawn on geometry elements. In this 
case, all you have to do is identify the geometry circle and then the start and end angles are used as 
intersections within the geometry.

If a circular segment has to be drawn while working in isometric or dimetric view, the command 
Ellipse>Segment, Distorted must be used as the result on the page is elliptical, not circular.

1. Identify reference circle
Any circle which exists independently or as part of another object can be identified as the reference 
object. This can also be the arc of a circular segment or a circular arc within a surface.
Click on the relevant object (part object) with the mouse to identify it. If several objects lie very close
to the point clicked on, then a small dialog appears at the bottom of the screen, with the help of which
the correct object can be chosen.

2. Enter start angle
The start angle for the circular segment can be entered with the mouse by clicking anywhere in the 
drawing. The position of this point relative to the center determines the start angle.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
You can also enter an angle directly into a dialog. This gives the start angle of the circular segment. 
For further information on coordinate entry, see Function Keys>Direct Input (F8).

3. Enter end angle
The end angle for the circular segment can be entered with the mouse by clicking anywhere in the 
drawing. The position of this point relative to the center determines the end angle.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
You can also enter an angle directly into a dialog. This gives the end angle of the circular segment. 
The angle can also be given relative to the previously entered start angle. For further information on 
coordinate entry, see Function Keys>Direct Input (F8).

The appearance of the circular segment is determined by the current arc direction setting. This is set 
using the command Function Keys>Arc Direction(F2), with the F2 key or the button in the panel. If 
the arc direction is positive, the circular segment is drawn in a mathematically positive sense (i.e. 
anti-clockwise) from the start angle to the end angle. If the arc direction is negative, the circular 
segment is drawn in a mathematically negative sense (i.e. clockwise) from the start angle to the end 
angle (see graphic).



The eventual appearance of the circular segment is shown during its entry and changes immediately if
the arc direction is changed during entry.

The segment is assigned to the current layer. It also contains a reference to the current pen.

The arc direction saved in the segment is independent of the current arc direction. To alter the arc 
direction of an existing segment, use the command Transform Object to>Invert.

Related commands:
Circular Segment>Standard
Circular Arc>On Circle
Circular Sector>On Circle



Ellipse>Rectangular (Draw Menu)
This command draws a rectangular ellipse. "Rectangular" means here that both of the ellipse's half-axes 
are at right angles to one another. In addition, when using this command they are horizontal and vertical. 
Horizontal and vertical refer to the position relative to the page and not the view. If the drawing is rotated,
then the half-axes will be rotated correspondingly.

1. Enter center point
The center point of the ellipse can be entered with the mouse by clicking at any point in the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

2. Enter point on frame
The point on the frame surrounding the ellipse can be entered with the mouse by clicking anywhere in
the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered. Relative values relate to the previously entered center point. 
By entering relative values, both of the ellipse's half-axes can be entered precisely. For further 
information on coordinate entry, see Function Keys>Direct Input (F8).

A rectangular ellipse is stored as a distorted ellipse. This means that it can be rotated or distorted later.

The ellipse is assigned to the current layer. It also contains a reference to the current pen.

Related commands:
Ellipse>Rectangular, Rotated
Ellipse>Distorted
Ellipse>Arc, Rectangular
Ellipse>Arc, Distorted
Ellipse>Sector, Rectangular
Ellipse>Sector, Distorted
Ellipse>Segment, Rectangular
Ellipse>Segment, Distorted



Ellipse>Rectangular, Rotated (Draw Menu)
This command draws a rotated rectangular ellipse. "Rectangular" means here that both of the ellipse's 
half-axes are at right angles to one another.

1. Enter center point
The center point of the ellipse can be entered with the mouse by clicking at any point in the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

2. Enter point on frame
The point on the frame surrounding the ellipse can be entered with the mouse by clicking anywhere in
the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered. Relative values relate to the previously entered center point. 
By entering relative values, both of the ellipse's half-axes can be entered precisely. For further 
information on coordinate entry, see Function Keys>Direct Input (F8).

3. Enter angle
The ellipse rotation angle can be entered with the mouse by clicking anywhere in the drawing. The 
position of this point relative to the center point determines the rotation angle.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
You can also enter an angle directly into a dialog. This shows the ellipse's rotation angle. For further 
information on coordinate entry, see Function Keys>Direct Input (F8).

A rectangular ellipse is stored internally as a distorted ellipse. They can be further rotated or distorted 
later.

The ellipse is assigned to the current layer. It also contains a reference to the current pen.

Related commands:
Ellipse>Rectangular
Ellipse>Distorted
Ellipse>Arc, Rectangular
Ellipse>Arc, Distorted
Ellipse>Sector, Rectangular
Ellipse>Sector, Distorted
Ellipse>Segment, Rectangular
Ellipse>Segment, Distorted



Ellipse>Distorted (Draw Menu)
This command draws a distorted ellipse. "Distorted" means here that both half-axes are entered separately
and can therefore be at any angle to one another.

This command is particularly useful when, in isometric or dimetric view, a circle has to be entered. To do 
this, both of the ellipse's half-axes have to run in the respective main directions.

1. Enter center point
The center point of the ellipse can be entered with the mouse by clicking at any point in the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

2. Enter point 1 on ellipse
The first point through which the ellipse should run is the end point of the first half axis. It can be 
entered with the mouse by clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered. Relative values relate to the previously entered center point. 
For further information on coordinate entry, see Function Keys>Direct Input (F8).

3. Enter point 2 on ellipse
The second point through which the ellipse should run is the end point of the second half axis. It can 
be entered with the mouse by clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered. Relative values relate to the previously entered center point. 
The angle and length can be entered relative to the first half-axis. For further information on 
coordinate entry, see Function Keys>Direct Input (F8).

The ellipse is assigned to the current layer. It also contains a reference to the current pen.

Related commands:
Ellipse>Rectangular
Ellipse>Rectangular, Rotated
Ellipse>Arc, Rectangular
Ellipse>Arc, Distorted
Ellipse>Sector, Rectangular
Ellipse>Sector, Distorted
Ellipse>Segment, Rectangular
Ellipse>Segment, Distorted



Ellipse>Arc, Rectangular (Draw Menu)
This command draws a rectangular elliptic arc. "Rectangular" means here that both half-axes of the 
underling ellipse are at right angles to one another. With this command they are in addition horizontal and
vertical. Horizontal and vertical refer to the position relative to the page, not the view. If the drawing is 
displayed rotated then the half axes are displayed correspondingly rotated.

1. Enter center point
The center point of the ellipse can be entered with the mouse by clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

2. Enter point on frame
The point on the frame surrounding the ellipse can be entered with the mouse by clicking anywhere in
the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered. Relative values relate to the previously entered center point. 
By entering relative values, both of the ellipse's half-axes can be entered precisely. For further 
information on coordinate entry, see Function Keys>Direct Input (F8).

3. Enter start angle
The start angle of the elliptical arc can be entered with the mouse by clicking anywhere in the 
drawing. The position of this point relative to the center determines the start angle.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
You can also enter an angle directly into a dialog. This gives the start angle of the elliptical arc. For 
further information on coordinate entry, see Function Keys>Direct Input (F8).

4. Enter end angle
The end angle of the elliptical arc can be entered with the mouse by clicking anywhere in the 
drawing. The position of this point relative to the center determines the end angle.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
You can also enter an angle directly into a dialog. This gives the end angle of the elliptical arc. The 
angle can also be given relative to the previously entered start angle. For further information on 
coordinate entry, see Function Keys>Direct Input (F8).

The appearance of the elliptical arc is determined by the current arc direction setting. This is set using
the command Function Keys>Arc Direction(F2), with the F2 key or the button in the panel. If the arc 
direction is positive, the elliptical arc is drawn in a mathematically positive (i.e. anti-clockwise) 
direction from the start angle to the end angle. If the arc direction is negative, the elliptical arc is 
drawn in a mathematically negative (i.e. clockwise) direction from the start angle to the end angle 
(see graphic).



The later appearance of the elliptical arc is shown during entry and changes immediately if the current
arc direction is changed during entry.

A rectangular elliptical arc is stored as a distorted elliptical arc. It can therefore be further rotated or 
distorted later.

The elliptical arc is assigned to the current layer. In addition, it contains a reference to the current pen.

The arc direction settings saved in an elliptical arc are not affected by changing the current arc direction. 
To change the arc direction of an existing arc, use the command Transform Object to>Invert .

Related commands:
Ellipse>Rectangular
Ellipse>Rectangular, Rotated
Ellipse>Distorted
Ellipse>Arc, Distorted
Ellipse>Sector, Rectangular
Ellipse>Sector, Distorted
Ellipse>Segment, Rectangular
Ellipse>Segment, Distorted



Ellipse>Arc, Distorted (Draw Menu)
This command draws a distorted elliptical arc. "Distorted" means here that both half-axes of the 
underlying ellipse are entered separately and can be at any angle to one another.

This command is particularly useful if, in isometric or dimetric view, a circular arc has to be entered. To 
do this, both half-axes of the underling ellipse must run in the main directions.

1. Enter center point
The center point of the ellipse can be entered with the mouse by clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

2. Enter point 1 on ellipse
The first point through which the ellipse should run is the end point of the first half axis. It can be 
entered with the mouse by clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered. Relative values relate to the previously entered center point. 
For further information on coordinate entry, see Function Keys>Direct Input (F8).

3. Enter point 2 on ellipse
The second point through which the ellipse should run is the end point of the second half axis. It can 
be entered with the mouse by clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered. Relative values relate to the previously entered center point. 
The angle and length can be entered relative to the first half-axis. For further information on 
coordinate entry, see Function Keys>Direct Input (F8).

4. Enter start angle
The start angle of the elliptical arc can be entered with the mouse by clicking anywhere in the 
drawing. The position of this point relative to the center determines the start angle.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
You can also enter an angle directly into a dialog. This gives the start angle of the elliptical arc. For 
further information on coordinate entry, see Function Keys>Direct Input (F8).

5. Enter end angle
The end angle of the elliptical arc can be entered with the mouse by clicking anywhere in the 
drawing. The position of this point relative to the center determines the end angle.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
You can also enter an angle directly into a dialog. This gives the end angle of the elliptical arc. The 
angle can also be given relative to the previously entered start angle. For further information on 
coordinate entry, see Function Keys>Direct Input (F8).



The appearance of the elliptical arc is determined by the current arc direction setting. This is set using
the command Function Keys>Arc Direction(F2), with the F2 key or the button in the panel. If the arc 
direction is positive, the elliptical arc is drawn in a mathematically positive (i.e. anti-clockwise) 
direction from the start angle to the end angle. If the arc direction is negative, the elliptical arc is 
drawn in a mathematically negative (i.e. clockwise) direction from the start angle to the end angle 
(see graphic).

The later appearance of the elliptical arc is shown during entry and changes immediately if the current
arc direction is changed during entry.

The elliptical arc is assigned to the current layer. In addition, it contains a reference to the current pen.

The arc direction settings saved in an elliptical arc are not affected by changing the current arc direction. 
To change the arc direction of an existing arc, use the command Transform Object to>Invert .

Related commands:
Ellipse>Rectangular
Ellipse>Rectangular, Rotated
Ellipse>Distorted
Ellipse>Arc, Rectangular
Ellipse>Sector, Rectangular
Ellipse>Sector, Distorted
Ellipse>Segment, Rectangular
Ellipse>Segment, Distorted



Ellipse>Sector, Rectangular (Draw Menu)
This command draws a rectangular elliptical sector. "Rectangular" means here that both half-axes of the 
underling ellipse are at right angles to one another. With this command they are in addition horizontal and
vertical. Horizontal and vertical refer to the position relative to the page, not the view. If the drawing is 
displayed rotated then the half axes are displayed correspondingly rotated.

1. Enter center point
The center point of the elliptical sector can be entered with the mouse by clicking anywhere in the 
drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

2. Enter point on frame
The point on the frame surrounding the ellipse can be entered with the mouse by clicking anywhere in
the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered. Relative values relate to the previously entered center point. 
By entering relative values, both of the ellipse's half-axes can be entered precisely. For further 
information on coordinate entry, see Function Keys>Direct Input (F8).

3. Enter start angle
The start angle of the elliptical sector can be entered with the mouse by clicking anywhere in the 
drawing. The position of this point relative to the center determines the start angle.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
You can also enter an angle directly into a dialog. This gives the start angle of the elliptical sector. For
further information on coordinate entry, see Function Keys>Direct Input (F8).

4. Enter end angle
The end angle of the elliptical sector can be entered with the mouse by clicking anywhere in the 
drawing. The position of this point relative to the center determines the end angle.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
You can also enter an angle directly into a dialog. This gives the end angle of the elliptical sector. The 
angle can also be given relative to the previously entered start angle. For further information on 
coordinate entry, see Function Keys>Direct Input (F8).

The appearance of the elliptical sector is affected by the current arc direction setting. This is set using 
the command Function Keys>Arc Direction(F2), with the F2 key or the button in the panel. If the arc 
direction is positive, then the elliptical sector is drawn in a mathematically positive direction (i.e. 
anticlockwise) from the start angle to the end angle. If the arc direction is negative, then the elliptical 
sector is drawn in a mathematically negative direction (i.e. clockwise) from the start angle to the end 
angle (see graphic).



The later appearance of the elliptical sector is shown during entry and changes immediately if the 
current arc direction is changed during entry.

A rectangular elliptical sector is stored internally as a distorted elliptical sector. It can therefore be further 
rotated or distorted later.

The elliptical sector is assigned to the current layer. In addition, it contains a reference to the current pen.

The arc direction setting saved in the elliptical sector is not affected by changing the current arc direction.
To change the arc direction of an existing elliptical sector, use the command Transform Object to>Invert .

Related commands:
Ellipse>Rectangular
Ellipse>Rectangular, Rotated
Ellipse>Distorted
Ellipse>Arc, Rectangular
Ellipse>Arc, Distorted
Ellipse>Sector, Distorted
Ellipse>Segment, Rectangular
Ellipse>Segment, Distorted



Ellipse>Sector, Distorted (Draw Menu)
This command draws a distorted elliptical sector. "Distorted" means here that the two half-axes of the 
underlying ellipse are entered separately and can therefore be at any angle to one another.

This command is particularly useful if, in isometric or dimetric view, a circular sector has to be entered. 
The two half-axes have to run in the main directions.

1. Enter center point
The center point of the elliptical sector can be entered with the mouse by clicking anywhere in the 
drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

2. Enter point 1 on ellipse
The first point through which the ellipse should run is the end point of the first half axis. It can be 
entered with the mouse by clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered. Relative values relate to the previously entered center point. 
For further information on coordinate entry, see Function Keys>Direct Input (F8).

3. Enter point 2 on ellipse
The second point through which the ellipse should run is the end point of the second half axis. It can 
be entered with the mouse by clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered. Relative values relate to the previously entered center point. 
The angle and length can be entered relative to the first half-axis. For further information on 
coordinate entry, see Function Keys>Direct Input (F8).

4. Enter start angle
The start angle of the elliptical sector can be entered with the mouse by clicking anywhere in the 
drawing. The position of this point relative to the center determines the start angle.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
You can also enter an angle directly into a dialog. This gives the start angle of the elliptical sector. For
further information on coordinate entry, see Function Keys>Direct Input (F8).

5. Enter end angle
The end angle of the elliptical sector can be entered with the mouse by clicking anywhere in the 
drawing. The position of this point relative to the center determines the end angle.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
You can also enter an angle directly into a dialog. This gives the end angle of the elliptical sector. The 
angle can also be given relative to the previously entered start angle. For further information on 
coordinate entry, see Function Keys>Direct Input (F8).



The appearance of the elliptical sector is affected by the current arc direction setting. This is set using 
the command Function Keys>Arc Direction(F2), with the F2 key or the button in the panel. If the arc 
direction is positive, then the elliptical sector is drawn in a mathematically positive direction (i.e. 
anticlockwise) from the start angle to the end angle. If the arc direction is negative, then the elliptical 
sector is drawn in a mathematically negative direction (i.e. clockwise) from the start angle to the end 
angle (see graphic).

The later appearance of the elliptical sector is shown during its entry and changes immediately if the 
current arc direction is changed during entry.

The elliptical sector is assigned to the current layer. In addition, it contains a reference to the current pen.

The arc direction setting saved in the elliptical sector is not affected by changing the current arc direction.
To change the arc direction of an existing elliptical sector, use the command Transform Object to>Invert .

Related commands:
Ellipse>Rectangular
Ellipse>Rectangular, Rotated
Ellipse>Distorted
Ellipse>Arc, Rectangular
Ellipse>Arc, Distorted
Ellipse>Sector, Rectangular
Ellipse>Segment, Rectangular
Ellipse>Segment, Distorted



Ellipse>Segment, Rectangular (Draw Menu)
This command draws a rectangular elliptical segment. "Rectangular" means here that both half-axes of 
the underling ellipse are at right angles to one another. With this command they are in addition horizontal 
and vertical. Horizontal and vertical refer to the position relative to the page, not the view. If the drawing 
is displayed rotated then the half axes are displayed correspondingly rotated.

1. Enter center point
The center point of the elliptical sector can be entered with the mouse by clicking anywhere in the 
drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

2. Enter point on frame
The point on the frame surrounding the ellipse can be entered with the mouse by clicking anywhere in
the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered. Relative values relate to the previously entered center point. 
By entering relative values, both of the ellipse's half-axes can be entered precisely. For further 
information on coordinate entry, see Function Keys>Direct Input (F8).

3. Enter start angle
The start angle of an elliptical sector can be entered with the mouse by clicking anywhere in the 
drawing. The position of this point relative to the center determines the start angle.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
You can also enter an angle directly into a dialog. This gives the start angle of the ellipse segment. For
further information on coordinate entry, see Function Keys>Direct Input (F8).

4. Enter end angle
The end angle of an elliptical sector can be entered with the mouse by clicking anywhere in the 
drawing. The position of this point relative to the center determines the end angle.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
You can also enter an angle directly into a dialog. This shows the end angle of the ellipse segment. 
The angle can also be given relative to the previously entered start angle. For further information on 
coordinate entry, see Function Keys>Direct Input (F8).

The appearance of the elliptical segment is affected by the current arc direction setting. This is set 
using the command Function Keys>Arc Direction(F2), with the F2 key or the button in the panel. If 
the arc direction is positive, then the elliptical segment is drawn in a mathematically positive direction
(i.e. anticlockwise) from the start angle to the end angle. If the arc direction is negative, then the 
elliptical segment is drawn in a mathematically negative direction (i.e. clockwise) from the start angle
to the end angle (see graphic).



The later appearance of the elliptical segment is shown during its entry and changes immediately if 
the current arc direction is changed during entry.

A rectangular elliptical segment is saved as a distorted elliptical segment. It can therefore be further 
rotated or distorted later.

The elliptical segment is assigned to the current layer. In addition, it contains a reference to the current 
pen.

The arc direction stored in the elliptical segment is unaffected by changing the current arc direction. To 
change the arc direction of an existing elliptical segment, use the command Transform Object to>Invert .

Related commands:
Ellipse>Rectangular
Ellipse>Rectangular, Rotated
Ellipse>Distorted
Ellipse>Arc, Rectangular
Ellipse>Arc, Distorted
Ellipse>Sector, Rectangular
Ellipse>Sector, Distorted
Ellipse>Segment, Distorted



Ellipse>Segment, Distorted (Draw Menu)
This command draws a distorted elliptical segment. "Distorted" means here that both half-axes of the 
underlying ellipse are entered separately and can therefore be at any angle to one another.

This command is particularly useful when, in isometric or dimetric view, a circular segment has to be 
entered. To do this, both half-axes of the underlying ellipse must run in the main directions.

1. Enter center point
The center point of the elliptical sector can be entered with the mouse by clicking anywhere in the 
drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

2. Enter point 1 on ellipse
The first point through which the ellipse should run is the end point of the first half axis. It can be 
entered with the mouse by clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered. Relative values relate to the previously entered center point. 
For further information on coordinate entry, see Function Keys>Direct Input (F8).

3. Enter point 2 on ellipse
The second point through which the ellipse should run is the end point of the second half axis. It can 
be entered with the mouse by clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered. Relative values relate to the previously entered center point. 
The angle and length can be entered relative to the first half-axis. For further information on 
coordinate entry, see Function Keys>Direct Input (F8).

4. Enter start angle
The start angle of an elliptical sector can be entered with the mouse by clicking anywhere in the 
drawing. The position of this point relative to the center determines the start angle.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
You can also enter an angle directly into a dialog. This gives the start angle of the ellipse segment. For
further information on coordinate entry, see Function Keys>Direct Input (F8).

5. Enter end angle
The end angle of an elliptical sector can be entered with the mouse by clicking anywhere in the 
drawing. The position of this point relative to the center determines the end angle.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
You can also enter an angle directly into a dialog. This shows the end angle of the elliptic segment. 
The angle can also be given relative to the previously entered start angle. For further information on 
coordinate entry, see Function Keys>Direct Input (F8).



The appearance of the elliptical segment is affected by the current arc direction setting. This is set 
using the command Function Keys>Arc Direction(F2), with the F2 key or the button in the panel. If 
the arc direction is positive, then the elliptical segment is drawn in a mathematically positive direction
(i.e. anticlockwise) from the start angle to the end angle. If the arc direction is negative, then the 
elliptical segment is drawn in a mathematically negative direction (i.e. clockwise) from the start angle
to the end angle (see graphic).

The later appearance of the elliptical segment is shown during its entry and changes immediately if 
the current arc direction is changed during entry.

The elliptical segment is assigned to the current layer. In addition, it contains a reference to the current 
pen.

The arc direction stored in the elliptical segment is unaffected by changing the current arc direction. To 
change the arc direction of an existing elliptical segment, use the command Transform Object to>Invert .

Related commands:
Ellipse>Rectangular
Ellipse>Rectangular, Rotated
Ellipse>Distorted
Ellipse>Arc, Rectangular
Ellipse>Arc, Distorted
Ellipse>Sector, Rectangular
Ellipse>Sector, Distorted
Ellipse>Segment, Rectangular



Spline (Draw Menu)
This command draws a spline. A spline is a curve which runs through a number of points, joining them as 
smoothly as possible.

1. Enter start point
The start point of the spline can be entered using the mouse by clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

2. Enter point
After entering the start point, more points can be entered one after another. The spline begins at the 
start point and runs through all subsequently entered points. These points can be entered using the 
mouse by clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
In addition you can specify the length and/or angle of the next section relative to the previously 
entered section. For further information on coordinate entry, see Function Keys>Direct Input (F8).

Spline entry is ended by clicking the right mouse button. Unlike most other commands this does not 
lead to the previous entry being ignored, but instead inserts the spline. If this is not wanted, the Undo 
command must be chosen.

A spline can consist of up to 1000 points. If the limit is reached, further entry is not allowed.

Because a spline needs a lot of calculation, splines should only be used sparingly. If shallow curves are 
needed which do not have to be splines, the use of Bézier curves is preferable. Bézier curves can be 
drawn with the Curve and Surface commands.

The spline is assigned to the current layer. It also contains a reference to the current pen.

Related commands:
Curve
Surface
Line>Polyline
Polygon>Arbitrary
Freehand Line>Draw



Curve (Draw Menu)
This command draws a curve. A curve is made up of lines, circular arcs and Bézier curves. They can be 
combined to make a complex line

Note: According to the complexity of this object type, its entry can be very complicated. The all-
encompassing process described here is only needed in a few special cases. Mostly, the same thing can be 
achieved more simply.
If a curve is to be made up only of lines, it can be entered using the command Line>Polyline. In many 
other cases it is better to draw all the part objects and then transform them to curves using the command 
Transform Objects>To Curves and then merge them together using the command Trim Curve>Extent.

After choosing the command nothing happens until the start point of the curve is entered.

1. Enter start point
The start point of the curve can be entered with the mouse by clicking at any point in the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

After entering the start point, the Curve Entry dialog appears, in which the procedure to be used during 
surface entry can be specified. The way entry is carried out depends on which buttons are activated in this
dialog.

The sequence of point entry specified will be repeated until input is interrupted by pressing the right 
mouse button. This recalls the dialog where a new choice can be made.

The surface is assigned to the current layer. It also contains a reference to the current pen.

A surface can consist of up to 1000 points, where each line requires one point, a circular arc two points 
and a Bézier curve three points. If the limit is reached, further entry is not allowed. These 1000 points can
be distributed on up to 100 outlines in the surface.

Related commands:
Surface
Spline
Line>Polyline
Polygon>Arbitrary
Freehand Line>Draw



Surface (Draw Menu)
This command draws a surface. A surface is made up of lines, circular arcs and Bézier curves. These can 
be fitted together to make a closed surface, known as an outline. A surface can be made up of more than 
one closed outline.

Note: According to the complexity of this object type, its entry can be very complicated. The all-
encompassing process described here is only needed in a few special cases. Mostly, the same thing can be 
achieved more simply.
A surface made up only of lines can be entered using the command Polygon>Arbitrary. In many other 
cases it is sensible to draw part surfaces and combine them using Trim Surface>Union (A=A+B), Trim 
Surface>Intersection (A=A×B) and Trim Surface>Difference (A=A-B).

After choosing the command nothing happens until the start point of the first outline is entered.

1. Enter start point
The start point of the first outline can be entered with the mouse by clicking at any point in the 
drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

After entering the start point, the Curve Entry dialog appears, in which the procedure to be used during 
surface entry can be specified. The way entry is carried out depends on which buttons are activated in this
dialog.

The sequence of point entry specified will be repeated until input is interrupted by pressing the right 
mouse button. This recalls the dialog where a new choice can be made.

The surface is assigned to the current layer. It also contains a reference to the current pen.

A surface can consist of up to 1000 points, where each line requires one point, a circular arc two points 
and a Bézier curve three points. If the limit is reached, further entry is not allowed. These 1000 points can
be distributed on up to 100 outlines in the surface

Related commands:
Trim Surface>Generate Surface
Curve
Spline
Line>Polyline
Polygon>Arbitrary
Freehand Line>Draw
Eraser



Zigzag Line>Draw (Draw Menu)
This command draws a zigzag line. The height and width of the zags varies according to the line width 
which the zigzag line is displayed; the distance between zags can be set using the command Zigzag 
Line>Parameters.

1. Enter start point
The start point of the zigzag line can be entered with the mouse by clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

2. Enter end point
The end point of the zigzag line can be entered with the mouse by clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered. Relative coordinates relate to the previously entered start 
point. For further information on coordinate entry, see Function Keys>Direct Input (F8).

Zigzag lines are usually treated by the program like simple lines. This is especially the case for commands
from the Trimming Menu.

The zigzag line is assigned to the current layer. It also contains a reference to the current pen.

The distance between zags in existing zigzag lines is not changed when the current zag distance is 
changed. To alter the distance between zags in an existing zigzag line, use the command Edit Properties .

Related command:
Line>Standard



Zigzag Line>Parameters (Draw Menu)
This command can be used to set the current distance between zags in zig zag lines.

1. Enter distance between zags
After choosing this command, a dialog appears where the new distance between zags can be entered. 
This distance between zags is used for all subsequently drawn zigzag lines.

The distance between zags in existing zigzag lines is not changed when the current zag distance is 
changed. To alter the distance between zags in an existing zigzag line, use the command Edit Properties .

Affected commands:
Zigzag Line>Draw
Transform Objects to>Zigzag Line



Freehand Line>Draw (Draw Menu)
This command draws a freehand line. A freehand line is a series of lines which are joined together and are
drawn as if using a real pen.

1. Enter start point
The start point of the freehand line can be entered with the mouse by clicking anywhere in the 
drawing.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute or polar 
coordinates can then be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

2. Enter point
After entering the start point more points can be entered one after another. The freehand line begins at
the start point and then runs through all the subsequently-entered points. These points can be entered 
with the mouse by clicking at any points in the drawing.

It is also possible to move the mouse with the left button held down. In this case a line which follows 
the mouse movements is drawn. If the mouse button is released, then single points can again be 
entered by clicking. A further stretch of line can then be drawn by moving the mouse with the left 
button held down.

Optionally, specific coordinates can be entered. Press the F8 key or press ENTER. Absolute, relative 
or polar coordinates can then be entered.
In addition, it is possible to enter the length and/or angle of each subsequent segment relative to the 
previous one. In this way it is easy, for example, to draw sections at certain angles. For further 
information on coordinate entry, see Function Keys>Direct Input (F8).

Freehand line entry is finished by clicking the right mouse button. Unlike other functions, this does 
not lead to the previous entry being ignored, but to the line being inserted. If this is not wanted, the 
Undo command must be chosen.

A freehand line can consist of up to 1000 segments. If this limit is reached during entry, further points can
not be entered.

A freehand line is stored internally as a curve. It can be modified with the same commands as curves.

The curve is assigned to the active layer. It also contains a reference to the current pen.

The accuracy with which mouse movements with the left mouse button held down are converted to a 
series of lines can be specified using the command Freehand Line>Parameters. This accuracy influences 
the number of line segments and therefore the maximum possible length of the freehand line. An 
alteration to the accuracy only affects objects or parts drawn after making the alteration.

Note: All point entries can be undone step by step using Function Keys>Previous Point (ESC)    or by 
pressing the ESC key. Incorrect entries can be easily corrected without having to reenter the whole 
freehand line.

Related commands:
Curve



Surface
Spline
Line>Polyline
Polygon>Arbitrary



Freehand Line>Parameters (Draw Menu)
This command can be used to specify the accuracy for generating freehand lines.

1. Enter accuracy
After choosing the command a dialog appears where the accuracy for the generation of freehand lines
can be entered. This accuracy is used for all subsequently drawn freehand lines.
The accuracy is given in the form of a minimum line length. This means that a mouse movement only
leads to the generation of a new line part if the mouse has been moved more than the set amount from
the previous end position.

Previously drawn freehand lines are not affected by changing the current accuracy. The accuracy of 
existing freehand lines cannot be changed.

Affected command:
Freehand Line>Draw



Geometry Menu
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Geometry Line

Standard
On line
Horizontal
Vertical
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Parallel, Variable
Parallel, Fixed
Angle to Line
Bisector of Angle
Center Cross

Geometry Tangent
Object - Point
Object, Horizontal
Object, Vertical
Angle - Object
Object - Object

Geometry Circle
Standard
On Circle
Circumcircle
Diameter
Incircle
Concentric
Tangential
Line - Line - Line
Radius - Point - Point
Radius - Object - Point
Radius - Object - Object

Edit Geometry
Erase, Identification
Erase, Complete
Move
Scale
Rotate

Marking
Division

Distance
Object
Array

Multiple Copy
Markings
Rotation
Gradual
Distance



Object
Array



Geometry (Geometry Menu)
This command can be used to set the display parameters for the geometry. When it is chosen the 
Geometry dialog appears.

Note: Geometry objects are normally only displayed on screen. They are not output to a printer or plotter 
or copied to the clipboard or included in exported metafiles or bitmaps. 
If the geometry is to be used during output, the relevant check box in the Settings>Output must be 
enabled. The way in which these objects appear in the output can also be specified here. 

Related command:
Function Keys>Geometry (F9)



Geometry Line>Standard (Geometry Menu)
This command is used to draw a line in the geometry. 

1. Enter start point
The start point of the geometry line can be entered with the mouse by clicking at any point in the 
drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

2. Enter end point
The end point of the geometry line can be entered with the mouse by clicking anywhere in the 
drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, polar or relative coordinates can be entered. Relative values refer to the previously entered 
start point. For further information on coordinate entry, see Function Keys>Direct Input (F8).

If the geometry is not displayed when the line is drawn, it is constructed now.

The geometry can be displayed using the command Function Keys>Geometry (F9), or turned on/off with 
the F9 key or the corresponding button in the Panel.

Related commands:
Geometry Line>On Line
Geometry Line>Horizontal
Geometry Line>Vertical
Geometry Line>Mid-Perpendicular
Geometry Line>Perpendicular
Geometry Line>Parallel, Variable
Geometry Line>Parallel, Fixed
Geometry Line>Angle to Line
Geometry Line>Bisector of Angle



Geometry Line>On Line (Geometry Menu)
This command draws a geometry line on an extension of an existing line.

1. Identify reference line
Any line in an existing object can be identified as the reference line. This can also be a side of a 
rectangle or a part of a circular segment.

The line is identified by clicking on it with the mouse. If more than one line is close to the position 
clicked on, a small dialog appears at the bottom of the screen with the help of which the correct line 
can be chosen.

If the geometry is not displayed when the line is drawn, it is constructed now.

The geometry can be displayed using the command Function Keys>Geometry (F9), or turned on/off with 
the F9 key or the corresponding button in the Panel.

Related commands:
Geometry Line>Standard
Geometry Line>Horizontal
Geometry Line>Vertical
Geometry Line>Mid-Perpendicular
Geometry Line>Perpendicular
Geometry Line>Parallel, Variable
Geometry Line>Parallel, Fixed
Geometry Line>Angle to Line
Geometry Line>Bisector of Angle



Geometry Line>Horizontal (Geometry Menu)
This command draws a horizontal geometry line. "Horizontal" relates to the position on the page and not 
to the view. If the drawing is rotated, then the line will be rotated correspondingly. 

1. Enter start point
The start point of the geometry line can be entered with the mouse by clicking at any point in the 
drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

If the geometry is not displayed when the line is drawn, it is constructed now.

The geometry can be displayed using the command Function Keys>Geometry (F9), or turned on/off with 
the F9 key or the corresponding button in the Panel.

Related commands:
Geometry Line>Standard
Geometry Line>On Line
Geometry Line>Vertical
Geometry Line>Mid-Perpendicular
Geometry Line>Perpendicular
Geometry Line>Parallel, Variable
Geometry Line>Parallel, Fixed
Geometry Line>Angle to Line
Geometry Line>Bisector of Angle



Geometry Line>Vertical (Geometry Menu)
This command draws a vertical geometry line. "Vertical" relates to the position on the page and not to the 
view. If the drawing is rotated, then the line will be rotated correspondingly. 

1. Enter start point
The start point of the geometry line can be entered with the mouse by clicking at any point in the 
drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

If the geometry is not displayed when the line is drawn, it is constructed now.

The geometry can be displayed using the command Function Keys>Geometry (F9), or turned on/off with 
the F9 key or the corresponding button in the Panel.

Related commands:
Geometry Line>Standard
Geometry Line>On Line
Geometry Line>Horizontal
Geometry Line>Mid-Perpendicular
Geometry Line>Perpendicular
Geometry Line>Parallel, Variable
Geometry Line>Parallel, Fixed
Geometry Line>Angle to Line
Geometry Line>Bisector of Angle



Geometry Line>Mid-Perpendicular (Geometry Menu)
This command draws a geometry line which runs along the mid-perpendicular of another line. The 
geometry line is so constructed, that the right angle is given in normal view. If working with a distorted 
view (e.g. when using dimetric view) the visible angle is not 90 degrees.

1. Identify reference line
Any line in an existing object can be identified as the reference line. This can also be a side of a 
rectangle or a part of a circular segment. Geometry lines cannot be used because they have no 
"middle".
The line is identified by clicking on it with the mouse. If more than one line is close to the position 
clicked on, a small dialog appears at the bottom of the screen with the help of which the correct line 
can be chosen.

If the geometry is not displayed when the line is drawn, it is constructed now.

The geometry can be displayed using the command Function Keys>Geometry (F9), or turned on/off with 
the F9 key or the corresponding button in the Panel.

Related commands:
Geometry Line>Standard
Geometry Line>On Line
Geometry Line>Horizontal
Geometry Line>Vertical
Geometry Line>Perpendicular
Geometry Line>Parallel, Variable
Geometry Line>Parallel, Fixed
Geometry Line>Angle to Line
Geometry Line>Bisector of Angle



Geometry Line>Perpendicular (Geometry Menu)
This command draws a geometry line which is perpendicular to another line (or geometry line), circle (or 
geometry circle) or an ellipse. The geometry line is so constructed, that the right angle is given in normal 
view. If working with a distorted view (e.g. when using dimetric view) the visible angle is not 90 degrees.

1. Identify reference object
Any part object in an existing object can be identified as the reference object. This can be a side of a 
rectangle, the arc of an ellipse segment or a circular segment within a surface.
The (part) object is identified by clicking on it with the mouse. If several (part) objects lie close to the
point clicked on, then a small dialog appears at the bottom of the screen with the help of which the 
correct (part) object can be chosen.

The identified (part) object is referred to as the "Reference Object".

If an ellipse part was identified, the point at which it was clicked on (the "ID point") affects the way 
the rest of the command is carried out. If a perpendicular is dropped on to an ellipse, it can end on 
either side of the ellipse. The point closer to the ID point is used as the end point of the perpendicular 
(see graphic).

2. Enter point
The point through which the perpendicular should run can be entered with the mouse by clicking 
anywhere in the drawing. A perpendicular is dropped from this point to the reference object.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, polar or relative coordinates can be entered.
If a circle is identified as the reference object, then it is possible to enter the length and angle of the 
perpendicular. The angle indicates the direction of the perpendicular (beginning with the reference 
object), the length gives the length of the perpendicular. If the ID point is on the "wrong" side of the 
circle, the perpendicular is drawn through the circle. In this case, its length is the specified length plus
the diameter of the circle. For further information on coordinate entry, see Function Keys>Direct 
Input (F8).

If the geometry is not displayed when the line is drawn, it is constructed now.

The geometry can be displayed using the command Function Keys>Geometry (F9), or turned on/off with 
the F9 key or the corresponding button in the Panel.

Related commands:
Geometry Line>Standard
Geometry Line>On Line



Geometry Line>Horizontal
Geometry Line>Vertical
Geometry Line>Mid-Perpendicular
Geometry Line>Parallel, Variable
Geometry Line>Parallel, Fixed
Geometry Line>Angle to Line
Geometry Line>Bisector of Angle



Geometry Line>Parallel, Variable (Geometry Menu)
This command draws a geometry line which runs parallel to another line or geometry line.

The suffix "Variable" shows that the distance is not entered numerically, but is implied by the entry of a 
point on the line If a known numeric distance is to be entered, use the command Geometry Line>Parallel, 
Fixed .

1. Identify reference line
Any line in an existing object can be identified as the reference line. This can also be a side of a 
rectangle or a part of a circular segment.
The line is identified by clicking on it with the mouse. If more than one line is close to the position 
clicked on, a small dialog appears at the bottom of the screen with the help of which the correct line 
can be chosen.

After identification a straight line which runs parallel to the identified line and moves with the mouse 
appears. This line is referred to as the "Reference Straight Line".

2. Enter point
After identifying the reference line, further points can be entered. Each point defines a parallel which 
runs through that point. This point can be entered with the mouse, by clicking anywhere in the 
drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

Parallel entry is ended by clicking the right mouse button. Unlike other commands, this does not lead 
to the last entry being ignored, but inserts the parallel(s). If this is not desired, the command Undo 
must be chosen next.

Up to 1000 parallels can be entered at one time. If this limit is reached, then no further entries are 
accepted.

If the geometry is not already displayed when the lines are drawn, then it is constructed now.

The geometry can be displayed using the command Function Keys>Geometry (F9), or turned on/off with 
the F9 key or the corresponding button in the Panel.

Note: Point entry can be undone, step by step, using the command Function Keys>Previous Point (ESC) 
or the ESC key. This makes it easy to correct incorrect entries without having to re-enter all the 
previously entered parallels.

Related commands:
Geometry Line>Standard
Geometry Line>On Line
Geometry Line>Horizontal
Geometry Line>Vertical
Geometry Line>Mid-Perpendicular
Geometry Line>Perpendicular
Geometry Line>Parallel, Fixed



Geometry Line>Angle to Line
Geometry Line>Bisector of Angle



Geometry Line>Parallel, Fixed (Geometry Menu)
This command draws a geometry line which runs parallel to another line or geometry line.

The suffix "Fixed" indicates that the distance is specified by entering a specific value. If the size of the 
distance is not known and the distance should be entered implicitly using the mouse, use the command 
Geometry Line>Parallel, Variable .

1. Enter distance
After choosing the command, a dialog appears into which the distance can be entered. This distance 
remains valid until a new command is chosen or the current command is restarted using Restart 
Command (+ESC) or the key combination SHIFT+ESC.

2. Identify reference line
Any line in an existing object can be identified as the reference line. This can also be a side of a 
rectangle or a part of a circular segment.
The line is identified by clicking on it with the mouse. If more than one line is close to the position 
clicked on, a small dialog appears at the bottom of the screen with the help of which the correct line 
can be chosen.

After identification a straight line appears which moves when the mouse is moved. It always moves in
multiples of the distance. This line is referred to as the "Reference Straight Line".

3. Enter point
After identifying the reference line, further points can be entered. Each point defines a parallel which 
runs through that point and is a multiple of the specified distance from the reference line. This point 
can be entered with the mouse, by clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

Parallel entry is ended by clicking the right mouse button. Unlike other commands, this does not lead 
to the last entry being ignored, but inserts the parallel(s). If this is not desired, the command Undo 
must be chosen next.

Up to 1000 parallels can be entered at one time. If this limit is reached, then no further entries are 
accepted.

If the geometry is not displayed when the line is drawn, it is constructed now.

The geometry can be displayed using the command Function Keys>Geometry (F9), or turned on/off with 
the F9 key or the corresponding button in the Panel.

Note: Point entry can be undone, step by step, using the command Function Keys>Previous Point (ESC) 
or the ESC key. This makes it easy to correct incorrect entries without having to re-enter all the 
previously entered parallels.

Related commands:
Geometry Line>Standard
Geometry Line>On Line



Geometry Line>Horizontal
Geometry Line>Vertical
Geometry Line>Mid-Perpendicular
Geometry Line>Perpendicular
Geometry Line>Parallel, Variable
Geometry Line>Angle to Line
Geometry Line>Bisector of Angle



Geometry Line>Angle to Line (Geometry Menu)
This command draws a geometry line which runs at a specified angle to another line or geometry line.

1. Enter angle
After choosing this command, a dialog appears where a specific angle can be entered. This angle 
remains valid until either another command is chosen or the current command is restarted using the 
command Restart Command (+ESC) or the key combination SHIFT+ESC.

2. Identify reference line
Any line in an existing object can be identified as the reference line. This can also be a side of a 
rectangle or a part of a circular segment.
The line is identified by clicking on it with the mouse. If more than one line is close to the position 
clicked on, a small dialog appears at the bottom of the screen with the help of which the correct line 
can be chosen.

After identification a straight line appears which runs at the specified angle to the identified line. This 
line is referred to as the "Reference Straight Line".

3. Enter point
The point through which the line should run can be entered with the mouse by clicking anywhere in 
the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

If the geometry is not displayed when the line is drawn, it is constructed now.

Geometry display can be turned on or off with the command Function Keys>Geometry (F9), with the F9 
key or the corresponding button in the Panel.

Related commands:
Geometry Line>Standard
Geometry Line>On Line
Geometry Line>Horizontal
Geometry Line>Vertical
Geometry Line>Mid-Perpendicular
Geometry Line>Perpendicular
Geometry Line>Parallel, Variable
Geometry Line>Parallel, Fixed
Geometry Line>Bisector of Angle



Geometry Line>Bisector of Angle (Geometry Menu)
This command draws a geometry line which runs along the angle bisector of two other lines or geometry 
lines.

1. Identify reference line 1
Any line in an existing object can be identified as the first reference line. This can also be a side of a 
rectangle or a part of a circular segment.
The line is identified by clicking on it with the mouse. If more than one line is close to the position 
clicked on, a small dialog appears at the bottom of the screen with the help of which the correct line 
can be chosen.

The position at which the line was identified (the "ID point") affects the way in which the rest of the 
command is carried out. Together with the position at which the second line was identified, it 
determines which of the two possible angle bisectors should be used (see below).

2. Identify reference line 2
Any line in an existing object can be identified as the second reference line. This can also be a side of 
a rectangle or a part of a circular segment.
The line is identified by clicking on it with the mouse. If more than one line is close to the position 
clicked on, a small dialog appears at the bottom of the screen with the help of which the correct line 
can be chosen.

The position at which the line was identified (the "ID point") affects the way in which the rest of the 
command is carried out. Together with the position at which the first line was identified, it determines
which of the two possible angle bisectors should be used (see graphic).

If the geometry is not displayed when the line is drawn, it is constructed now.

The geometry can be displayed using the command Function Keys>Geometry (F9), or turned on/off with 
the F9 key or the corresponding button in the Panel.

Related commands:
Geometry Line>Standard
Geometry Line>On Line
Geometry Line>Horizontal
Geometry Line>Vertical
Geometry Line>Mid-Perpendicular
Geometry Line>Perpendicular
Geometry Line>Parallel, Variable
Geometry Line>Parallel, Fixed
Geometry Line>Angle to Line





Geometry Line>Center Cross (Geometry Menu)
This command draws to geometry lines. One runs horizontally and one runs vertically. They cross at the 
center of an identified circle or ellipse.

1. Identify reference circle / ellipse
Any circle or ellipse which exists on its own or as part of another object can be identified as a 
reference object. This can also be the arc of an elliptical segment or a circular arc within a surface.
The (part) object is identified by clicking on it with the mouse. If several (part) objects lie close to the
point clicked on, then a small dialog appears at the bottom of the screen with the help of which the 
correct (part) object can be chosen.

If the geometry is not already displayed when the lines are drawn, then it is constructed now.

The geometry can be displayed using the command Function Keys>Geometry (F9), or turned on/off with 
the F9 key or the corresponding button in the Panel.

Related commands:
Geometry Line>Horizontal
Geometry Line>Vertical



Geometry Tangent>Object - Point (Geometry Menu)
This command draws a geometry line which begins at a given point and runs tangent to an ellipse or 
circle.

1. Identify reference circle / ellipse
Any circle or ellipse which exists on its own or as part of another object can be identified as a 
reference object. This can also be the arc of an elliptical segment or a circular arc within a surface.
The (part) object is identified by clicking on it with the mouse. If several (part) objects lie close to the
point clicked on, then a small dialog appears at the bottom of the screen with the help of which the 
correct (part) object can be chosen.

The position at which the (part) object is identified (the "ID point) affects the way in which the rest of
the command is carried out. A tangent to a circle or ellipse can be drawn to either side of the circle or 
ellipse. The tangent point which is nearer to the ID point is used as the end point for the line.

2. Enter point
The point through which the tangent should run can be entered with the mouse by clicking anywhere 
in the drawing. The tangent is dropped from this point to the object to work out the second point of 
the tangent.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

This command does not function if the entered point is on the object outline or inside the object. In 
this case point entry is refused.

If the geometry is not displayed when the line is drawn, it is constructed now.

The geometry can be displayed using the command Function Keys>Geometry (F9), or turned on/off with 
the F9 key or the corresponding button in the Panel.

Related commands:
Geometry Tangent>Object, Horizontal
Geometry Tangent>Object, Vertical
Geometry Tangent>Angle - Object
Geometry Tangent>Object - Object



Geometry Tangent>Object, Horizontal (Geometry Menu)
This command draws a horizontal geometry line which is tangent to a circle or ellipse. "Horizontal" 
relates to the position on the page and not to the view. If the drawing is rotated, then the line will be 
rotated correspondingly. 

1. Identify reference circle / ellipse
Any circle or ellipse which exists on its own or as part of another object can be identified as a 
reference object. This can also be the arc of an elliptical segment or a circular arc within a surface.
The (part) object is identified by clicking on it with the mouse. If several (part) objects lie close to the
point clicked on, then a small dialog appears at the bottom of the screen with the help of which the 
correct (part) object can be chosen.

The position at which the (part) object is identified (the "ID point) affects the way in which the rest of
the command is carried out. If a horizontal tangent is placed on a circle or ellipse, the tangent can be 
placed above or below the circle or ellipse. The tangent point nearer to the ID point is used as the 
point through which the line should run (see graphic).

If the geometry is not displayed when the line is drawn, it is constructed now.

The geometry can be displayed using the command Function Keys>Geometry (F9), or turned on/off with 
the F9 key or the corresponding button in the Panel.

Related commands:
Geometry Tangent>Object - Point
Geometry Tangent>Object, Vertical
Geometry Tangent>Angle - Object
Geometry Tangent>Object - Object



Geometry Tangent>Object, Vertical (Geometry Menu)
This command draws a vertical geometry line which runs tangent to a circle or ellipse. "Vertical" relates 
to the position on the page and not to the view. If the drawing is rotated, then the line will be rotated 
correspondingly. 

1. Identify reference circle / ellipse
Any circle or ellipse which exists on its own or as part of another object can be identified as a 
reference object. This can also be the arc of an elliptical segment or a circular arc within a surface.
The (part) object is identified by clicking on it with the mouse. If several (part) objects lie close to the
point clicked on, then a small dialog appears at the bottom of the screen with the help of which the 
correct (part) object can be chosen.

The position at which the (part) object is identified (the "ID point) affects the way in which the rest of
the command is carried out. If a vertical tangent is placed on a circle or ellipse, it can be placed at the 
right or left of the circle or ellipse. The tangent point nearer to the ID point is used as the point 
through which the line should run (see graphic).

If the geometry is not displayed when the line is drawn, it is constructed now.

The geometry can be displayed using the command Function Keys>Geometry (F9), or turned on/off with 
the F9 key or the corresponding button in the Panel.

Related commands:
Geometry Tangent>Object - Point
Geometry Tangent>Object, Horizontal
Geometry Tangent>Angle - Object
Geometry Tangent>Object - Object



Geometry Tangent>Angle - Object (Geometry Menu)
This command draws a geometry line which is tangent to a given circle at a specified angle.

1. Enter angle
After choosing this command, a dialog appears where a specific angle can be entered. This angle 
remains valid until either another command is chosen or the current command is restarted using the 
command Restart Command (+ESC) or the key combination SHIFT+ESC.

2. Identify reference circle / ellipse
Any circle or ellipse which exists on its own or as part of another object can be identified as a 
reference object. This can also be the arc of an elliptical segment or a circular arc within a surface.
The (part) object is identified by clicking on it with the mouse. If several (part) objects lie close to the
point clicked on, then a small dialog appears at the bottom of the screen with the help of which the 
correct (part) object can be chosen.

The position at which the (part) object is identified (the "ID point) affects the way in which the rest of
the command is carried out. If a tangent is to be placed at a specified angle to a circle or ellipse, it can
be placed on either side of the circle or ellipse. The tangent whose tangent point is nearer to the ID 
point is used (see graphic).

If the geometry is not displayed when the line is drawn, it is constructed now.

The geometry can be displayed using the command Function Keys>Geometry (F9), or turned on/off with 
the F9 key or the corresponding button in the Panel.

Related commands:
Geometry Tangent>Object - Point
Geometry Tangent>Object, Horizontal
Geometry Tangent>Object, Vertical
Geometry Tangent>Object - Object



Geometry Tangent>Object - Object (Geometry Menu)
This command draws a geometry line which is tangent to two circles or ellipses.

1. Identify reference circle / ellipse 1
Any circle or ellipse which exists independently or as part of another object can be identified as the 
first reference object. This can also be the arc of an ellipse segment or a circular arc within a surface.
The (part) object is identified by clicking on it with the mouse. If several (part) objects lie close to the
point clicked on, then a small dialog appears at the bottom of the screen with the help of which the 
correct (part) object can be chosen.

The position at which the (part) object is identified (the "ID point) affects the way in which the rest of
the command is carried out. If a tangent is placed on two circles, there are up to four possible results. 
Together with the second ID point, this ID point determines which of the four possible tangents 
should be used (see below).

2. Identify reference circle / ellipse 2
Any circle or ellipse which exists independently or as part of another object can be identified as the 
second reference object. This can also be the arc of an ellipse segment or a circular arc within a 
surface.
The (part) object is identified by clicking on it with the mouse. If several (part) objects lie close to the
point clicked on, then a small dialog appears at the bottom of the screen with the help of which the 
correct (part) object can be chosen.

The position at which the (part) object is identified (the "ID point) affects the way in which the rest of
the command is carried out. If a tangent is placed on two circles, there are up to four possible results. 
Together with the first ID point, this ID point determines which of the four possible tangents should 
be used (see below).

If one circle or ellipse lies wholly within another, it is not possible to work out a line tangent to both 
objects. In this case, a corresponding error message appears.

If the geometry is not displayed when the line is drawn, it is constructed now.

The geometry can be displayed using the command Function Keys>Geometry (F9), or turned on/off with 
the F9 key or the corresponding button in the Panel.

Related commands:
Geometry Tangent>Object - Point
Geometry Tangent>Object, Horizontal
Geometry Tangent>Object, Vertical
Geometry Tangent>Angle - Object





Geometry Circle>Standard (Geometry Menu)
This command draws a geometry circle. The geometry circle is specified by entering its center point and 
radius.

1. Enter center point
The center point of the geometry cycle can be entered with the mouse by clicking anywhere in the 
drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

2. Enter radius
The radius of the geometry circle can be entered with the mouse by clicking anywhere in the drawing 
at a point through which the circle should run.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, polar or relative coordinates can be entered.
In addition it is possible to enter a specific radius. This gives the radius of the geometry circle. For 
further information on coordinate entry, see Function Keys>Direct Input (F8).

If the geometry is not displayed when the circle is drawn, it is constructed now.

The geometry can be displayed using the command Function Keys>Geometry (F9), or turned on/off with 
the F9 key or the corresponding button in the Panel.

Related commands:
Geometry Circle>On Circle
Geometry Circle>Circumcircle
Geometry Circle>Diameter
Geometry Circle>Incircle
Geometry Circle>Concentric
Geometry Circle>Tangential
Geometry Circle>Line - Line - Line
Geometry Circle>Radius - Point - Point
Geometry Circle>Radius - Object - Point
Geometry Circle>Radius - Object - Object



Geometry Circle>On Circle (Geometry Menu)
This command draws a geometry circle on top of an existing circle or circle part.

This command is particularly useful if a circle or circular arc which currently only exists in the drawing is
to be used as a geometry circle.

1. Identify reference circle
Any circle which exists on its own or within an existing object can be identified as a reference object. 
This can be the arc of a circular segment or a circular arc within a surface.
The (part) object is identified by clicking on it with the mouse. If several (part) objects lie close to the
point clicked on, then a small dialog appears at the bottom of the screen with the help of which the 
correct (part) object can be chosen.

If the geometry is not displayed when the circle is drawn, it is constructed now.

The geometry can be displayed using the command Function Keys>Geometry (F9), or turned on/off with 
the F9 key or the corresponding button in the Panel.

Related commands:
Geometry Circle>Standard
Geometry Circle>Circumcircle
Geometry Circle>Diameter
Geometry Circle>Incircle
Geometry Circle>Concentric
Geometry Circle>Tangential
Geometry Circle>Line - Line - Line
Geometry Circle>Radius - Point - Point
Geometry Circle>Radius - Object - Point
Geometry Circle>Radius - Object - Object



Geometry Circle>Circumcircle (Geometry Menu)
This command draws a geometry circle. The geometry circle is determined by three points through which 
it should run. This is the same as calculating a triangle's circumcircle.

1. Enter point 1 on circle
The first point through which the geometry circle should run can be entered with the mouse by 
clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

2. Enter point 2 on circle
The second point through which the geometry circle should run can be entered with the mouse by 
clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, polar or relative coordinates can be entered. Relative values relate to the previously entered, 
first, point. For further information on coordinate entry, see Function Keys>Direct Input (F8).

3. Enter point 3 on circle
The third point through which the geometry circle should run can be entered with the mouse by 
clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, polar or relative coordinates can be entered. Relative values relate to the previously entered, 
second point . For further information on coordinate entry, see Function Keys>Direct Input (F8).

If the geometry is not displayed when the circle is drawn, it is constructed now.

The geometry can be displayed using the command Function Keys>Geometry (F9), or turned on/off with 
the F9 key or the corresponding button in the Panel.

Related commands:
Geometry Circle>Standard
Geometry Circle>On Circle
Geometry Circle>Diameter
Geometry Circle>Incircle
Geometry Circle>Concentric
Geometry Circle>Tangential
Geometry Circle>Line - Line - Line
Geometry Circle>Radius - Point - Point
Geometry Circle>Radius - Object - Point
Geometry Circle>Radius - Object - Object



Geometry Circle>Diameter (Geometry Menu)
This command draws a geometry circle. The geometry circle is specified by entering two points which are
the ends of its diameter.

1. Enter point 1 on circle
The first point through which the geometry circle should run can be entered with the mouse by 
clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

2. Enter point 2 on circle
The second point through which the geometry circle should run can be entered with the mouse by 
clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, polar or relative coordinates can be entered. Relative values relate to the previously entered, 
first, point. For further information on coordinate entry, see Function Keys>Direct Input (F8).

If the geometry is not displayed when the circle is drawn, it is constructed now.

The geometry can be displayed using the command Function Keys>Geometry (F9), or turned on/off with 
the F9 key or the corresponding button in the Panel.

Related commands:
Geometry Circle>Standard
Geometry Circle>On Circle
Geometry Circle>Circumcircle
Geometry Circle>Incircle
Geometry Circle>Concentric
Geometry Circle>Tangential
Geometry Circle>Line - Line - Line
Geometry Circle>Radius - Point - Point
Geometry Circle>Radius - Object - Point
Geometry Circle>Radius - Object - Object



Geometry Circle>Incircle (Geometry Menu)
This command draws a geometry circle. The geometry circle is specified by entering the three corners of 
a triangle whose in circle it should be.

If the sides of the circle are known instead of its corner points, the command Geometry Circle>Line - 
Line - Line can be used instead.

1. Enter corner point 1
The triangle's first corner point can be entered with the mouse by clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

2. Enter corner point 2
The triangle's second corner point can be entered with the mouse by clicking anywhere in the 
drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, polar or relative coordinates can be entered. Relative values relate to the last-entered corner 
point. For further information on coordinate entry, see Function Keys>Direct Input (F8).

3. Enter corner point 3
The triangle's third corner point can be entered with the mouse by clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, polar or relative coordinates can be entered. Relative values relate to the last-entered corner 
point. For further information on coordinate entry, see Function Keys>Direct Input (F8).

If the geometry is not displayed when the circle is drawn, it is constructed now.

The geometry can be displayed using the command Function Keys>Geometry (F9), or turned on/off with 
the F9 key or the corresponding button in the Panel.

Related commands:
Geometry Circle>Standard
Geometry Circle>On Circle
Geometry Circle>Circumcircle
Geometry Circle>Diameter
Geometry Circle>Concentric
Geometry Circle>Tangential
Geometry Circle>Line - Line - Line
Geometry Circle>Radius - Point - Point
Geometry Circle>Radius - Object - Point
Geometry Circle>Radius - Object - Object



Geometry Circle>Concentric (Geometry Menu)
This command draws a geometry circle which runs concentric to another circle or circle part.

1. Identify reference circle
Any circle which exists on its own or within an existing object can be identified as a reference object. 
This can be the arc of a circular segment or a circular arc within a surface.
The (part) object is identified by clicking on it with the mouse. If several (part) objects lie close to the
point clicked on, then a small dialog appears at the bottom of the screen with the help of which the 
correct (part) object can be chosen.

2. Enter radius
After identifying the reference line, further points can be entered. Each point defines a concentric 
circle which runs though this point. This point can be entered with the mouse, by clicking anywhere 
in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, polar or relative coordinates can be entered.
In addition it is possible to enter a specific radius. This gives the radius of the geometry circle. The 
radius can be entered relative to the radius of the reference circle. For further information on 
coordinate entry, see Function Keys>Direct Input (F8).

Concentric circle entry is ended by clicking the right mouse button. In contrast to most commands, 
clicking the right mouse button does not lead to the previous entry being ignored, but to all concentric
circles being inserted. If this is not desired, the command Undo must be chosen next.

Up to 1000 concentric circles can be entered in one procedure. If this limit is reached, then no further 
entries are accepted.

If the geometry is not displayed when the circle is drawn, it is constructed now.

The geometry can be displayed using the command Function Keys>Geometry (F9), or turned on/off with 
the F9 key or the corresponding button in the Panel.

Note: Point entry can be undone, step by step, using the command Function Keys>Previous Point (ESC) 
or the ESC key. This means that incorrect entries can easily be corrected, without having to redo all of the
previously entered concentric circles.

Related commands:
Geometry Circle>Standard
Geometry Circle>On Circle
Geometry Circle>Circumcircle
Geometry Circle>Diameter
Geometry Circle>Incircle
Geometry Circle>Tangential
Geometry Circle>Line - Line - Line
Geometry Circle>Radius - Point - Point
Geometry Circle>Radius - Object - Point
Geometry Circle>Radius - Object - Object



Geometry Circle>Tangential (Geometry Menu)
This command draws a geometry circle which has a given center point and is tangent to another line (or 
geometry line), circle (or geometry circle) or ellipse.

1. Identify reference object
Any part object in an existing object can be identified as the reference object. This can be a side of a 
rectangle, the arc of an ellipse segment or a circular segment within a surface.
The (part) object is identified by clicking on it with the mouse. If several (part) objects lie close to the
point clicked on, then a small dialog appears at the bottom of the screen with the help of which the 
correct (part) object can be chosen.

The identified (part) object is referred to as the "Reference Object". After identification, a straight line
appears on which the circle's center point will lie. This is known as the "Reference Straight Line".

2. Enter reference point
The position of the circle and therefore the tangent point of the objects can be entered using the 
mouse, by clicking anywhere in the drawing. A perpendicular is dropped from this position to the 
reference object in order to work out the tangent point.

If a circle is identified as the reference object, the position of the reference point determines which 
side of the reference circle the tangent point should lie. The intersection of the reference straight line 
with the reference cirle nearer to the reference point is used as the tangent point.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, polar or relative coordinates can be entered.
If a circle is identified as the reference object, you can enter an angle. This shows the direction of the 
reference straight line. For further information on coordinate entry, see Function Keys>Direct Input 
(F8).

3. Enter center point
The center point of the circle can be entered using the mouse, by clicking anywhere in the drawing. A 
perpendicular is dropped from this point to the reference straight line to work out the center of the 
circle.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, polar or relative coordinates can be entered.
In addition it is possible to enter a specific radius. This shows the radius of the circle. For further 
information on coordinate entry, see Function Keys>Direct Input (F8).

If the geometry is not displayed when the circle is drawn, it is constructed now.

The geometry can be displayed using the command Function Keys>Geometry (F9), or turned on/off with 
the F9 key or the corresponding button in the Panel.

Related commands:
Geometry Circle>Standard
Geometry Circle>On Circle
Geometry Circle>Circumcircle
Geometry Circle>Diameter
Geometry Circle>Incircle



Geometry Circle>Concentric
Geometry Circle>Line - Line - Line
Geometry Circle>Radius - Point - Point
Geometry Circle>Radius - Object - Point
Geometry Circle>Radius - Object - Object



Geometry Circle>Line - Line - Line (Geometry Menu)
This command draws a geometry circle which is tangent to three lines or geometry lines.

1. Identify reference line 1
Any line in an existing object can be identified as the first reference line. This can also be a side of a 
rectangle or a part of a circular segment.
The line is identified by clicking on it with the mouse. If more than one line is close to the position 
clicked on, a small dialog appears at the bottom of the screen with the help of which the correct line 
can be chosen.

The position at which the line is identified (the "ID point") has no effect in this command. Because 
there are up to eight possible results, making a choice on the basis of the ID point's position would be 
to complicated.

2. Identify reference line 2
Any line in an existing object can be identified as the second reference line. This can also be a side of 
a rectangle or a part of a circular segment.
The line is identified by clicking on it with the mouse. If more than one line is close to the position 
clicked on, a small dialog appears at the bottom of the screen with the help of which the correct line 
can be chosen.

3. Identify reference line 3
Any line in an existing object can be identified as the third reference line. This can also be a side of a 
rectangle or a part of a circular segment.
The line is identified by clicking on it with the mouse. If more than one line is close to the position 
clicked on, a small dialog appears at the bottom of the screen with the help of which the correct line 
can be chosen.

4. Choose object
After identifying all three reference lines, all the possible geometry circles are calculated (the graphic 
shows one possible set of results)

They are presented so that a choice can be made. To do this, a small dialog appears at the bottom of 
the screen from which the correct geometry circle can be chosen. Only one circle can be chosen at 
any one time.

If all three reference lines are parallel to one another, it is not possible to calculate the geometry circles. In
this case, a corresponding error message appears. It does however work if only two of the reference lines 
are parallel to one another.

If the geometry is not displayed when the circle is drawn, it is constructed now.



The geometry can be displayed using the command Function Keys>Geometry (F9), or turned on/off with 
the F9 key or the corresponding button in the Panel.

Related commands:
Geometry Circle>Standard
Geometry Circle>On Circle
Geometry Circle>Circumcircle
Geometry Circle>Diameter
Geometry Circle>Incircle
Geometry Circle>Concentric
Geometry Circle>Tangential
Geometry Circle>Radius - Point - Point
Geometry Circle>Radius - Object - Point
Geometry Circle>Radius - Object - Object



Geometry Circle>Radius - Point - Point (Geometry Menu)
This command draws a geometry circle, which has a given radius and runs through two points.

1. Enter radius
After choosing the command, a dialog appears in which the geometry circle's radius can be specified. 
This radius remains valid until a new command is chosen or the current command is restarted using 
the command Restart Command (+ESC) or the key combination SHIFT+ESC.

2. Enter point 1
The first point through which the geometry circle should run can be entered with the mouse by 
clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

3. Enter point 2
The second point through which the geometry circle should run can be entered with the mouse by 
clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, polar or relative coordinates can be entered. Relative values relate to the previously entered, 
first, point. For further information on coordinate entry, see Function Keys>Direct Input (F8).

4. Choose object
After entering both points, all possible geometry circles are worked out (the graphic shows one 
possible set of results).

They are presented so that a choice can be made. To do this, a small dialog appears at the bottom of 
the screen from which the correct geometry circle can be chosen. Only one circle can be chosen at 
any one time.

If the distance between the points is more than double the radius, it is not possible to calculate the 
geometry circles. In this case, a corresponding error message appears.

If the geometry is not displayed when the circle is drawn, it is constructed now.

The geometry can be displayed using the command Function Keys>Geometry (F9), or turned on/off with 
the F9 key or the corresponding button in the Panel.

Related commands:



Geometry Circle>Standard
Geometry Circle>On Circle
Geometry Circle>Circumcircle
Geometry Circle>Diameter
Geometry Circle>Incircle
Geometry Circle>Concentric
Geometry Circle>Tangential
Geometry Circle>Line - Line - Line
Geometry Circle>Radius - Object - Point
Geometry Circle>Radius - Object - Object



Geometry Circle>Radius - Object - Point (Geometry Menu)
This command draws a geometry circle, which has a given radius, is tangent to a given line (or geometry 
line) or circle (or geometry circle) and runs through a given point.

1. Enter radius
After choosing the command, a dialog appears in which the geometry circle's radius can be specified. 
This radius remains valid until a new command is chosen or the current command is restarted using 
the command Restart Command (+ESC) or the key combination SHIFT+ESC.

2. Identify reference object
Any part object in an existing object can be identified as the reference object. This can be a side of a 
rectangle or a circular arc within a surface. Ellipses and ellipse parts cannot be identified.
The (part) object is identified by clicking on it with the mouse. If several (part) objects lie close to the
point clicked on, then a small dialog appears at the bottom of the screen with the help of which the 
correct (part) object can be chosen.

The identified (part) object is referred to as the "Reference Object".

The position at which the object is identified (the "ID point") has no effect on the rest of this 
command. As there are up to four possible results, it would be to complicated to make a choice based 
on the ID point's position.

3. Enter point
The point through which the geometry circle should run can be entered with the mouse by clicking 
anywhere in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

4. Choose object
After identifying the reference object and entering the point, all possible geometry circles are worked 
out (the graphic shows one possible set of results).

They are presented so that a choice can be made. To do this, a small dialog appears at the bottom of 
the screen from which the correct geometry circle can be chosen. Only one circle can be chosen at 
any one time.

If the distance between the point and the object is more than twice the radius, it is not possible to calculate
the geometry circles. In this case, a corresponding error message appears.

If the geometry is not displayed when the circle is drawn, it is constructed now.



The geometry can be displayed using the command Function Keys>Geometry (F9), or turned on/off with 
the F9 key or the corresponding button in the Panel.

Related commands:
Geometry Circle>Standard
Geometry Circle>On Circle
Geometry Circle>Circumcircle
Geometry Circle>Diameter
Geometry Circle>Incircle
Geometry Circle>Concentric
Geometry Circle>Tangential
Geometry Circle>Line - Line - Line
Geometry Circle>Radius - Point - Point
Geometry Circle>Radius - Object - Object



Geometry Circle>Radius - Object - Object (Geometry Menu)
This command draws a geometry circle, which has a given radius and is tangent to two given lines (or 
geometry lines) or circles (or geometry circles).

1. Enter radius
After choosing the command, a dialog appears in which the geometry circle's radius can be specified. 
This radius remains valid until a new command is chosen or the current command is restarted using 
the command Restart Command (+ESC) or the key combination SHIFT+ESC.

2. Identify reference object 1
Any partial object in an existing object can be identified as the first reference object. This can be a 
side of a rectangle or a circular arc within a surface. Ellipses and ellipse parts cannot be identified.
The (part) object is identified by clicking on it with the mouse. If several (part) objects lie close to the
point clicked on, then a small dialog appears at the bottom of the screen with the help of which the 
correct (part) object can be chosen.

The identified (part) object is referred to as the "Reference Object".

The position at which the object is identified (the "ID point") has no effect on the rest of this 
command. As there are up to eight possible results, it would be to complicated to make a choice on 
the basis of the ID point's position.

3. Identify reference object 2
Any partial object in an existing object can be identified as the second reference object. This can be a 
side of a rectangle or a circular arc within a surface. Ellipses and ellipse parts cannot be identified.
The (part) object is identified by clicking on it with the mouse. If several (part) objects lie close to the
point clicked on, then a small dialog appears at the bottom of the screen with the help of which the 
correct (part) object can be chosen.

The identified (part) object is referred to as the "Reference Object".

4. Choose object
After identifying both reference objects, all possible geometry circles are worked out (the graphic 
shows one possible set of results).

They are presented so that a choice can be made. To do this, a small dialog appears at the bottom of 
the screen from which the correct geometry circle can be chosen. Only one circle can be chosen at 
any one time.

If the distance between both objects is more than double the radius, or if two parallel lines are identified, 
it is not possible to calculate the geometry circles. In this case, a corresponding error message appears.

If the geometry is not displayed when the circle is drawn, it is constructed now.



The geometry can be displayed using the command Function Keys>Geometry (F9), or turned on/off with 
the F9 key or the corresponding button in the Panel.

Related commands:
Geometry Circle>Standard
Geometry Circle>On Circle
Geometry Circle>Circumcircle
Geometry Circle>Diameter
Geometry Circle>Incircle
Geometry Circle>Concentric
Geometry Circle>Tangential
Geometry Circle>Line - Line - Line
Geometry Circle>Radius - Point - Point
Geometry Circle>Radius - Object - Point



Edit Geometry>Erase, Identification (Geometry Menu)
This command deletes a geometry object.

1. Identify geometry object
Any geometry object can be identified. If the geometry is not visible, it should first of all be turned on
using the command Function Keys>Geometry (F9), the F9 key or the corresponding button in the 
Panel.
Objects are identified by clicking on them. If more than one object lies at the point clicked on, then 
the correct object can be selected with the help of a small dialog which appears at the bottom of the 
screen.

The geometry object will be immediately deleted. It can be restored by using the command Undo.

Related commands:
Delete Geometry>Erase, Complete
Erase Drawing
Delete Objects



Edit Geometry>Erase, Complete (Geometry Menu)
This command erases the whole geometry.

The geometry objects are erased immediately. If need be, they can be restored using the command Undo.

Related commands:
Delete Geometry>Delete Identification
Erase Drawing
Delete Objects



Edit Geometry>Move (Geometry Menu)
This command moves the whole geometry.

1. Enter reference point
The movement reference point can be entered using the mouse, by clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

2. Enter target point
The target point for the movement can be entered using the mouse, by clicking anywhere in the 
drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, polar or relative coordinates can be entered. Relative values relate to the previously entered 
reference point. For further information on coordinate entry, see Function Keys>Direct Input (F8).

If the duplicate function is active during the entry of the last point (e.g. because the CTRL key is held 
down), the geometry objects are copied and not moved.

It is also possible to move the geometry when it is not displayed. The geometry can be displayed using the
command Function Keys>Geometry (F9), or turned on/off with the F9 key or the corresponding button in 
the Panel.

Related commands:
Edit Geometry>Scale
Edit Geometry>Rotate
Move Objects>Standard
Move Objects>Perpendicular
Move Objects>Parallel
Move Objects>Relative



Edit Geometry>Scale (Geometry Menu)
This command scales the whole geometry proportionally, i.e. changes its size.

1. Enter reference point
The scaling reference point (scaling origin) can be entered using the mouse, by clicking anywhere in 
the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

2. Enter scaling factor
After entering the reference point a dialog appears, in which the scaling factor can be entered. It is 
given relative to 1 and applies to both horizontal and vertical directions.

The small buttons provide a quick way of accessing frequently-needed scaling factors. The values 
"0.707" and "1.414" are needed to fit a DIN page size to the next smallest or largest size. If a button is
pressed, the corresponding value is transferred to the field, but the dialog is not closed.

If the "Duplicate" check box is enabled when the dialog is closed by clicking on "OK" ,the original 
geometry object is not scaled, but a copy is made and the copy is scaled.

It is also possible to scale the geometry if it is not displayed. The geometry can be displayed using the 
command Function Keys>Geometry (F9), or turned on/off with the F9 key or the corresponding button in 
the Panel.

Related commands:
Edit Geometry>Move
Edit Geometry>Rotate
Scale Objects>Factros
Scale Objects>Proportional
Scale Objects>Non-Proportional
Scale Objects>Reference Distance



Edit Geometry>Rotate (Geometry Menu)
This command rotates the whole geometry.

1. Enter reference point
The rotation reference point ( the center of rotation) can be entered using the mouse, by clicking 
anywhere in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

2. Enter rotation angle
After entering the reference point a dialog appears, in which the rotation angle can be entered.

The small buttons provide an easy way of accessing frequently used angles of rotation. If one of these
buttons is pressed then the value is transferred to the field but the dialog is not closed.

If the "Duplicate" check box is enabled when the dialog is closed by clicking on "OK", then the original 
geometry objects are not rotated, but a copy is made of them, and the copy is rotated.

It is also possible to rotate the geometry if it is not displayed. The geometry can be displayed using the 
command Function Keys>Geometry (F9), or turned on/off with the F9 key or the corresponding button in 
the Panel.

Related commands:
Edit Geometry>Move
Edit Geometry>Scale
Rotate Objects>Center
Rotate Objects>Arbitrary



Marking (Geometry Menu)
This command generates a marking. A marking is a point in the drawing marked with a marking symbol (
 ). Markings can be used to save and recall particular positions.

1. Enter position
The position for the marking can be entered using the mouse, by clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

The marking is assigned to a layer, like every other object, which can be frozen and/or blended out. 
Markings are not allocated to the current layer. Instead, the command Layers>Defaults is used to decide 
whether they should be assigned to the current layer, or another specified layer.

Note: Markings are normally only displayed on the screen. They are ignored by output to a printer or 
plotter, to the Clipboard, a metafile or bitmap graphic.
If markings are to be included in output, the relevant check box must be enabled in the Settings>Output 
check box. The appearance of markings when output can be specified here.

Related commands:
Division>Distance
Division>Object
Division>Array



Division>Distance (Geometry Menu)
This command can be used to divide up a distance according to various mathematical processes. A 
marking is placed between each division.

1. Enter start point
The start point of the distance to be divided can be entered using the mouse, by clicking anywhere in 
the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

2. Enter end point
The end point of the distance to be divided can be entered using the mouse, by clicking anywhere in 
the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, polar or relative coordinates can be entered. Relative values refer to the previously entered 
start point. For further information on coordinate entry, see Function Keys>Direct Input (F8).

After entering the points at either end of the length, the Division in which the division parameters can be 
specified. After entering the division parameters, markings are placed at all the calculated division points.

The generated markings are, like any other object, assigned to a layer which can be frozen and/or hidden. 
All the markings make up one object, i.e. they can only be edited or deleted together.
Markings are not allocated to the current layer. Instead, the command Layers>Defaults is used to decide 
whether they should be assigned to the current layer, or another specified layer.

Note: Markings are normally only displayed on the screen. They are ignored by output to a printer or 
plotter, to the Clipboard, a metafile or bitmap graphic.
If markings are to be included in output, the relevant check box must be enabled in the Settings>Output 
check box. The appearance of markings when output can be specified here.

Related commands:
Marking
Division>Object
Division>Array



Division>Object (Geometry Menu)
This command divides the outline of an object according to a specified mathematical principle. A marking
is inserted at the end of each division.

1. Identify reference object
Any part object in an existing object can be identified as the reference object. This can be a side of a 
rectangle, the arc of an ellipse segment or a circular segment within a surface.
The (part) object is identified by clicking on it with the mouse. If several (part) objects lie close to the
point clicked on, then a small dialog appears at the bottom of the screen with the help of which the 
correct (part) object can be chosen.

The identified (part) object is referred to as the "Reference Object".

The outline of the object is divided up during division. In general, this is referred to as the "Distance"

Which point is interpreted as the start point depends on the reference object type. The rotation direction of
the division is determined by the current arc direction. This is specified using the command Function 
Keys>Arc Direction (F2), with the F2 key or the button in the Panel. If the arc direction is positive, the 
circular arc is divided beginning from the start angle in a mathematically positive sense (i.e. 
anticlockwise). If the arc direction is negative, the circular arc is divided beginning from the start angle in
a mathematically negative sense (i.e. clockwise).

Note: Ellipses and elliptical arcs are treated in a special way. As ellipses and elliptical arcs are mostly 
used in technical drawing to show circles in isometric or dimetric view, they are treated correspondingly. 
They are treated like circles during the division process.

After identifying the reference object, the Division dialog appears, in which the division parameters can 
be specified. After entering the division parameters markings are placed on all the division points 
calculated.

The generated markings are, like any other object, assigned to a layer which can be frozen and/or hidden. 
All the markings make up one object, i.e. they can only be edited or deleted together.
Markings are not automatically assigned to the current layer. Instead, the command Layers>Defaults is 
used to decide whether they should be assigned to the current layer, or another specified layer.

Note: Markings are normally only displayed on the screen. They are ignored by output to a printer or 
plotter, to the Clipboard, a metafile or bitmap graphic.
If markings are to be included in output, the relevant check box must be enabled in the Settings>Output 
check box. The appearance of markings when output can be specified here.

Related commands:
Marking
Division>Distance
Division>Array



Division>Array (Geometry Menu)
This command can be used to divide up a two-dimensional array using various mathematical procedures. 
A marking is inserted at each division point.

The array is entered in the form of a parallelogram. A parallelogram is a quadrangle whose opposite sides 
are parallel to one another. It can also be seen as a distorted rectangle.

1. Enter corner point 1
The first corner point of the parallelogram can be entered using the mouse, by clicking anywhere in 
the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

2. Enter corner point 2
The second corner point of the parallelogram can be entered using the mouse, by clicking anywhere 
in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, polar or relative coordinates can be entered. Relative values relate to the last-entered corner 
point. For further information on coordinate entry, see Function Keys>Direct Input (F8).

3. Enter corner point 3
The third corner point of the parallelogram can be entered using the mouse, by clicking anywhere in 
the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, polar or relative coordinates can be entered. Relative values relate to the last-entered corner 
point. For further information on coordinate entry, see Function Keys>Direct Input (F8).

The lengths Point 1-Point 2 and Point 1-Point 3 are used for the division process. In general, these are 
referred to as "Lengths".

After entering the three points the Division dialog appears twice, so that the division parameters for both 
lengths can be entered. After entering the division parameters, a marking is placed at each division point.

The generated markings are, like any other object, assigned to a layer which can be frozen and/or hidden. 
All the markings make up one object, i.e. they can only be edited or deleted together.
Markings are not automatically assigned to the current layer. Instead, the command Layers>Defaults is 
used to decide whether they should be assigned to the current layer, or another specified layer.

Note: Markings are normally only displayed on the screen. They are ignored by output to a printer or 
plotter, to the Clipboard, a metafile or bitmap graphic.
If markings are to be included in output, the relevant check box must be enabled in the Settings>Output 
check box. The appearance of markings when output can be specified here.

Related commands:
Marking
Division>Distance



Division>Object



Multiple Copy>Markings (Geometry Menu)
This command can be used to make multiple copies of selected groups of objects. The copies are inserted 
at the positions where there is a selected marking.

1. Choose objects
The objects to be copied must be chosen. Any number of objects can be chosen. This can be done 
using various methods which can be combined with one another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

2. Enter reference point
The reference point within the objects can be entered using the mouse, by clicking anywhere in the 
drawing. The reference point indicates exactly where markings should be placed.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

After choosing the objects and entering the reference point, the chosen objects are copied to all currently 
selected markings. If there are no selected markings, an error message appears.

Related commands:
Multiple Copy>Rotation
Multiple Copy>Gradual
Multiple Copy>Distance
Multiple Copy>Object
Multiple Copy>Array



Multiple Copy>Rotation (Geometry Menu)
This command can be used to make multiple copies of chosen groups of objects. The copies are arranged 
in a circle around a given center point. The objects are rotated during copying.

1. Choose objects
The objects to be copied must be chosen. Any number of objects can be chosen. This can be done 
using various methods which can be combined with one another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

2. Enter reference point
The reference point, i.e. the point at which the copies will be placed, can be entered using the mouse, 
by clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

3. Enter number of steps
After choosing the objects and entering the reference point, a dialog appears in which the number of 
steps to be used can be entered. Values between 2 and 250 are allowed. This number of steps is 
divided equally around the whole rotation.

The original objects are retained. If 10 steps are specified, nine extra copies of the object are created and 
distributed, with the original object, around a circle centered around the reference point.

Related commands:
Multiple Copy>Markings
Multiple Copy>Gradual
Multiple Copy>Distance
Multiple Copy>Object



Multiple Copy>Array



Multiple Copy>Gradual (Geometry Menu)
This command can be used to make multiple copies of chosen groups of objects. The copies are each 
moved by a specified distance.

1. Choose objects
The objects to be copied must be chosen. Any number of objects can be chosen. This can be done 
using various methods which can be combined with one another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

2. Enter reference point
The copy's reference point, i.e. the start point of the step vector, can be entered using the mouse, by 
clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

3. Enter target point
The target point for the copy, i.e. the end point of the step vector, can be entered using the mouse, by 
clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, polar or relative coordinates can be entered. Relative values relate to the previously entered 
reference point.The movement can be easily entered in this way by entering polar or relative 
coordinates. For further information on coordinate entry, see Function Keys>Direct Input (F8).

3. Enter number of steps
After choosing the objects and entering the reference and target points a dialog, in which the number 
of steps to be used can be entered, appears. Values between 1 and 250 are allowed.



The original objects are retained. If 10 steps were entered, 10 copies of the objects are made and moved in
the direction of the given step vector.

Related commands:
Multiple Copy>Markings
Multiple Copy>Rotation
Multiple Copy>Distance
Multiple Copy>Object
Multiple Copy>Array



Multiple Copy>Distance (Geometry Menu)
This command can be used to make multiple copies of chosen groups of objects. The copies are placed 
onto the division points of a given distance, worked out according to different mathematical processes.

1. Choose objects
The objects to be copied must be chosen. Any number of objects can be chosen. This can be done 
using various methods which can be combined with one another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

2. Enter reference point
The reference point within the objects can be entered using the mouse, by clicking anywhere in the 
drawing. The reference point indicates the place where the division point should be placed.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

3. Enter start point
The start point of the distance to be divided can be entered using the mouse, by clicking anywhere in 
the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

4. Enter end point
The end point of the distance to be divided can be entered using the mouse, by clicking anywhere in 
the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 



absolute, polar or relative coordinates can be entered. Relative values refer to the previously entered 
start point. For further information on coordinate entry, see Function Keys>Direct Input (F8).

After choosing the objects and entering the distance's start and end points, the Division dialog appears, in 
which the division parameters can be specified.

After entering the division parameters the objects are copied to all the distance's division points.

Related commands:
Multiple Copy>Markings
Multiple Copy>Rotation
Multiple Copy>Gradual
Multiple Copy>Object
Multiple Copy>Array
Division>Distance



Multiple Copy>Object (Geometry Menu)
This command can be used to make multiple copies of chosen groups of objects. The copies are placed on
the division points of an identified object, worked out by various mathematical processes.

1. Choose objects
The objects to be copied must be chosen. Any number of objects can be chosen. This can be done 
using various methods which can be combined with one another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

2. Enter reference point
The reference point within the objects can be entered using the mouse, by clicking anywhere in the 
drawing. The reference point indicates the place where the division point should be placed.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

3. Identify reference object
Any part object in an existing object can be identified as the reference object. This can be a side of a 
rectangle, the arc of an ellipse segment or a circular segment within a surface.
The (part) object is identified by clicking on it with the mouse. If several (part) objects lie close to the
point clicked on, then a small dialog appears at the bottom of the screen with the help of which the 
correct (part) object can be chosen.

The identified (part) object is referred to as the "Reference Object".

The outline of the identified object is divided up during the division. In general, this is referred to as the 
"Distance"

Which point is interpreted as the start point depends on the reference object type. The rotation direction of



the division is determined by the current arc direction. This is specified using the command Function 
Keys>Arc Direction (F2), with the F2 key or the button in the Panel. If the arc direction is positive, the 
circular arc is divided beginning from the start angle in a mathematically positive sense (i.e. 
anticlockwise). If the arc direction is negative, the circular arc is divided beginning from the start angle in
a mathematically negative sense (i.e. clockwise).

Note: Ellipses and elliptical arcs are treated in a special way. As ellipses and elliptical arcs are mostly 
used in technical drawings to show circles in isometric or dimetric view, they are treated correspondingly. 
They are treated like circles during the division process.

After choosing the objects and identifying the reference object, the Division dialog appears, in which the 
division parameters can be specified.

After entering the division parameters the objects are copied to all the reference object's division points (if
need be they are rotated).

Related commands:
Multiple Copy>Markings
Multiple Copy>Rotation
Multiple Copy>Gradual
Multiple Copy>Distance
Multiple Copy>Array
Division>Object



Multiple Copy>Array (Geometry Menu)
This command can be used to make multiple copies of chosen groups of objects. The copies are placed on
the division points of a two-dimensional array, which can be calculated according to various mathematical
processes.

The arrray is entered in the form of a parallelogram. A parallelogram is a quadrangle whose opposite sides
are parallel to one another. It can also be seen as a distorted rectangle.

1. Choose objects
The objects to be copied must be chosen. Any number of objects can be chosen. This can be done 
using various methods which can be combined with one another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

2. Enter reference point
The reference point within the objects can be entered using the mouse, by clicking anywhere in the 
drawing. The reference point indicates the place where the division point should be placed.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

3. Enter corner point 1
The first corner point of the parallelogram can be entered using the mouse, by clicking anywhere in 
the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

4. Enter corner point 2



The second corner point of the parallelogram can be entered using the mouse, by clicking anywhere 
in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, polar or relative coordinates can be entered. Relative values relate to the last-entered corner 
point. For further information on coordinate entry, see Function Keys>Direct Input (F8).

5. Enter corner point 3
The third corner point of the parallelogram can be entered using the mouse, by clicking anywhere in 
the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, polar or relative coordinates can be entered. Relative values relate to the last-entered corner 
point. For further information on coordinate entry, see Function Keys>Direct Input (F8).

The lengths Point 1 - Point 2 and Point 1 - Point 3 are used in the procedure. These are generally referred 
to as "Distances".

After choosing the objects and entering the reference point and the three points, the Division dialog 
appears in which the division parameters for each of the two lengths can be specified.

After entering the division parameters, the objects are copied to all the calculated division points in the 
array.

Related commands:
Multiple Copy>Markings
Multiple Copy>Rotation
Multiple Copy>Gradual
Multiple Copy>Distance
Multiple Copy>Object
Division>Array



Trimming Menu
Trim Object

Cut Out
Split
Resolve Completely
Length / Radius to Point
Length / Radius to Object
Angle to Point
Angle to Object

Trim Curve
Edit
Extend
Split

Trim Surface
Union (A=A+B)
Intersection (A=A×B)
Difference (A=A-B)
Combine Outlines
Split into Outlines
Generate Surface
Parameters

Trim Edge
Chamfer Edge

Line - Line
One Edge
Complete

Round Edge, Outer Arc
Line - Line
One Edge
Complete

Round Edge, Inner Arc
Line - Line
One Edge
Complete

Transform Object to
Invert
Zigzag Line
Circle
Circular Arc
Circular Sector
Circular Segment
Ellipse
Elliptic Arc
Elliptic Sector
Elliptic Segment
Curve
Surface
Eraser



Move Single Point
Point Selection

Select Area
Deselect Area
Discard Selection

Move Points
Standard
Perpendicular
Parallel
Relative

Eraser



Trim Object>Cut Out (Trimming Menu)
This command can be used to cut a piece from an existing object. Where possible, the end of an object 
can be capped.

1. Identify the object to be trimmed
Any standard object can be identified as the object to be trimmed. Lines, circles, circle parts, ellipses 
and ellipse parts. The objects are always treated as wholes; sectors and segments are handled like 
arcs.
To identify an object, click on it with the mouse. If the identification is ambiguous, i.e. if more than 
one object is very close to the position clicked on, then a dialog with whose help the correct object 
can be chosen appears at the bottom of the screen.

The identified object is referred to in the rest of this section as the "trim object".

The position at which the trim object is identified (the "ID Point") affects the rest of the command. It 
determines which part of the object should be trimmed or capped. Refer to the graphics at the end of 
this section.

2. Enter point 1
The first separation point can be specified by clicking on any point within the drawing. A 
perpendicular is dropped from here to the trim object to work out the exact separation point. In most 
cases it is a good idea to snap to the intersection of the trim object with another object. To do this, 
hold down the SHIFT key during point entry.

Optionally, exact coordinates can be entered. To do this, press either F8 or ENTER. You can now 
enter absolute or polar coordinates.
If the reference object is a circle, circle part, ellipse or ellipse part then it is possible to specify an 
angle, measured from the midpoint of the trim object. For further information on direct coordinate 
entry, see Function Keys>Direct Input (F8).

3. Enter point 2
The second separation point can be specified by clicking on any point within the drawing. A 
perpendicular is dropped from here to the trim object to work out the exact separation point. In most 
cases it is a good idea to snap to the intersection of the trim object with another object. To do this, 
hold down the SHIFT key during point entry.

Optionally, exact coordinates can be entered. To do this, press either F8 or ENTER. You can now 
enter absolute or polar coordinates.
Depending on the type of the trim object, there are other input possibilities. If the trim object is a line,
then you can specify a length. This is the length of the line from a previously-specified starting point. 
To do this a small arrow appears in the Status window. This shows the direction for the length 
measurement. If you enter a positive value, the line is drawn from the starting point in the direction of
the arrow. If a negative vale is entered, the line is drawn in the opposite direction.
In all other cases, it is possible to specify an angle, measured from the midpoint of the trim object. 
For further information on direct coordinate entry, see Function Keys>Direct Input (F8).

If the duplicate function is on while the last point is specified (e.g. if the CTRL key is held down), the 
trim object remains unchanged; a duplicate is generated and trimmed.

After specifying both separation points, the trim object is trimmed. If both separation points lie on the 



object outline, then a portion is removed or both outstanding ends are separated. If a one separation point 
is outside the outline, then one end of the object is capped. The segment nearest to the ID point is always 
removed (see diagram).

Trimming lines:

Trimming circle and ellipse parts.

Note a basic rule for trimming: the object is always changed where it is clicked on!

If both points lie outside the object outline, an error message appears.



Note: If a non-standard object (e.g. a surface or a curve) is to be trimmed, it must be resolved to its 
constituent parts first using the command Trim Object>Resolve Completely. These can then be trimmed.

Related commands:
Trim Object>Split
Trim Object>Length / Radius to Point
Trim Object>Length / Radius to Object
Trim Edge



Trim Object>Split (Trimming Menu)
This command splits an existing object into two parts.

1. Identify the object to be trimmed
Any standard object can be identified as the object to be trimmed. Lines, circles, circle parts, ellipses 
and ellipse parts. The objects are always treated as wholes; sectors and segments are handled like 
arcs.
To identify an object, click on it with the mouse. If the identification is ambiguous, i.e. if more than 
one object is very close to the position clicked on, then a dialog with whose help the correct object 
can be chosen appears at the bottom of the screen.

The identified object is referred to in the rest of this section as the "trim object".

2. Enter point 1
The first separation point can be specified by clicking on any point within the drawing. A 
perpendicular is dropped from here to the trim object to work out the exact separation point. In most 
cases it is a good idea to snap to the intersection of the trim object with another object. To do this, 
hold down the SHIFT key during point entry.

Optionally, exact coordinates can be entered. To do this, press either F8 or ENTER. You can now 
enter absolute or polar coordinates.
If the reference object is a circle, circle part, ellipse or ellipse part then it is possible to specify an 
angle, measured from the midpoint of the trim object. For further information on direct coordinate 
entry, see Function Keys>Direct Input (F8).

If the trim object is a circle or ellipse, a second separation point has to be specified. In other cases, this is 
not necessary.

3. Enter point 2
The second separation point can be specified by clicking on any point within the drawing. A 
perpendicular is dropped from here to the trim object to work out the exact separation point. In most 
cases it is a good idea to snap to the intersection of the trim object with another object. To do this, 
hold down the SHIFT key during point entry.

Optionally, exact coordinates can be entered. To do this, press either F8 or ENTER. You can now 
enter absolute or polar coordinates.
If the reference object is a circle, circle part, ellipse or ellipse part then it is possible to specify an 
angle, measured from the midpoint of the trim object. For further information on direct coordinate 
entry, see Function Keys>Direct Input (F8).

If the duplicate function is on while the last point is specified (e.g. if the CTRL key is held down), the 
trim object remains unchanged; a duplicate is generated and trimmed.

After specifying the separation points, the trim object is split. If the separation point lies outside the object
outline, then an error message appears.

Note: If a non-standard object (e.g. a surface or a curve) is to be trimmed, it must be resolved to its 
constituent parts first using the command Trim Object>Resolve Completely. These can then be trimmed.

Related commands:



Trim Object>Cut Out
Trim Object>Resolve Completely
Trim Curve>Split
Trim Edge



Trim Object>Resolve Completely (Trimming Menu)
This command breaks existing objects into their constituent basic elements. These basic elements are 
lines, circles and circular arcs.

This command is useful if complicated objects are to be trimmed. As the trimming functions only work 
with standard objects, objects such as curves, surfaces and hatchings have to be resolved into basic 
elements first.

1. Choose objects
The objects which are to be broken up are chosen. Any number of objects can be chosen. This can be 
done in various ways, which can be used in combination with one another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

If the duplicate function is active during object choosing, a copy of the chosen objects is separated.

If a text is to be split up, they must be transformed to surfaces first using the command Text>Resolve. 
These can then be split up using the commands described here. The same goes for groups and instances, 
which must also be resolved first.

Related commands:
Trim Object>Cut Out
Trim Object>Split
Trim Curve>Split
Group>Ungroup
Text>Resolve
Resolve Instances



Trim Object>Length / Radius to Point (Trimming Menu)
This command can be used to modify an existing object. If the object is a line, then its length can be 
changed. If, however, it is a circle or circle part, then its radius can be altered. The size of the alteration is 
determined by entering a point.

1. Identify the object to be trimmed
Any standard object can be identified and trimmed. In this case, standard objects are lines, circles and
circle parts. The objects are always treated as a whole, sectors and segments are treated like arcs.
Objects are identified by clicking on them. If more than one object lies at the point clicked on, then 
the correct object can be selected with the help of a small dialog which appears at the bottom of the 
screen.

The identified object is referred to as the "trim object"

The point at which the line was identified (the ID point) affects the rest of the command. It 
determines which end of the line should be moved. Refer to the graphics at the end of this section.

If the trim object is a line, a straight line appears, extending the line. It is called the "reference line", 
and can be used to snap to its intersections with other objects.

2. Enter point
The point to which the length or radius should be altered, can be entered using the mouse, by clicking 
anywhere in the drawing. In most cases, it makes sense to use the intersection of the trim object or 
reference straight line with other objects as a snapping point. To do this, the SHIFT key is kept held 
down during point entry.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered.
If the trim object is a line, then a length can be entered. The length can be entered relative to the 
current line length. It determines the resulting line length. The end point of the line nearest to the ID 
point is then moved until this length is reached.
If on the other hand the trim object is a circle or circle part you can enter a radius. The radius can be 
entered relative to the current circle or circle part"s radius. It determines the resulting radius of the 
trim object. For further information on coordinate entry, see Function Keys>Direct Input (F8).

If the duplicate function is active during the entry of the last point (e.g. because the CTRL key is held 
down), the trim object itself is not trimmed, but a copy is made and the copy is trimmed.

After entering the point, the trim object is trimmed. If the trim object is a line, the end point of the line 
nearest to the ID point is moved (see graphic).

Note this basic rule for trimming: the object is always changed where it is clicked on.



Note: If a non-standard object (e.g. a curve or surface) is to be trimmed, then the command Trim 
Object>Resolve Completely must be used to break it into its constituent parts. These can then be trimmed.

Related commands:
Trim Object>Cut Out
Trim Object>Split
Trim Object>Length / Radius to Object
Trim Object>Angle to Point
Trim Object>Angle to Object
Trim Edge



Trim Object>Length / Radius to Object (Trimming Menu)
This command can be used to modify an existing object. If it is a line, the length of the line can be 
changed. If, however, it is a circle or circle part, then its radius can be altered. The size of the change is 
determined by the intersection or tangent with a given object

1. Identify the object to be trimmed
Any standard object can be identified and trimmed. In this case, standard objects are lines, circles and
circle parts. The objects are always treated as a whole, sectors and segments are treated like arcs.
Objects are identified by clicking on them. If more than one object lies at the point clicked on, then 
the correct object can be selected with the help of a small dialog which appears at the bottom of the 
screen.

The identified object is referred to as the "trim object"

If the trim object is a line, then the position at which the line was identified (the "ID point"), affects 
the rest of the command. It determines which end of the line should be moved. Refer to the graphics 
at the end of this section.

2. Identify reference object
Any part object in an existing object can be identified as a reference object. This may be an edge of a 
rectangle, the arc of an elliptic segment or a circular arc within a surface.
To identify it, click on the (part) object with the mouse. If more than one possible (part) object lies 
close to the point clicked on, then a small dialog appears at the bottom of the screen from which the 
"right" object can be chosen.

The identified object is referred to as the "reference object"

The position at which the (part) object was identified (the "ID point"), affects the rest of the 
command. If the trim object has several possible intersections or tangent points with the reference 
object, the point closer to the ID point is chosen.

If the duplicate function is active while the reference object is selected (e.g. because the CTRL key was 
held down), the trim object itself is not trimmed, but a copy is generated and the copy is trimmed.

After entering the point, the trim object is trimmed. If the trim object is a line, the end point of the line 
nearest to the ID point is moved (see graphic).



Note a basic rule for trimming: The object changes, wherever it is clicked on.

Note: If a non-standard object (e.g. a curve or surface) is to be trimmed, then the command Trim 
Object>Resolve Completely must be used to break it into its constituent parts. These can then be trimmed.

Related commands:
Trim Object>Cut Out
Trim Object>Split
Trim Object>Length / Radius to Point
Trim Object>Angle to Point
Trim Object>Angle to Object
Trim Edge



Trim Object>Angle to Point (Trimming Menu)
This command can be used to modify an existing object. If the object is a line, the line direction is 
changed. If on the other hand it is a circle part, the start or end angle is changed. The size of the alteration 
is determined by entering a point.

1. Identify the object to be trimmed
Any standard object can be identified and trimmed. Standard objects are in this case lines, circle parts 
and ellipse parts. The objects are always treated as a whole, sectors and segments are treated like arcs.
Objects are identified by clicking on them. If more than one object lies at the point clicked on, then 
the correct object can be selected with the help of a small dialog which appears at the bottom of the 
screen.

The identified object is referred to as the "trim object"

The position at which the object is identified (the "ID point"), affects the rest of the command. It 
determines which end point of the line or which arc angle should be altered.

After identification, a circle or ellipse (the "reference object") appears. This indicates the possible 
new end point positions.

2. Enter point
The point to which the angle should be changed, can be entered using the mouse, by clicking 
anywhere in the drawing. A perpendicular is dropped from this point to the reference object. In most 
cases it makes sense to use the intersection of the reference object with another object as a snapping 
reference. To do this, the SHIFT key is kept held down during point entry.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered.
In addition, an angle can be entered. The angle can be entered relative to the current angle. It 
determines the resulting trim object angle. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

If the duplicate function is active during the entry of the last point (e.g. because the CTRL key is held 
down), the trim object itself is not trimmed, but a copy is generated and the copy is trimmed.

After entering the point, the trim object is trimmed. If the trim object is a line, the end point of the line 
nearest to the ID point is moved (see graphic).

If the trim object is a circle or ellipse part, then the angle at the end of the arc closer to the ID point is 
altered (see graphic).



Note a basic rule for trimming: The object changes, wherever it is clicked on.

Note: If a non-standard object (e.g. a curve or surface) is to be trimmed, then the command Trim 
Object>Resolve Completely must be used to break it into its constituent parts. These can then be trimmed.

Related commands:
Trim Object>Cut Out
Trim Object>Split
Trim Object>Length / Radius to Point
Trim Object>Length / Radius to Object
Trim Object>Angle to Object



Trim Object>Angle to Object (Trimming Menu)
This command can be used to modify an existing object. If it is a line, the line direction is altered. If 
however it is a circle or ellipse part, then the start or end angle is changed. The size of the change is given
by the intersection or tangent point with a given object.

1. Identify the object to be trimmed
Any standard object can be identified and trimmed. Standard objects are in this case lines, circle parts 
and ellipse parts. The objects are always treated as a whole, sectors and segments are treated like arcs.
Objects are identified by clicking on them. If more than one object lies at the point clicked on, then 
the correct object can be selected with the help of a small dialog which appears at the bottom of the 
screen.

The identified object is referred to as the "trim object"

The position at which the object is identified (the "ID point"), affects the rest of the command. It 
determines which end point of the line or which arc angle should be altered.

2. Identify reference object
Any part object in an existing object can be identified as a reference object. This may be an edge of a 
rectangle, the arc of an elliptic segment or a circular arc within a surface.
To identify it, click on the (part) object with the mouse. If more than one possible (part) object lies 
close to the point clicked on, then a small dialog appears at the bottom of the screen from which the 
"right" object can be chosen.

The identified object is referred to as the "reference object"

The position at which the (part) object was identified (the "ID point"), affects the rest of the 
command. If the trim object has several possible intersections or tangent points with the reference 
object, the point closer to the ID point is chosen.

If the duplicate function is active while the reference object is selected (e.g. because the CTRL key was 
held down), the trim object itself is not trimmed, but a copy is made and the copy is trimmed.

After entering the point, the trim object is trimmed. If the trim object is a line, the end point of the line 
nearest to the ID point is moved (see graphic).



If the trim object is a circle or ellipse part, then the arc end angle closer to the ID point is changed (see 
graphic).

 



Note a basic rule for trimming: The object changes, wherever it is clicked on.

Note: If a non-standard object (e.g. a curve or surface) is to be trimmed, then the command Trim 
Object>Resolve Completely must be used to break it into its constituent parts. These can then be trimmed.

Related commands:
Trim Object>Cut Out
Trim Object>Split
Trim Object>Length / Radius to Point
Trim Object>Length / Radius to Object
Trim Object>Angle to Point



Trim Curve>Edit (Trimming Menu)
An existing curve can be edited using this command. Elements can be inserted, transformed or deleted.

If a curve is to be extended from one of its ends to join an existing element, this can be done with the 
command Trim Curve>Extend. To divide a curve into two points, the command Trim Curve>Split can be 
used

Single points on a curve (End points, corner points and angel points) can be moved using the command 
Move Single Point.

1. Identify curve
To identify it, click on the curve with the mouse. If several curves lie close to the position clicked on, 
a small dialog appears at the bottom of the window, with the help of which the "right" curve can be 
chosen.

The position at which the curve is identified (the "ID point"), affects the rest of the command. It 
determines which end of the curve should be edited or at which point an element should be inserted.

After identifying the curve, the Edit Curve dialog appears, in which the action can be chosen which will 
be carried out with the element or joint of the curve which is nearest to the ID point. The further progress 
of the entry depends on which button is chosen in this dialog.

If the duplicate function is active during selection, a copy of the curve is generated and the copy, not the 
original, is altered.

Note: Polylines and freehand lines are stored internally as curves and can therefore be manipulated with 
this command. All other objects must, if necessary, be converted to a curve using the command Transform
Objects to>Curve.

Related commands:
Trim Curve>Extend
Trim Curve>Split



Trim Curve>Extend (Trimming Menu)
An existing curve can be extended to another, existing, object using this command.

If a curve is to be split into two parts, then the command Trim Curve>Split can be used. With the 
command Trim Curve>Edit individual elements of a curve can be altered or deleted.

1. Identify curve
To identify it, click on the curve with the mouse. If several curves lie close to the position clicked on, 
a small dialog appears at the bottom of the window, with the help of which the "right" curve can be 
chosen.

The position at which the curve is identified (the "ID point"), affects the rest of the command. It 
determines which end of the curve the object identified next should be attached to.

2. Identify object
The object to which the curve should be extended can be a line, a circular arc or another curve. To 
identify the object, click on it with the mouse. If more than one object lies at the point clicked on, 
then the correct object can be selected with the help of a small dialog which appears at the bottom of 
the screen.

The position at which the object is identified (the "ID point"), affects the rest of the command. It 
determines which end of the object the previously identified curve should be extended to.

After identifying both objects, the extended curve is generated. The endpoints nearer to the ID point of 
the two objects previously identified are joined by a line (see graphic).

If the duplicate function was active while selecting the second object (e.g. because the CTRL key was 
held down), the identified objects remain intact. Otherwise they are deleted and only the new, extended 
curve remains.



Note: If, for example, two lines are to be joined, then one of them must first be transformed to a curve 
using the command Transform Objects to>Curve. This can then be extended to the second line. The same 
goes for circular arcs and the combinations of lines and circular arcs. Polylines are already curves and can
be used directly.

Related commands:
Trim Curve>Edit
Trim Curve>Split



Trim Curve>Split (Trimming Menu)
This command can be used to split an existing curve at one of its junctions.

If a curve is to be extended from one of its ends to join an existing element, this can be done with the 
command Trim Curve>Extend. The command Trim Curve>Edit can be used to alter or delete individual 
elements of a curve.

1. Identify curve
To identify it, click on the curve with the mouse. If several curves lie close to the position clicked on, 
a small dialog appears at the bottom of the window, with the help of which the "right" curve can be 
chosen.

The position at which the curve is identified (the "ID point"), affects the rest of the command. It 
determines which end of the curve the object identified next should be attached to.

If the duplicate function was active when the curve was selected (e.g. because the CTRL key was held 
down), a copy of the curve is made and the copy is cut up, the original curve remains intact.

Note: Polylines are stored internally as curves and can be directly manipulated with this command. All 
other objects must, if necessary, be converted to curves using the command Transform Objects to>Curve.

Related commands:
Trim Curve>Edit
Trim Curve>Extend
Trim Object>Cut Out
Trim Object>Split
Trim Object>Resolve Completely



Trim Surface>Union (A=A+B) (Trimming Menu)
Using this command existing flat objects can be combined into one surface which covers all areas of the 
drawing which were covered by at least one of the surfaces. This is the same as creating a union of two 
surfaces according to group theory.

The following object types are classed as "flat": circles, circular sectors, circular segments, ellipses, 
elliptical sectors, elliptical segments and surfaces. Ellipses and ellipse parts are converted into polylines 
and are therefore "only" contained as polylines in the result.

1. Identify areal object 1
The first object is identified by clicking on it with the mouse. If more than one object lies at the point 
clicked on, then the correct object can be selected with the help of a small dialog which appears at the
bottom of the screen.

2. Identify areal object 2
The second object is identified by clicking on it with the mouse. If more than one object lies at the 
point clicked on, then the correct object can be selected with the help of a small dialog which appears 
at the bottom of the screen.

If the duplicate function was active while selecting the second object (e.g. because the CTRL key was 
held down), the original objects remain intact. Otherwise they are deleted.

The result in each case is one "surface" object, which may however be made up of more than one surface 
part. A graphic with examples of the union follows:

The order in which the objects were identified does not influence the result.

Note: This command works with all objects which have a closed outline. These are automatically 
converted to surfaces for the calculation.
Many object types can not be converted into a surface without loss. Ellipses and ellipse parts must be 
converted into polylines, which invariably leads to a loss of quality. The accuracy of the conversion can 
be specified using the command Settings>Screen under the heading "Accuracy - Transform".
The original objects (which remain unchanged if the duplicate function is active), are not influenced by 



this conversion. Surfaces with "holes" can also be used.
There can be problems if both objects share (part) of an edge. In this case there can, in spite of calculation
to 16 decimal places, be incorrect interpretations. Do not rely on overlapping surfaces always or never 
being combined. This varies from case to case. The result may consist of one object which contains both 
the original surfaces, unaltered, as part surfaces.

Related commands:
Trim Surface>Intersection (A=A×B)
Trim Surface>Difference(A=A-B)
Trim Surface>Combine Outlines
Trim Surface>Split into Outlines
Trim Surface>Generate Surface



Trim Surface>Intersection (A=A×B) (Trimming Menu)
This command can be used to combine existing flat objects into one surface which covers all the parts of 
the drawing previously covered by both objects. This is the same as the intersection of two objects 
according to the group theory.

The following object types are classed as "flat": circles, circular sectors, circular segments, ellipses, 
elliptical sectors, elliptical segments and surfaces. Ellipses and ellipse parts are converted into polylines 
and are therefore "only" contained as polylines in the result.

1. Identify areal object 1
The first object is identified by clicking on it with the mouse. If more than one object lies at the point 
clicked on, then the correct object can be selected with the help of a small dialog which appears at the
bottom of the screen.

2. Identify areal object 2
The second object is identified by clicking on it with the mouse. If more than one object lies at the 
point clicked on, then the correct object can be selected with the help of a small dialog which appears 
at the bottom of the screen.

If the duplicate function was active while selecting the second object (e.g. because the CTRL key was 
held down), the original objects remain intact. Otherwise they are deleted.

The result in each case is one "surface" object, which may however be made up of more than one surface 
part. There follows a graphic showing examples of intersections:

The order in which the objects were identified does not influence the result.

Note: This command works with all objects which have a closed outline. These are automatically 
converted to surfaces for the calculation.
Many object types can not be converted into a surface without loss. Ellipses and ellipse parts must be 
converted into polylines, which invariably leads to a loss of quality. The accuracy of the conversion can 
be specified using the command Settings>Screen under the heading "Accuracy - Transform".
The original objects (which remain unchanged if the duplicate function is active), are not influenced by 



this conversion. Surfaces with "holes" can also be used.
There can be problems if both objects share (part) of an edge. In this case there can, in spite of calculation
to 16 decimal places, be incorrect interpretations. Do not rely on the sides of overlapping objects always 
or never remaining unaltered. This varies from case to case.

Related commands:
Trim Surface>Union (A=A+B)
Trim Surface>Difference (A=A-B)
Trim Surface>Combine Outlines
Trim Surface>Split into Outlines
Trim Surface>Generate Surface



Trim Surface>Difference(A=A-B) (Trimming Menu)
This command can be used to combine existing flat objects into one surface which covers all parts of the 
drawing previously covered only by the first object and not by the second object. This is the same as the 
difference of two surfaces according to the group theory.

The following object types are classed as "flat": circles, circular sectors, circular segments, ellipses, 
elliptical sectors, elliptical segments and surfaces. Ellipses and ellipse parts are converted into polylines 
and are therefore "only" contained as polylines in the result.

1. Identify areal object 1
The first object is identified by clicking on it with the mouse. If more than one object lies at the point 
clicked on, then the correct object can be selected with the help of a small dialog which appears at the
bottom of the screen.

2. Identify areal object 2
The second object is identified by clicking on it with the mouse. If more than one object lies at the 
point clicked on, then the correct object can be selected with the help of a small dialog which appears 
at the bottom of the screen.

If the duplicate function was active while selecting the second object (e.g. because the CTRL key was 
held down), the original objects remain intact. Otherwise they are deleted.

The result in each case is one "surface" object, which may however be made up of more than one surface 
part. There follows a graphic showing examples of differences::

Note that the order in which the objects are identified is important. The last identified object is always 
"subtracted" from the object identified first.

Note: This command works with all objects which have a closed outline. These are automatically 
converted to surfaces for the calculation.
Many object types can not be converted into a surface without loss. Ellipses and ellipse parts must be 
converted into polylines, which invariably leads to a loss of quality. The accuracy of the conversion can 
be specified using the command Settings>Screen under the heading "Accuracy - Transform".



The original objects (which remain unchanged if the duplicate function is active), are not influenced by 
this conversion. Surfaces with "holes" can also be used.
There can be problems if both objects share (part) of an edge. In this case there can, in spite of calculation
to 16 decimal places, be incorrect interpretations. Do not rely on the sides of overlapping objects always 
or never remaining unaltered. This varies from case to case.

Related commands:
Trim Surface>Union (A=A+B)
Trim Surface>Intersection (A=A×B)
Trim Surface>Combine Outlines
Trim Surface>Split into Outlines
Trim Surface>Generate Surface



Trim Surface>Combine Outlines (Trimming Menu)
This command can be used to combine existing flat objects to a single surface. The outlines of all objects 
are simply included in one surface.

The following object types are regarded as "flat": circle, circular sector, circular segment, ellipse, 
elliptical sector, elliptical segment and surface. Ellipses and ellipse parts are converted into polylines first,
and are therefore "only" present in the result as polylines.

1. Choose objects
The objects to be combined in one surface are chosen. Any number of objects can be chosen. This can
be done using various methods, which can be combined with one another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

If the duplicate function is on during choosing, the original objects remain unchanged. Otherwise, all the 
objects used in the new surface are deleted. If objects which cannot be used (e.g. lines, texts, 
measurements) were chosen, they remain unchanged.

The result in each case is one "surface" object, which may however be made up of more than one surface 
part. A graphic showing examples of the combinations follows. The differently-colored hatchings show 
which areas are regarded as "part of the surface". All other areas are "outside the surface". This closes up 
any holes.



The areas of the objects shown hatched are hatched or filled if the relevant object is hatched or filled. The 
effects of this combination can be expressed as: ( Object 1 - Object 2 ) × ( Object 2 - Object 1 ).

Note: This command works with all objects which have a closed outline. These are automatically 
converted to surfaces for the calculation.
Many object types can not be converted into a surface without loss. Ellipses and ellipse parts must be 
converted into polylines, which invariably leads to a loss of quality. The accuracy of the conversion can 
be specified using the command Settings>Screen under the heading "Accuracy - Transform".
The original objects (which remain unchanged if the duplicate function is active), are not influenced by 
this conversion. Surfaces with "holes" can also be used.

Related commands:
Trim Surface>Union (A=A+B)
Trim Surface>Intersection (A=A×B)
Trim Surface>Difference (A=A-B)
Trim Surface>Split into Outlines
Trim Surface>Generate Surface



Trim Surface>Split into Outlines (Trimming Menu)
This command can be used to break existing surfaces which contain more than one outline into their 
individual outlines

1. Choose objects
The objects to be broken into their outlines must be chosen. Any number of objects can be chosen. 
This can be done using various methods, which can be combined with one another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

If the duplicate function is on during choosing, the original objects remain unchanged. Otherwise they are
deleted.

The results are several "surface" objects which each have one outline only. A graphic showing an example
follows. The differently-colored hatchings show which areas are regarded as "part of the surface". All 
other areas are "outside the surface". This closes up any holes.



The areas of the objects which are shown hatched, are hatched or filled when the corresponding object is 
hatched or filled.

Related commands:
Trim Surface>Union (A=A+B)
Trim Surface>Intersection (A=A×B)
Trim Surface>Difference (A=A-B)
Trim Surface>Combine Outlines
Trim Surface>Generate Surface



Trim Surface>Generate Surface (Trimming Menu)
This command can be used to generate a surface from individual outline elements. This is particularly 
useful to hatch areas which are not a surface, but are made up of the space between other objects.

1. Choose objects
The objects whose outlines are to be included in the new surface are chosen. Any number of objects 
can be chosen. This can be done using various methods, which can be combined with one another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

2. Enter reference point
The reference point can be entered using the mouse, by clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

The position of the ID point determines where and how the surface should be generated. The 
reference point must be close to one of the outline elements to be incorporated in the surface. It shows
with which element the search for a closed outline should begin. Through its position relative to this 
element, it also determines whether the "largest possible" or "smallest possible" surface should be 
worked out (see graphic).



The effect of the reference point can be explained (simply) as follows: Imagine emptying a can of 
paint at the reference point. The paint spreads out in all directions until it reaches an object.
The result is one area which is covered in paint, and one area which is not. The boundary between 
these two areas is the outline of the newly-generated surface.

Important: During surface generation, only the one outline near the ID point is created. If a surface 
made up of more than one outline is to be generated, then each outline must be generated 
independently. They can then be combined using the command Trim Surface>Combine Outlines.

After entering the reference point, the surface is generated and inserted. The result can be influenced by 
the parameters specified with the command Trim Surface>Parameters. If an error message appears 
although it ought to be possible to generate the surface, try increasing the tolerance.

Generated surfaces are not automatically allocated to the current layer. Instead, the command 
Layers>Defaults is used to decide whether they should be assigned to the current layer, or another 
specified layer. The same goes for the command Pens>Defaults and pen assignments.

Note: As the result is a surface, only its elements (lines, circular arcs and Bézier curves) can be used 
when calculating the result. Many object types (above all, ellipses and ellipse parts) must be converted to 
polylines first, which inevitably causes loss of quality. The accuracy of the conversion can be specified 
using the command Settings>Screen under the heading "Accuracy - Transform".
The select objects, on the basis of which the surface is generated are neither deleted nor altered. If they 
are to be deleted, the easiest way is to use the command Delete Objects or press the DELETE key. The 
required selection can easily be made by pressing the F11 Key. This deletes exactly the objects used to 
generate the surface.

Related commands:
Trim Surface>Union (A=A+B)
Trim Surface>Intersection (A=A×B)



Trim Surface>Difference (A=A-B)
Trim Surface>Combine Outlines
Trim Surface>Split into Outlines



Trim Surface>Parameters (Trimming Menu)
This command can be used to specify the tolerance used when trimming surfaces to work out 
intersections and identities.

1. Enter tolerance
After choosing the command, a dialog appears where the tolerance for generating surfaces can be 
entered. This tolerance is valid for all subsequently generated surfaces.
The accuracy is given in the form of a maximum deviation relative to 0.1. This shows how far two 
objects can be apart from another but still count as "overlapping" or "intersecting".
It also shows the minimum line length which will be generated within the surface. If two subsequent 
joins lie closer to each other than the tolerance specified, they are joined together.

The tolerance should only be increased slightly if an error message appears while generating a surface, 
although it ought theoretically to be possible to create a closed surface. Objects which are tangential to 
one another are particularly critical.

Make sure that all the objects needed to generate the surface are actually selected and that the reference 
point actually lies close to one of the elements of the surface to be created. This is very often the cause of 
an error message.

Existing surfaces are unaffected by changes to the current tolerance. Once a surface has been generated, 
its tolerance can not be altered.

Affected commands:
Trim Surface>Union (A=A+B)
Trim Surface>Intersection (A=A×B)
Trim Surface>Difference (A=A-B)
Trim Surface>Generate Surface



Trim Edge (Trimming Menu)
This command can be used to trim two lines so that they form a corner.

1. Identify line 1
Click on the first line with the mouse to identify it. If more than one possible line lies close to the 
position clicked on, then a small dialog appears at the bottom of the screen, from which the "right" 
line can be selected.

The position at which the line was identified (the "ID point") affects the rest of the command. It 
determines which end of the line will be altered. Refer to the graphics at the end of this section.

2. Identify line 2
Click on the second line with the mouse to identify it. If more than one possible line lies close to the 
position clicked on, then a small dialog appears at the bottom of the screen, from which the "right" 
line can be selected.

The position at which the line was identified (the "ID point") affects the rest of the command. It 
determines which end of the line will be altered. Refer to the graphics at the end of this section.

If the duplicate function was active while selecting the second object (e.g. because the CTRL key was 
held down), the original lines remain unaltered. Otherwise they are deleted.

The position of the ID points determine which end of the lines will be altered The end of the line closer to
the ID point is always the one altered. In this way, any of up to four possible corners can be generated 
(see graphic).

Note a basic rule for trimming: The object changes, wherever it is clicked on.

If the lines identified are parallel, then an error message appears.

Related commands:



Trim Object>Split
Trim Object>Cut Out



Chamfer Edge>Line - Line (Trimming Menu)
This command can be used to trim two lines so that they form a corner which is immediately chamfered.

1. Enter angle and length
After choosing the command, a dialog appears, in which the chamfer angle and length can be entered.
The angle and length remain valid until either a new command is chosen or the current command is 
restarted using the command Restart Command (+ESC) or the key combination SHIFT+ESC.

2. Identify line 1
Click on the first line with the mouse to identify it. If more than one possible line lies close to the 
position clicked on, then a small dialog appears at the bottom of the screen, from which the "right" 
line can be selected.

The position at which the line was identified (the "ID point") affects the rest of the command. It 
determines which end of the line will be altered. Refer to the graphics at the end of this section.

3. Identify line 2
Click on the second line with the mouse to identify it. If more than one possible line lies close to the 
position clicked on, then a small dialog appears at the bottom of the screen, from which the "right" 
line can be selected.

The position at which the line was identified (the "ID point") affects the rest of the command. It 
determines which end of the line will be altered. Refer to the graphics at the end of this section.

If the duplicate function was active while selecting the second object (e.g. because the CTRL key was 
held down), the original lines remain unaltered. Otherwise they are deleted.

The chamfer length is the distance between the chamfer start point and the intersection of the identified 
lines, it is laid on the line which was identified first.

The position of the ID points determine which end of the lines will be altered. The end of the line closer 
to the ID point is always the one altered. In this way, any of the four possible corners can be created and 
chamfered (see graphic).



Note a basic rule for trimming: The object changes, wherever it is clicked on.

If the lines identified are parallel, then an error message appears.

Note: Corners within curves or surfaces can be chamfered using the commands Chamfer Edge>One Edge
and Chamfer Edge>Complete.

Related commands:
Chamfer Edge>One Edge
Chamfer Edge>Complete
Round Edge, Outer Arc>Line - Line
Round Edge, Outer Arc>One Edge
Round Edge, Outer Arc>Complete
Round Edge, Inner Arc>Line - Line
Round Edge, Inner Arc>One Edge
Round Edge, Inner Arc>Complete



Chamfer Edge>One Edge (Trimming Menu)
This command can be used to chamfer a corner within a curve or surface. Only corners made up of two 
lines can be chamfered.

1. Enter angle and length
After choosing the command, a dialog appears, in which the chamfer angle and length can be entered.
The angle and length remain valid until either a new command is chosen or the current command is 
restarted using the command Restart Command (+ESC) or the key combination SHIFT+ESC.

2. Identify curve / surface
To identify the curve or surface, click on its outline with the mouse. If more than one object lies at the
point clicked on, then the correct object can be selected with the help of a small dialog which appears 
at the bottom of the screen.

The position at which the object was identified (the "ID point") affects how the command is carried 
out. It determines which corner will be chamfered (see graphic).

Note a basic rule for trimming: The object changes, wherever it is clicked on.

If the duplicate function was held down while the curve or surface was selected (e.g. because the CTRL 
key was held down), the object itself is not chamfered, but a copy is generated and that is chamfered.

If the two lines of the "corner" are parallel, then an error message appears.

Note: A corner made from two individual lines can be chamfered using the command Chamfer 
Edge>Line - Line. All the corners of a curve or surface can be chamfered at once using the command 
Chamfer Edge>Complete.

Related commands:
Chamfer Edge>Line - Line
Chamfer Edge>Complete
Round Edge, Outer Arc>Line - Line
Round Edge, Outer Arc>One Edge
Round Edge, Outer Arc>Complete
Round Edge, Inner Arc>Line - Line
Round Edge, Inner Arc>One Edge
Round Edge, Inner Arc>Complete



Chamfer Edge>Complete (Trimming Menu)
This command can be used to chamfer all the corners in a curve or surface at the same time. Only corners 
made of two lines will be chamfered.

1. Enter angle and length
After choosing the command, a dialog appears, in which the chamfer angle and length can be entered.
The angle and length remain valid until either a new command is chosen or the current command is 
restarted using the command Restart Command (+ESC) or the key combination SHIFT+ESC.

2. Identify curve / surface
To identify the curve or surface, click on its outline with the mouse. If more than one object lies at the
point clicked on, then the correct object can be selected with the help of a small dialog which appears 
at the bottom of the screen.

If the duplicate function was held down while the curve or surface was selected (e.g. because the CTRL 
key was held down), the object itself is not chamfered, but a copy is generated and that is chamfered.

Note: A corner made up of two individual lines can be chamfered using the command Chamfer 
Edge>Line - Line. A single corner of the curve or surface can be chamfered using Chamfer 
Edge>Complete.

Related commands:
Chamfer Edge>Line - Line
Chamfer Edge>One Edge
Round Edge, Outer Arc>Line - Line
Round Edge, Outer Arc>One Edge
Round Edge, Outer Arc>Complete
Round Edge, Inner Arc>Line - Line
Round Edge, Inner Arc>One Edge
Round Edge, Inner Arc>Complete



Round Edge, Outer Arc>Line - Line (Trimming Menu)
This command can be used to trim two lines so that they form a corner which is then rounded using a 
convex circular arc.

1. Enter radius
After choosing the command, a dialog appears, in which the rounding angle to be used can be 
entered. This radius remains valid either until another command is chosen or the current command is 
restarted using the command Restart Command (+ESC) or the key combination SHIFT+ESC.

2. Identify line 1
Click on the first line with the mouse to identify it. If more than one possible line lies close to the 
position clicked on, then a small dialog appears at the bottom of the screen, from which the "right" 
line can be selected.

The position at which the line was identified (the "ID point") affects the rest of the command. It 
determines which end of the line will be altered. Refer to the graphics at the end of this section.

3. Identify line 2
Click on the second line with the mouse to identify it. If more than one possible line lies close to the 
position clicked on, then a small dialog appears at the bottom of the screen, from which the "right" 
line can be selected.

The position at which the line was identified (the "ID point") affects the rest of the command. It 
determines which end of the line will be altered. Refer to the graphics at the end of this section.

If the duplicate function was active while selecting the second object (e.g. because the CTRL key was 
held down), the original lines remain unaltered. Otherwise they are deleted.

The position of the ID points determine which end of the lines will be altered. The end of the line closer 
to the ID point is always the one altered. In this way, any of the four possible corners can be generated 
and rounded (see graphic).



Note a basic rule for trimming: The object changes, wherever it is clicked on.

If the lines identified are parallel, then an error message appears.

Note: If a corner in a surface or curve is to be rounded, this can be done with the commands Round Edge,
Outer Arc>One Edge und Round Edge, Outer Arc>Complete.

Related commands:
Chamfer Edge>Line - Line
Chamfer Edge>One Edge
Chamfer Edge>Complete
Round Edge, Outer Arc>One Edge
Round Edge, Outer Arc>Complete
Round Edge, Inner Arc>Line - Line
Round Edge, Inner Arc>One Edge
Round Edge, Inner Arc>Complete



Round Edge, Outer Arc>One Edge (Trimming Menu)
This command can be used to round a corner using a convex arc. Only corners consisting of two lines can
be rounded.

1. Enter radius
After choosing the command, a dialog appears, in which the rounding angle to be used can be 
entered. This radius remains valid either until another command is chosen or the current command is 
restarted using the command Restart Command (+ESC) or the key combination SHIFT+ESC.

2. Identify curve / surface
To identify the curve or surface, click on its outline with the mouse. If more than one object lies at the
point clicked on, then the correct object can be selected with the help of a small dialog which appears 
at the bottom of the screen.

The position at which the object was identified (the "ID point") affects how the command is carried 
out. It determines which corner of the object is to be rounded (see graphic ).

Note a basic rule for trimming: The object changes, wherever it is clicked on.

If the duplicate function was held down while the curve or surface was selected (e.g. because the CTRL 
key was held down), a copy of the object is generated and the copy, not the original, is changed.

If the two lines of the "corner" are parallel, then an error message appears.

Note: If a corner made up of two individual lines is to be rounded, this can be done with the command 
Round Edge, Outer Arc>Line - Line. All the corners in a curve or surface can be chamfered at one using 
the command Round Edge, Outer Arc>Complete.

Related commands:
Chamfer Edge>Line - Line
Chamfer Edge>One Edge
Chamfer Edge>Complete
Round Edge, Outer Arc>Line - Line
Round Edge, Outer Arc>Complete
Round Edge, Inner Arc>Line - Line
Round Edge, Inner Arc>One Edge
Round Edge, Inner Arc>Complete



Round Edge, Outer Arc>Complete (Trimming Menu)
This command can be used to round all the corners in a curve or surface at the same time using a convex 
arc. Only corners made up of two lines are rounded.

1. Enter radius
After choosing the command, a dialog appears, in which the rounding angle to be used can be 
entered. This radius remains valid either until another command is chosen or the current command is 
restarted using the command Restart Command (+ESC) or the key combination SHIFT+ESC.

2. Identify curve / surface
To identify the curve or surface, click on its outline with the mouse. If more than one object lies at the
point clicked on, then the correct object can be selected with the help of a small dialog which appears 
at the bottom of the screen.

If the duplicate function was held down while the curve or surface was selected (e.g. because the CTRL 
key was held down), a copy of the object is generated and the copy, not the original, is changed.

Note: A corner made up of two individual lines can be rounded with the command Round Edge, Outer 
Arc>Line - Line. A single corner in a curve or surfaces can be rounded using Round Edge, Outer 
Arc>Complete.

Related commands:
Chamfer Edge>Line - Line
Chamfer Edge>One Edge
Chamfer Edge>Complete
Round Edge, Outer Arc>Line - Line
Round Edge, Outer Arc>One Edge
Round Edge, Inner Arc>Line - Line
Round Edge, Inner Arc>One Edge
Round Edge, Inner Arc>Complete



Round Edge, Inner Arc>Line - Line (Trimming Menu)
This command can be used to trim two lines so that they form a corner which is immediately rounded 
with a concave arc

1. Enter radius
After choosing the command, a dialog appears, in which the rounding angle to be used can be 
entered. This radius remains valid either until another command is chosen or the current command is 
restarted using the command Restart Command (+ESC) or the key combination SHIFT+ESC.

2. Identify line 1
Click on the first line with the mouse to identify it. If more than one possible line lies close to the 
position clicked on, then a small dialog appears at the bottom of the screen, from which the "right" 
line can be selected.

The position at which the line was identified (the "ID point") affects the rest of the command. It 
determines which end of the line will be altered. Refer to the graphics at the end of this section.

3. Identify line 2
Click on the second line with the mouse to identify it. If more than one possible line lies close to the 
position clicked on, then a small dialog appears at the bottom of the screen, from which the "right" 
line can be selected.

The position at which the line was identified (the "ID point") affects the rest of the command. It 
determines which end of the line will be altered. Refer to the graphics at the end of this section.

If the duplicate function was active while selecting the second object (e.g. because the CTRL key was 
held down), the original lines remain unaltered. Otherwise they are deleted.

The position of the ID points determine which end of the lines will be altered. The end of the line closer 
to the ID point is always the one altered. In this way, any of the four possible corners can be generated 
and rounded (see graphic).



Note a basic rule for trimming: The object changes, wherever it is clicked on.

If the lines identified are parallel, then an error message appears.

Note: A corner within a curve or surface can be rounded using the commands Round Edge, Inner 
Arc>One Edge and Round Edge, Inner Arc>Complete.

Related commands:
Chamfer Edge>Line - Line
Chamfer Edge>One Edge
Chamfer Edge>Complete
Round Edge, Outer Arc>Line - Line
Round Edge, Outer Arc>One Edge
Round Edge, Outer Arc>Complete
Round Edge, Inner Arc>One Edge
Round Edge, Inner Arc>Complete



Round Edge, Inner Arc>One Edge (Trimming Menu)
This command can be used to round a corner within a curve or surface with a concave arc. Only corners 
consisting of two lines can be rounded.

1. Enter radius
After choosing the command, a dialog appears, in which the rounding angle to be used can be 
entered. This radius remains valid either until another command is chosen or the current command is 
restarted using the command Restart Command (+ESC) or the key combination SHIFT+ESC.

2. Identify curve / surface
To identify the curve or surface, click on its outline with the mouse. If more than one object lies at the
point clicked on, then the correct object can be selected with the help of a small dialog which appears 
at the bottom of the screen.

The position at which the object was identified (the "ID point") affects how the command is carried 
out. It determines which corner of the object should be rounded (see graphic).

Note a basic rule for trimming: The object changes, wherever it is clicked on.

If the duplicate function was held down while the curve or surface was selected (e.g. because the CTRL 
key was held down), a copy of the object is generated and the copy, not the original, is changed.

If the two lines of the "corner" are parallel, then an error message appears.

Note: A corner made up of two individual lines can be rounded using the command Round Edge, Inner 
Arc>Line - Line. All the corners in a curve or surface can be rounded at the same time using Round Edge,
Inner Arc>Complete.

Related commands:
Chamfer Edge>Line - Line
Chamfer Edge>One Edge
Chamfer Edge>Complete
Round Edge, Outer Arc>Line - Line
Round Edge, Outer Arc>One Edge
Round Edge, Outer Arc>Complete
Round Edge, Inner Arc>Line - Line
Round Edge, Inner Arc>Complete



Round Edge, Inner Arc>Complete (Trimming Menu)
This command can be used to round all the corners in a surface at the same time, using a concave arc. 
Only those corners which consist of two lines are rounded.

1. Enter radius
After choosing the command, a dialog appears, in which the rounding angle to be used can be 
entered. This radius remains valid either until another command is chosen or the current command is 
restarted using the command Restart Command (+ESC) or the key combination SHIFT+ESC.

2. Identify curve / surface
To identify the curve or surface, click on its outline with the mouse. If more than one object lies at the
point clicked on, then the correct object can be selected with the help of a small dialog which appears 
at the bottom of the screen.

If the duplicate function was held down while the curve or surface was selected (e.g. because the CTRL 
key was held down), a copy of the object is generated and the copy, not the original, is changed.

Note: A corner which is made up of two individual lines can be rounded using the command Round Edge,
Inner Arc>Line - Line. A single corner in the curve or surface can be rounded using Round Edge, Inner 
Arc>Complete.

Related commands:
Chamfer Edge>Line - Line
Chamfer Edge>One Edge
Chamfer Edge>Complete
Round Edge, Outer Arc>Line - Line
Round Edge, Outer Arc>One Edge
Round Edge, Outer Arc>Complete
Round Edge, Inner Arc>Line - Line
Round Edge, Inner Arc>One Edge



Transform Object to>Invert (Trimming Menu)
This command can be used to invert a circle or ellipse part. This means that the exact opposite of the 
previous arc is drawn afterwards.

1. Identify object
In principle, any object can be identified for transformation. However, transformation only makes 
sense for some objects.
Objects are identified by clicking on them. If more than one object lies at the point clicked on, then 
the correct object can be selected with the help of a small dialog which appears at the bottom of the 
screen.

If the duplicate function was active during the selection process (e.g. because the CTRL key was held 
down), the object itself is not altered, but a copy is generated and then altered.

Note: If a circular arc within a curve is to be inverted, this can be done with the command Trim 
Curve>Edit. If the circular arc is in a surface, the surface must first be converted to a curve using 
Transform Objects To>Curve in order to allow the previously-named command to edit it.

Related commands:
Transform Objects to>Zigzag Line
Transform Objects to>Circle
Transform Objects to>Circular Arc
Transform Objects to>Circular Sector
Transform Objects to>Circular Segment
Transform Objects to>Ellipse
Transform Objects to>Elliptic Arc
Transform Objects to>Elliptic Sector
Transform Objects to>Elliptic Segment
Transform Objects to>Curve
Transform Objects to>Surface
Transform Objects to>Eraser



Transform Object to>Zigzag Line (Trimming Menu)
This command can be used to transform a normal line into a zigzag line.

1. Identify object
In principle, any object can be identified for transformation. However, transformation only makes 
sense for some objects.
Objects are identified by clicking on them. If more than one object lies at the point clicked on, then 
the correct object can be selected with the help of a small dialog which appears at the bottom of the 
screen.

If the duplicate function was active during the selection process (e.g. because the CTRL key was held 
down), the object itself is not altered, but a copy is generated and then altered.

The newly generated zigzag line uses the current zag spacing. The zag spacing can be specified using the 
command Zigzag Line>Parameters.

Related commands:
Transform Objects to>Invert
Transform Objects to>Circle
Transform Objects to>Circular Arc
Transform Objects to>Circular Sector
Transform Objects to>Circular Segment
Transform Objects to>Ellipse
Transform Objects to>Elliptic Arc
Transform Objects to>Elliptic Sector
Transform Objects to>Elliptic Segment
Transform Objects to>Curve
Transform Objects to>Surface
Transform Objects to>Eraser



Transform Object to>Circle (Trimming Menu)
This command can be used to convert a circle part to a full circle.

1. Identify object
In principle, any object can be identified for transformation. However, transformation only makes 
sense for some objects.
Objects are identified by clicking on them. If more than one object lies at the point clicked on, then 
the correct object can be selected with the help of a small dialog which appears at the bottom of the 
screen.

If the duplicate function was active during the selection process (e.g. because the CTRL key was held 
down), the object itself is not altered, but a copy is generated and then altered.

Related commands:
Transform Objects to>Invert
Transform Objects to>Zigzag Line
Transform Objects to>Circular Arc
Transform Objects to>Circular Sector
Transform Objects to>Circular Segment
Transform Objects to>Ellipse
Transform Objects to>Elliptic Arc
Transform Objects to>Elliptic Sector
Transform Objects to>Elliptic Segment
Transform Objects to>Curve
Transform Objects to>Surface
Transform Objects to>Eraser



Transform Object to>Circular Arc (Trimming Menu)
This command can be used to convert a circle part into a circular arc.

1. Identify object
In principle, any object can be identified for transformation. However, transformation only makes 
sense for some objects.
Objects are identified by clicking on them. If more than one object lies at the point clicked on, then 
the correct object can be selected with the help of a small dialog which appears at the bottom of the 
screen.

If the duplicate function was active during the selection process (e.g. because the CTRL key was held 
down), the object itself is not altered, but a copy is generated and then altered.

Note: If a circle is to be transformed into a circular arc, this can be done with the command Trim 
Object>Cut Out.

Related commands:
Transform Objects to>Invert
Transform Objects to>Zigzag Line
Transform Objects to>Circle
Transform Objects to>Circular Sector
Transform Objects to>Circular Segment
Transform Objects to>Ellipse
Transform Objects to>Elliptic Arc
Transform Objects to>Elliptic Sector
Transform Objects to>Elliptic Segment
Transform Objects to>Curve
Transform Objects to>Surface
Transform Objects to>Eraser



Transform Object to>Circular Sector (Trimming Menu)
A circle part can be converted to a circular segment using this command.

1. Identify object
In principle, any object can be identified for transformation. However, transformation only makes 
sense for some objects.
Objects are identified by clicking on them. If more than one object lies at the point clicked on, then 
the correct object can be selected with the help of a small dialog which appears at the bottom of the 
screen.

If the duplicate function was active during the selection process (e.g. because the CTRL key was held 
down), the object itself is not altered, but a copy is generated and then altered.

Note: If a circle is to be transformed to a circular sector, this can be done with the command Trim 
Object>Cut Out.

Related commands:
Transform Objects to>Invert
Transform Objects to>Zigzag Line
Transform Objects to>Circle
Transform Objects to>Circular Arc
Transform Objects to>Circular Segment
Transform Objects to>Ellipse
Transform Objects to>Elliptic Arc
Transform Objects to>Elliptic Sector
Transform Objects to>Elliptic Segment
Transform Objects to>Curve
Transform Objects to>Surface
Transform Objects to>Eraser



Transform Object to>Circular Segment (Trimming Menu)
This command can be used to transform a circle part to a circular segment.

1. Identify object
In principle, any object can be identified for transformation. However, transformation only makes 
sense for some objects.
Objects are identified by clicking on them. If more than one object lies at the point clicked on, then 
the correct object can be selected with the help of a small dialog which appears at the bottom of the 
screen.

If the duplicate function was active during the selection process (e.g. because the CTRL key was held 
down), the object itself is not altered, but a copy is generated and then altered.

Note: If a circle is to be transformed into a circular segment, this can be done with the command Trim 
Object>Cut Out.

Related commands:
Transform Objects to>Invert
Transform Objects to>Zigzag Line
Transform Objects to>Circle
Transform Objects to>Circular Arc
Transform Objects to>Circular Sector
Transform Objects to>Ellipse
Transform Objects to>Elliptic Arc
Transform Objects to>Elliptic Sector
Transform Objects to>Elliptic Segment
Transform Objects to>Curve
Transform Objects to>Surface
Transform Objects to>Eraser



Transform Object to>Ellipse (Trimming Menu)
This command can be used to convert a circle, circle part or ellipse part to an ellipse.

1. Identify object
In principle, any object can be identified for transformation. However, transformation only makes 
sense for some objects.
Objects are identified by clicking on them. If more than one object lies at the point clicked on, then 
the correct object can be selected with the help of a small dialog which appears at the bottom of the 
screen.

If the duplicate function was active during the selection process (e.g. because the CTRL key was held 
down), the object itself is not altered, but a copy is generated and then altered.

During the transformation of a circle or circle part to an ellipse, a right-angled ellipse whose half axes 
have the length of the original circle"s radius and run vertically or horizontally is generated.

Related commands:
Transform Objects to>Invert
Transform Objects to>Zigzag Line
Transform Objects to>Circle
Transform Objects to>Circular Arc
Transform Objects to>Circular Sector
Transform Objects to>Circular Segment
Transform Objects to>Elliptic Arc
Transform Objects to>Elliptic Sector
Transform Objects to>Elliptic Segment
Transform Objects to>Curve
Transform Objects to>Surface
Transform Objects to>Eraser



Transform Object to>Elliptic Arc (Trimming Menu)
This command can be used to transform a circle or ellipse part to an elliptic arc.

1. Identify object
In principle, any object can be identified for transformation. However, transformation only makes 
sense for some objects.
Objects are identified by clicking on them. If more than one object lies at the point clicked on, then 
the correct object can be selected with the help of a small dialog which appears at the bottom of the 
screen.

If the duplicate function was active during the selection process (e.g. because the CTRL key was held 
down), the object itself is not altered, but a copy is generated and then altered.

During the transformation of a circle or circle part to an ellipse, a right-angled ellipse whose half axes 
have the length of the original circle"s radius and run vertically or horizontally is generated.

Note: If an ellipse is to be converted to an elliptic arc, this can be done with the command Trim 
Object>Cut Out.

Related commands:
Transform Objects to>Invert
Transform Objects to>Zigzag Line
Transform Objects to>Circle
Transform Objects to>Circular Arc
Transform Objects to>Circular Sector
Transform Objects to>Circular Segment
Transform Objects to>Ellipse
Transform Objects to>Elliptic Sector
Transform Objects to>Elliptic Segment
Transform Objects to>Curve
Transform Objects to>Surface
Transform Objects to>Eraser



Transform Object to>Elliptic Sector (Trimming Menu)
This command can be used to transform a circle part or ellipse part to an elliptic sector.

1. Identify object
In principle, any object can be identified for transformation. However, transformation only makes 
sense for some objects.
Objects are identified by clicking on them. If more than one object lies at the point clicked on, then 
the correct object can be selected with the help of a small dialog which appears at the bottom of the 
screen.

If the duplicate function was active during the selection process (e.g. because the CTRL key was held 
down), the object itself is not altered, but a copy is generated and then altered.

During the transformation of a circle or circle part to an ellipse, a right-angled ellipse whose half axes 
have the length of the original circle"s radius and run vertically or horizontally is generated.

Note: If an ellipse is to be transformed to an elliptic sector, this can be done with the command Trim 
Object>Cut Out.

Related commands:
Transform Objects to>Invert
Transform Objects to>Zigzag Line
Transform Objects to>Circle
Transform Objects to>Circular Arc
Transform Objects to>Circular Sector
Transform Objects to>Circular Segment
Transform Objects to>Ellipse
Transform Objects to>Elliptic Arc
Transform Objects to>Elliptic Segment
Transform Objects to>Curve
Transform Objects to>Surface
Transform Objects to>Eraser



Transform Object to>Elliptic Segment (Trimming Menu)
This command can be used to transform a circle part or ellipse part to an elliptic segment.

1. Identify object
In principle, any object can be identified for transformation. However, transformation only makes 
sense for some objects.
Objects are identified by clicking on them. If more than one object lies at the point clicked on, then 
the correct object can be selected with the help of a small dialog which appears at the bottom of the 
screen.

If the duplicate function was active during the selection process (e.g. because the CTRL key was held 
down), the object itself is not altered, but a copy is generated and then altered.

During the transformation of a circle or circle part to an ellipse, a right-angled ellipse whose half axes 
have the length of the original circle"s radius and run vertically or horizontally is generated.

Note: If an ellipse is to be transformed to an elliptic segment, this can be done with the command Trim 
Object>Cut Out.

Related commands:
Transform Objects to>Invert
Transform Objects to>Zigzag Line
Transform Objects to>Circle
Transform Objects to>Circular Arc
Transform Objects to>Circular Sector
Transform Objects to>Circular Segment
Transform Objects to>Ellipse
Transform Objects to>Elliptic Arc
Transform Objects to>Elliptic Sector
Transform Objects to>Curve
Transform Objects to>Surface
Transform Objects to>Eraser



Transform Objects To>Curve (Trimming Menu)
This command can be used to convert an object to a curve. A curve is an "open" object, i.e. it does not 
have a closed outline and therefore can not be filled. If filled objects are converted to curves, they will no 
longer be available, but will however still be present.

1. Identify object
In principle, any object can be identified for transformation. However, transformation only makes 
sense for some objects.
Objects are identified by clicking on them. If more than one object lies at the point clicked on, then 
the correct object can be selected with the help of a small dialog which appears at the bottom of the 
screen.

If the duplicate function was active during the selection process (e.g. because the CTRL key was held 
down), the object itself is not altered, but a copy is generated and then altered.

Many object types cannot be converted cleanly to a curve. Zigzag lines, splines, ellipses and ellipse parts 
must be converted into polylines, which invariably leads to a loss of quality. The accuracy of the 
conversion can be specified using the command Settings>Screen under the heading "Accuracy - 
Transform".

A surface can only be converted to a curve if it has a single outline. If it consists of multiple outlines, then
the command Trim Surface>Split into Outlines must be used to split it into individual outlines

Related commands:
Transform Objects to>Invert
Transform Objects to>Zigzag Line
Transform Objects to>Circle
Transform Objects to>Circular Arc
Transform Objects to>Circular Sector
Transform Objects to>Circular Segment
Transform Objects to>Ellipse
Transform Objects to>Elliptic Arc
Transform Objects to>Elliptic Sector
Transform Objects to>Elliptic Segment
Transform Objects to>Surface
Transform Objects to>Eraser
Text>Resolve



Transform Object to>Surface (Trimming Menu)
This command can be used to transform an object to a surface.

1. Identify object
In principle, any object can be identified for transformation. However, transformation only makes 
sense for some objects.
Objects are identified by clicking on them. If more than one object lies at the point clicked on, then 
the correct object can be selected with the help of a small dialog which appears at the bottom of the 
screen.

If the duplicate function was active during the selection process (e.g. because the CTRL key was held 
down), the object itself is not altered, but a copy is generated and then altered.

Many object types can not be converted cleanly into a surface. Ellipses and ellipse parts must be 
converted into polylines, which invariably leads to a loss of quality. The accuracy of the conversion can 
be specified using the command Settings>Screen under the heading "Accuracy - Transform".

Related commands:
Transform Objects to>Invert
Transform Objects to>Zigzag Line
Transform Objects to>Circle
Transform Objects to>Circular Arc
Transform Objects to>Circular Sector
Transform Objects to>Circular Segment
Transform Objects to>Ellipse
Transform Objects to>Elliptic Arc
Transform Objects to>Elliptic Sector
Transform Objects to>Elliptic Segment
Transform Objects to>Curve
Transform Objects to>Eraser
Text>Resolve



Transform Object to>Eraser (Trimming Menu)
This command can be used to transform an object to an eraser.

1. Identify object
In principle, any object can be identified for transformation. However, transformation only makes 
sense for some objects.
Objects are identified by clicking on them. If more than one object lies at the point clicked on, then 
the correct object can be selected with the help of a small dialog which appears at the bottom of the 
screen.

If the duplicate function was active during the selection process (e.g. because the CTRL key was held 
down), the object itself is not altered, but a copy is generated and then altered.

Many object types can not be converted cleanly into an eraser. Ellipses and ellipse parts must be 
converted into polylines, which invariably leads to a loss of quality. The accuracy of the conversion can 
be specified using the command Settings>Screen under the heading "Accuracy - Transform".

See the Eraser section for details on the working of erasers.

Related commands:
Transform Objects to>Invert
Transform Objects to>Zigzag Line
Transform Objects to>Circle
Transform Objects to>Circular Arc
Transform Objects to>Circular Sector
Transform Objects to>Circular Segment
Transform Objects to>Ellipse
Transform Objects to>Elliptic Arc
Transform Objects to>Elliptic Sector
Transform Objects to>Elliptic Segment
Transform Objects to>Curve
Transform Objects to>Surface
Text>Resolve



Move Single Point (Trimming Menu)
This command can be used to move individual object definition points. Using this function objects which 
can not be manipulated with the "normal" manipulation commands can be manipulated.

If several definition points are to be moved at once (e.g. to stretch an object) this can be done more easily 
by first selecting all the points to be moved using Point Selection>Select Area and then moving them 
using Move Points>Standard.

1. Select definition point
The definition point to be moved can be selected with the mouse, by clicking near it. If the definition 
points of one or more objects lie at exactly the same position, they are all moved by the same amount.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

2. Enter target point
The new position for the selected definition point can be entered using the mouse, by clicking 
anywhere in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, relative or polar coordinates can be entered. Relative values relate to the original position of 
the point. For further information on coordinate entry, see Function Keys>Direct Input (F8).

To make the definition points more recognizable, you should turn their display on. This can be done with 
the Settings>Display.

The possibilities which can result from moving individual definition points are varied. The consequences 
are equally various and can be unexpected. Many definition points have a close relationship to other 
definition points and can only be moved in certain ways. Under some circumstances, some definition 
points can not be moved because of object parameter settings. Be sparing in the use of moving individual 
definition points.

Some frequently required operations can be carried out without risk using this command:
Moving end and corner points of lines, polylines and polygons (see graphic).

Altering the half-axes of ellipses or ellipse parts and moving the start or end angle of 
circle or ellipse parts (see graphic).



Moving the frame corner points of multi-line texts (see graphic).

Many of these operations can also be carried out with commands from the Shape Menu and the Trimming
Menu. In some cases it may however be quicker and easier to move one or more individual definition 
points.

Note: The duplicate function does not work with this command. The object itself is always changed. A 
copy is not made automatically, and if needed it must be explicitly created.
If a definition point lies outside an object frame (e.g. the pivot point of a Bézier curve), then the 
movement will not usually be displayed correctly. In this case, a screen redraw can be forced using the 
Spacebar. The movement is still effective even if the screen is not redrawn; strictly it is not necessary to 
redraw the screen.

Related commands:
Move Point>Standard
Move Point>Perpendicular
Move Point>Parallel
Move Point>Relative



Point Selection>Select Area (Trimming Menu)
This command can be used to select all the definition points within a specified area. They can then be 
moved, for example, using the command Move Points>Standard.

1. Area: Enter corner point 1
The first corner point of the area can be entered using the mouse, by clicking anywhere in the 
drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

2. Area: Enter corner point 2
The second corner point of the area can be entered using the mouse, by clicking anywhere in the 
drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, relative or polar coordinates can be entered. Relative values relate to the previously entered 
first corner point. For further information on coordinate entry, see Function Keys>Direct Input (F8).

All definition points in the area specified are selected. Selected points are shown by small filled squares 
(normally blue). They are also displayed if definition point display is turned off (see Settings>Display).

Related commands:
Point Selection>Deselect Area
Point Selection>Discard Selection



Point Selection>Deselect Area (Trimming Menu)
This command can be used to deselect all definition points within a specified rectangular area.

1. Area: Enter corner point 1
The first corner point of the area can be entered using the mouse, by clicking anywhere in the 
drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

2. Area: Enter corner point 2
The second corner point of the area can be entered using the mouse, by clicking anywhere in the 
drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, relative or polar coordinates can be entered. Relative values relate to the previously entered 
first corner point. For further information on coordinate entry, see Function Keys>Direct Input (F8).

All definition points within the specified area are deselected. Deselected points are no longer shown by 
small, filled, squares. If definition point display is turned on (see Settings>Display), they are displayed 
again as normal definition points (normally with a red frame). Other wise they merge into the 
background.

Related commands:
Point Selection>Select Area
Point Selection>Discard Selection



Point Selection>Discard Selection (Trimming Menu)
This command can be used to deselect all definition points.

All currently selected definition points in the drawing are deselected. Deselected points are no longer 
shown by small, filled, squares. If definition point display is turned on (see Settings>Display), they are 
displayed again as normal definition points (normally with a red frame). Other wise they merge into the 
background.

Related commands:
Point Selection>Select Area
Point Selection>Deselect Area



Move Points>Standard (Trimming Menu)
This command can be used to move all the currently selected definition points at the same time.

1. Enter reference point
The movement reference point can be entered using the mouse, by clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

2. Enter target point
The target point for the movement can be entered using the mouse, by clicking anywhere in the 
drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, relative or polar coordinates can be entered. Relative values relate to the previously entered 
reference point. For further information on coordinate entry, see Function Keys>Direct Input (F8).

The possibilities which can result from moving individual definition points are varied. The consequences 
are equally various and can be unexpected. Many definition points have a close relationship to other 
definition points and can only be moved in certain ways. Under some circumstances, some definition 
points can not be moved because of object parameter settings. Be sparing in the use of moving individual 
definition points.

Moving several definition points at once to stretch or shorten objects is particularly interesting. To do this,
all the definition points of an object are selected and then moved together (see graphic).

Moving definition points is also very useful when working with tables or similar grids built up from 
rectangles. To move the border between rectangles, it is quicker to move the definition points than to 
scale all the affected rectangles (see graphic).

Note: The duplicate function does not work with this command, i.e. the objects themselves will be 
changed. If a copy is required, it must be done before carrying out the command.

Related commands:



Move Point>Perpendicular
Move Point>Parallel
Move Point>Relative
Move Single Point



Move Points>Perpendicular (Trimming Menu)
This command can be used to move all currently selected definition points at the same time. The 
movement takes place perpendicular to a specified reference object.

1. Identify reference object
Any part object in an existing object can be identified as a reference object. This may be an edge of a 
rectangle, the arc of an elliptic segment or a circular arc within a surface.
To identify it, click on the (part) object with the mouse. If more than one possible (part) object lies 
close to the point clicked on, then a small dialog appears at the bottom of the screen from which the 
"right" object can be chosen.

The identified object is referred to as the "reference object"

If an ellipse part is identified, then the position at which the (part) object was identified (the ID point) 
affects the rest of the command. If a perpendicular is dropped on to an ellipse, then it can end at either
side of the ellipse. The point closer to the ID point is used as the end of the perpendicular (see 
graphic).

2. Enter reference point
The movement reference point can be entered using the mouse, by clicking anywhere in the drawing. 
A perpendicular is dropped from this point to the reference object.

The target point can be positioned on the straight line between the end of the perpendicular and the 
reference point. This line, the "reference line", is displayed.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

3. Enter target point
The target point for the movement can be entered using the mouse, by clicking anywhere in the 
drawing. A perpendicular is dropped from this position to the reference straight line to work out the 
movement target point.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, relative or polar coordinates can be entered. Relative values relate to the previously entered 
reference point.
In addition, you can enter a length. This shows the size of the movement, in the direction of the 
reference straight line, beginning at the previously entered start point. During entry a small arrow 
appears to the left of the status window. This shows the orientation for the length. If a positive value 
is entered, then movement takes place in the direction of the arrow. If a negative value is entered, then



movement takes place in the opposite direction to the arrow. For further information on coordinate 
entry, see Function Keys>Direct Input (F8).

The possibilities which can result from moving individual definition points are varied. The consequences 
are equally various and can be unexpected. Many definition points have a close relationship to other 
definition points and can only be moved in certain ways. Under some circumstances, some definition 
points can not be moved because of object parameter settings. Be sparing in the use of moving individual 
definition points.

Moving multiple definition points parallel to a reference object is useful, for example, if a sloping 
opening drawn in the plan view is to be enlarged or reduced (see graphic).

Note: The duplicate function does not work with this command, i.e. the objects themselves will be 
changed. If a copy is required, it must be done before carrying out the command.

Related commands:
Move Point>Standard
Move Point>Parallel
Move Point>Relative
Move Single Point



Move Points>Parallel (Trimming Menu)
This command can be used to move all currently selected definition points at the same time. The 
movement takes place parallel to a specified reference object.

1. Identify reference object
Any part object in an existing object can be identified as a reference object. This can be the edge of a 
rectangle or a circular arc within a surface. Ellipse (part)s cannot be identified.
To identify it, click on the (part) object with the mouse. If more than one possible (part) object lies 
close to the point clicked on, then a small dialog appears at the bottom of the screen from which the 
"right" object can be chosen.

The identified object is referred to as the "reference object"

2. Enter reference point
The movement reference point can be entered using the mouse, by clicking anywhere in the drawing.
If the previously identified reference object is a line, the reference point determines a line which runs 
parallel to the reference object. This is displayed and referred to as the "reference line". If the 
reference object is a circle or circle part then the reference point determines a circle concentric with 
the reference object. This is displayed, and referred to as the "Reference Circle". The target point can 
then be positioned on the reference circle or reference straight line.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

3. Enter target point
The target point for the movement can be entered using the mouse, by clicking anywhere in the 
drawing. A perpendicular is dropped from this position to the reference circle to work out the target 
point for the movement.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, relative or polar coordinates can be entered. Relative values relate to the previously entered 
reference point.
Depending on the type of the reference object, there are additional input possibilities. During entry a 
small arrow appears to the left of the status window. This shows the orientation for the length. If a 
positive value is entered, then movement takes place in the direction of the arrow. If a negative value 
is entered, then movement takes place in the opposite direction to the arrow.
In all other cases an angle measured from the center of the reference circle can be entered. The angle 
can be entered relative to the reference point"s angle. For further information on coordinate entry, see 
Function Keys>Direct Input (F8).

The possibilities which can result from moving individual definition points are varied. The consequences 
are equally various and can be unexpected. Many definition points have a close relationship to other 
definition points and can only be moved in certain ways. Under some circumstances, some definition 
points can not be moved because of object parameter settings. Be sparing in the use of moving individual 
definition points.

Moving definition points parallel to a reference object is particularly useful to stretch or shorten several 
sloping objects at once. To do this, all the definition points at one end of an object are selected and then 
moved at the same time (see graphic).



Note: The duplicate function does not work with this command, i.e. the objects themselves will be 
changed. If a copy is required, it must be done before carrying out the command.

Related commands:
Move Point>Standard
Move Point>Perpendicular
Move Point>Relative
Move Single Point



Move Points>Relative (Trimming Menu)
This command can be used to move all currently selected definition points at the same time. The 
movement is determined by entering a numeric value.

1. Enter horizontal and vertical movement
After choosing the command, a dialog appears, in which the size of the movement in horizontal and 
vertical directions can be entered.

The possibilities which can result from moving individual definition points are varied. The consequences 
are equally various and can be unexpected. Many definition points have a close relationship to other 
definition points and can only be moved in certain ways. Under some circumstances, some definition 
points can not be moved because of object parameter settings. Be sparing in the use of moving individual 
definition points.

Particularly interesting is the relative movement of multiple definition points, for example to move the 
end and corner points of several lines and rectangles at the same time by a given amount. To do this, all 
corner and end points are selected and then moved (see graphic).

Note: The duplicate function does not work with this command, i.e. the objects themselves will be 
changed. If a copy is required, it must be done before carrying out the command.

Related commands:
Move Point>Standard
Move Point>Perpendicular
Move Point>Parallel
Move Single Point



Eraser (Trimming Menu)
This command can be used to create a simple eraser in the shape of a polygon. A polygon is a closed 
sequence of connected lines.

1. Enter start point
The start point of the polygon can be entered using the mouse, by clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

2. Enter point
After entering the start point, the rest of the points can be entered one after another. The polygon 
begins at the start point, runs through the other points, and ends at the start point. These points can be 
entered with the mouse by clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, relative or polar coordinates can be entered.
In addition, you can enter the length or angle of the next segment relative to the previous one. For 
example, this makes it easy to enter sections at a predetermined angle. For further information on 
coordinate entry, see Function Keys>Direct Input (F8).

Polygon entry is ended by clicking the right mouse button. This does not, unlike other functions, lead 
to the previous input being ignored, but instead inserts the polygon. If you did not want this, then the 
command Undo must be used to undo the action.

An eraser can consist of up to 1000 sections. If this limit is reached, no further points can be entered.

The eraser is stored internally like a surface and can be made up of multiple, nested, outlines. If a 
complex eraser like this is to be created, it must first be created as a surface, and then converted to an 
eraser using the command Transform Object to>Eraser.
Erasers can be transformed into surfaces at any time using the command Transform Object to>Surface. It 
can then be manipulated with the same commands as those with which a surface can be manipulated.

Important: Erasers only work on output devices which can work with covering surfaces. For example, 
plotters will not do this. In addition, they cannot remain effective if the drawing is converted to DXF 
format.
Erasers are created by overpainting the foreground with the background color. The color which was 
specified as the "Drawing Surface" color in the Settings>Colors dialog is used. The color specified in the 
Settings>Output dialog for the "Output Area" is used for all other output. This color is also effective if the
output area is not output.

The eraser created is assigned to the currently active layer. In addition it contains a reference to the active 
pen, but this is only important if the eraser is converted to a surface.

Note: All point entries can be "taken back" using the command Function Keys>Previous Point(ESC) or 
by pressing the ESC key. This makes it easy to correct wrong entries without having to enter the whole 
eraser again.

Related commands:



Surface
Polygon>Arbitrary
Trim Surface>Generate Surface
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Dimension Line>Straight (Dimension Menu)
This command can be used to draw a straight dimension line. A straight dimension line is basically a line 
with two end symbols, e.g. arrowheads or points.

1. Set the dimension line parameters
After choosing the command the Dimension Line dialog appears, in which the dimension line 
parameters can be specified. These parameters remain valid until either a new command is chosen or 
the current command is restarted using Restart Command (+ESC) or the key combination 
SHIFT+ESC.

2. Enter start point
The dimension line's start point can be entered using the mouse, by clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

3. Enter end point
The dimension line's end point can be entered using the mouse, by clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, relative or polar coordinates can be entered. Relative values relate to the previously entered 
start point. For further information on coordinate entry, see Function Keys>Direct Input (F8).

Dimension lines are not automatically assigned to the current layer. Instead, the command 
Layers>Defaults is used to decide whether they should be assigned to the current layer, or another 
specified layer. The same goes for pens, which can be assigned using the command Pens>Defaults.

Related commands:
Dimension Line>Curved
Line>Standard



Dimension Line>Curved (Dimension Menu)
This command can be used to draw a curved dimension line. A curved dimension line is basically a 
circular arc with two end symbols, e.g. arrowheads or points.

1. Set dimension line parameters
After choosing the command, the Dimension Line dialog appears, in which the dimension line 
parameters can be specified. These parameters remain valid until either a new command is chosen or 
the current command is restarted using Restart Command (+ESC) or the key combination 
SHIFT+ESC.

2. Enter center point
The center point of the circular arc can be entered using the mouse, by clicking anywhere in the 
drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

3. Enter radius
The circular arc radius can be entered with the mouse, by clicking anywhere in the drawing at a point 
through which the circle should run.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, relative or polar coordinates can be entered.
It is also possible to enter the radius directly. For further information on coordinate entry, see 
Function Keys>Direct Input (F8).

4. Enter start angle
The circular arc's start angle can be entered using the mouse, by clicking anywhere in the drawing. 
The position of this point relative to the center point determines the start angle.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, relative or polar coordinates can be entered.
You can also enter the start angle directly. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

5. Enter end angle
The circular arc's end angle can be entered using the mouse, by clicking anywhere in the drawing. 
The position of this point relative to the center point determines the end angle.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, relative or polar coordinates can be entered.
You can also enter the end angle directly. The angle can also be given relative to a previously entered 
start point. For further information on coordinate entry, see Function Keys>Direct Input (F8).

The arc's appearance is determined by the current arc direction This is specified using the command 
Function Keys>Arc Direction (F2), with the F2 key or the button in the panel. If the arc direction is 
positive, the arc is drawn from the start angle in a mathematically positive sense (i.e. anticlockwise). 
If the arc direction is negative, the arc is drawn from the start angle in a mathematically negative 
sense (i.e. clockwise) (see graphic).



The appearance of the circular arc is shown during input, and changes if the current arc direction is 
changed.

Dimension lines are not automatically assigned to the current layer. Instead, the command 
Layers>Defaults is used to decide whether they should be assigned to the current layer, or another 
specified layer. The same goes for pens, which can be assigned using the command Pens>Defaults.

The arc direction saved in the curved dimension line remains unchanged if the current arc direction is 
changed later. If a curved dimension line's arc direction is to be changed, use the command Transform 
Objects to>Invert.

Related commands:
Dimension Line>Straight
Circular Arc>Standard



Dimension>Length, Points (Dimension Menu)
This command can be used to measure a distance with specified end points, i.e. it can be used to measure 
distances which are not in the form of an edge or line.

1. Specify dimension parameters
After choosing the command, the Dimension With Line dialog appears, in which the dimension 
parameters can be specified. These parameters remain valid until either a new command is chosen or 
the current command is restarted using Restart Command (+ESC) or the key combination 
SHIFT+ESC.

2. Enter start point
The dimension line's start point can be entered using the mouse, by clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

3. Enter end point
The dimension line's end point can be entered using the mouse, by clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, relative or polar coordinates can be entered. Relative values relate to the previously entered 
start point. For further information on coordinate entry, see Function Keys>Direct Input (F8).

After identifying the distance to be measured, the position of the dimension line and number must be 
specified. To do this, several points have to be entered. How many, and which, points have to be entered, 
depends on the specified dimension parameters.

If "Display Dimension Line" is set and the dimension direction is set to "Any":

4. Enter dimension line direction
The dimension line direction is determined by a point which, together with the start point of the 
distance to be measured defines a straight line in whose direction the dimension should run. This 
point can be entered using the mouse, by clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, relative or polar coordinates can be entered.
In addition, it is possible to enter an angle. This show's the dimension's direction. For further 
information on coordinate entry, see Function Keys>Direct Input (F8).

If "Display Dimension Line" is enabled:

5. Enter dimension line position
The position of the dimension line is determined by the position of a point through which it should 
run. If a particular distance has been entered, then the point shows the approximate position of the 
dimension line. This point can be entered using the mouse, by clicking anywhere in the drawing.

If the dimension line mode is set to "Full Length, Random", then this point also shows the start point 
of the dimension line and therefore the direction of any extension line.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 



polar coordinates can now be entered.
In addition, a length can be entered. This shows the distance between the dimension line and the 
length to be measured. During direct entry, a small arrow appears at the left of the status window. 
This shows the orientation for the length. If you enter a positive value, then the dimension line is 
moved in the direction of the arrow. If a negative value is entered, the dimension line is moved in the 
opposite direction. For further information on coordinate entry, see Function Keys>Direct Input (F8).

If "Display Dimension Line" is enabled and the dimension line mode is set to "Partial Length, Right 
Angled":

6. Enter dimension line end point
The dimension line's end point can be entered using the mouse, by clicking anywhere in the drawing. 
A perpendicular is dropped from this point to the dimension line to determine the end point of the 
dimension line.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, relative or polar coordinates can be entered. Relative values relate to the start point of the 
dimension line. For further information on coordinate entry, see Function Keys>Direct Input (F8).

If "Center Dimension Text" or "Close Dimension Text" is not set:

7. Enter dimension text position
The position of the dimension text can be entered using the mouse, by clicking anywhere in the 
drawing. The positioning of the dimension text can be restricted with the "Center Dimension Text" 
and "Close Dimension Text".

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

If "Rotate Dimension Text" is set:

8. Enter dimension text direction
The dimension text direction can be entered using the mouse, by clicking anywhere in the drawing. 
The location of this position relative to the dimension text position determines the dimension text's 
rotation angle.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, relative or polar coordinates can be entered.
In addition, it is possible to enter an angle. This shows the dimension text's rotation angle. For further 
information on coordinate entry, see Function Keys>Direct Input (F8).

After entering all the parameters, the measurement is made. If the "Tolerances" check box was enabled in 
the dimension parameters, then the Dimension and Tolerances dialog appears, in which the tolerances and
supplementary dimension text can be specified.

The dimension is not automatically assigned to the current layer. Instead, the command Layers>Defaults 
is used to decide whether they should be assigned to the current layer, or another specified layer. The 
same goes for pens, which can be assigned using the command Pens>Defaults.

Note: A dimension contains two sets of properties - one for the dimension line, and one for the dimension
text. For example, this makes it possible to show the dimension text in a different color to the dimension 



line. Or assign the dimension text to a different layer from the dimension line.
If the command Edit Properties is used on a dimension, you can change between the two sets of properties
using the icons in the dialog which appears, and view or alter both sets of properties separately.

Related commands:
Dimension>Length, Points
Dimension>Length, Object
Dimension>Distance, Object - Point
Dimension>Distance, Object - Object
Dimension>Arc Length, Points
Dimension>Arc Length, Circle Part
Calculate>Perimeter / Length



Dimension>Length, Object (Dimension Menu)
This command can be used to measure an existing individual line or an edge in an object.

1. Specify dimension parameters
After choosing the command, the Dimension With Line dialog appears, in which the dimension 
parameters can be specified. These parameters remain valid until either a new command is chosen or 
the current command is restarted using Restart Command (+ESC) or the key combination 
SHIFT+ESC.

2. Identify reference line
Any line in an existing object can be identified as the reference line. This can also be the edge of a 
rectangle or a leg of a circular segment.

To identify it, the line is clicked on with the mouse. If more than one line lies close to the position 
clicked on, a small dialog appears at the bottom of the screen, with the help of which the 'right' line 
can be chosen.

The position at which the reference line was identified (the ID point), affects the rest of the command.
It determines which end of the distance is used as the start point. The end point nearer to the ID point 
is always used.

After identifying the distance to be measured, the position of the dimension line and dimension text has to
be specified. To do this, several points have to be entered. How many, and which, points have to be 
entered, depends on the specified dimension parameters.

If "Display Dimension Line" is set and the dimension direction is set to "Any":

3. Enter dimension line direction
The dimension line direction is determined by a point which, together with the start point of the 
distance to be measured defines a straight line in whose direction the dimension should run. This 
point can be entered using the mouse, by clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, relative or polar coordinates can be entered.
In addition, it is possible to enter an angle. This show's the dimension's direction. For further 
information on coordinate entry, see Function Keys>Direct Input (F8).

If "Display Dimension Line" is enabled:

4. Enter dimension line position
The position of the dimension line is determined by the position of a point through which it should 
run. If a particular distance has been entered, then the point shows the approximate position of the 
dimension line. This point can be entered using the mouse, by clicking anywhere in the drawing.

If the dimension line mode is set to "Full Length, Random", then this point also shows the start point 
of the dimension line and therefore the direction of any extension line.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered.
In addition, a length can be entered. This shows the distance between the dimension line and the 
length to be measured. During direct entry, a small arrow appears at the left of the status window. 



This shows the orientation for the length. If you enter a positive value, then the dimension line is 
moved in the direction of the arrow. If a negative value is entered, the dimension line is moved in the 
opposite direction. For further information on coordinate entry, see Function Keys>Direct Input (F8).

If "Display Dimension Line" is enabled and the dimension line mode is set to "Partial Length, Right 
Angled":

5. Enter dimension line end point
The dimension line's end point can be entered using the mouse, by clicking anywhere in the drawing. 
A perpendicular is dropped from this point to the dimension line to determine the end point of the 
dimension line.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, relative or polar coordinates can be entered. Relative values relate to the start point of the 
dimension line. For further information on coordinate entry, see Function Keys>Direct Input (F8).

If "Center Dimension Text" or "Close Dimension Text" is not set:

6. Enter dimension text position
The position of the dimension text can be entered using the mouse, by clicking anywhere in the 
drawing. The positioning of the dimension text can be restricted with the "Center Dimension Text" 
and "Close Dimension Text".

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

If "Rotate Dimension Text" is set:

7. Enter dimension text direction
The dimension text direction can be entered using the mouse, by clicking anywhere in the drawing. 
The location of this position relative to the dimension text position determines the dimension text's 
rotation angle.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, relative or polar coordinates can be entered.
In addition, it is possible to enter an angle. This shows the dimension text's rotation angle. For further 
information on coordinate entry, see Function Keys>Direct Input (F8).

After entering all the parameters, the measurement is made. If the "Tolerances" check box was enabled in 
the dimension parameters, then the Dimension and Tolerances dialog appears, in which the tolerances and
supplementary dimension text can be specified.

The dimension is not automatically assigned to the current layer. Instead, the command Layers>Defaults 
is used to decide whether they should be assigned to the current layer, or another specified layer. The 
same goes for pens, which can be assigned using the command Pens>Defaults.

Note: A dimension contains two sets of properties - one for the dimension line, and one for the dimension
text. For example, this makes it possible to show the dimension text in a different color to the dimension 
line. Or assign the dimension text to a different layer from the dimension line.
If the command Edit Properties is used on a dimension, you can change between the two sets of properties
using the icons in the dialog which appears, and view or alter both sets of properties separately.



Related commands:
Dimension>Length, Points
Dimension>Distance, Object - Point
Dimension>Distance, Object - Object
Dimension>Arc Length, Points
Dimension>Arc Length, Circle Part
Calculate>Perimeter / Length



Dimension>Distance, Object - Point (Dimension Menu)
This command can be used to measure a distance defined as the distance between an object and a point.

1. Specify dimension parameters
After choosing the command, the Dimension With Line dialog appears, in which the dimension 
parameters can be specified. These parameters remain valid until either a new command is chosen or 
the current command is restarted using Restart Command (+ESC) or the key combination 
SHIFT+ESC.

During the measurement of distances, the measurement is parallel to the distance. The dimension 
line's direction setting is ignored.

2. Identify reference object
Any part object which is part of an existing object can be identified as a reference object. This can be 
the edge of a rectangle, the arc of an ellipse segment or a circular arc within a surface.
To identify a (part) object, click on it with the mouse. If more than one (part) object lies at the point 
clicked on, then a small dialog appears at the bottom of the screen, with the help of which the 'right' 
(part) object can be chosen.

If a circle or ellipse part is identified the point at which the object was identified (the ID point) affects
the rest of the command. If the distance from a point to a circle is being measured, then this distance 
can be calculated to either side of the circle. The point nearer the ID point is used as the end of the 
distance (see graphic).

3. Enter end point
The end point of the distance can be entered using the mouse, by clicking anywhere in the drawing. A 
perpendicular is dropped from this point to the reference object in order to work out the distance.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

After determining the distance to be measured, the position of the dimension line and dimension text must
be specified. To do this, several points have to be entered. How many, and which, points have to be 
entered, depends on the specified dimension parameters.

If "Display Dimension Line" is enabled:

4. Enter dimension line position
The position of the dimension line is determined by the position of a point through which it should 
run. If a particular distance has been entered, then the point shows the approximate position of the 
dimension line. This point can be entered using the mouse, by clicking anywhere in the drawing.



If the dimension line mode is set to "Full Length, Random", then this point also shows the start point 
of the dimension line and therefore the direction of any extension line.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered.
In addition, a length can be entered. This shows the distance between the dimension line and the 
length to be measured. During direct entry, a small arrow appears at the left of the status window. 
This shows the orientation for the length. If you enter a positive value, then the dimension line is 
moved in the direction of the arrow. If a negative value is entered, the dimension line is moved in the 
opposite direction. For further information on coordinate entry, see Function Keys>Direct Input (F8).

If "Display Dimension Line" is enabled and the dimension line mode is set to "Partial Length, Right 
Angled":

5. Enter dimension line end point
The dimension line's end point can be entered using the mouse, by clicking anywhere in the drawing. 
A perpendicular is dropped from this point to the dimension line to determine the end point of the 
dimension line.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, relative or polar coordinates can be entered. Relative values relate to the start point of the 
dimension line. For further information on coordinate entry, see Function Keys>Direct Input (F8).

If "Center Dimension Text" or "Close Dimension Text" is not set:

6. Enter dimension text position
The position of the dimension text can be entered using the mouse, by clicking anywhere in the 
drawing. The positioning of the dimension text can be restricted with the "Center Dimension Text" 
and "Close Dimension Text".

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

If "Rotate Dimension Text" is set:

7. Enter dimension text direction
The dimension text direction can be entered using the mouse, by clicking anywhere in the drawing. 
The location of this position relative to the dimension text position determines the dimension text's 
rotation angle.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, relative or polar coordinates can be entered.
In addition, it is possible to enter an angle. This shows the dimension text's rotation angle. For further 
information on coordinate entry, see Function Keys>Direct Input (F8).

After entering all the parameters, the measurement is made. If the "Tolerances" check box was enabled in 
the dimension parameters, then the Dimension and Tolerances dialog appears, in which the tolerances and
supplementary dimension text can be specified.

The dimension is not automatically assigned to the current layer. Instead, the command Layers>Defaults 



is used to decide whether they should be assigned to the current layer, or another specified layer. The 
same goes for pens, which can be assigned using the command Pens>Defaults.

Note: A dimension contains two sets of properties - one for the dimension line, and one for the dimension
text. For example, this makes it possible to show the dimension text in a different color to the dimension 
line. Or assign the dimension text to a different layer from the dimension line.
If the command Edit Properties is used on a dimension, you can change between the two sets of properties
using the icons in the dialog which appears, and view or alter both sets of properties separately.

Related commands:
Dimension>Length, Points
Dimension>Length, Object
Dimension>Distance, Object - Object
Dimension>Arc Length, Points
Dimension>Arc Length, Circle Part
Calculate>Perimeter / Length



Dimension>Distance, Object - Object (Dimension Menu)
This command can be used to measure a distance defined as the space between two objects.

1. Specify dimension parameters
After choosing the command, the Dimension With Line dialog appears, in which the dimension 
parameters can be specified. These parameters remain valid until either a new command is chosen or 
the current command is restarted using Restart Command (+ESC) or the key combination 
SHIFT+ESC.

During the measurement of distances, the measurement is parallel to the distance. The dimension 
line's direction setting is ignored.

2. Identify reference object 1
Any partial object in an existing object can be identified as the first reference object. This can be an 
edge of a rectangle or a circular arc within a surface. Ellipses and ellipse parts can not be identified.
To identify a (part) object, click on it with the mouse. If more than one (part) object lies at the point 
clicked on, then a small dialog appears at the bottom of the screen, with the help of which the 'right' 
(part) object can be chosen.

If a circle or circle part is identified, then the position at which it was identified (the ID point) affects 
the rest of the command. See the graphics below.

3. Identify reference object 2
Any partial object in an existing object can be identified as the first reference object. This can be an 
edge of a rectangle or a circular arc within a surface. Ellipses and ellipse parts can not be identified.
To identify a (part) object, click on it with the mouse. If more than one (part) object lies at the point 
clicked on, then a small dialog appears at the bottom of the screen, with the help of which the 'right' 
(part) object can be chosen.

If a circle or circle part is identified, then the position at which it was identified (the ID point) affects 
the rest of the command. The two ID points determine which of the two possible distances will be 
used (see graphics).

After determining the distance to be measured, the position of the dimension line and dimension text must
be specified. To do this, several points have to be entered. How many, and which, points have to be 



entered, depends on the specified dimension parameters.

If "Display Dimension Line" is enabled:

4. Enter dimension line position
The position of the dimension line is determined by the position of a point through which it should 
run. If a particular distance has been entered, then the point shows the approximate position of the 
dimension line. This point can be entered using the mouse, by clicking anywhere in the drawing.

If the dimension line mode is set to "Full Length, Random", then this point also shows the start point 
of the dimension line and therefore the direction of any extension line.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered.
In addition, a length can be entered. This shows the distance between the dimension line and the 
length to be measured. During direct entry, a small arrow appears at the left of the status window. 
This shows the orientation for the length. If you enter a positive value, then the dimension line is 
moved in the direction of the arrow. If a negative value is entered, the dimension line is moved in the 
opposite direction. For further information on coordinate entry, see Function Keys>Direct Input (F8).

If "Display Dimension Line" is enabled and the dimension line mode is set to "Partial Length, Right 
Angled":

5. Enter dimension line end point
The dimension line's end point can be entered using the mouse, by clicking anywhere in the drawing. 
A perpendicular is dropped from this point to the dimension line to determine the end point of the 
dimension line.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, relative or polar coordinates can be entered. Relative values relate to the start point of the 
dimension line. For further information on coordinate entry, see Function Keys>Direct Input (F8).

If "Center Dimension Text" or "Close Dimension Text" is not set:

6. Enter dimension text position
The position of the dimension text can be entered using the mouse, by clicking anywhere in the 
drawing. The positioning of the dimension text can be restricted with the "Center Dimension Text" 
and "Close Dimension Text".

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

If "Rotate Dimension Text" is set:

7. Enter dimension text direction
The dimension text direction can be entered using the mouse, by clicking anywhere in the drawing. 
The location of this position relative to the dimension text position determines the dimension text's 
rotation angle.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, relative or polar coordinates can be entered.
In addition, it is possible to enter an angle. This shows the dimension text's rotation angle. For further 



information on coordinate entry, see Function Keys>Direct Input (F8).

After entering all the parameters, the measurement is made. If the "Tolerances" check box was enabled in 
the dimension parameters, then the Dimension and Tolerances dialog appears, in which the tolerances and
supplementary dimension text can be specified.

The dimension is not automatically assigned to the current layer. Instead, the command Layers>Defaults 
is used to decide whether they should be assigned to the current layer, or another specified layer. The 
same goes for pens, which can be assigned using the command Pens>Defaults.

Note: A dimension contains two sets of properties - one for the dimension line, and one for the dimension
text. For example, this makes it possible to show the dimension text in a different color to the dimension 
line. Or assign the dimension text to a different layer from the dimension line.
If the command Edit Properties is used on a dimension, you can change between the two sets of properties
using the icons in the dialog which appears, and view or alter both sets of properties separately.

Related commands:
Dimension>Length, Points
Dimension>Length, Object
Dimension>Distance, Object - Point
Dimension>Arc Length, Points
Dimension>Arc Length, Circle Part
Calculate>Perimeter / Length



Dimension>Radius, Points (Dimension Menu)
This command can be used to measure the radius of a circle whose center point and radius are directly 
entered. Radiuses whose reference circle is not present in the form of an object can also be measured.

1. Specify dimension parameters
After choosing the command, the Dimension With Line dialog appears, in which the dimension 
parameters can be specified. These parameters remain valid until either a new command is chosen or 
the current command is restarted using Restart Command (+ESC) or the key combination 
SHIFT+ESC.

2. Enter center point
The center of the reference circle can be entered using the mouse, by clicking anywhere in the 
drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

3. Enter radius
The radius of the reference circle can be entered with the mouse by clicking anywhere in the drawing 
at a point through which the circle should run.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, relative or polar coordinates can be entered.
It is also possible to enter the radius directly. This shows the radius of the reference circle. For further 
information on coordinate entry, see Function Keys>Direct Input (F8).

After specifying the reference circle to be measured, the position of the dimension line and the dimension 
text must be specified. To do this, several points have to be entered. How many, and which, points have to
be entered, depends on the specified dimension parameters.

If "Display Dimension Line" is set and the dimension direction is set to "Any":

4. Enter dimension line direction
The direction of the dimension line is determined by a point which, together with the center point of 
the reference circle, defines a straight line in whose direction the dimension runs. This point can be 
entered using the mouse, by clicking anywhere in the drawing.

If the dimension line mode is set to "Partial Length, Right Angled", this point also determines which 
side of the reference circle the dimension line should appear on (see graphic).

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 



absolute, relative or polar coordinates can be entered.
In addition, it is possible to enter an angle. This show's the dimension's direction. For further 
information on coordinate entry, see Function Keys>Direct Input (F8).

If "Display Dimension Line" is enabled:

5. Enter dimension line position
The position of the dimension line is determined by the position of a point through which it should 
run. If a particular distance has been entered, then the point shows the approximate position of the 
dimension line. This point can be entered using the mouse, by clicking anywhere in the drawing.

If the dimension line mode is set to "Partial Length, Right Angled", then this point shows the end 
point of the dimension line. A perpendicular is dropped from this point to the dimension line to work 
out the end point.

If the dimension line mode is set to "Full Length, Random", then this point also shows the start point 
of the dimension line and therefore the direction of any extension line.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered.
If the dimension line mode is not "Partial Length, Right Angled", it is possible to enter a length. This 
shows the distance between the dimension line and the length to be measured. During direct entry, a 
small arrow appears at the left of the status window. This shows the orientation for the length. If you 
enter a positive value, then the dimension line is moved in the direction of the arrow. If a negative 
value is entered, the dimension line is moved in the opposite direction. For further information on 
coordinate entry, see Function Keys>Direct Input (F8).

If "Center Dimension Text" or "Close Dimension Text" is not set:

6. Enter dimension text position
The position of the dimension text can be entered using the mouse, by clicking anywhere in the 
drawing. The positioning of the dimension text can be restricted with the "Center Dimension Text" 
and "Close Dimension Text".

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

If "Rotate Dimension Text" is set:

7. Enter dimension text direction
The dimension text direction can be entered using the mouse, by clicking anywhere in the drawing. 
The location of this position relative to the dimension text position determines the dimension text's 
rotation angle.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, relative or polar coordinates can be entered.
In addition, it is possible to enter an angle. This shows the dimension text's rotation angle. For further 
information on coordinate entry, see Function Keys>Direct Input (F8).

After entering all the parameters, the measurement is made. If the "Tolerances" check box was enabled in 
the dimension parameters, then the Dimension and Tolerances dialog appears, in which the tolerances and



supplementary dimension text can be specified. An R appears in front of the text.

The dimension is not automatically assigned to the current layer. Instead, the command Layers>Defaults 
is used to decide whether they should be assigned to the current layer, or another specified layer. The 
same goes for pens, which can be assigned using the command Pens>Defaults.

Note: A dimension contains two sets of properties - one for the dimension line, and one for the dimension
text. For example, this makes it possible to show the dimension text in a different color to the dimension 
line. Or assign the dimension text to a different layer from the dimension line.
If the command Edit Properties is used on a dimension, you can change between the two sets of properties
using the icons in the dialog which appears, and view or alter both sets of properties separately.

Related commands:
Dimension>Radius, Object
Dimension>Diameter, Points
Dimension>Diameter, Object



Dimension>Radius, Object (Dimension Menu)
This command can be used to measure the radius of a circle which exists on its own or as part of an 
object's edge.

1. Specify dimension parameters
After choosing the command, the Dimension With Line dialog appears, in which the dimension 
parameters can be specified. These parameters remain valid until either a new command is chosen or 
the current command is restarted using Restart Command (+ESC) or the key combination 
SHIFT+ESC.

2. Identify reference circle
Any circle which exists separately or as part of another object can be identified as the reference 
object. This can also be the arc of a circle segment or a circular arc within a surface.
To identify a (part) object, click on it with the mouse. If more than one (part) object lies at the point 
clicked on, then a small dialog appears at the bottom of the screen, with the help of which the 'right' 
(part) object can be chosen.

After selecting the reference circle to measure, the position of the dimension line and the dimension text 
must be specified. To do this, several points have to be entered. How many, and which, points have to be 
entered, depends on the specified dimension parameters.

If "Display Dimension Line" is set and the dimension direction is set to "Any":

3. Enter dimension line direction
The direction of the dimension line is determined by a point which, together with the center point of 
the reference circle, defines a straight line in whose direction the dimension runs. This point can be 
entered using the mouse, by clicking anywhere in the drawing.

If the dimension line mode is set to "Partial Length, Right Angled", this point also determines which 
side of the reference circle the dimension line should appear on (see graphic).

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, relative or polar coordinates can be entered.
In addition, it is possible to enter an angle. This show's the dimension's direction. For further 
information on coordinate entry, see Function Keys>Direct Input (F8).

If "Display Dimension Line" is enabled:

4. Enter dimension line position
The position of the dimension line is determined by the position of a point through which it should 
run. If a particular distance has been entered, then the point shows the approximate position of the 
dimension line. This point can be entered using the mouse, by clicking anywhere in the drawing.



If the dimension line mode is set to "Partial Length, Right Angled", then this point shows the end 
point of the dimension line. A perpendicular is dropped from this point to the dimension line to work 
out the end point.

If the dimension line mode is set to "Full Length, Random", then this point also shows the start point 
of the dimension line and therefore the direction of any extension line.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered.
If the dimension line mode is not "Partial Length, Right Angled", it is possible to enter a length. This 
shows the distance between the dimension line and the length to be measured. During direct entry, a 
small arrow appears at the left of the status window. This shows the orientation for the length. If you 
enter a positive value, then the dimension line is moved in the direction of the arrow. If a negative 
value is entered, the dimension line is moved in the opposite direction. For further information on 
coordinate entry, see Function Keys>Direct Input (F8).

If "Center Dimension Text" or "Close Dimension Text" is not set:

5. Enter dimension text position
The position of the dimension text can be entered using the mouse, by clicking anywhere in the 
drawing. The positioning of the dimension text can be restricted with the "Center Dimension Text" 
and "Close Dimension Text".

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

If "Rotate Dimension Text" is set:

6. Enter dimension text direction
The dimension text direction can be entered using the mouse, by clicking anywhere in the drawing. 
The location of this position relative to the dimension text position determines the dimension text's 
rotation angle.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, relative or polar coordinates can be entered.
In addition, it is possible to enter an angle. This shows the dimension text's rotation angle. For further 
information on coordinate entry, see Function Keys>Direct Input (F8).

After entering all the parameters, the measurement is made. If the "Tolerances" check box was enabled in 
the dimension parameters, then the Dimension and Tolerances dialog appears, in which the tolerances and
supplementary dimension text can be specified. An R appears in front of the text.

The dimension is not automatically assigned to the current layer. Instead, the command Layers>Defaults 
is used to decide whether they should be assigned to the current layer, or another specified layer. The 
same goes for pens, which can be assigned using the command Pens>Defaults.

Note: A dimension contains two sets of properties - one for the dimension line, and one for the dimension
text. For example, this makes it possible to show the dimension text in a different color to the dimension 
line. Or assign the dimension text to a different layer from the dimension line.
If the command Edit Properties is used on a dimension, you can change between the two sets of properties



using the icons in the dialog which appears, and view or alter both sets of properties separately.

Related commands:
Dimension>Radius, Points
Dimension>Diameter, Points
Dimension>Diameter, Object



Dimension>Diameter, Points (Dimension Menu)
This command can be used to measure the diameter of a circle whose center and radius are entered 
directly. This can also be used to measure a diameter whose reference circle is not present in the form of 
an object.

1. Specify dimension parameters
After choosing the command, the Dimension With Line dialog appears, in which the dimension 
parameters can be specified. These parameters remain valid until either a new command is chosen or 
the current command is restarted using Restart Command (+ESC) or the key combination 
SHIFT+ESC.

2. Enter center point
The center of the reference circle can be entered using the mouse, by clicking anywhere in the 
drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

3. Enter radius
The radius of the reference circle can be entered with the mouse by clicking anywhere in the drawing 
at a point through which the circle should run.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, relative or polar coordinates can be entered.
It is also possible to enter the radius directly. This shows the radius of the reference circle. For further 
information on coordinate entry, see Function Keys>Direct Input (F8).

After specifying the reference circle to be measured, the position of the dimension line and the dimension 
text must be specified. To do this, several points have to be entered. How many, and which, points have to
be entered, depends on the specified dimension parameters.

If "Display Dimension Line" is set and the dimension direction is set to "Any":

4. Enter dimension line direction
The direction of the dimension line is determined by a point which, together with the center point of 
the reference circle, defines a straight line in whose direction the dimension runs. This point can be 
entered using the mouse, by clicking anywhere in the drawing.

If the dimension line mode is set to "Partial Length, Right Angled", this point also determines which 
side of the reference circle the dimension line should appear on (see graphic).



Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, relative or polar coordinates can be entered.
In addition, it is possible to enter an angle. This show's the dimension's direction. For further 
information on coordinate entry, see Function Keys>Direct Input (F8).

If "Display Dimension Line" is enabled:

5. Enter dimension line position
The position of the dimension line is determined by the position of a point through which it should 
run. If a particular distance has been entered, then the point shows the approximate position of the 
dimension line. This point can be entered using the mouse, by clicking anywhere in the drawing.
If the dimension line mode is set to "Partial Length, Right Angled", then this point shows the end 
point of the dimension line. A perpendicular is dropped from this point to the dimension line to work 
out the end point.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered.
If the dimension line mode is not "Partial Length, Right Angled", it is possible to enter a length. This 
shows the distance between the dimension line and the length to be measured. During direct entry, a 
small arrow appears at the left of the status window. This shows the orientation for the length. If you 
enter a positive value, then the dimension line is moved in the direction of the arrow. If a negative 
value is entered, the dimension line is moved in the opposite direction. For further information on 
coordinate entry, see Function Keys>Direct Input (F8).

If "Center Dimension Text" or "Close Dimension Text" is not set:

6. Enter dimension text position
The position of the dimension text can be entered using the mouse, by clicking anywhere in the 
drawing. The positioning of the dimension text can be restricted with the "Center Dimension Text" 
and "Close Dimension Text".

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

If "Rotate Dimension Text" is set:

7. Enter dimension text direction
The dimension text direction can be entered using the mouse, by clicking anywhere in the drawing. 
The location of this position relative to the dimension text position determines the dimension text's 
rotation angle.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, relative or polar coordinates can be entered.
In addition, it is possible to enter an angle. This shows the dimension text's rotation angle. For further 
information on coordinate entry, see Function Keys>Direct Input (F8).

After entering all the parameters, the measurement is made. If the "Tolerances" check box was enabled in 
the dimension parameters, then the Dimension and Tolerances dialog appears, in which the tolerances and
supplementary dimension text can be specified. An "Ø" symbol is placed in front of the dimension text.

The dimension is not automatically assigned to the current layer. Instead, the command Layers>Defaults 



is used to decide whether they should be assigned to the current layer, or another specified layer. The 
same goes for pens, which can be assigned using the command Pens>Defaults.

Note: A dimension contains two sets of properties - one for the dimension line, and one for the dimension
text. For example, this makes it possible to show the dimension text in a different color to the dimension 
line. Or assign the dimension text to a different layer from the dimension line.
If the command Edit Properties is used on a dimension, you can change between the two sets of properties
using the icons in the dialog which appears, and view or alter both sets of properties separately.

Related commands:
Dimension>Radius, Points
Dimension>Radius, Object
Dimension>Diameter, Object



Dimension>Diameter, Object (Dimension Menu)
This command can be used to measure the diameter of a circle which exists independently or as part of an
object's edge.

1. Specify dimension parameters
After choosing the command, the Dimension With Line dialog appears, in which the dimension 
parameters can be specified. These parameters remain valid until either a new command is chosen or 
the current command is restarted using Restart Command (+ESC) or the key combination 
SHIFT+ESC.

2. Identify reference circle
Any circle which exists separately or as part of another object can be identified as the reference 
object. This can also be the arc of a circle segment or a circular arc within a surface.
To identify a (part) object, click on it with the mouse. If more than one (part) object lies at the point 
clicked on, then a small dialog appears at the bottom of the screen, with the help of which the 'right' 
(part) object can be chosen.

After selecting the reference circle to measure, the position of the dimension line and the dimension text 
must be specified. To do this, several points have to be entered. How many, and which, points have to be 
entered, depends on the specified dimension parameters.

If "Display Dimension Line" is set and the dimension direction is set to "Any":

3. Enter dimension line direction
The direction of the dimension line is determined by a point which, together with the center point of 
the reference circle, defines a straight line in whose direction the dimension runs. This point can be 
entered using the mouse, by clicking anywhere in the drawing.

If the dimension line mode is set to "Partial Length, Right Angled", this point also determines which 
side of the reference circle the dimension line should appear on (see graphic).

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, relative or polar coordinates can be entered.
In addition, it is possible to enter an angle. This show's the dimension's direction. For further 
information on coordinate entry, see Function Keys>Direct Input (F8).

If "Display Dimension Line" is enabled:

4. Enter dimension line position
The position of the dimension line is determined by the position of a point through which it should 
run. If a particular distance has been entered, then the point shows the approximate position of the 
dimension line. This point can be entered using the mouse, by clicking anywhere in the drawing.



If the dimension line mode is set to "Partial Length, Right Angled", then this point shows the end 
point of the dimension line. A perpendicular is dropped from this point to the dimension line to work 
out the end point.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered.
If the dimension line mode is not "Partial Length, Right Angled", it is possible to enter a length. This 
shows the distance between the dimension line and the length to be measured. During direct entry, a 
small arrow appears at the left of the status window. This shows the orientation for the length. If you 
enter a positive value, then the dimension line is moved in the direction of the arrow. If a negative 
value is entered, the dimension line is moved in the opposite direction. For further information on 
coordinate entry, see Function Keys>Direct Input (F8).

If "Center Dimension Text" or "Close Dimension Text" is not set:

5. Enter dimension text position
The position of the dimension text can be entered using the mouse, by clicking anywhere in the 
drawing. The positioning of the dimension text can be restricted with the "Center Dimension Text" 
and "Close Dimension Text".

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

If "Rotate Dimension Text" is set:

6. Enter dimension text direction
The dimension text direction can be entered using the mouse, by clicking anywhere in the drawing. 
The location of this position relative to the dimension text position determines the dimension text's 
rotation angle.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, relative or polar coordinates can be entered.
In addition, it is possible to enter an angle. This shows the dimension text's rotation angle. For further 
information on coordinate entry, see Function Keys>Direct Input (F8).

After entering all the parameters, the measurement is made. If the "Tolerances" check box was enabled in 
the dimension parameters, then the Dimension and Tolerances dialog appears, in which the tolerances and
supplementary dimension text can be specified. An "Ø" symbol is placed in front of the dimension text.

The dimension is not automatically assigned to the current layer. Instead, the command Layers>Defaults 
is used to decide whether they should be assigned to the current layer, or another specified layer. The 
same goes for pens, which can be assigned using the command Pens>Defaults.

Note: A dimension contains two sets of properties - one for the dimension line, and one for the dimension
text. For example, this makes it possible to show the dimension text in a different color to the dimension 
line. Or assign the dimension text to a different layer from the dimension line.
If the command Edit Properties is used on a dimension, you can change between the two sets of properties
using the icons in the dialog which appears, and view or alter both sets of properties separately.

Related commands:



Dimension>Radius, Points
Dimension>Radius, Object
Dimension>Diameter, Points



Dimension>Angle, Points (Dimension Menu)
This command can be used to measure an angle specified by entering the ends of two legs. This can also 
be used to measure angles which are not formed by existing object edges.

1. Specify dimension parameters
After choosing the command, the Dimension With Line dialog appears, in which the dimension 
parameters can be specified. These parameters remain valid until either a new command is chosen or 
the current command is restarted using Restart Command (+ESC) or the key combination 
SHIFT+ESC.

2. Enter start point of leg 1
The dimension line's start point can be entered using the mouse, by clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

3. Enter end point of leg 1
The dimension line's end point can be entered using the mouse, by clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, relative or polar coordinates can be entered. Relative values relate to the previously entered 
start point. For further information on coordinate entry, see Function Keys>Direct Input (F8).

4. Enter start point of leg 2
The dimension line's start point can be entered using the mouse, by clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

5. Enter end point of leg 2
The dimension line's end point can be entered using the mouse, by clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, relative or polar coordinates can be entered. Relative values relate to the previously entered 
start point. For further information on coordinate entry, see Function Keys>Direct Input (F8).

The position of the start and end points of the legs determines which of the possible angles should be 
measured. In general, the legs are treated like straight lines, i.e. extended endlessly in both directions. 
This means that there must be an intersection (if the legs are parallel, an angle cannot be measured).

The direction of the two legs (imagine it as an arrow from the start point to the end point) shows which of
the two lines from the intersection is used as the limit of the angle (see the following graphic).



After entering the legs of the angle to be measured, the position of the dimension line and the dimension 
text must be specified. To do this, several points have to be entered. How many, and which, points have to
be entered, depends on the specified dimension parameters.

If "Display Dimension Line" is enabled:

6. Enter dimension line position
The position of the dimension line is determined by the position of a point through which it should 
run. If a particular distance has been entered, then the point shows the approximate position of the 
dimension line. This point can be entered using the mouse, by clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered.
It is also possible to enter the radius directly. This shows the radius of the dimension line. For further 
information on coordinate entry, see Function Keys>Direct Input (F8).

If "Center Dimension Text" or "Close Dimension Text" is not set:

7. Enter dimension text position
The position of the dimension text can be entered using the mouse, by clicking anywhere in the 
drawing. The positioning of the dimension text can be restricted with the "Center Dimension Text" 
and "Close Dimension Text".

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

If "Rotate Dimension Text" is set:

8. Enter dimension text direction
The dimension text direction can be entered using the mouse, by clicking anywhere in the drawing. 
The location of this position relative to the dimension text position determines the dimension text's 
rotation angle.



Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, relative or polar coordinates can be entered.
In addition, it is possible to enter an angle. This shows the dimension text's rotation angle. For further 
information on coordinate entry, see Function Keys>Direct Input (F8).

After entering all the parameters, the measurement is made. If the "Tolerances" check box was enabled in 
the dimension parameters, then the Dimension and Tolerances dialog appears, in which the tolerances and
supplementary dimension text can be specified. The "°" symbol is added after the dimension text.

The dimension is not automatically assigned to the current layer. Instead, the command Layers>Defaults 
is used to decide whether they should be assigned to the current layer, or another specified layer. The 
same goes for pens, which can be assigned using the command Pens>Defaults.

Note: A dimension contains two sets of properties - one for the dimension line, and one for the dimension
text. For example, this makes it possible to show the dimension text in a different color to the dimension 
line. Or assign the dimension text to a different layer from the dimension line.
If the command Edit Properties is used on a dimension, you can change between the two sets of properties
using the icons in the dialog which appears, and view or alter both sets of properties separately.

Related commands:
Dimension>Angle, Line - Line
Dimension>Angle, Circle Part



Dimension>Angle, Line - Line (Dimension Menu)
This command can be used to measure an angle shown by the position of two legs. It can be used to 
measure angles formed by existing objects.

1. Specify dimension parameters
After choosing the command, the Dimension With Line dialog appears, in which the dimension 
parameters can be specified. These parameters remain valid until either a new command is chosen or 
the current command is restarted using Restart Command (+ESC) or the key combination 
SHIFT+ESC.

2. Identify reference line 1
Any line in an existing object can be identified as the first reference line (first leg). This can also be 
the edge of a rectangle or a leg of a circular segment.

To identify it, the line is clicked on with the mouse. If more than one line lies close to the position 
clicked on, a small dialog appears at the bottom of the screen, with the help of which the 'right' line 
can be chosen.

The position at which the reference line was identified (the ID point), affects the rest of the command.
It determines which of the possible angles should be measured. See the graphics below.

3. Identify reference line 2
Any line in an existing object can be identified as the second reference line (second leg). This can 
also be the edge of a rectangle or a leg of a circular segment.

To identify it, the line is clicked on with the mouse. If more than one line lies close to the position 
clicked on, a small dialog appears at the bottom of the screen, with the help of which the 'right' line 
can be chosen.

The position at which the reference line was identified (the ID point), affects the rest of the command.
It determines which of the possible angles should be measured. See the following graphics.



The position of the ID point with reference to each leg shows which angle is measured.

After selecting the legs for the angle to be measured, the positions of the dimension line and the 
dimension text must be specified. To do this, several points have to be entered. How many, and which, 
points have to be entered, depends on the specified dimension parameters.

If "Display Dimension Line" is enabled:

4. Enter dimension line position
The position of the dimension line is determined by the position of a point through which it should 
run. If a particular distance has been entered, then the point shows the approximate position of the 
dimension line. This point can be entered using the mouse, by clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered.
It is also possible to enter the radius directly. This value shows the radius for the dimension line. For 
further information on coordinate entry, see Function Keys>Direct Input (F8).

If "Center Dimension Text" or "Close Dimension Text" is not set:

5. Enter dimension text position
The position of the dimension text can be entered using the mouse, by clicking anywhere in the 
drawing. The positioning of the dimension text can be restricted with the "Center Dimension Text" 
and "Close Dimension Text".

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

If "Rotate Dimension Text" is set:

6. Enter dimension text direction
The dimension text direction can be entered using the mouse, by clicking anywhere in the drawing. 
The location of this position relative to the dimension text position determines the dimension text's 
rotation angle.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, relative or polar coordinates can be entered.
In addition, it is possible to enter an angle. This shows the dimension text's rotation angle. For further 
information on coordinate entry, see Function Keys>Direct Input (F8).

After entering all the parameters, the measurement is made. If the "Tolerances" check box was enabled in 
the dimension parameters, then the Dimension and Tolerances dialog appears, in which the tolerances and
supplementary dimension text can be specified. The "°" symbol is added after the dimension text.

The dimension is not automatically assigned to the current layer. Instead, the command Layers>Defaults 
is used to decide whether they should be assigned to the current layer, or another specified layer. The 
same goes for pens, which can be assigned using the command Pens>Defaults.

Note: A dimension contains two sets of properties - one for the dimension line, and one for the dimension
text. For example, this makes it possible to show the dimension text in a different color to the dimension 
line. Or assign the dimension text to a different layer from the dimension line.



If the command Edit Properties is used on a dimension, you can change between the two sets of properties
using the icons in the dialog which appears, and view or alter both sets of properties separately.

Related commands:
Dimension>Angle, Points
Dimension>Angle, Circle Part



Dimension>Angle, Circle Part (Dimension Menu)
This command can be used to measure the opening angle of an existing circle part.

1. Specify dimension parameters
After choosing the command, the Dimension With Line dialog appears, in which the dimension 
parameters can be specified. These parameters remain valid until either a new command is chosen or 
the current command is restarted using Restart Command (+ESC) or the key combination 
SHIFT+ESC.

2. Identify reference circle part
Any circle part in an existing object (Circular arc, sector or segment) can be identified as the 
reference circle part. This can also be a circular arc within a curve or a curved dimension line.

To identify a circle part, click on it with the mouse. If more than one circle part lies at the point 
clicked on, then a small dialog appears at the bottom of the screen, with the help of which the 'right' 
circle part can be selected.

After selecting the circle part and therefore the angle to be measured, the position of the dimension line 
and the dimension text must be specified. To do this, several points have to be entered. How many, and 
which, points have to be entered, depends on the specified dimension parameters.

If "Display Dimension Line" is enabled:

3. Enter dimension line position
The position of the dimension line is determined by the position of a point through which it should 
run. If a particular distance has been entered, then the point shows the approximate position of the 
dimension line. This point can be entered using the mouse, by clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered.
It is also possible to enter the radius directly. This value shows the radius for the dimension line. For 
further information on coordinate entry, see Function Keys>Direct Input (F8).

If "Center Dimension Text" or "Close Dimension Text" is not set:

4. Enter dimension text position
The position of the dimension text can be entered using the mouse, by clicking anywhere in the 
drawing. The positioning of the dimension text can be restricted with the "Center Dimension Text" 
and "Close Dimension Text".

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

If "Rotate Dimension Text" is set:

5. Enter dimension text direction
The dimension text direction can be entered using the mouse, by clicking anywhere in the drawing. 
The location of this position relative to the dimension text position determines the dimension text's 
rotation angle.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 



absolute, relative or polar coordinates can be entered.
In addition, it is possible to enter an angle. This shows the dimension text's rotation angle. For further 
information on coordinate entry, see Function Keys>Direct Input (F8).

After entering all the parameters, the measurement is made. If the "Tolerances" check box was enabled in 
the dimension parameters, then the Dimension and Tolerances dialog appears, in which the tolerances and
supplementary dimension text can be specified. The "°" symbol is added after the dimension text.

The dimension is not automatically assigned to the current layer. Instead, the command Layers>Defaults 
is used to decide whether they should be assigned to the current layer, or another specified layer. The 
same goes for pens, which can be assigned using the command Pens>Defaults.

Note: A dimension contains two sets of properties - one for the dimension line, and one for the dimension
text. For example, this makes it possible to show the dimension text in a different color to the dimension 
line. Or assign the dimension text to a different layer from the dimension line.
If the command Edit Properties is used on a dimension, you can change between the two sets of properties
using the icons in the dialog which appears, and view or alter both sets of properties separately.

Related commands:
Dimension>Angle, Points
Dimension>Angle, Line - Line



Dimension>Arc Length, Points (Dimension Menu)
This command can be used to measure the arc length of a circle part, shown by its center, radius, start and
end points. It can also be used to measure the length of arcs which are not part of an existing circle part.

1. Specify dimension parameters
After choosing the command, the Dimension With Line dialog appears, in which the dimension 
parameters can be specified. These parameters remain valid until either a new command is chosen or 
the current command is restarted using Restart Command (+ESC) or the key combination 
SHIFT+ESC.

2. Enter center point
The center of the reference circle part can be entered using the mouse, by clicking anywhere in the 
drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

3. Enter radius
The reference circle's radius can be entered with the mouse by clicking anywhere in the drawing at a 
point through which the rerence circle should run.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, relative or polar coordinates can be entered.
It is also possible to enter the radius directly. This shows the radius of the reference circle. For further 
information on coordinate entry, see Function Keys>Direct Input (F8).

4. Enter start angle
The reference circle part's start angle can be entered using the mouse, by clicking anywhere in the 
drawing. The position of this point relative to the center point determines the start angle.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, relative or polar coordinates can be entered.
In addition, it is possible to enter an angle. This shows the reference circle part's start angle. For 
further information on coordinate entry, see Function Keys>Direct Input (F8).

5. Enter end angle
The reference circle part's end angle can be entered using the mouse, by clicking anywhere in the 
drawing. The position of this point relative to the center point determines the end angle.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, relative or polar coordinates can be entered.
In addition, it is possible to enter an angle. This shows the reference circle part's end angle. The angle 
can also be given relative to a previously entered start point. For further information on coordinate 
entry, see Function Keys>Direct Input (F8).

The reference circle part's appearance is determined by the current arc direction. This is specified 
using the command Function Keys>Arc Direction (F2), with the F2 key or the button in the panel. If 
the arc direction is positive, the circle part is drawn from the start angle to the end angle in a 
mathematically positive (i.e. anticlockwise) direction. If the arc direction is negative, the circle part is 



drawn from the start angle to the end angle in a mathematically negative (i.e. clockwise) direction 
(see graphic).

The eventual appearance of the reference circle part is shown during entry, and changes if the arc 
direction is changed during entry.

After entering the circle part and the angle to be measured, the position of the dimension line and the 
dimension text must be specified. To do this, several points have to be entered. How many, and which, 
points have to be entered, depends on the specified dimension parameters.

If "Display Dimension Line" is enabled:

6. Enter dimension line position
The position of the dimension line is determined by the position of a point through which it should 
run. If a particular distance has been entered, then the point shows the approximate position of the 
dimension line. This point can be entered using the mouse, by clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered.
It is also possible to enter the radius directly. This value shows the radius for the dimension line. For 
further information on coordinate entry, see Function Keys>Direct Input (F8).

If "Center Dimension Text" or "Close Dimension Text" is not set:

7. Enter dimension text position
The position of the dimension text can be entered using the mouse, by clicking anywhere in the 
drawing. The positioning of the dimension text can be restricted with the "Center Dimension Text" 
and "Close Dimension Text".

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

If "Rotate Dimension Text" is set:

8. Enter dimension text direction
The dimension text direction can be entered using the mouse, by clicking anywhere in the drawing. 
The location of this position relative to the dimension text position determines the dimension text's 
rotation angle.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, relative or polar coordinates can be entered.
In addition, it is possible to enter an angle. This shows the dimension text's rotation angle. For further 
information on coordinate entry, see Function Keys>Direct Input (F8).

After entering all the parameters, the measurement is made. If the "Tolerances" check box was enabled in 
the dimension parameters, then the Dimension and Tolerances dialog appears, in which the tolerances and
supplementary dimension text can be specified.

The dimension is not automatically assigned to the current layer. Instead, the command Layers>Defaults 
is used to decide whether they should be assigned to the current layer, or another specified layer. The 



same goes for pens, which can be assigned using the command Pens>Defaults.

Note: A dimension contains two sets of properties - one for the dimension line, and one for the dimension
text. For example, this makes it possible to show the dimension text in a different color to the dimension 
line. Or assign the dimension text to a different layer from the dimension line.
If the command Edit Properties is used on a dimension, you can change between the two sets of properties
using the icons in the dialog which appears, and view or alter both sets of properties separately.

Related commands:
Dimension>Arc Length, Circle Part
Calculate>Perimeter / Length



Dimension>Arc Length, Circle Part (Dimension Menu)
This command can be used to measure the arc length of an existing circle part.

1. Specify dimension parameters
After choosing the command, the Dimension With Line dialog appears, in which the dimension 
parameters can be specified. These parameters remain valid until either a new command is chosen or 
the current command is restarted using Restart Command (+ESC) or the key combination 
SHIFT+ESC.

2. Identify reference circle part
Any circle part (arc, segment or sector) which exists can be identified. This can also be a circular arc 
within a curve or a curved dimension line.

To identify a circle part, click on it with the mouse. If more than one circle part lies at the point 
clicked on, then a small dialog appears at the bottom of the screen, with the help of which the 'right' 
circle part can be selected.

After identifying the circle par and with it the angle to be measured, the position of the dimension line 
and the dimension text must be specified. To do this, several points have to be entered. How many, and 
which, points have to be entered, depends on the specified dimension parameters.

If "Display Dimension Line" is enabled:

3. Enter dimension line position
The position of the dimension line is determined by the position of a point through which it should 
run. If a particular distance has been entered, then the point shows the approximate position of the 
dimension line. This point can be entered using the mouse, by clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered.
It is also possible to enter the radius directly. This value shows the radius for the dimension line. For 
further information on coordinate entry, see Function Keys>Direct Input (F8).

If "Center Dimension Text" or "Close Dimension Text" is not set:

4. Enter dimension text position
The position of the dimension text can be entered using the mouse, by clicking anywhere in the 
drawing. The positioning of the dimension text can be restricted with the "Center Dimension Text" 
and "Close Dimension Text".

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

If "Rotate Dimension Text" is set:

5. Enter dimension text direction
The dimension text direction can be entered using the mouse, by clicking anywhere in the drawing. 
The location of this position relative to the dimension text position determines the dimension text's 
rotation angle.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 



absolute, relative or polar coordinates can be entered.
In addition, it is possible to enter an angle. This shows the dimension text's rotation angle. For further 
information on coordinate entry, see Function Keys>Direct Input (F8).

After entering all the parameters, the measurement is made. If the "Tolerances" check box was enabled in 
the dimension parameters, then the Dimension and Tolerances dialog appears, in which the tolerances and
supplementary dimension text can be specified.

The dimension is not automatically assigned to the current layer. Instead, the command Layers>Defaults 
is used to decide whether they should be assigned to the current layer, or another specified layer. The 
same goes for pens, which can be assigned using the command Pens>Defaults.

Note: A dimension contains two sets of properties - one for the dimension line, and one for the dimension
text. For example, this makes it possible to show the dimension text in a different color to the dimension 
line. Or assign the dimension text to a different layer from the dimension line.
If the command Edit Properties is used on a dimension, you can change between the two sets of properties
using the icons in the dialog which appears, and view or alter both sets of properties separately.

Related commands:
Dimension>Arc Length, Points
Calculate>Perimeter / Length



Dimension>Coordinates (Dimension Menu)
This command can be used to measure the coordinates of a point.

1. Specify dimension parameters
After choosing the command, the Dimension Without Line dialog appears, in which the dimension 
parameters can be specified. These parameters remain valid until either a new command is chosen or 
the current command is restarted using Restart Command (+ESC) or the key combination 
SHIFT+ESC.

2. Enter reference point
The reference point whose dimensions are to be measured can be entered using the mouse, by 
clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

After entering the reference point, the position of the dimension text must be specified. To do this, one or 
two points (depending on the dimension parameters) must be entered.

3. Enter dimension text position
The position of the dimension text can be entered using the mouse, by clicking anywhere in the 
drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

If "Rotate Dimension Text" is set:

4. Enter dimension text direction
The dimension text direction can be entered using the mouse, by clicking anywhere in the drawing. 
The location of this position relative to the dimension text position determines the dimension text's 
rotation angle.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, relative or polar coordinates can be entered.
In addition, it is possible to enter an angle. This shows the dimension text's rotation angle. For further 
information on coordinate entry, see Function Keys>Direct Input (F8).

After entering all the parameters, the measurement is made. If the "Tolerances" check box was enabled in 
the dimension parameters, then the Coordinates and Tolerances dialog appears, in which the tolerances 
and supplementary dimension text can be specified. A "(" appears in font of the text, a "/" in front of the 
mid text and a ")" after the text.

The dimension is not automatically assigned to the current layer. Instead, the command Layers>Defaults 
is used to decide whether they should be assigned to the current layer, or another specified layer. The 
same goes for pens, which can be assigned using the command Pens>Defaults.

Related Command:



No Related Command



Calculate>Area (Dimension Menu)
This command can be used to calculate the surface area of several selected objects and insert the value as 
a dimension. The surfaces are calculated once, and the total is then saved in a scale-independent form. 
The dimension is adapted to the current scale.

1. Specify dimension parameters
After choosing the command, the Dimension Without Line dialog appears, in which the dimension 
parameters can be specified. These parameters remain valid until either a new command is chosen or 
the current command is restarted using Restart Command (+ESC) or the key combination 
SHIFT+ESC.

2. Choose objects
The objects whose surfaces are to be calculated and added together have to be chosen. Any number of
objects can be chosen. Various methods, which can be used together, can be used:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

After choosing the objects, their surface areas are calculated. Complex objects with Bézier curves and 
ellipse parts must first be converted to polylines. The accuracy of the conversion can be set using the 
command Settings>Screen, "Accuracy - Transform" section.

The position of the dimension text must be specified. To do this, one or two points (depending on the 
dimension parameters) must be entered.

3. Enter dimension text position
The position of the dimension text can be entered using the mouse, by clicking anywhere in the 
drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).



If "Rotate Dimension Text" is set:

4. Enter dimension text direction
The dimension text direction can be entered using the mouse, by clicking anywhere in the drawing. 
The location of this position relative to the dimension text position determines the dimension text's 
rotation angle.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, relative or polar coordinates can be entered.
In addition, it is possible to enter an angle. This shows the dimension text's rotation angle. For further 
information on coordinate entry, see Function Keys>Direct Input (F8).

After entering all the parameters, the measurement is made. If the "Tolerances" check box was enabled in 
the dimension parameters, then the Dimension and Tolerances dialog appears, in which the tolerances and
supplementary dimension text can be specified. The surface symbol appears in front of the text.

The dimension is not automatically assigned to the current layer. Instead, the command Layers>Defaults 
is used to decide whether they should be assigned to the current layer, or another specified layer. The 
same goes for pens, which can be assigned using the command Pens>Defaults.

Related Command:
Calculate>Perimeter / Length



Calculate>Perimeter / Length (Dimension Menu)
This command can be used to measure the perimeters and side lengths of several selected objects and 
insert the value as a dimension. The perimeters and lengths are calculated once and the result is saved in a
scale-independent form. The dimension displayed adapts to the scale in use.

1. Specify dimension parameters
After choosing the command, the Dimension Without Line dialog appears, in which the dimension 
parameters can be specified. These parameters remain valid until either a new command is chosen or 
the current command is restarted using Restart Command (+ESC) or the key combination 
SHIFT+ESC.

2. Choose objects
The objects whose perimeters and lengths are to be calculated and added together have to be chosen. 
Any number of objects can be chosen. Various methods, which can be used together, can be used:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

After choosing the objects their extent is calculated. Complex objects like Bézier curves and ellipses must
first be converted to polylines. The accuracy of the conversion can be set using the command 
Settings>Screen, "Accuracy - Transform" section.

The position of the dimension text must be specified. To do this, one or two points (depending on the 
dimension parameters) must be entered.

3. Enter dimension text position
The position of the dimension text can be entered using the mouse, by clicking anywhere in the 
drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).



If "Rotate Dimension Text" is set:

4. Enter dimension text direction
The dimension text direction can be entered using the mouse, by clicking anywhere in the drawing. 
The location of this position relative to the dimension text position determines the dimension text's 
rotation angle.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, relative or polar coordinates can be entered.
In addition, it is possible to enter an angle. This shows the dimension text's rotation angle. For further 
information on coordinate entry, see Function Keys>Direct Input (F8).

After entering all the parameters, the measurement is made. If the "Tolerances" check box was enabled in 
the dimension parameters, then the Dimension and Tolerances dialog appears, in which the tolerances and
supplementary dimension text can be specified.

The dimension is not automatically assigned to the current layer. Instead, the command Layers>Defaults 
is used to decide whether they should be assigned to the current layer, or another specified layer. The 
same goes for pens, which can be assigned using the command Pens>Defaults.

Related commands:
Dimension>Length, Object
Dimension>Arc Length, Circle Part
Calculate>Area



Dimension Parameters (Dimension Menu)
This command can be used to set the general dimension parameters. These parameters are valid for all 
types of measurement. They are changed from the Dimension Parameters dialog.

These parameters are applied to all new measurements. To alter the dimension properties of existing 
measurements, use the command Edit Properties.

Affected commands:
Dimension>Length, Points
Dimension>Length, Object
Dimension>Distance, Object - Point
Dimension>Distance, Object - Object
Dimension>Radius, Points
Dimension>Radius, Object
Dimension>Diameter, Points
Dimension>Diameter, Object
Dimension>Angle, Points
Dimension>Angle, Line Line
Dimension>Angle, Circle Part
Dimension>Arc Length, Points
Dimension>Arc Length, Circle Part
Dimension>Coordinates
Calculate>Area
Calculate>Perimeter / Length



Edit Dimension Line>Rotate (Dimension Menu)
This command can be used to draw alter the direction of an existing measurement. If there is one, the 
dimension line will be rotated accordingly.

1. Identify measurement object
Any measurement object can be identified. Objects are identified by clicking on them. If more than 
one object lies at the point clicked on, then the correct object can be selected with the help of a small 
dialog which appears at the bottom of the screen.

2. Enter dimension line direction
The new dimension line direction is determined by a point which, together with the start point of the 
dimension defines a straight line in the direction of which the dimension should run. This point can be
entered using the mouse, by clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, relative or polar coordinates can be entered.
In addition, it is possible to enter an angle. This show's the dimension's direction. For further 
information on coordinate entry, see Function Keys>Direct Input (F8).

If the duplicate function is active during the entry of the last point (e.g. because the CTRL key is held 
down), the dimension object is copied, and the copy (not the original) is altered.

After entering the new dimension line direction the measured object is adapted accordingly; the 
dimension line direction mode is set to "Any".

Related commands:
Edit Dimension Line>Position
Edit Dimension>Rotate
Edit Dimension>Position



Edit Dimension Line>Position (Dimension Menu)
This command can be used to change the position or length of an existing dimension line.

1. Identify measurement object
Any measurement object can be identified. Objects are identified by clicking on them. If more than 
one object lies at the point clicked on, then the correct object can be selected with the help of a small 
dialog which appears at the bottom of the screen.

2. Enter dimension line position
The new dimension line position is determined by a point through which it should run. If the 
dimension line mode of the selected object is set to "Partial Length, Right Angled", then the point 
shows the end point of the dimension line.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered.
If the dimension line mode is not "Partial Length, Right Angled", it is possible to enter a length. This 
shows how much the dimension line should be moved by. During direct entry, a small arrow appears 
at the left of the status window. This shows the orientation for the length. If you enter a positive value,
then the dimension line is moved in the direction of the arrow. If a negative value is entered, the 
dimension line is moved in the opposite direction. For further information on coordinate entry, see 
Function Keys>Direct Input (F8).

If the duplicate function is active during the entry of the last point (e.g. because the CTRL key is held 
down), a copy of the measurement object is made and the copy (not the original) is moved

After entering the new dimension line position, the object is adapted correspondingly; the dimension line 
distance mode is set to "Any".

Related commands:
Edit Dimension Line>Rotate
Edit Dimension>Rotate
Edit Dimension>Position



Edit Dimension>Rotate (Dimension Menu)
This command can be used to alter the rotation of an existing dimension text.

1. Identify measurement object
Any measurement object can be identified. Objects are identified by clicking on them. If more than 
one object lies at the point clicked on, then the correct object can be selected with the help of a small 
dialog which appears at the bottom of the screen.

4. Enter dimension text direction
The dimension text direction can be entered using the mouse, by clicking anywhere in the drawing. 
The location of this position relative to the dimension text position determines the dimension text's 
rotation angle.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, relative or polar coordinates can be entered.
In addition, it is possible to enter an angle. This shows the dimension text's rotation angle. For further 
information on coordinate entry, see Function Keys>Direct Input (F8).

If the duplicate function is active during the entry of the last point (e.g. because the CTRL key is held 
down), a copy of the measurement object is made and the copy (not the original) is moved.

After entering the new dimension text position, the measurement object is rotated accordingly. The 
dimension text mode is set to "Rotated".

Related commands:
Edit Dimension>Position
Edit Dimension>Update
Edit Dimension Line>Rotate
Edit Dimension Line>Position



Edit Dimension>Position (Dimension Menu)
This command can be used to draw alter the position of an existing piece of dimension text.

1. Identify measurement object
Any measurement object can be identified. Objects are identified by clicking on them. If more than 
one object lies at the point clicked on, then the correct object can be selected with the help of a small 
dialog which appears at the bottom of the screen.

2. Enter dimension text position
The dimension text's new position is determined by entering a point which shows the mid point of the
text base line. This point can be entered using the mouse, by clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

If the duplicate function is active during the entry of the last point (e.g. because the CTRL key is held 
down), the object itself is not altered, but a copy is made and the copy is altered.

After entering the new dimension text position, the measurement object is adapted correspondingly and, if
set, the "Close" and "Centered" dimension text modes are cleared.

Related commands:
Edit Dimension>Rotate
Edit Dimension>Update
Edit Dimension Line>Rotate
Edit Dimension Line>Position



Edit Dimension>Update (Dimension Menu)
This command can be used to recalculate selected measurements, altering the dimension text, for example
to adapt them to a new scale or coordinate system.

1. Choose dimension texts
The dimension objects whose dimensions should be recalculated are chosen. Any number of objects 
can be chosen. Various methods, which can be used together, can be used:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

After choosing the objects to be measured, their dimensions are recalculated and inserted. This happens 
whether the "Adapt" dimension text mode is active or not.

Note: The "Adapt" dimension text mode is not altered by this command. If dimension texts should be 
recalculated automatically from now on, the command Edit Properties should be used to enable the 
"Adapt" dimension text mode.

Related commands:
Edit Dimension>Rotate
Edit Dimension>Position
Edit Dimension Line>Rotate
Edit Dimension Line>Position



Fonts (Dimension Menu)
This command can be used to set the font parameters. In addition, Tek Illustrator's own fonts can be 
loaded into or removed from memory. To do this, the Fonts dialog appears.

The actions chosen in this dialog are carried out when the dialog is closed by clicking on OK. Afterwards,
the drawing windows are redrawn.

Note: The list of loaded fonts is saved permanently. All fonts which are loaded when the program is 
exited, are automatically loaded when the program is next started.

Related Command:
Libraries



Text>Single Line (Dimension Menu)
This command can be used to generate a single line of text. It can have up to 250 characters, in a single 
line. Carriage returns within the text will be ignored.

1. Enter single line text
After choosing the command, the Enter Single Line Text dialog appears in which the text can be 
entered and its parameters can be specified. The text and parameters remain valid either until a new 
command is chosen or the current command is restarted using the command Restart Command 
(+ESC) or the key combination SHIFT+ESC.

2. Enter position
The text position can be entered using the mouse, by clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

The text generated is not automatically assigned to the current layer. Instead, the command 
Layers>Defaults is used to decide whether they should be assigned to the current layer, or another 
specified layer. The same goes for pens, which can be assigned using the command Pens>Defaults.

Related Command:
Text>Multiple Lines



Text>Multiple Lines (Dimension Menu)
This command can be used to enter multiple line text. A piece of text can consist of up to 8000 characters 
split into multiple lines. A rectangle, which can be rotated and scaled, is specified for the text to go into.

1. Area: Enter corner point 1
The first corner point of the text area can be entered using the mouse, by clicking anywhere in the 
drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

2. Area: Enter corner point 2
The second corner point of the text area can be entered using the mouse, by clicking anywhere in the 
drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Now 
absolute, relative or polar coordinates can be entered. Relative values relate to the previously entered 
first corner point. For further information on coordinate entry, see Function Keys>Direct Input (F8).

3. Enter multiple line text
After specifying the text area, the Enter Multiple Line Text dialog appears where the text can be 
entered and its parameters can be specified.

The text generated is not automatically assigned to the current layer. Instead, the command 
Layers>Defaults is used to decide whether they should be assigned to the current layer, or another 
specified layer. The same goes for pens, which can be assigned using the command Pens>Defaults.

Note: The text area is defined internally by three points, which span a parallelogram. If one of the points 
is moved (e.g. using Move Single Point), then the text adapts itself accordingly.
The alteration only affects the way in which the individual lines of text run. The text size is not altered, 
and the characters are not distorted. The following diagram shows the effect of moving the definition 
point.



Related Command:
Text>Single Line



Text>Resolve (Dimension Menu)
This command can be used to resolve a text object into individual characters. The characters are 
converted into curves or surfaces. This is true for both Tek Illustrator's own fonts and TrueType fonts.

1. Choose texts
The text objects who should be resolved are chosen. Any number of objects can be chosen. Various 
methods, which can be used together, can be used:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

If the duplicate function is active when the objects are chosen, a copy of the text objects is made, and the 
copy (not the originals) is erased.

Note: Characters converted to surfaces require significantly more memory than the original text. A single 
line of text in a complicated font can be over 100K in size when converted. Apart from the increase in 
required memory, the conversion results in screen redraws taking longer; the text can also no longer be 
edited. It is only necessary to convert text to surfaces if individual characters have to be manipulated.

If serious problems arise when sending TrueType fonts to a particular output device, then they can, at the 
same time, be converted to surfaces for screen display and/or printing (see the "TrueType always as 
surface" checkbox in the dialogs Display Settings and Output Settings). The objects themselves are 
unchanged by these settings and can still be edited. In addition, the memory requirement does not 
increase.

Related Command:
Group>Ungroup
Trim Object>Resolve Completely
Resolve Instances



Hatch Objects>Union (A+B) (Dimension Menu)
This command can be used to hatch a surface defined by the union of two object groups, A and B.

The first group, which can be empty, consists of the currently selected objects (Group A). The second 
group is chosen each time (Group B). Each of the two groups is is handled as one surface, i.e. the objects 
in each group are combined first.

1. Choose objects
The objects which are to make up group B for hatching purposes must be chosen. Various methods, 
which can be used together, can be used:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

After choosing the objects, the union surface of both object groups is hatched. Only those objects in the 
group which have a closed outline and thus form a surface are regarded. The hatching type chosen with 
the command Hatch Objects>Hatching Type is used.

The hatching consists of one or more "hatching" objects. These objects are not automatically assigned to 
the current layer. Instead, the command Layers>Defaults is used to decide whether they should be 
assigned to the current layer, or another specified layer. The pen assignments from the current hatching 
type are used.

Related commands:
Hatch Objects>Intersection (A×B)
Hatch Objects>Difference (A-B)



Hatch Objects>Intersection (A×B) (Dimension Menu)
This command can be used to hatch a surface defined by the intersection of two groups of objects, A and 
B.

The first group, which cannot be empty, consists of the currently selected objects (Group A). The second 
group is chosen each time (Group B). Each of the two groups is handled as one surface, i.e. the objects in 
each group are combined first.

1. Choose objects
The objects which are to make up group B for hatching purposes must be chosen. Various methods, 
which can be used together, can be used:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

After choosing the objects, the surface defined by the intersection of the objects is hatched. Only those 
objects in the group which have a closed outline and thus form a surface are regarded. The hatching type 
chosen with the command Hatch Objects>Hatching Type is used.

If no object is selected, then the operation cannot be carried out. A warning message appears and the 
command is canceled.

The hatching consists of one or more "hatching" objects. These objects are not automatically assigned to 
the current layer. Instead, the command Layers>Defaults is used to decide whether they should be 
assigned to the current layer, or another specified layer. The pen assignments from the current hatching 
type are used.

Related commands:
Hatch Objects>Union (A+B)
Hatch Objects>Difference (A-B)



Hatch Objects>Difference (A-B) (Dimension Menu)
This command can be used to hatch a suffice composed of the difference between object group A and 
object group B.

The first group, which cannot be empty, consists of the currently selected objects (group A). The second 
group is chosen each time (group B). Each of the two groups is handled as one surface, i.e. the objects in 
each group are combined first.

1. Choose objects
The objects which are to make up group B for hatching purposes must be chosen. Various methods, 
which can be used together, can be used:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

After selecting the objects, the surface made of the difference between them is hatched. Only those 
objects in the group which have a closed outline and thus form a surface are regarded. The hatching type 
chosen with the command Hatch Objects>Hatching Type is used.

If no object is selected, then the operation cannot be carried out. A warning message appears and the 
command is canceled.

The hatching consists of one or more "hatching" objects. These objects are not automatically assigned to 
the current layer. Instead, the command Layers>Defaults is used to decide whether they should be 
assigned to the current layer, or another specified layer. The pen assignments from the current hatching 
type are used.

Related commands:
Hatch Objects>Union (A+B)
Hatch Objects>Intersection (A×B)



Hatch Objects>Hatching Type (Dimension Menu)
This command can be used to manage hatching types. They can be defined, edited, deleted or made 
current.

To do this, the Hatching Types dialog appears. The hatching type selected when this dialog is closed 
becomes the current hatching type.

Affected commands:
Hatch Objects>Union (A+B)
Hatch Objects>Intersection (A×B)
Hatch Objects>Difference (A-B)
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Symbol / Block
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Create (Insertion Point)
Create (Frame)
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Edit Attributes
Generate Parts List
Clean Up Blocks
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Replace Library
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Symbol Window

Display Parameters
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Save As
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Save as Default

Display Symbol Window
Save Symbol Window on Exit



Symbol / Block>Insert (Library Menu)
This command can be used to insert an instance of a symbol or block into a drawing. Instances of 
symbols which are not currently in memory can be created. These will (as long as automatic library 
loading is enabled) be loaded automatically.

1. Choose symbol / block
After choosing this command the Symbol / Block>Insert dialog appears, where the symbol or block 
to insert can be chosen. The choice of symbol and parameters remains active until either a new 
command is chosen or the current command is canceled or restarted using Restart command (+ESC) 
or the key combination SHIFT +ESC.

After closing the dialog by clicking on "OK", a rectangle with a cross through it appears at the crosshair 
intersection. The rectangle represents the symbol to be inserted. It is already rotated and sized according 
to the chosen settings.

2. Specify the position
The point at which the symbol or block is inserted is chosen by clicking the mouse at any chosen 
point within the drawing.

Optionally, precise coordinates can be specified. To do this, press the F8 or the ENTER key. You can 
specify absolute or polar coordinates in the dialog which appears. For information about entering 
coordinates, refer to Function Keys>Direct Input (F8).

After specifying the insertion point, an instance of the chosen symbol or block is created. If the "Edit" 
check box in the "Local Attributes" section has been enabled, the Define Attributes dialog appears in 
which the local attributes of the instance can be edited. If this dialog is closed by clicking on the "Cancel"
button, the instance is still created. The alterations to the attributes will however be ignored.

The instance which is generated will not automatically be assigned to the current layer. Instead, the 
command Layers>Defaults is used to decide whether they should be assigned to the current layer, or 
another specified layer. The instance is drawn using the current pen and the appearance of the instanced 
symbol is not changed.

Note: An instance of a symbol cannot be displayed if the relevant symbol is not in memory. If, at a later 
time, this is not the case (e.g. because the relevant library is not available), a text in the form 
(Library Name)Symbol Name is shown. The instance itself can however be manipulated as usual. 
Local attributes can be edited and commands like copying, rotating and scaling work as normal. As soon 
as the symbol is available again, the instance is displayed again.
If a drawing is going to be given to someone who does not have the library, all symbols should be 
converted to blocks (see Symbols to Blocks).

Related commands:
Symbol / Block>Create (Insertion Point)
Symbol / Block>Create (Frame)



Symbol / Block>Create (Insertion Point) (Library Menu)
This command can be used to create a new symbol or block. After selecting the objects and instances 
which are to make up the symbol or block, an insertion point is entered.

1. Choose objects
The objects and instances which are to make up the new symbol or block are chosen. Any number of 
objects can be chosen. There are several ways of doing this, which can be combined with one another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

2. Enter reference point
The symbol or block's insertion point can be entered using the mouse, by clicking anywhere in the 
drawing.

The insertion point should be placed at a distinct place in the symbol, e.g. at the end point of a line or 
the corner point of a rectangle.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

After entering the insertion point, the Generate Symbol / Block dialog appears, in which the name of the 
symbol or block to be generated can be entered. In addition, some parameters can be specified. After 
closing the dialog by clicking on "OK", the symbol or block is generated.

If the "Edit Attributes" check box is enabled in the parameters dialog, then the Define Attributes dialog 
appears, in which the local and global attributes of the symbol or block can be edited. If this dialog is 
closed with the "Cancel" button, the symbol or block is still generated! The alterations to the attributes 
will however be ignored.

If the "Edit Properties" check box in the parameters dialog is enabled, then the Extended Properties dialog



appears, in which the properties of the symbol or block can be edited. If this dialog is closed with the 
"Cancel" button, the symbol or block is still generated! The alterations to the properties will however be 
ignored.

Note: Symbols and blocks may themselves contain instances of other symbols, blocks and groups. This 
makes it possible, for example, to create components made up of components from several symbols from 
different libraries. There are however two restrictions, which should help avoid problems.:

Blocks and groups cannot be used in symbols! This would make the symbol, and the 
whole library dependent on the drawing which contains the block or group.

The maximum number of layers which can be nested is 10. Deeper nestings are possible, 
but they will not be displayed. If a circular reference is accidentally created (Symbol X contains an 
instance of Y, Symbol Y contains an instance of X), this is the same as an unending nesting and the 
symbols will not be displayed.
In general, the use of nesting within libraries should be avoided if possible. They make the library more 
difficult to maintain and less clear.

Related commands:
Symbol / Block>Insert
Symbol / Block>Create (Frame)
Group>Create Group



Symbol / Block>Create (Frame) (Library Menu)
This command can be used to create a new symbol or block. After selecting the objects and instances 
which should make up the symbol or block, an area which specifies the extent of the symbol is entered

It is only necessary to generate symbols using a frame if the symbol is to be used as a character in a Tek 
Illustrator font.

1. Choose objects
The objects and instances which are to make up the new symbol or block are chosen. Any number of 
objects can be chosen. There are several ways of doing this, which can be combined with one another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

2. Area: Enter corner point 1
The first corner point of the area can be entered using the mouse, by clicking anywhere in the 
drawing. This corner point also shows the symbol/block's insertion point.

This must be the left limit on the baseline of a character (see graphic). This point does not have to be 
on the frame surrounding the symbol.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered. For further information on coordinate entry, see Function 



Keys>Direct Input (F8).

3. Area: Enter corner point 2
The area's second corner point can be entered using the mouse, by clicking anywhere in the drawing.

For a font character, this point should be the right limit of the character at the height of a capital A 
(ascend line, see graphic). This point does not have to be on the frame surrounding the symbol.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute, 
relative or polar coordinates can now be entered. Relative coordinates relate to the first corner point. 
For further information on coordinate entry, see Function Keys>Direct Input (F8).

After entering the area, the Generate Symbol / Block dialog appears, in which the name of the symbol or 
block to be generated can be entered. In addition, some parameters can be specified. After closing the 
dialog by clicking on "OK", the symbol or block is generated.

If the "Edit Attributes" check box is enabled in the parameters dialog, then the Define Attributes, in which
the local and global attributes of the symbol or block can be edited. If this dialog is closed with the 
"Cancel" button, the symbol or block is still generated! The alterations to the attributes will however be 
ignored.

If the "Edit Properties" check box in the parameters dialog is enabled, then the Extended Properties dialog
appears, in which the properties of the symbol or block can be edited. If this dialog is closed with the 
"Cancel" button, the symbol or block is still generated! The alterations to the properties will however be 
ignored.

Note: Symbols and blocks may themselves contain instances of other symbols, blocks and groups. This 
makes it possible, for example, to create components made up of components from several symbols from 
different libraries. There are however two restrictions, which should help avoid problems.

Blocks and groups cannot be used in symbols! This would make the symbol, and the 
whole library dependent on the drawing which contains the block or group.

The maximum number of layers which can be nested is 10. Deeper nestings are possible, 
but they will not be displayed. If a circular reference is accidentally created (Symbol X contains an 
instance of Y, Symbol Y contains an instance of X), this is the same as an unending nesting and the 
symbols will not be displayed.
In general, the use of nesting within libraries should be avoided if possible. They make the library more 
difficult to maintain and less clear.

Related commands:
Symbol / Block>Insert
Symbol / Block>Create (Insertion Point)



Group>Create Group



Symbol / Block>Edit (Library Menu)
This command can be used to edit symbols, blocks and folders. They can be deleted, copied and renamed 
and in addition the attributes and properties of individual symbols and blocks can be edited. This is done 
from the Edit Symbol / Block dialog.

The operations carried out in this dialog take immediate effect on the symbols and blocks in memory and 
can not be undone (there is no "Cancel" button). Be very careful when using this command!

Important: Symbols or blocks deleted with this command can not be recovered using Undo. If symbols 
are accidentally deleted, the libraries which are affected should be updated using the Libraries command, 
without previously saving the changes.

Related commands:
Edit Attributes
Symbols to Blocks
Replace Symbol / Block
Replace Library



Edit Attributes (Library Menu)
This command can be used to edit the local attributes of a selected instance. This is also possible if the 
corresponding symbol is not currently in memory.

1. Identify instance
To identify the instance, click on the outline of the symbol. If more than one instance lies close to the 
point clicked on, a small dialog appears at the bottom of the screen , with the help of which the "right"
instance can be selected.

After the instance has been selected, the Define Attributes dialog appears, in which the instance's local 
attributes can be edited.

Note: If the symbol on which the instance is based is in memory, then the global attributes of the symbol 
will also be displayed, but they will not be editable.

Related Command:
Generate Parts List



Generate Parts List (Library Menu)
This command can be used to generate a parts list. A parts list is a tabular list of local, global and implicit 
attributes defined in blocks and instances in the current drawing as well as the currently-loaded libraries. 
To do this, the dialog    Generate Parts List appears, in which the parameters for the parts list can be 
specified.

Note: A parts list can also be generated if neither global nor local attributes have been defined. Each 
instance has its own implied attributes (symbol name, library name, position etc.), which are always 
available, and these can be used to generate a parts list.

Related Command:
Edit Attributes



Clean Up Blocks (Library Menu)
This command clears up the blocks in the current drawing. This means that all the blocks which are 
currently defined but not in use are deleted.

Before this command is carried out, you are asked for confirmation, to avoid the accidental deletion of 
blocks.

Groups are not deleted by this command, even though they are a special type of block. Groups are cleared
out when drawings are loaded and saved.

Important: Blocks deleted with this command can not be recovered using Undo. If blocks are 
accidentally removed they can usually be restored from the last-saved version of the drawing using the 
command Merge Drawing>Other Elements.

Related Command:
No Related Command



Symbols to Blocks (Library Menu)
This command converts symbols currently used in the drawing to blocks. The Convert Symbols dialog 
appears, in which the symbols to be converted and whether instances of those symbols can be specified.

If a drawing which makes use of symbols from libraries is to be given to someone who does not have 
those libraries, then there can be problems. Instances which refer to those symbols cannot be created and 
the drawing is useless.

If however the symbols are converted to blocks, the drawing can still be used. The advantages of 
instances (low memory use and changeability) are retained.

Note: The original symbols are unchanged, new blocks are however created. Conversion of symbols to 
blocks can not be undone using Undo. The adaptation of the instances can however be undone.

Related commands:
Symbol / Block>Edit
Replace Symbol / Block
Replace Library



Resolve Instances (Library Menu)
This command can resolve instances of symbols and blocks. This means that the objects from which the 
symbols or blocks are made up are inserted into the drawing instead of the instance.

All the settings in the instance (position, rotation angle, scaling, inheritance of properties) are kept, so that
the newly created objects can be differentiated from the original objects which made up the 
symbol/block).

Note: This command cannot be used to resolve groups. This must be done using the Group>Ungroup 
command.

1. Choose instances
Those instances to be resoled are chosen. Any number of objects can be chosen, all other objects as 
instances are ignored. Choosing can take place in various ways which can be combined with one 
another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

After choosing, the instances are resolved. Only one layer is resolved at a time. If the symbols/blocks 
which the selected instances refer to contain other instances, then they are not resolved. If need be, this 
must be done in a second step.

If the duplicate function is active while the objects are chosen, the chosen instances are copied and the 
copy is resolved.

If there are no instances among the selected objects, then a warning appears. If all the instances in the 
object are to be resolved, this can be done by pressing the F10 Key to select all objects, choosing the 
command and repeating the process until the warning appears.

Note: Some objects can not be distorted. These are, above all, circles and circle parts, but also curves and 
surfaces which contain circular arcs. If an instance which is to be resolved contains such an onject in 



distorted form, then the circles and circle parts are converted to ellipses and ellipse parts during 
resolution.
Circular arcs within curves and surfaces can not be transformed. This leads, unavoidably, to problems in 
the display.

Related commands:
Group>Ungroup
Trim Objects>Resolve Completely
Text>Resolve



Replace Symbol / Block (Library Menu)
This command replaces instances of particular symbols or blocks with other instances. This is done by 
altering the reference contained in the instance. The display parameters (Position, rotation angle, scaling) 
and the local attributes of the instance remain unchanged.

The Replace Symbol / Block dialog appears, in which you can specify which symbol is to replaced by 
which other symbol.

Note: As only instances are affected by this command, the substitution can be undone using the Undo 
command

Related commands:
Symbols to Blocks
Replace Library
Edit Properties



Replace Library (Library Menu)
This command replaces instances of symbols from one library (or blocks) with instances of identically 
named symbols from another library (or blocks). This is done by altering the reference contained in the 
instance. The display parameters (Position, rotation angle, scaling) and the local attributes of the instance 
remain unchanged.

The Replace Library dialog appears where you can specify which library is to be replaced by which other 
library.

This replacement can only be successful if both libraries contain identically named symbols. If this is not 
the case, the references in the instances are changed and may point to a non-existent symbol. The program
does not check this beforehand!

Note: As only instances are affected by this command, the substitution can be undone using the Undo 
command

Related commands:
Symbols to Blocks
Replace Symbol / Block
Edit Properties



Libraries (Library Menu)
This command can be used to set the library parameters. In addition, libraries can be loaded, saved, 
updated or removed from memory. This is done from the Libraries dialog.

The actions specified in this dialog are carried out as soon as the "OK" button is clicked on. After this, all 
the drawing windows are redrawn.

Note: The list of loaded libraries will be permanently saved. All libraries which are loaded when the 
program is closed will be automatically loaded when the program is next started. Symbols from libraries 
which use the cache are not initially loaded.

Related Command:
Fonts



Symbol Window>Display Parameters (Library Menu)
This command can be used to set the symbol window's display parameters. This is done from the Symbol 
Window Parameters dialog

The alterations take effect as soon as the dialog is closed by clicking on "OK". If the sort mode was 
changed, the buttons are sorted. If displayed, the symbol window is then redrawn.

Affected command:
No directly affected command



Symbol Window>Open (Library Menu)
This command can be used to open an existing symbol list file, i.e. load it into memory and activate it. A 
File Selection Dialog appears, from which the file to be loaded can be chosen.

Note: Symbol list files store not only the symbol window button assignments but also their display 
parameters. (see Symbol Window>Display Parameters).

Related commands:
Symbol Window>Save As
Symbol Window>Save as Default
Save Symbol Window on Exit



Symbol Window>Save As (Library Menu)
This command can be used to save the symbol window's current assignments in a symbol list file. It can 
then be loaded and activated again later.

A File Selection Dialog appears in which the name of the symbol list file where the settings are to be 
saved appears, followed by the Details dialog where the symbol list file details can be changed.

Note: Symbol list files store not only the symbol window button assignments but also their display 
parameters. (see Symbol Window>Display Parameters).

Related commands:
Symbol Window>Open
Symbol Window>Save as Default
Save Symbol Window on Exit



Symbol Window>Details (Library Menu)
This command can be used to view and alter the details of the current symbol list file. This is done from 
the Details dialog.

Related Command:
Symbol Window>Save As



Symbol Window>Save as Default (Library Menu)
This command can be used to save the current symbol window allocations as the default. This means that 
the current allocation will be automatically loaded and activated the next time the program is started.

The current settings are saved in the file TSTEK3.SYM (or, in multi user mode in user dependent files 
with the name -??????-.SYM). If the file already exists, a warning dialog appears, to help prevent 
accidental overwriting of existing default settings.

Note: Symbol list files store not only the symbol window button assignments but also their display 
parameters. (see Symbol Window>Display Parameters).

Related commands:
Symbol Window>Open
Symbol Window>Save As
Save Symbol Window on Exit



Display Symbol Window (Library Menu)
This command turns display of the Symbol Window on or off.

Note: The symbol window's status is saved permanently. In multi user mode, the settings are saved in 
user dependent files.

Related commands:
Display Status Window
Display Toolbox
Settings>Screen



Save Symbol Window on Exit (Library Menu)
This command can be used to specify that the current symbol window allocation should be saved as the 
default when the program is closed. These allocations will then be loaded and activated when the program
is restarted.

The current symbol window assignments are saved in the file TSTEK3.SYM when the program is exited 
(in multi-user mode, the assignments are saved in the user dependent -???????-.SYM files).

Note: This function has been included because of customer demand. However we recommend that you do
not use it; instead use the command Symbol Window>Save as Default if it is necessary to save the 
assignments. Using this function usually results in the permanent saving of unwanted changes.

Related commands:
Symbol Window>Open
Symbol Window>Save As
Symbol Window>Save as Default



Extra Menu
Select

Identification
Complete

Deselect
Identification
Complete

Invert
Identification
Complete

Conditional Selection
Identification
Complete

Conditional Deselection
Identification
Complete

Snap Modes
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Quadrant
Edge
Corner / End-Point
Intersection
Geometry
Marking
Other Point
Snap Radius

Function Keys
Previous Point (ESC)
Restart Command (+ESC)
Help (F1)
Arc Direction (F2)
Display Grid (F3)
Position Grid (F4)
Area Mode (F5)
Snap (F6)
Duplicate (F7)
Direct Input (F8)
Geometry (F9)
Identify all Objects (F10)
Previous Identification (F11)
Identify Selected Objects (F12)

Control Keys
Window Refresh (SPACE)
Left Mouse Button
Middle Mouse Button
Right Mouse Button
Menu Keys (ALT)
Step Left (ARROWLEFT)



Step Right (ARROWRIGHT)
Step Up (ARROWUP)
Step Down (ARROWDOWN)
Page Left (HOME)
Page Right (END)
Page Up (PAGEUP)
Page Down (PAGEDOWN)
Edit Step



Select>Identification (Extra Menu)
This command can be used to select several specified objects.

Selection has two uses: Firstly, a group of objects can be semi-permanently marked. It can then be used 
later as the basis for object selection. This can be done with the F12 Key.

The selected group of objects can also be used as a second selected object alongside the normal, directly 
selected objects. This is the case with the commands Hatch Objects>Union (A+B), Hatch 
Objects>Intersection (A×B), Hatch Objects>Difference (A-B) and Multiple Copy>Markings.

1. Choose objects
The objects to be selected are chosen. Any number of objects can be chosen. This can be done using 
various methods which can be combined with one another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

The chosen objects are then included in the selection. The selection remains current until it is explicitly 
changed. However, selections are not saved with drawings and are therefore not available when a drawing
is opened.

Related commands:
Select>Complete
Deselect>Identification
Deselect>Complete
Invert>Identification
Invert>Complete
Conditional Selection>Identification
Conditional Selection>Complete
Conditional Deselection>Identification
Conditional Deselection>Complete





Select>Complete (Extra Menu)
This command can be used to select all objects in the drawing at the same time.

Selection has two uses: Firstly, a group of objects can be semi-permanently marked. It can then be used 
later as the basis for object selection. This can be done with the F12 Key.

The selected group of objects can also be used as a second selected object alongside the normal, directly 
selected objects. This is the case with the commands Hatch Objects>Union (A+B), Hatch 
Objects>Intersection (A×B), Hatch Objects>Difference (A-B) and Multiple Copy>Markings.

Related commands:
Select>Identification
Deselect>Identification
Deselect>Complete
Invert>Identification
Invert>Complete
Conditional Selection>Identification
Conditional Selection>Complete
Conditional Deselection>Identification
Conditional Deselection>Complete



Deselect>Identification (Extra Menu)
This command can be used to deselect multiple selected objects, previously selected using 
Select>Identification or Select>Complete.

Selection has two uses: Firstly, a group of objects can be semi-permanently marked. It can then be used 
later as the basis for object selection. This can be done with the F12 Key.

The selected group of objects can also be used as a second selected object alongside the normal, directly 
selected objects. This is the case with the commands Hatch Objects>Union (A+B), Hatch 
Objects>Intersection (A×B), Hatch Objects>Difference (A-B) and Multiple Copy>Markings.

1. Choose objects
The objects to be deselected are chosen. Any number of objects can be chosen. This can be done 
using various methods which can be combined with one another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

Next, the chosen objects are deselected.

Related commands:
Select>Identification
Select>Complete
Deselect>Complete
Invert>Identification
Invert>Complete
Conditional Selection>Identification
Conditional Selection>Complete
Conditional Deselection>Identification
Conditional Deselection>Complete



Deselect>Complete (Extra Menu)
This command can be used to deselect all objects in a drawing which were selected using 
Select>Identification or Select>Complete.

Selection has two uses: Firstly, a group of objects can be semi-permanently marked. It can then be used 
later as the basis for object selection. This can be done with the F12 Key.

The selected group of objects can also be used as a second selected object alongside the normal, directly 
selected objects. This is the case with the commands Hatch Objects>Union (A+B), Hatch 
Objects>Intersection (A×B), Hatch Objects>Difference (A-B) and Multiple Copy>Markings.

Related commands:
Select>Identification
Select>Complete
Deselect>Identification
Invert>Identification
Invert>Complete
Conditional Selection>Identification
Conditional Selection>Complete
Conditional Deselection>Identification
Conditional Deselection>Complete



Invert>Identification (Extra Menu)
This command can be used to invert the selection of multiple specified objects. Objects which were 
previously selected are deselected and vice versa.

Selection has two uses: Firstly, a group of objects can be semi-permanently marked. It can then be used 
later as the basis for object selection. This can be done with the F12 Key.

The selected group of objects can also be used as a second selected object alongside the normal, directly 
selected objects. This is the case with the commands Hatch Objects>Union (A+B), Hatch 
Objects>Intersection (A×B), Hatch Objects>Difference (A-B) and Multiple Copy>Markings.

1. Choose objects
The objects to be deselected are chosen. Any number of objects can be chosen. This can be done 
using various methods which can be combined with one another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

Next, the selection of the chosen objects is inverted.

Related commands:
Select>Identification
Select>Complete
Deselect>Identification
Deselect>Complete
Invert>Complete
Conditional Selection>Identification
Conditional Selection>Complete
Conditional Deselection>Identification
Conditional Deselection>Complete



Invert>Complete (Extra Menu)
This command can be used to invert the selection of all objects in the drawing. Objects which were 
previously selected are deselected and vice versa.

Selection has two uses: Firstly, a group of objects can be semi-permanently marked. It can then be used 
later as the basis for object selection. This can be done with the F12 Key.

The selected group of objects can also be used as a second selected object alongside the normal, directly 
selected objects. This is the case with the commands Hatch Objects>Union (A+B), Hatch 
Objects>Intersection (A×B), Hatch Objects>Difference (A-B) and Multiple Copy>Markings.

Related commands:
Select>Identification
Select>Complete
Deselect>Identification
Deselect>Complete
Invert>Identification
Conditional Selection>Identification
Conditional Selection>Complete
Conditional Deselection>Identification
Conditional Deselection>Complete



Conditional Selection>Identification (Extra Menu)
This command can be used to carry out a conditional selection a specified group of objects. Only those 
objects with specified properties are selected.

Selection has two uses: Firstly, a group of objects can be semi-permanently marked. It can then be used 
later as the basis for object selection. This can be done with the F12 Key.

The selected group of objects can also be used as a second selected object alongside the normal, directly 
selected objects. This is the case with the commands Hatch Objects>Union (A+B), Hatch 
Objects>Intersection (A×B), Hatch Objects>Difference (A-B) and Multiple Copy>Markings.

1. Choose objects
The objects to be deselected are chosen. Any number of objects can be chosen. This can be done 
using various methods which can be combined with one another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

After choosing the objects, the Conditional Selection dialog appears, in which the selection conditions 
can be specified. The "Regard" check box must be checked for each condition to be fulfilled. If more than
one check box is enabled, then each of those conditions must be fulfilled at the same time.

Next, the chosen objects which fulfill the specified conditions are selected. The selection remains current 
until it is explicitly changed. However, selections are not saved with drawings and are therefore not 
available when a drawing is opened.

Related commands:
Select>Identification
Select>Complete
Deselect>Identification
Deselect>Complete
Invert>Identification



Invert>Complete
Conditional Selection>Complete
Conditional Deselection>Identification
Conditional Deselection>Complete



Conditional Selection>Complete (Extra Menu)
This command can be used to carry out a conditional selection on all the objects in the drawing. Only 
those objects with specified properties are selected.

Selection has two uses: Firstly, a group of objects can be semi-permanently marked. It can then be used 
later as the basis for object selection. This can be done with the F12 Key.

The selected group of objects can also be used as a second selected object alongside the normal, directly 
selected objects. This is the case with the commands Hatch Objects>Union (A+B), Hatch 
Objects>Intersection (A×B), Hatch Objects>Difference (A-B) and Multiple Copy>Markings.

After choosing the command , the Conditional Selection dialog appears, in which the selection conditions 
can be specified. The "Regard" check box must be checked for each condition to be fulfilled. If more than
one check box is enabled, then each of those conditions must be fulfilled at the same time.

Those objects in the drawing which fulfill the specified conditions are then selected.

Related commands:
Select>Identification
Select>Complete
Deselect>Identification
Deselect>Complete
Invert>Identification
Invert>Complete
Conditional Selection>Identification
Conditional Deselection>Identification
Conditional Deselection>Complete



Conditional Deselection>Identification (Extra Menu)
This command can be used to carry out a conditional deselection on a specified group of objects. Only 
those objects which fulfill specified conditions are deselected.

Selection has two uses: Firstly, a group of objects can be semi-permanently marked. It can then be used 
later as the basis for object selection. This can be done with the F12 Key.

The selected group of objects can also be used as a second selected object alongside the normal, directly 
selected objects. This is the case with the commands Hatch Objects>Union (A+B), Hatch 
Objects>Intersection (A×B), Hatch Objects>Difference (A-B) and Multiple Copy>Markings.

1. Choose objects
The objects to be deselected are chosen. Any number of objects can be chosen. This can be done 
using various methods which can be combined with one another:

Objects can be chosen, as for identification, by simply clicking on their outlines. If 
several objects lie at the position clicked on, a small dialog appears at the bottom of the screen, with the 
help of which the correct object can be picked out.

Whole sections can be chosen by holding down the SHIFT key, and specifying two 
opposite corners of a rectangle. This chooses all the objects which lie wholly within the specified area.

Whether only the objects wholly within the area, or also those which overlap it should be chosen 
is detemined by the area mode. This is changed with the F5 Key or the button in the panel.

All the objects in the drawing can be chosen by pressing the F10 Key .
If the same group of objects is to be manipulated several times, it can be selected again 

by pressing the F11 Key.
All the currently selected objects can be chosen by pressing the F12 Key .

If several of these choosing methods are to be combined, the CTRL key must be kept held down 
throughout the choosing process.
All choosing operations are self-inverting. If an object is chosen twice during a choosing process, it 
counts as "not chosen". A third selection rechooses it, and so on.

Example: If all the objects in the drawing except two are to be chosen, follow these steps:
Press and hold down the CTRL key
Press the F10 key
Click, one after another, on the two objects not to be chosen
Release the CTRL key

After choosing the objects, the Conditional Selection dialog appears, in which the conditions to be 
fulfilled can be specified. The "Regard" check box must be checked for each condition to be fulfilled. If 
more than one check box is enabled, then each of those conditions must be fulfilled at the same time.

The chosen objects which fulfill the specified conditions are then deselected.

Related commands:
Select>Identification
Select>Complete
Deselect>Identification
Deselect>Complete
Invert>Identification
Invert>Complete
Conditional Selection>Identification



Conditional Selection>Complete
Conditional Deselection>Complete



Conditional Deselection>Complete (Extra Menu)
This command can be used to carry out a conditional deselection on all the objects in the drawing. Only 
those objects which fulfill specified conditions are deselected.

Selection has two uses: Firstly, a group of objects can be semi-permanently marked. It can then be used 
later as the basis for object selection. This can be done with the F12 Key.

The selected group of objects can also be used as a second selected object alongside the normal, directly 
selected objects. This is the case with the commands Hatch Objects>Union (A+B), Hatch 
Objects>Intersection (A×B), Hatch Objects>Difference (A-B) and Multiple Copy>Markings.

After choosing the command , the Conditional Selection, in which the selection conditions can be 
specified. The "Regard" check box must be checked for each condition to be fulfilled. If more than one 
check box is enabled, then each of those conditions must be fulfilled at the same time.

The objects which fulfill the specified conditions are then deselected.

Related commands:
Select>Identification
Select>Complete
Deselect>Identification
Deselect>Complete
Invert>Identification
Invert>Complete
Conditional Selection>Identification
Conditional Selection>Complete
Conditional Deselection>Identification



Snap Modes>Midpoint (Extra Menu)
The snap modes determine which type of point should be used as a snapping reference. There are various 
snap modes, some of which can be used together.

The snap modes take effect when snapping is active. Snapping can be turned on or off using the F6 Key 
or the first button in the Panel. It can be temporarily (de)activated during point entry using the SHIFT key.

This snap mode uses center points as snapping references. These can be the midpoints of lines or the 
center points of circles, circle parts, ellipses and ellipse parts. If snapping and this snap modes are active, 
instead of entering a point a (part) object is identified whose center point is then worked out.

1. Identify reference object
Any part object in an existing object can be identified as a reference object. This can be the side of a 
rectangle, the arc of an ellipse segment or a circular arc within a surface. A geometry line can not be 
identified as it has no "middle".
The (part) object is identified by clicking with the mouse on its outline. If more than one (part) object 
lies at the point clicked on, then a small dialog appears at the bottom of the screen, with the help of 
which the 'right' object can be chosen.

After selecting the (part) object, its center or mid point is calculated. This point is then used like a point 
entered by hand (see graphic).

The "Midpoint" snap mode is an exclusive mode. If it is active, then all other snap modes are deactivated.

Optionally, this snap mode can be turned on or off by clicking with the left mouse button on the button in 
the panel shown to the left. In addition the button always shows the snap mode's current status.

Related commands:
Snap Modes>Quadrant
Snap Modes>Edge
Snap Modes>Corner / End-Point
Snap Modes>Intersection
Snap Modes>Geometry
Snap Modes>Marking
Snap Modes>Other Point
Snap Modes>Snap Radius
Function Keys>Snap (F6)



Snap Modes>Quadrant (Extra Menu)
The snap modes determine which type of point should be used as a snapping reference. There are various 
snap modes, some of which can be used together.

The snap modes take effect when snapping is active. Snapping can be turned on or off using the F6 Key 
or the first button in the Panel. It can be temporarily (de)activated during point entry using the SHIFT key.

This snap mode enables quadrant points to be used as snapping references. With circles and circle parts 
these are the points on the circle which lie at angles of 0°, 90°, 180° and 270° relative to the circle's 
center. With ellipses, they lie at the four ends of the positive and negative half axes. If snapping is on and 
this snap mode is active, instead of entering a point, an object is identified whose quadrant points are then
worked out.

1. Identify reference object
Any part object in an existing object can be identified as a reference object. This can be the arc of an 
ellipse or a circular arc within a circle. A line can not be chosen.
The (part) object is identified by clicking with the mouse on its outline. If more than one (part) object 
lies at the point clicked on, then a small dialog appears at the bottom of the screen, with the help of 
which the 'right' object can be chosen.

The position at which the (part) object was identified (the "ID point") affects the rest of the command.
It determines which of the four possible quadrant points is selected. The one nearest to the ID point is 
always chosen (see below).

After choosing the (part) object all quadrant points are worked out and the one nearest to the ID point is 
selected. This point is then used like a point entered by hand (see graphic).

The "Quadrant" snap mode is an exclusive snap mode. If it is active, then all other snap modes are 
deactivated.

Optionally, this snap mode can be turned on or off by clicking with the left mouse button on the button in 
the panel shown to the left. In addition the button always shows the snap mode's current status.

Related commands:
Snap Modes>Midpoint
Snap Modes>Edge
Snap Modes>Corner / End-Point
Snap Modes>Intersection
Snap Modes>Geometry



Snap Modes>Marking
Snap Modes>Other Point
Snap Modes>Snap Radius
Function Keys>Snap (F6)



Snap Modes>Edge (Extra Menu)
The snap modes determine which type of point should be used as a snapping reference. There are various 
snap modes, some of which can be used together.

The snap modes take effect when snapping is active. Snapping can be turned on or off using the F6 Key 
or the first button in the Panel. It can be temporarily (de)activated during point entry using the SHIFT key.

With this snap mode points can be placed exactly on the edge of an object. If snapping and this snap mode
are active, instead of entering a point an object is identified on whose edge a point is placed.

1. Identify reference object
Any part object in an existing object can be identified as a reference object. This can be the side of a 
rectangle, the arc of an ellipse segment or a circular arc within a surface.
The (part) object is identified by clicking with the mouse on its outline. If more than one (part) object 
lies at the point clicked on, then a small dialog appears at the bottom of the screen, with the help of 
which the 'right' object can be chosen.

The position at which the (part) object was identified (the "ID point") affects the rest of the command.
It determines the position from which the perpendicular should be dropped onto the object (see 
below).

After choosing the (part) object, a perpendicular is dropped from the ID point to the selected object. A 
snapping reference point is inserted where the perpendicular touches the object (see graphic).

The "Edge" snap mode is an exclusive snap mode. If it is active, then all other snap modes are 
deactivated.

Optionally, this snap mode can be turned on or off by clicking with the left mouse button on the button in 
the panel shown to the left. In addition the button always shows the snap mode's current status.

Related commands:
Snap Modes>Midpoint
Snap Modes>Quadrant
Snap Modes>Corner / End-Point
Snap Modes>Intersection
Snap Modes>Geometry
Snap Modes>Marking
Snap Modes>Other Point
Snap Modes>Snap Radius
Function Keys>Snap (F6)





Snap Modes>Corner / End-Point (Extra Menu)
The snap modes determine which type of point should be used as a snapping reference. There are various 
snap modes, some of which can be used together.

The snap modes take effect when snapping is active. Snapping can be turned on or off using the F6 Key 
or the first button in the Panel. It can be temporarily (de)activated during point entry using the SHIFT key.

This snap mode can be used to insert snapping reference points at the corners and ends of objects. These 
are the end points of lines, curves, circular and elliptical arcs, dimension lines and hatching lines, as well 
as corner points within curves, surfaces, circular sectors, circular segments, elliptic sectors and elliptic 
segments. To snap to such a point, simply click near it.

The "Corner / End-Point" snap mode can be combined with the Intersection, Geometry, Marking and 
Other Point snap modes.

Optionally, this snap mode can be turned on or off by clicking with the left mouse button on the button in 
the panel shown to the left. In addition the button always shows the snap mode's current status.

Related commands:
Snap Modes>Midpoint
Snap Modes>Quadrant
Snap Modes>Edge
Snap Modes>Intersection
Snap Modes>Geometry
Snap Modes>Marking
Snap Modes>Other Point
Snap Modes>Snap Radius
Function Keys>Snap (F6)



Snap Modes>Intersection (Extra Menu)
The snap modes determine which type of point should be used as a snapping reference. There are various 
snap modes, some of which can be used together.

The snap modes take effect when snapping is active. Snapping can be turned on or off using the F6 Key 
or the first button in the Panel. It can be temporarily (de)activated during point entry using the SHIFT key.

This snap mode can be used to place snapping reference points at intersections within objects. If the 
"Geometry" snap mode is active at the same time, snapping reference points can also be placed at the 
intersections of objects with the geometry and (if present) reference objects. To place a snapping 
reference point on an intersection, simply click near it.

The "Intersection" snap mode can be combined with the Corner / End-Point, Geometry, Marking and 
Other Point snap modes.

Optionally, this snap mode can be turned on or off by clicking with the left mouse button on the button in 
the panel shown to the left. In addition the button always shows the snap mode's current status.

Related commands:
Snap Modes>Midpoint
Snap Modes>Quadrant
Snap Modes>Edge
Snap Modes>Corner / End-Point
Snap Modes>Geometry
Snap Modes>Marking
Snap Modes>Other Point
Snap Modes>Snap Radius
Function Keys>Snap (F6)



Snap Modes>Geometry (Extra Menu)
The snap modes determine which type of point should be used as a snapping reference. There are various 
snap modes, some of which can be used together.

The snap modes take effect when snapping is active. Snapping can be turned on or off using the F6 Key 
or the first button in the Panel. It can be temporarily (de)activated during point entry using the SHIFT key.

This snap mode can be used to insert snapping reference points at intersections of geometry objects and 
intersections of reference objects with geometry objects. If "Intersection" snap mode is also active, 
snapping reference points can also be inserted at the intersection of objects with the geometry. To insert a 
snapping reference point at an intersection, simply click near it.

The "Geometry" snap mode can be combined with the Corner / End-Point, Intersection, Marking and 
Other Point snap modes.

Optionally, this snap mode can be turned on or off by clicking with the left mouse button on the button in 
the panel shown to the left. In addition the button always shows the snap mode's current status.

Related commands:
Snap Modes>Midpoint
Snap Modes>Quadrant
Snap Modes>Edge
Snap Modes>Corner / End-Point
Snap Modes>Intersection
Snap Modes>Marking
Snap Modes>Other Point
Snap Modes>Snap Radius
Function Keys>Snap (F6)



Snap Modes>Marking (Extra Menu)
The snap modes determine which type of point should be used as a snapping reference. There are various 
snap modes, some of which can be used together.

The snap modes take effect when snapping is active. Snapping can be turned on or off using the F6 Key 
or the first button in the Panel. It can be temporarily (de)activated during point entry using the SHIFT key.

Snapping reference points can be placed on top of markings using this command. To place a snapping 
reference on a marking, simply click near it.

The "Marking" snap mode can be combined with the Corner / End-Point, Intersection, Geometry and 
Other Point snap modes.

Optionally, this snap mode can be turned on or off by clicking with the left mouse button on the button in 
the panel shown to the left. In addition the button always shows the snap mode's current status.

Related commands:
Snap Modes>Midpoint
Snap Modes>Quadrant
Snap Modes>Edge
Snap Modes>Corner / End-Point
Snap Modes>Intersection
Snap Modes>Geometry
Snap Modes>Other Point
Snap Modes>Snap Radius
Function Keys>Snap (F6)



Snap Modes>Other Point (Extra Menu)
The snap modes determine which type of point should be used as a snapping reference. There are various 
snap modes, some of which can be used together.

The snap modes take effect when snapping is active. Snapping can be turned on or off using the F6 Key 
or the first button in the Panel. It can be temporarily (de)activated during point entry using the SHIFT key.

Snapping reference points can be placed at other points using this command. "Other Points" are all 
definition points which cannot have snapping reference points placed on them with other snap modes, for 
example the angel points of Bézier curves, end points of ellipse's half axes, position points of dimensions,
the corners of multiple line text frames, etc. To place a snapping reference point on one of these points, 
simply click near it.

The "Other Point" snap mode can be combined with the Corner / End-Point, Intersection, Geometry and 
Marking snap modes.

Optionally, this snap mode can be turned on or off by clicking with the left mouse button on the button in 
the panel shown to the left. In addition the button always shows the snap mode's current status.

Related commands:
Snap Modes>Midpoint
Snap Modes>Quadrant
Snap Modes>Edge
Snap Modes>Corner / End-Point
Snap Modes>Intersection
Snap Modes>Geometry
Snap Modes>Marking
Snap Modes>Snap Radius
Function Keys>Snap (F6)



Snap Modes>Snap Radius (Extra Menu)
This command can be used to specify the parameters for placing snapping reference points and the 
identification of objects. This is done from a dialog in which the snap radius and the tolerance can be 
specified.

The snap radius is given in screen pixels and determines how far from a point or object the crosshair can 
be to be effective when placing a snapping reference point or identifying an object.
The snap radius can have values from 5 to 50. The current snap radius is displayed in the Panel's top 
button.

The tolerance specifies how precisely the distance should be calculated when placing a snapping 
reference point or identifying an object. It is given in screen pixels.
For example, if the tolerance is two pixels, all objects less than two pixels from the ID point are chosen. A
small dialog then appears at the bottom of the screen with the help of which the 'right' object can be 
chosen.
The tolerance can have values between 1 and 10.

Optionally, the right mouse button can be clicked on the button in the panel shown to the left, calling the 
dialog described above.

Related commands:
Snap Modes>Midpoint
Snap Modes>Quadrant
Snap Modes>Edge
Snap Modes>Corner / End-Point
Snap Modes>Intersection
Snap Modes>Geometry
Snap Modes>Marking
Snap Modes>Other Point
Function Keys>Snap (F6)



Function Keys>Previous Point (ESC) (Extra Menu)
This command can be used to undo the last point entry. This only works during execution of a command

All previous entries can and must be redone. This may include parameter settings and object selection.

Related Command:
No related commands



Function Keys>Restart Command (+ESC) (Extra Menu)
This command can be used to interrupt the current command and restart it. This is the same as clicking 
the right mouse button and choosing the command from the menu again.

Restarting a command is particularly useful with those commands where a dialog for setting the 
parameters appears when the command is chosen. The dialog appears again and the parameters can be 
changed.

Related Command:
No related commands



Function Keys>Help (F1) (Extra Menu)
This command can be used to call the Tek Illustrator reference. This command is context-sensitive, i.e. 
the reference topic relevant to the program's current status is called. These possibilities exist:

If the Pop Up Menu is open, and the mouse pointer is above a command icon in the Pop 
Up Menu, then the description of that command is called.

If the mouse pointer is over a command icon in the toolbox, then the description of that 
command is called.

If a menu is pulled down and a command is highlighted, then the description of that 
command is called.

If a dialog is open, then the description of that dialog is called, if one is available.
If coordinate entry via the status window is active, a description of the process is called.
In all other cases, a description of the current command is called. This is the command 

whose icon is shown in the status window.

If you want to go directly to the Reference's index, choose the command Index from the Help menu.

Related commands:
Index
Using Help



Function Keys>Arc Direction (F2) (Extra Menu)
This command can be used to change the current arc direction. The arc direction particularly affects the 
drawing of circle and ellipse parts. It determines whether the arc should be drawn in a mathematically 
positive (I.e. anticlockwise) or negative (i.e. clockwise) direction from the start angle to the end angle.

This is an example of the effect of the arc direction command on a circular arc.

Optionally, the arc direction can be changed by clicking the left mouse button on the button in the panel 
shown to the left. The button shows the current arc direction.

Related Command:
No related commands



Function Keys>Display Grid (F3) (Extra Menu)
This command can be used to show and hide the display grid. The display grid of the window in which 
the crosshair is located is changed. If the mouse is outside the drawing window the current window's 
setting is changed.

Optionally, the display grid can be turned on or off by clicking with the left mouse button on the button in
the panel shown to the left. In this case the active window's setting is always changed. The button shows 
the current display grid status.

The display grid can only be displayed if its parameters are valid and it is not deactivated. It can be 
changed using the command Coordinate Systems>Edit.

By clicking the right mouse button on the button shown to the left, a dialog can be called in which the 
display grid settings for the active window can be specified (see Coordinate Systems>Display Grid).

Related Command:
Function Keys>Position Grid (F4)



Function Keys>Position Grid (F4) (Extra Menu)
This command can be used to turn the position grid on and off. The position grid of the window in which 
the crosshair is located is changed. If the mouse is outside the drawing window the current window's 
setting is changed.

 Optionally, the position grid can be turned on or off by clicking with the left mouse button on the button 
in the panel shown to the left. In this case the active window's setting is always changed. The button 
shows the current display grid status.

The position grid can only be displayed if its parameters are valid and it is not deactivated. It can be 
changed using the command Coordinate Systems>Edit.

 By clicking the right mouse button on the button shown to the left, a dialog can be called in which the 
position grid settings for the active window can be specified (see Coordinate Systems Position Grid).

Related Command:
Function Keys>Display Grid (F3)



Function Keys>Area Mode (F5) (Extra Menu)
This command can be used to switch the current area mode. The area mode determines whether, when 
selecting objects using areas (pressing the SHIFT key), the objects to be selected must be completely 
within the specified area or only have to overlap the area partly.

The area mode can also be changed by clicking the left mouse button on the button in the panel shown to 
the left. The button also shows the current area mode.

Related Command:
No related commands



Function Keys>Snap (F6) (Extra Menu)
This command can be used to turn the snapping function on and off. It can only be turned on if at least 
one snap mode is active. If the snapping function is active, points which are entered 'jump', according to 
the snap mode, to a defined point in the drawing or a point is inserted at a position calculated according to
object identification.

Snapping can also be turned on or off by clicking the left mouse button on the button in the panel shown 
to the left. The button shows the snapping function's current status.

During point entry, the snapping function can be briefly (de)activated by holding down the SHIFT key.

If snapping is on, four small lines are shown on the crosshair. Their distance from the crosshair's 
intersection shows the current Snap Radius an. This determines how closely a point must be clicked to in 
order to use it as a snapping reference.

The snap radius can also be set by clicking with the right mouse button on the button in the panel shown 
to the left. The value shown in the button is the snap radius.

Related commands:
Snap Modes>Midpoint
Snap Modes>Quadrant
Snap Modes>Edge
Snap Modes>Corner / End-Point
Snap Modes>Intersection
Snap Modes>Geometry
Snap Modes>Marking
Snap Modes>Other Point
Snap Modes>Snap Radius



Function Keys>Duplicate (F7) (Extra Menu)
This command can be used to turn the duplicate function on or off. This determines whether the original 
object is changed by operations or whether a copy of the object is made, and the copy changed.

The duplicate function can be turned on or off by clicking the left mouse button on the button in the panel
shown to the left. The button shows the current status of the duplicate function.

During point entry the duplicate function can be briefly (de)activated by holding down the CTRL key.

If the duplicate function is on, a small + is shown above and to the right of the crosshair intersection.

Related Command:
No related commands



Function Keys>Direct Input (F8) (Extra Menu)
Using this command, specific numeric coordinates can be entered, instead of using the mouse.

The coordinates are entered in an entry field which appears in the lower part of the Status Window. The 
upper line of the status window shows what sort of entry is expected. Entry is confirmed by pressing 
RETURN or interrupted by pressing ESC.

If the status window is not already displayed when this command is chosen, it appears and then 
disappears when the coordinates have been entered (see also Display Status Window).

Direct coordinate entry can also be called by clicking the left mouse button in the status window, by 
pressing the F8 key, or (if using the standard keyboard assignments) pressing ENTER.

Standard Examples
These standard examples illustrate the most important input possibilities. Not all the possibilities shown 
are always available. Relative angles and lengths can only be entered if there is an obvious reference. If 
need be, attention is drawn to this in the description of the relevant command in the help system.

The standard examples are sorted according to the default, shown in the upper line of the status window.

Default=Coordinates (x;y)
Input: 150;100
Result: A point is inserted at the coordinates (150;100) with reference to the current coordinate 

system.

Input: 100+30/4;7*18
Result: A point is inserted at the coordinates (107.5;126) with reference to the current coordinate 

system.

Input: x+150;y+100
Result: A point is inserted 150 Units to the right of the reference point and 100 units above the 

reference point.

Input: dy=100
Result: A point is inserted 100 Units to the right of the reference point.

Input: w=45;l=2*50
Result: A point is inserted 100 units at an angle of 45° from the reference point.

Input: 15cm;10cm
Result: A point with the coordinates (15 cm;10 cm) with reference to the current coordinate 

system is inserted - independent of the current unit.

Default=Radius (r)
Input: 15



Result: The object to be entered is given a radius of 15 units.

Input: r+10
Result: The object to be entered is given a radius 10 units larger than the reference object.

Input: x=150;y=100
Result: A point is inserted at coordinates (150;100) with reference to the current coordinate 

system.

Input: dx=150;dy=100
Result: A point is inserted 150 Units to the right of the reference point and 100 units above the 

reference point. The reference point is the center point of the previously entered object.

Default=Length (l)

An arrow is shown over the icon in the status window. This arrow shows the current direction for length 
measurements. Positive lengths run in the direction of the arrow, negative lengths in the opposite 
direction.

Input: 30
Result: The object to be entered is given a length of 30 units. The length is entered in the 

direction which the arrow in the status window shows.

Input: -50mm
Result: The object to be entered is given a length of 50 mm - regardless of the current unit. The 

length is entered in the opposite direction to that in which the arrow in the status window 
shows.

Default=Angle and Length (w;l)
Input: 30;120
Result: The object has an angle of 30° and a length of 120 units.

Full Description
Entry takes the form of references to particular variables. According to which variables the value refers 
to, they are interpreted differently.

Variables and Terms
There are six variables to which values can be assigned.

x Absolute X-coordinate of a point
y Absolute Y-coordinate of a point
dx Relative X-coordinate of a point (the same as x=x+ )
dy Relative Y-coordinate of a point (the same as y=y+ )
l Length, amount of a polar coordinate
r Radius (handled like l)



w Angle
a Angle (handled like w)

Each variable is given a value in the form of a term. This is done in a similar way to writing mathematical
equations with an equals sign. This means that terms can be used which contain numeric values, brackets, 
operators and functions. Possible operators are:

+ Addition Example: 8+2
- Subtraction Example: 10-2
* Multiplication Example: 3*4
/ Division Example: 15/3
^ Power Example: 2^8

Arguments of functions must be in brackets. The available functions are:
sqr Square
sqrt Square Root
ln Natural Logarithm
sin Sine
cos Cosine
tan Tangent
arcsin Arcsine
arccos Arccosin
arctan Arctan
ceil smallest whole number larger than or equal to the argument
floor largest whole number smaller than or equal to the argument

If values are to be assigned to several variables, they must be separated by a semicolon. If a variable is to 
be assigned the default value, it is not necessary to enter the name of the variable and the equals sign. For 
example, to enter the default values for "Absolute coordinates (x;y)", it is enough to enter:

100;200

If the default is something else, then the name of the variable and the equals sign must be entered:

x=100;y=200

If a standard combination such as (x;y) or (w;l) is to be entered, only the name of the first variable has to 
be entered:

x=100;200

If a reference point or object is known, then it is possible to enter one value instead of two. The other 
value is initialized with the coordinates of the reference point or object. In this case, the following two 
entries are the same:

y=200 is the same as x=x;y=200
x=100 is the same as x=100;y=y

l=50 is the same as w=w;l=50
w=45 is the same as w=45;l=l



Constants
According to the type of input being carried out, certain constants are available which can be used in the 
terms. They allow, for example, relative values to be entered. The following constants are available.

x and y current X- and Y-coordinates of the reference point
l current length of the reference object or previously entered line section
r current radius of the reference object
w and a current angle of the reference object or previously entered line section

_fl "Frame Left"
_fr "Frame Right"
_ft "Frame Top"
_fb "Frame Bottom"

Rectangular coordinates of the frame which surrounds all currently selected objects.

_pl "Page Left"
_pr "Page Right"
_pt "Page Top"
_pb "Page Bottom"

Corner coordinates of the current page.

e base number for natural logarithms (2.7182...)
pi pi (p) (3.1415...)

Units
All values entered without a specific unit relate to the current length or angle unit of the active window's 
coordinate system.

To specify a unit for a value, the appropriate abbreviation should be used. These are the possible units and
their abbreviations.
µm Micrometer 1/1000 mm
mm Millimeter 1 mm
cm Centimeter 10 mm
dm Decimeter 100 mm
m Meter 1000 mm
km Kilometer 1000000 mm
mil Mil 1/1000 in
in Inch 1 in = 25,4 mm
ft Foot 12 in
yd Yard 3 ft
ml Mile 1760 yd
dp Decipoint 1/720 in
pt Point 1/72 in
bp Didot 1/2660 m
cic Cicero 12/2660 m

Possible angle units and abbreviations



deg Degree 360 per rotation
gra Gon 400 per rotation
rad Radian 2pi per rotation
rel Relative 1 per rotation

Units can be mixed within a term. These are examples using mm as the current length unit and deg as 
the current angle unit.

100+1in is the same as 100 mm + 1 in = 125,4 mm
(100+1)in is the same as 101 in = 2565,4 mm
2yd+1ft+9,5in is the same as 93,5 in = 2374,9 mm
sin(pi rad) is the same as sin(180°) = 0.0

Examples
Start Point at Line>Standard:
x=150;y=200
150;200 These entries both describe the point with an X-coordinate of 150 and a Y-

coordinate of 200.

w=45;l=60 This entry describes the location of a point 60 units at a direction of 45° from the 
origin. The polar coordinates are calculated relative to the origin because there is 
no reference point.

End Point at Line>Standard:
x=150;y=200
150;200 These entries both describe the point with an X-coordinate of 150 and a Y-

coordinate of 200.

x=x+50;y=y+100
dx=50;dy=100
x+50;y+100 These entries describe a point whose position is 50 units to the right of and 100 

units above the lines start point. The relative coordinates are calculated relative to
the start point of the line.

w=45;l=60 This entry describes the location of a point 60 units at a direction of 45° from the 
start point of the line. The polar coordinates are calculated relative to the start 
point of the line.

End Point at a Polyline:
At least the start point and end point have already been entered.

x=150;y=200
150;200 These entries describe a point with an X-coordinate of 150 and a Y-coordinate of 

200.

x=x+50;y=y+100
dx=50;dy=100
x+50;y+100 These entries describe the position of a point 50 units to the right of the current 



part line's start point and 100 units above it. The relative coordinates are 
calculated relative to the current line's start point.

w=45;l=60 This entry describes the location of a point 60 units at a direction of 45° from the 
start point of the part line. The polar coordinates are calculated relative to the 
start point of the part line.

w=w+45;l This entry describes the end point of a part line with an angle of 45° relative to 
the previous part line and whose length is the same as the preceding part line. 
Angles and lengths are calculated relative to the preceding part line.

Length Entered With Trim Object>Length to Point:

A line is selected as the object to be trimmed. An arrow is shown over the icon in the status window. This 
arrow shows the current direction for length measurements. Positive lengths run in the direction of the 
arrow, negative lengths in the opposite direction.

l=80
80 The selected end of the line is moved so that the line has a length of 80 units. The

length is measured from the other end of the line in the direction indicated by the 
arrow in the status window.

l=l+20
l+20 The selected end of the line is moved so that the line is lengthened by 20 units.

l=l+l
2*l The selected end of the line is moved so that the length of the line doubles.

x=150;y=200 The line ends at the foot of a perpendicular dropped from a point with the X-
coordinate 150 and the Y-coordinate 200 on to the reference straight line.

x=x+50;y=y+100
dx=50;dy=100 The line ends at the foot of a perpendicular dropped onto the reference straight 

line from a point 50 units to the right and 100 units above its start point. The 
relative coordinates are relative to the start point of the line.

Radius Entered With Circle>Concentric:
A circle is selected as a reference object.

r=50
50 The circle is given a radius of 50 units.

r=r+20
r+20 The circle is given a radius, 20 units larger than the reference circle.

r=r+r
2*r The circle is given a radius twice as large as that of the reference circle.

x=150;y=200 The circle runs through the point at the X-coordinate 150 and the Y-coordinate 
200.



x=x+50;y=y+100
dx=50;dy=100 The circle runs through a point 50 units to the right and 100 units above the 

center of the reference circle.

Angle Entry With Trim Object>Angle to Point:
A circular arc is selected as the object to be trimmed.

w=45
45 The selected end of the circular arc is lengthened or shortened to an angle of 45°.

w=w+10
w+10 The selected end of the circular arc is moved by 10° anticlockwise.

w=w-15
w-15 The selected end of the circular arc is moved by 15° clockwise.

x=150;y=200 The selected end of the circular arc has its position determined by the X-
coordinate 150 and the Y-coordinate 200.

x=x+50;y=y+100
dx=50;dy=100 The selected end of the circular arc has its position determined by a point 50 units

to the right of and 100 units above the center of the reference circle.

Combined Angle and Length Entry With Line>Perpendicular:
A circle is selected as the reference object.

w=30;l=100
30;100 The perpendicular runs 100 units from the circle at an angle of 30°.

x=150;y=200 The perpendicular ends at the point with the X-coordinate 150 and the Y-
coordinate 200.

x=x+50;y=y+100
dx=50;dy=100 The perpendicular ends at a point 50 units to the right of and 100 units above the 

center of the reference circle.

Related Command:
No related commands



Function Keys>Geometry (F9) (Extra Menu)
This command can be used to turn the display of the geometry on and off. This affects all visible 
windows.

The geometry display can also be turned on and off by clicking the left mouse button on the button in the 
panel shown to the left.

The geometry's appearance can be changed using the Geometry command. Geometry display can also be 
turned on and off here.

Clicking on the button in the panel shown to the left with the right mouse button also calls the dialog for 
changing the geometry settings.

Related Command:
Geometry



Function Keys>Identify All (F10) (Extra Menu)
This command can be used to select all objects and instances in a drawing. If conditional selection is in 
use, then only objects fulfilling the conditions are selected.

Objects in hidden or frozen layers are not selected.

Related commands:
Previous Identification (F11)
Identify Selected Objects (F12)



Function Keys>Previous Identification (F11) (Extra Menu)
This command can be used to select all the objects selected during the previous selection.

Some commands restrict the information about previously selected objects to certain groups of objects. 
For example, if the command Paste was used to insert an object from the clipboard, then the relevant 
information is available for this (and only this) object. If a pasted object is to be moved immediately after 
pasting, choose the Move Objects>Standard command and press the F11 key.

Related commands:
Identify All(F10)
Identify Selected Objects (F12)



Function Keys>Identify Selected Objects (F12) (Extra Menu)
This command can be used to select all currently selected objects.

In this way a certain selection can be used as a container for a frequently required group of objects. If you
stop working on a group briefly you can mark the group of objects to continue working on it later.

Choose the command Select>Identification and press the F11 Key. This selects all the previously selected
objects. You can now delete other work with selected objects, which does not affect the selection

If you now want to select the objects again, press the F12 key. If the selection is no longer required, it can 
be deleted using the command Deselect>Complete.

Related commands:
Identify All (F10)
Previous Identification (F11)



Control Keys>Window Refresh (SPACEBAR) (Extra Menu)
This command can be used to force a redraw of the drawing window. The window over which the 
crosshair is located is redrawn. If the mouse is outside the drawing window, then the current window is 
redrawn.

If the SPACEBAR is held down, the zoom can be changed using the mouse. If the left mouse button is 
clicked in a drawing window the zoom factor is doubled in that window. If the right mouse button is 
clicked then the zoom factor in the window clicked in is halved.

In principle this is the same as using the commands Zoom>Double Zoom and Zoom>Halve Zoom.

Related Command:
No related commands



Control Keys>Left Mouse Button (Extra Menu)
This command can be used to simulate the clicking of the left mouse button. The program reacts as if the 
left mouse button had been clicked and then immediately released at the current mouse position.

The mouse button can be almost completely replaced by a chosen key. However, it is not possible to 
simulate holding down the mouse button, as needed for the command Draw>Freehand Line in this way

Related commands:
Control Keys>Middle Mouse Button
Control Keys>Right Mouse Button



Control Keys>Middle Mouse Button (Extra Menu)
This command can be used to simulate the clicking of the middle mouse button. The program reacts as if 
the middle mouse button had been clicked and then immediately released at the current mouse position. 
This also functions if the mouse in use does not have a middle button.

The middle mouse button usage can be specified using Settings>Mouse Button Usage.

Related commands:
Settings>Mouse Button
Control Keys>Left Mouse Button
Control Keys>Right Mouse Button



Control Keys>Right Mouse Button (Extra Menu)
This command can be used to simulate the clicking of the right mouse button. The program reacts as if the
right mouse button had been clicked and then immediately released at the current mouse position.

The right mouse button can be configured using Settings>Mouse Button Usage.

Related commands:
Settings>Mouse Button
Control Keys>Left Mouse Button
Control Keys>Middle Mouse Button



Control Keys>Menu Button (ALT) (Extra Menu)
With this command the pressing of the Windows menu key (i.e. ALT) can be simulated. The program 
reacts as if the ALT key had been pressed and immediately released.

This activates the menu. If the menu bar is visible, the File menu drops down. If the menu bar is not 
visible the menu appears at the current mouse position with the File menu selected.

Related Command:
No related commands



Control Keys>Step Left (LEFTARROW) (Extra Menu)
This command can be used to simulate pressing the cursor key with a left pointing arrow. The program 
reacts as if the LEFTARROW had been pressed and immediately released.

This moves the window by a specified step to the left, that is, the window content moves to the right. The 
size of the step by which the section is moved can be specified using the command Control Keys>Edit 
Step.

The window in which the crosshair is located is changed. If the mouse pointer is outside the drawing area,
the current (active) window is changed.

The visible section of the picture can also be moved by clicking on one of the buttons in the panel shown 
left.

If the drawing window's scroll bars are visible (this can be set using the command Settings>Screen), the 
corresponding scroll bar arrow can be clicked on. The specified step size will be used.

Related commands:
Control Keys>Step Right (RIGHT ARROW)
Control Keys>Step Up (UP ARROW)
Control Keys>Step Down (DOWN ARROW)
Zoom>Previous Zoom



Control Keys>Step Right (RIGHTARROW) (Extra Menu)
This command can be used to simulate pressing the cursor key with the right pointing arrow. The program
reacts as if the RIGHTARROW key had been pressed and immediately released.

This moves the window by a specified step to the right, that is, the window content moves to the left. The 
size of the step by which the section is moved can be specified using the command Control Keys>Edit 
Step.

The window in which the crosshair is located is changed. If the mouse pointer is outside the drawing area,
the current (active) window is changed.

The visible section of the picture can also be moved by clicking on one of the buttons in the panel shown 
left.

If the drawing window's scroll bars are visible (this can be set using the command Settings>Screen), the 
corresponding scroll bar arrow can be clicked on. The specified step size will be used.

Related commands:
Control Keys>Step Left (LEFTARROW)
Control Keys>Step Up (UP ARROW)
Control Keys>Step Down (DOWN ARROW)
Zoom>Previous Zoom



Control Keys>Step Up (UP ARROW) (Extra Menu)
This command can be used to simulate pressing the cursor key with an upward pointing arrow. The 
program reacts as if the UP ARROW had been pressed and immediately released.

This moves the window up by a specified step, that is, the window content moves down. The size of the 
step by which the section is moved can be specified using the command Control Keys>Edit Step.

The window in which the crosshair is located is changed. If the mouse pointer is outside the drawing area,
the current (active) window is changed.

The visible section of the picture can also be moved by clicking on one of the buttons in the panel shown 
left.

If the drawing window's scroll bars are visible (this can be set using the command Settings>Screen), the 
corresponding scroll bar arrow can be clicked on. The specified step size will be used.

Related commands:
Control Keys>Step Left (LEFTARROW)
Control Keys>Step Right (RIGHT ARROW)
Control Keys>Step Down (DOWN ARROW)
Zoom>Previous Zoom



Control Keys>Step Down (DOWN ARROW) (Extra Menu)
This command can be used to simulate pressing the cursor key with the downward pointing arrow. The 
program reacts as if the DOWNARROW key had been pressed and immediately released.

This moves the window down by a specified step, that is, the window content moves up. The size of the 
step by which the section is moved can be specified using the command Control Keys>Edit Step.

The window in which the crosshair is located is changed. If the mouse pointer is outside the drawing area,
the current (active) window is changed.

The visible section of the picture can also be moved by clicking on one of the buttons in the panel shown 
left.

If the drawing window's scroll bars are visible (this can be set using the command Settings>Screen), the 
corresponding scroll bar arrow can be clicked on. The specified step size will be used.

Related commands:
Control Keys>Step Left (LEFTARROW)
Control Keys>Step Right (RIGHT ARROW)
Control Keys>Step Up (DOWN ARROW)
Zoom>Previous Zoom



Control Keys>Page Left (HOME) (Extra Menu)
This command simulates pressing the HOME key. The program reacts as if the HOME key had been 
pressed and immediately released.

The window on the drawing is moved by 90% to the left, that is, the window content moves to the right.

The window in which the crosshair is located is changed. If the mouse pointer is outside the drawing area,
the current (active) window is changed.

If the drawing window's scroll bars are visible (this can be set using the command Settings>Screen), the 
corresponding scroll bar can be clicked on.

Related commands:
Control Keys>Page Right (END)
Control Keys>Page Up (PAGEUP)
Control Keys>Page Down (PAGEDOWN)
Zoom>Previous Zoom



Control Keys>Page Right (END) (Extra Menu)
This command can be used to simulate pressing the END key. The program reacts as if the END key had 
been pressed and immediately released.

The window on the drawing is moved to the right by 90%, that is, the window content moves to the left.

The window in which the crosshair is located is changed. If the mouse pointer is outside the drawing area,
the current (active) window is changed.

If the drawing window's scroll bars are visible (this can be set using the command Settings>Screen), the 
corresponding scroll bar can be clicked on.

Related commands:
Control Keys>Page Left (HOME)
Control Keys>Page Up (PAGEUP)
Control Keys>Page Down (PAGEDOWN)
Zoom>Previous Zoom



Control Keys>Page Up (PAGEUP) (Extra Menu)
This command can be used to simulate the pressing of the PAGEUP key. The program reacts as if the 
PAGEUP had been pressed and immediately released.

The window on the drawing is moved up by 90%, that is the window content moves down.

The window in which the crosshair is located is changed. If the mouse pointer is outside the drawing area,
the current (active) window is changed.

If the drawing window's scroll bars are visible (this can be set using the command Settings>Screen), the 
corresponding scroll bar can be clicked on.

Related commands:
Control Keys>Page Left (HOME)
Control Keys>Page Right (END)
Control Keys>Page Down (PAGEDOWN)
Zoom>Previous Zoom



Control Keys>Page Down (PAGEDOWN) (Extra Menu)
This command can be used to simulate pressing the PAGEDOWN key. The program reacts as if the 
PAGEDOWN key had been pressed and immediately released.

This moves the window on the drawing down by 90%, that is, the window content moves to the up.

The window in which the crosshair is located is changed. If the mouse pointer is outside the drawing area,
the current (active) window is changed.

If the drawing window's scroll bars are visible (this can be set using the command Settings>Screen), the 
corresponding scroll bar can be clicked on.

Related commands:
Control Keys>Page Left (HOME)
Control Keys>Page Right (END)
Control Keys>Page Up (PAGEUP)
Zoom>Previous Zoom



Control Keys>Edit Step (Extra Menu)
This command can be used to alter the step size for moving the viewable part of the drawing with the help
of the buttons in the panel or the cursor keys. This is done via a dialog in which the step size, in percent, 
can be entered. Values between 5 and 100 percent are allowed.

The step size orientates itself to the smaller of the drawing window's height and width.

The dialog for specifying the step size can also be called by clicking the right mouse button on one of the 
buttons in the panel shown to the left.

Affected commands
Control Keys>Step Left (LEFT ARROW)
Control Keys>Step Right (RIGHT ARROW)
Control Keys>Step Up (UP ARROW)
Control Keys>Step Down (DOWN ARROW)



Help Menu
Contents of the Reference
Important Information

Using the Reference
Installing TrueType Fonts
Service Information
Advice for Plotter Output
Using Digitizers

How to Use Help
Order Form
Questions & Answers
TommySoftware  ®   Direct  
Start Puzzle
About Tek Illustrator



Reference Index (Help Menu)
This command, calls the Tek Illustrator Reference index. You can search for individual entries from this 
index. 

If you want specific information about a particular Tek Illustrator command, there are various ways of 
finding it directly from the program. 

1. Go to the Reference's index. In the index you will find a list of menus. Click on the desired menu. A 
list of all commands in this menu appears. Click on the command which you want information about.

2. Open the relevant menu from the Tek Illustrator menu bar. Use the cursor keys to move the highlight 
bar until it is over the command which you want information about. If there is a submenu, you can 
open it with the RIGHTARROW key, and close it again with the LEFTARROW key. As soon as the 
highlight bar is over the command which you want information about, press the F1 key. 

3. Activate the Popup Menu. Click on the menu icon for the desired menu, and if need be, on the 
submenu icon of the desired submenu. Move the mouse pointer over the icon of the command which 
you want information about. The command name should appear in the title bar of the Popup Menu. 
Press the F1 key. 

4. Display the Tools Window. Move the mouse pointer over the icon of the command which you want 
information about. Press the F1 key.

5. Choose the command which you want information about as usual (from the menus, the Pop Up Menu 
or with a keyboard shortcut). As soon as the command's icon appears in the Status Window, press F1. 
This displays Help about the current command.
This works only with commands which remain active after use (e.g. Draw>Line>Standard), not with 
commands which are carried out immediately, (e.g. File>Open Drawing).

If you want information on a particular dialog box, simply press the F1 key while that dialog box is open.

You can find more information in the electronic Tutorial, which is supplied with every registered copy of 
the Tek Illustrator.

Related commands:
How to Use Help
Using the Reference
Function Keys>Help (F1)



Using the Reference (Help Menu)
This command calls the Reference topic Using the Reference. It explains, in an uncomplicated form, the 
most important ways in which you can use the Reference. 

Related commands:
How to Use Help
Service Information
Installing TrueType Fonts
Advice for Plotter Output
Using Digitizers



Installing TrueType Fonts (Help Menu)
This command calls the Reference topic Installing TrueType Fonts . It explains how to install the 
TrueType fonts supplied with the registered version of the Tek Illustrator.

Related commands:
How to Use Help
Using the Reference
Service Information
Advice for Plotter Output
Using Digitizers



Service Information (Help Menu)
This command calls the Reference topic Service Information. It explains troubleshooting procedures for 
some common problems. In addition it describes how to send inquiries to TommySoftware®.

Related commands:
How to Use Help
Using the Reference
Installing TrueType Fonts
Advice for Plotter Output
Using Digitizers



Advice for Plotter Output (Help Menu)
This command calls the Reference topic Advice for Plotter Output. It explains the optional procedures for
output on HPGL-compatible plotters.

Related commands:
How to Use Help
Using the Reference
Installing TrueType Fonts
Service Information
Using Digitizers



Using Digitizers (Help Menu)
This command calls the Reference topic Using Digitizers. It explains how the Tek Illustrator works with 
digitizers (also known as graphic tablets or digitizing tablets).

Related commands:
How to Use Help
Using the Reference
Installing TrueType Fonts
Advice for Plotter Output
Service Information



How to Use Help (Help Menu)
This command calls a description of the Windows help system. This explains the use of the help system 
beginning with the basics.

This description is part of Windows and therefore varies according to your Windows version.

Related commands:
Index
Using the Reference
Function Keys>Help (F1)



Order Form (Help Menu)
This command calls an order form by means of which you can order further copies of TommySoftware® 
Tek Illustrator, libraries, fonts and other accessoires.

Related command:
No related commands



Questions & Answers (Help Menu)
This command calls a text that contains some frequently asked questions concerning TommySoftware® 
Tek Illustrator and their answers.

Related command:
No related commands



TommySoftware® Direct (Help Menu)
This command calls "TommySoftware® Direct", the customer newspaper of TommySoftware®. It will 
inofrm you about TommySoftware® Tek Illustrator, its accessories and other useful products of 
TommySoftware®.

Related command:
No related commands



Start Puzzle (Help Menu)
This command calls the TommySoftware® Tek Illustrator Puzzle. The Puzzle is a standalone program 
with the filename PUZZLE.EXE. It can also be started from the File Manager or the Program Manager.

The rules for the puzzle are well-known, but in case you are not familiar with them, here is a summary.

The aim is to get the fifteen tiles into the correct order again by pushing them around. 
You push a tile by dragging it with the mouse. The tiles can only be moved into the empty space.

To make it easier, the fifteen elements all have a small number. The puzzle is solved when the hole is at 
the top left and all the squares are correctly sorted. 

The Puzzle can always be solved. If you sometimes think that you are making no progress, then you are 
doing something wrong. It just takes a little patience, that's all.

Have fun!

Related command:
No related commands



About Tek Illustrator (Help Menu)
This command calls the Tek Illustrator information dialog. As well as the usual Copyright information, 
this dialog contains various important information.

The exact Version number is shown in the first line. The letter at the end of the Version number shows the 
language version (›d‹ for German, ›e‹ for English, ›f‹ for French etc.).

Between the two horizontal lines, installation information is shown. In one or two lines the name of the 
company and user for whom the program is installed is shown. If not, the program has not been correctly 
installed and you should repeat the installation process

The serial number is shown under the names. You should always have this number (and the version 
number) to hand when you contact TommySoftware®!

The number after "Licenses" shows how many copies of the program are licensed for use by the company
shown under that serial number. Normally, this number is ›1‹. Only the number of copies shown here may
be used at the same time. For multi-user licenses, contact your dealer or the TommySoftware® Head 
Office (you can find the address in the Using the Reference topic.

Finally the entry after "Available Memory" shows how much memory is free. This value does not show 
how much memory is free for drawing files or symbols. Rather, it shows how much system memory is 
fully unused, that is not used by Tek Illustrator or other applications.
To make use of part of this memory as well as that already reserved for drawing files and symbols, it has 
to be explicitly reserved (see System Configuration>Memory and Monitor).

If a large value is displayed here, it does not mean that this memory can be used by Tek Illustrator. Values 
shown because of large swap files on the hard disk are particularly deceptive. They do not reflect the 
amount of physical memory and can lead to unnecessarily reserving memory.

Additionally: If you play around within this dialog, you may see something special. What this is and how
to find it, is for you to find out. Calling the Hotline, in this case, is pointless as we have a secret to keep.

Related Command:
Program Status



Other Commands
These commands are not contained in the Tek Illustrator menu system. They are called by clicking on 
buttons in the Symbol Window, with the help of the File List command or (if a digitizer is installed) with 
the keyboard combination SHIFT+TAB.

Symbol Window Commands
Insert Symbol from Window
Edit Symbol in Window

Drawing List Commands
Open Drawing from List

Digitizer Commands
Edit Button Assignment
Calibrate Digitizer
Set Origin
Load Assignment...
Save Assignment as...

Define Digitizer Command Field
Delete Digitizer Command Field



Insert Symbol from Window (Other Commands)
This command inserts a symbol allocated to a Symbol Window button into the drawing.

You can find further information on the way in which the Symbol Window works can be found in the 
Symbol Window topic.

Related command:
Define Symbol in Window



Define Window Symbol (Other Commands)
This command is used to allocate a Symbol to a Symbol Window button.

Further information on the workings of the Symbol Window can be found in the section on the Symbol 
Window.

Related Command:
Insert Symbol from Window



Open Drawing from List (Other Commands)
This command opens one of the drawings whose name is in the drawing list.

For further information on this, refer to the section on the Drawing List.

Related commands:
Open Drawing
Drawing List



Change Key Assignment (Other Commands)
This command can be used to set up the key assignments for a connected digitizer's input device.

Note: This command is not included in the Tek Illustrator menu system. It is only available if a digitizer 
with the correct driver is connected. If these conditions are met, then it can be chosen from the menu 
called by pressing ALT+TAB. For general tips on using digitizers, see Using Digitizers.

The Digitizer Key Assignment dialog appears, in which the keys for five digitizer functions can be 
defined.

If possible, an input device button which does not function as a mouse button should be defined. In this 
case it would only be possible to enter coordinates in areas outside the area visible on screen. However, 
this may be a good idea if using a very large digitizer.

The program does not check whether all the defined keys are actually present on the current input device. 
If a button is used for multiple layers, then it will be used for the layer with the smallest number. The 
other layers which were also assigned to that button will not be accessible.

Note: The key assignments will be saved when the program is exited, in the CALCOMP.DIG file in the 
Tek Illustrator directory.

Related commands:
Calibrate Digitizer
Set Origin
Load Assignment...
Save Assignment as...
Define Digitizer Command Field
Delete Digitizer Command Field



Calibrate Digitizer (Other Commands)
This command can be used to calibrate a connected digitizer. This helps match the sizes of objects entered
to the program as well as the exact positing of the template.

Note: This command is not included in the Tek Illustrator menu system. It is only available if a digitizer 
with the correct driver is connected. If these conditions are met, then it can be chosen from the menu 
called by pressing ALT+TAB. For general tips on using digitizers, see Using Digitizers.

During calibration, only absolute coordinates from the digitizer's reference system, can be entered in the 
Status Window. The digitizer's coordinate system uses units of exactly 1/250 of an inch (about 0.1 mm). 
Its origin is at the bottom left corner of the digitizer and runs positively to the right and upwards.

If you are working with one of the standard digitizer layouts (as shown in the form of a template in the 
drawings DIG12x12.T3G or DIG12x18.T2G), you should position them so that the position cross in the 
center of the screen are lies as near as possible to the coordinates (1500;1500). A deviation of ± 10 units is
tolerable. You will find further position crosses with coordinates in two of the template's corners.

1. Enter start point
The start point for the reference distance must be entered with the Digitize Input Device using the 
button which is set for direct coordinate entry (by default, the puck's second button).

2. Enter end point
The end point for the reference distance must also be entered with the Digitize Input Device using the 
button which is set for direct coordinate entry (by default, the puck's second button).

After entering the points, there distance from each other (dependent on the scale in use) is calculated and 
a dialog showing this distance is displayed. Enter, instead of this, the distance which the points should be 
apart according to your template.

All the following, directly chosen coordinates are recalculated so that they fit in with the scale specified 
in the program.

Note: The calibration data and the coordinate position specified here are saved in the file 
CALCOMP.DIG in the Tek Illustrator program directory.

Related commands:
Change Key assignment
Set Origin
Load Assignment...
Save Assignment as...
Define Digitizer Command Field
Delete Digitizer Command Field



Set Origin (Other Commands)
The origin for a connected digitizer can be calibrated using this command. This helps fit the positions of 
objects entered with the digitizer with the program.

Note: This command is not included in the Tek Illustrator menu system. It is only available if a digitizer 
with the correct driver is connected. If these conditions are met, then it can be chosen from the menu 
called by pressing ALT+TAB. For general tips on using digitizers, see Using Digitizers.

During calibration, only absolute coordinates from the digitizer's reference system, can be entered in the 
Status Window. The digitizer's coordinate system uses units of exactly 1/250 of an inch (about 0.1 mm). 
Its origin is at the bottom left corner of the digitizer and runs positively to the right and upwards.

1. Enter position
The origin must be entered with the Digitize Input Device using the button which is set for direct 
coordinate entry (by default, the puck's second button).

The position is then saved as the new origin.

Note: The calibration data and the coordinate position specified here are saved in the file 
CALCOMP.DIG in the Tek Illustrator program directory.

Related commands:
Change Key Assignment
Calibrate Digitizer
Load Assignment...
Save Assignment as...
Define Digitizer Command Field
Delete Digitizer Command Field



Load Assignment (Other Commands)
This command can be used to open an existing assignments file, i.e. load it into memory and activate it. 
This is done from a File Selection Dialog, from which the file to be used can be chosen.

Note: This command is not included in the Tek Illustrator menu system. It is only available if a digitizer 
with the correct driver is connected. If these conditions are met, then it can be chosen from the menu 
called by pressing ALT+TAB. For general tips on using digitizers, see Using Digitizers.

Related commands:
Change Key Assignment
Calibrate Digitizer
Set Origin
Save Assignment as...
Define Digitizer Command Field
Delete Digitizer Command Field



Save Assignment as (Other Commands)
This command can be used to save the current digitizer settings including the calibration data and key 
assignments in an assignments file which can be loaded again at a later point.

A File Selection Dialog appears in which a name for the file is entered.

Note: This command is not included in the Tek Illustrator menu system. It is only available if a digitizer 
with the correct driver is connected. If these conditions are met, then it can be chosen from the menu 
called by pressing ALT+TAB. For general tips on using digitizers, see Using Digitizers.

Related commands:
Change Key Assignment
Calibrate Digitizer
Set Origin
Load Assignment...
Define Digitizer Command Field
Delete Digitizer Command Field



Define Digitizer Command Field (Other Commands)
A command field for the connected digitizer can be defined using this command. In the name of the 
command, the identifier for the command is given after the words "command field". It consists of three 
parts.:

The first two numbers show the horizontal position of the command on the graphics 
tablet. This can be between 1 and 35 (inclusive).

The following letter shows the field's vertical position on the graphics tablet. It can be 
between A and W inclusive.

The last number is the control layer number. It can be between 1 and 4 inclusive.

Note: This command is not included in the Tek Illustrator menu system. It is only available if a digitizer 
with the correct driver is connected. If these conditions are fulfilled, it can be called by clicking the button
for the relevant command layer (by default the left or right "mouse button" on the puck) and at the same 
time holding down the SHIFT key). For general tips on using digitizers, see Using Digitizers.

1. Choose command
The command which is to be assigned must be chosen. The command can be chosen by any valid 
method, i.e. from the menu bar, the Popup Menu, the toolbox or a shortcut key.
A sub-menu cannot be assigned directly to a key. To do this, the "Complete sub-menu" check box 
must be enabled in the dialog which appears next.

After choosing the command it is assigned to the relevant digitizer command field and is immediately 
available. Any existing command field assignment for this command field will be overwritten.

Note: The command field assignments are saved permanently in the CALCOMP.DIG file located in the 
Tek Illustrator program directory.

Related commands:
Change Key Assignment
Calibrate Digitizer
Set Origin
Load Assignment...
Save Assignment as...
Delete Digitizer Command Field



Delete Digitizer Command Field (Other Commands)
This command can be used to delete a command field of an attached digitizer. In the name of the 
command, the identifier for the command is given after the words "command field". It consists of three 
parts.:

The first two numbers show the horizontal position of the command on the graphics 
tablet. This can be between 1 and 35 (inclusive).

The following letter shows the field's vertical position on the graphics tablet. It can be 
between A and W inclusive.

The last number is the control layer number. It can be between 1 and 4 inclusive.

Note: This command is not included in the Tek Illustrator menu system. It is only available if a digitizer 
with the correct driver is connected. If these conditions are fulfilled, it can be called by clicking on the 
button for the current command level (by default the left or right "mouse button") of the puck and holding
down SHIFT+CTRL at the same time. For general tips on using digitizers, see Using Digitizers.

After clicking on the digitizer command field to be deleted, a dialog field appears which shows the 
current field assignment and allows the delete command to be canceled.

Note: The command field assignments are saved permanently in the CALCOMP.DIG file located in the 
Tek Illustrator program directory.

Related commands:
Change Key Assignment
Calibrate Digitizer
Set Origin
Load Assignment...
Save Assignment as...
Define Digitizer Command Field



Command-Specific
Dialog Boxes
File Menu

Load Elements
Save Elements
Print Drawing
Autosave

Edit Menu
Display Bitmap
Export Bitmap
Comment Parameters

Configure Menu
Page Format
Define Layers
...Properties
...Defaults
Defines Coordinate Systems
...View
...Origin
...Units
...Numbers
...Display Grid
...Position Grid
Defines Pens
...Defaults
Define Line Patterns
...Edit
Named Zoom Areas
Program Status
Memory and Monitor
Standard Paths
Settings Display
...Screen
...Output
...Plotter
...Colors
...Mouse buttons
Change Key Assignment
Display Key Assignment

Shape Menu
Edit Properties
Single Line Text
Multiple Line Text
Zigzag Line
Dimension Line
Dimension With Line
Dimension Without Line
General Dimension Parameters



Instance
Edit Single Line Text
Edit Multiple Line Text
Dimension and Tolerances
Coordinates and Tolerances

Draw Menu
Curve Entry

Geometry Menu
Geometry
Division

Trimming Menu
Edit Curve

Dimension Menu
Dimension Parameter Options
Fonts
Create Single Line Text
Create Multiple Line Text
Define Hatch Type
...Edit

Library Menu
Insert Symbol / Block
Create Symbol / Block
Edit Symbol / Block
Copy Symbol / Block
...Select
Define Attributes
...Edit
Generate Parts List
...Attribute Selection
Transform Symbols
Replace Symbol / Block
Replace Library
Libraries
Symbol Window Parameters

Extra Menu
Selection Conditions

Other Commands
Digitizer Key Assignment



"Edit Properties" Dialog
To access an explanation of an individual element in the dialog box shown below, click the left mouse 
button on the element. Explanations are available whenever the mouse pointer changes from an arrow ( )
to a hand (

).

The check boxes at the left edge of the dialog are only available when the properties of several objects are
to be changed at the same time. In this case, the dialog will initially show the properties of the first-
chosen object. 

If only one object is selected, the check boxes are not visible and in addition the right marking can not be 
set. The dialogs opening settings are then the settings for the chosen object which can now be changed 
directly.

In this case the type of object is displayed in the title bar. If the chosen object is not an Instance, the "Fix 
check box on the right hand side will be selected instead of the "Inherit check box. The function in 
principle is the same. 

Associated command:
Edit Properties



"Single Line Text" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

The check boxes at the left and right of the dialog are only shown when altering the properties of more 
than one object at once. In this case the properties shown in the dialog to start with are the properties of 
the first single line of text underneath the selected objects.

If only one object is selected, the check boxes are not visible. The properties shown in the dialog to start 
with are the properties of the selected object, which can then be altered directly.

Associated command:
Edit Properties

Possible preceding dialog:
Edit Properties



"Multiple line Text" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

The check boxes at the left and right of the dialog are only shown when altering the properties of more 
than one object at once. In this case the properties shown in the dialog to start with are the properties of 
the first multiple text lines underneath the selected objects.

If only one object is selected, the check boxes are not visible. The properties shown in the dialog to start 
with are the properties of the selected object, which can then be altered directly.

Associated command:
Edit Properties

Possible preceding dialog:
Edit Properties



"Zigzag Line" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

The check boxes at the left and right of the dialog are only shown when altering the properties of more 
than one object at once. In this case the properties shown in the dialog to start with are the properties of 
the first zigzag line underneath the selected objects.

If only one object is selected, the check boxes are not visible. The properties shown in the dialog to start 
with are the properties of the selected object, which can then be altered directly.

Associated command:
Edit Properties

Possible preceding dialog:
Edit Properties



"Dimension Line" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

The check boxes at the left and right of the dialog are only shown when altering the properties of more 
than one object at once. In this case the properties shown in the dialog to start with are the properties of 
the first dimension line underneath the selected objects.

If only one object is selected, the check boxes are not visible. The properties shown in the dialog to start 
with are the properties of the selected object, which can then be altered directly. 

Associated commands:
Edit Properties
Dimension Line>Straight
Dimension Line>Curved

Possible preceding dialog:
Edit Properties



"General Dimension Parameters" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

The check boxes at the left and right of the dialog are only shown when altering the properties of more 
than one object at once. In this case the properties shown in the dialog to start with are the properties of 
the first dimension underneath the selected objects.

If only one object is selected, the check boxes are not visible. The properties shown in the dialog to start 
with are the properties of the selected object, which can then be altered directly. 

If the dialog is used for setting a commands parameters, then the check boxes are not displayed. The 
properties shown in the dialog to start with are the last-set parameters for that command which can be 
altered directly.

The "Options" button is not displayed if this dialog is called while carrying out the Edit Properties 
command.

Associated commands:
Edit Properties
Dimension Line>Straight
Dimension Line>Curved
Dimension>Length, Points
Dimension>Length, Objects
Dimension>Length, Object - Point
Dimension>Length, Object - Object
Dimension>Radius, Points
Dimension>Radius, Object
Dimension>Diameter, Points



Dimension>Diameter, Object
Dimension>Angle, Points
Dimension>Angle, Line - Line
Dimension>Angle, Circle Part
Dimension>Arc Length, Points
Dimension>Arc Length, Circle Part
Dimension>Coordinates
Calculate>Area
Calculate>Perimeter / Length
Dimension Parameters

Possible preceding dialogs:
Edit Properties
Dimension with Dimension Line
Dimension without Dimension Line



"Dimension With Line" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

The check boxes at the left and right of the dialog are only available if the properties of multiple objects 
are to be altered at the same time. In this case the dialog initially shows the settings of the first dimension 
with a dimension line under the chosen object. 

If only one object is selected, the check boxes are not visible. The dialog then initially shows the 
properties of the selected object, which can then be altered directly. 

If the dialog is used for setting a commands parameters, then the check boxes are not displayed. The 
properties shown in the dialog to start with are the last-set parameters for that command which can be 
altered directly. The "Tolerances" check box is only available in this case.

Associated commands:
Edit Properties



Dimension>Length, Points
Dimension>Length, Objects
Dimension>Length, Object - Point
Dimension>Length, Object - Object
Dimension>Radius, Points
Dimension>Radius, Object
Dimension>Diameter, Points
Dimension>Diameter, Object
Dimension>Angle, Points
Dimension>Angle, Line - Line
Dimension>Angle, Circle Part
Dimension>Arc Length, Points
Dimension>Arc Length, Circle Part

Possible preceding dialog:
Edit Properties



"Dimension Without Line" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

The check boxes at the left and right of the dialog are only available if the properties of multiple objects 
are to be altered at the same time. In this case the dialog initially shows the settings of the first dimension 
without a dimension line under the chosen object.

If only one object is selected, the check boxes are not visible. The dialog then initially shows the 
properties of the selected object, which can then be altered directly.

If the dialog is used for setting a commands parameters, then the check boxes are not displayed. The 
properties shown in the dialog to start with are the last-set parameters for that command which can be 
altered directly. The "Tolerances" check box is only available in this case.

Associated commands:
Edit Properties
Dimension>Coordinates
Calculate>Area
Calculate>Perimeter / Length

Possible preceding dialog:
Edit Properties



"Color Selection" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Note: The colors defined in this dialog are not saved in drawing files, but in settings files; that is 
independently from the drawing (see Settings>Save As).

Associated commands:
No command-specific usage

Possible preceding dialogs:
Edit Properties
Concrete Properties
Extended Properties



"File Selection" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
No command-specific usage



"Standard Color Selection" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
No command-specific usage

Possible preceding dialogs:
Comment Parameters
Color Settings
Geometry



"Print Drawing" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Print Drawing



"Load Elements" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

The "OK" button may be replaced with a button labeled "Continue...", if further dialogs follow this one.

Associated commands:
Merge Drawing>Standard Elements
Merge Drawing>Other Elements



"Save Elements" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Save Elements as



"Autosave" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Miscellaneous>Autosave



"Display Bitmap" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated commands:
Bitmap>Display
Bitmap>Parameters



"Export Bitmap" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Bitmap>Export



"Comment Parameters" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Comment Parameters



"Details" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

This dialog may appear at a reduced size with no Change Author or Last Change details. This is most 
likely when working with settings and symbol lists.

If the details can be viewed but not altered (for example fonts) the entry fields are replaced by simple text 
areas.

Associated commands:
Drawing Details
Settings>Details
Libraries
Symbol Window>Details

Possible preceding dialog:
Libraries



"Page Format" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Page Formats



"Define Layers" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Layers>Edit



"Layer Properties" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Layers>Edit

Possible preceding dialog:
Layers>Define



"Layer Defaults" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Layers>Defaults



"Define Coordinate Systems" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Coordinate Systems>Edit



"View Coordinate Systems" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Coordinate Systems>Edit

Possible preceding dialog:
Define Coordinate Systems



"Coordinate System Origin" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Coordinate Systems>Edit

Possible preceding dialog:
Define Coordinate Systems



"Coordinate System Units" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Coordinate Systems>Edit

Possible preceding dialog:
Define Coordinate Systems



"Coordinate System Numbers" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Coordinate Systems>Edit

Possible preceding dialog:
Define Coordinate Systems



"Coordinate System Display Grid" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Coordinate Systems>Edit

Possible preceding dialog:
Define Coordinate Systems



"Coordinate Systems Position Grid" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Coordinate Systems>Edit

Possible preceding dialog:
Define Coordinate Systems



"Define Pens" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Pens>Edit



"Pen Defaults" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Pens>Defaults



"Define Line Pattern" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Pens>Line Pattern



"Edit Line Pattern" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Pens>Line Pattern

Possible preceding dialog:
Edit Line pattern



"Concrete Properties" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
No command-specific usage

Possible preceding dialog:
Define Pens



"Named Zoom Areas" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Zoom>Zoom Section



"Program Status" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Program Status



"Memory and Monitor" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
System Configuration>Memory and Monitor



"Standard Paths" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
System Configuration>Program Status



"User Identification" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
No command-specific usage



"Display Settings" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Settings>Display



"Screen Settings" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Settings>Screen



"Output Settings" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated commands:
Settings>Output
Print Drawing
Bitmap>Export

Possible preceding dialogs:
Print Drawing
Exporting Bitmaps



"Color Settings" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Settings>Colors



"Display Key Assignments" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Settings>Display Key Assignments



"Mouse Button Usage Settings" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Settings>Mouse Button Usage



"Change Key Assignment" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Settings>Change Key Assignment



"Division" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated commands:
Division>Distance
Division>Object
Division>Array
Multiple Copy>Distance
Multiple Copy>Object
Multiple Copy>Array



"Dimension Parameter Options" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated commands:
Dimension Line>Straight
Dimension Line>Curved
Dimension>Length, Points
Dimension>Length, Objects
Dimension>Length, Object - Point
Dimension>Length, Object - Object
Dimension>Radius, Points
Dimension>Radius, Object
Dimension>Diameter, Points
Dimension>Diameter, Object
Dimension>Angle, Points
Dimension>Angle, Line - Line
Dimension>Angle, Circle Part
Dimension>Arc Length, Points
Dimension>Arc Length, Circle Part
Dimension>Coordinates
Calculate>Area
Calculate>Perimeter / Length
Dimension Parameters

Possible preceding dialog:
General Dimension Parameters



"Fonts" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Fonts



"Instance" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

The check box at the right of the dialog is only available if the properties of several objects are changed at
the same time. In this case the initial setup of this window is the same as the setup of the first instance 
among the selected objects.

If only one object is selected, the check box is not visible. If only one object is chosen, this check box is 
not visible. In this case the initial setup of this window is the same as the setup of the selected object.

Associated command:
Edit Properties



"Enter Single Line Text" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Text>Single Line



"Enter Multiple Line Text" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Text>Multiple Lines



"Geometry" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Geometry



"Curve Entry" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated commands:
Curve
Surface



"Selection Conditions" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated commands:
Conditional Selection>Identification
Conditional Selection>Complete
Conditional Deselection>Identification
Conditional Deselection>Complete



"Edit Single Line Text" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Edit Text



"Edit Multiple Line Text" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Edit Text



"Dimension Number and Tolerances" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated commands:
Edit Text
Dimension>Length, Points
Dimension>Length, Objects
Dimension>Length, Object - Point
Dimension>Length, Object - Object
Dimension>Radius, Points
Dimension>Radius, Object
Dimension>Diameter, Points
Dimension>Diameter, Object
Dimension>Angle, Points
Dimension>Angle, Line - Line
Dimension>Angle, Circle Part
Dimension>Arc Length, Points
Dimension>Arc Length, Circle Part
Calculate>Area
Calculate>Perimeter / Length



"Coordinates and Tolerances" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated commands:
Edit Text
Dimension>Coordinates



"Define Hatching Type" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Hatch Objects>Hatching Type



"Edit Hatching Types" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Hatch Objects>Hatching Type

Possible preceding dialog:
Define Hatching Types



"Extended Properties" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated commands:
No command-specific usage

Possible preceding dialogs:
Edit Properties
Define Pens
Output Settings
Editing Hatching Types
Insert Symbol / Block
Generate Symbol / Block
Edit Symbol / Block



"Insert Symbol / Block" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated commands:
Symbol / Block>Insert
Define Symbol in Window



"Generate Symbol / Block" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Note: If you want to store a Symbol in a new Library Folder, simply enter the name of the new Folder 
together with the name of the new Symbol in the "Symbol / Block" field, separating the Folder name from
the Symbol name with a slash ('\' (ANSI 092)), e.g. New Folder\New Symbol . The Folder and 
Symbol names can both use spaces and any character (apart from the slash '\').
It is not possible to create an empty folder. If all the symbols are deleted from a Folder, then the Folder 
will be removed automatically.

Associated commands:
Symbol / Block>Create (Insertion Point)
Symbol / Block>Create (Frame)



"Edit Symbol / Block" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Symbol / Block>Edit



"Copy Symbol / Block" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Note: If you want to copy a Symbol to a new Library Folder, simply enter the name of the new Folder 
together with the name of the new Symbol in the "Symbol / Block" field, separating the Folder name from
the Symbol name with a slash ('\' (Ansi 092)), e.g. New Folder\New Symbol . The Folder and 
Symbol names can both use spaces and any character (apart from the slash '\').
It is not possible to create an empty folder. If all the symbols are deleted from a Folder, then the Folder 
will be removed automatically.

Associated command:
Symbol / Block>Edit

Possible preceding dialog:
Edit Symbol / Block



"Define Attributes" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Edit Attribute



"Edit Attributes" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Edit Attribute

Possible preceding dialog:
Define Attributes



"Generate Parts List" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Generate Parts List



"Choose Parts List Attributes" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Generate Parts List

Possible preceding dialog:
Generate Parts List



"Transform Symbols" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Symbols to Blocks



"Replace Symbol / Block" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Replace Symbol / Block



"Replace Library" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Replace Library



"Libraries" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Libraries



"Select Symbol / Block" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated commands:
No command-specific usage

Possible preceding dialogs:
Instance
Copy Symbol / Block
Replace Symbol / Block



"Symbol Window Parameter" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Symbol Window>Display Parameters



"Plotter Settings" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Important! Before you alter the settings in this dialog, it is essential that you read the section on Notes 
on Plotter Output fully. It contains important information on the correct use of plotters.

Associated commands:
Print Drawing
Settings>Plotter

Possible preceding dialog:
Print Drawing



"Edit Curve" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Trim Curve>Edit



"Message" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

This type of dialog can appear for many reasons. Whatever the message, the program is interrupted until 
it is closed.

Associated command:
No command-specific usage



"General Entry" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

This, or a similar Dialog can appear for many reasons. Whatever the message, the program is interrupted 
until the required text or values are entered and it is closed.

Associated command:
No command-specific usage



"Digitizer Key Assignments" Dialog
Click the left mouse button on any element in the illustration to see an explanation of that element. 
Explanations are available when the mouse pointer changes from an arrow ( ) to a hand with a 
pointing finger (

).

Associated command:
Change Key Assignment



Clicking on this button will close the dialog accepting all changes. Any changes or operations specified 
will be carried out. 



Clicking on this button will close the dialog, accepting any changes made in the dialog.



Clicking on this button will close the dialog, without accepting any changes. Any following operation will
not be carried out.



The layer is chosen from this list. All currently defined layers are included in the list. 



If this check box is enabled the specified layer will be applied to all objects. It changes automatically as 
soon as a layer is chosen. 



This check box shows if and how the layer should be changed by inheritance. If it is gray, no alterations 
are made. If there is a cross in it, inheritance is enabled for all objects, otherwise it is deleted. 



The pen is chosen from this list. All currently defined pens are included in the list. 



If this check box is enabled then the chosen pen is used for all objects. It changes automatically as soon as
a layer is chosen. 



This check box shows if and how pen inheritance should be changed. If the check box is gray, no 
alterations are made. If it has a cross in it then all objects inherit the pen's properties. 



An example of the current line pattern is shown in this field. 



The line pattern is chosen from this list. All currently defined line patterns are included in the list. 



If this check box is enabled the chosen line pattern is used for all objects. It is enabled automatically as 
soon as a line pattern is chosen. 



This check box shows if and how line pattern inheritance should be changed. If the check box is gray, no 
alterations are made. If it has a cross in it then all objects inherit the line pattern's properties. 



The line width is entered into this field. The width is specified in the current units. 



This button sets the line width to 0.13 mm.



This button sets the line width to 0.18 mm.



This button sets the line width to 0.25 mm.



This button sets the line width to 0.35 mm.



This button sets the line width to 0.5 mm.



This button sets the line width to 0.7 mm.



This button sets the line width to 1,0 mm.



If this check box is enabled the current line width is applied to all objects. It changes automatically as 
soon as the line width is changed.



This check box shows how and whether the inheritance of the line width should be changed. If the check 
box is gray, no change is made. If it is checked then the line width is inherited by all objects, otherwise it 
is deleted.



The line color is specified from this color field. Clicking in this field with the left mouse button calls the 
Choose Color dialog, where the correct color can be chosen.



If this check box is enabled then the specified color is applied to all objects. It is enabled automatically as 
soon as the line color is changed.



This check box shows whether and how the line color inheritance should be changed. If the check box is 
gray, no change is made. If it is checked the line color will be inherited by all objects, otherwise it is 
deleted.



This icon represents "Edge" fill mode. An object which has this fill mode allocated to it, will only have its
outline drawn.



This icon represents "Filling" fill mode. An object which has this fill mode allocated to it will only have 
its filling drawn. Objects which have no filling (e.g. lines) are not visible if this filling mode is applied to 
them.



This icon represents "Both" fill mode. An object which has this fill mode applied to it, will be drawn with 
both its filling and outline. Objects which do not have fillings (e.g. lines) only have their outlines drawn.



If this check box is enabled, the chosen fill mode is applied to all objects. It is enabled automatically if the
fill mode is changed.



This check box shows how and if the fill mode inheritance is to be changed. If the check box is gray, no 
change is made. If it is checked, the fill mode is inherited by all objects, otherwise it is deleted.



The fill color is chosen from this color field. Clicking in this field with the left mouse button calls the 
Choose Color dialog, where the correct color can be chosen.



If this check box is enabled the specified fill color is applied to all objects. It changes automatically as 
soon as the fill color is changed.



This check box shows whether and how the fill color inheritance should be changed. If the check box is 
gray, no change is made. If it is checked the fill color is inherited by all objects, otherwise it is deleted.



In most cases, one or more dialogs where object-specific parameters can be specified can be called with 
these buttons. The following special dialogs are possible:

Single Line Text
Multiple Line Text
Zigzag Line
Dimension Line
General Dimension Parameters
Dimension with Line
Dimension without Line
Instance

If the button shows the text "Special..." (three points at the end), only one special dialog is available. This 
is called when the button is pressed. If the button shows the text "Special >" (an arrow at the end), then 
several dialogs are available. When the button is pressed, a small menu appears from which the dialog can
be chosen. If no special dialog is available, then the button is not visible.



This icon represents the properties of normal objects and dimension object dimension lines. If the 
adjacent check box is enabled, then the properties are displayed in the current dialog.
This icon is only visible if both choices are actually available. Otherwise, only the single property 
available within the object is displayed and edited.



This icon represents the properties of text objects and dimension object dimension numbers. If the 
adjacent check box is enabled, then the properties are displayed in the current dialog.
This icon is only visible if both choices are actually available. Otherwise, only the single property 
available within the object is displayed and edited.



The font to be used is chosen from this list. All available TrueType fonts and all loaded Tek Illustrator 
fonts are shown. If the Adobe Type Manager is present and active, all available PostScript and device 
fonts will also be listed.



The font style to be used can be chosen from this list. Different styles are available, according to the font 
chosen. Tek Illustrator fonts do not have styles.



If this check box is enabled, the font is displayed underlined. This option is not available for Tek 
Illustrator fonts.



If this check box is enabled, the font parameters (name, style and underlining) are transferred to all 
objects. It changes automatically, as soon as the font parameters are changed.



The font size to be used is entered in this field. The value is entered in the current line unit. Note that a 
unit can be specified immediately after the value, e.g. 10pt.



If this check box is enabled, the font size specified is transferred to all objects. It changes automatically, 
as soon as the font size is changed.



The compression factor to use for the font, relative to 1.0, is entered in this field.



If this check box is enabled, the specified compression factor is applied to all objects. It changes 
automatically, as soon as the compression factor is changed.



The font rotation angle to be used is entered in this field. The value is entered in the current angle unit.



If this check box is enabled, the rotation angle specified is transferred to all objects. It changes 
automatically as soon as the rotation angle is changed.



The slope angle for the font is entered in this field. The value is entered in the current angle unit.



If this check box is enabled, the specified slope angle is used for all objects. It changes automatically, as 
soon as the slope angle is changed.



The spacing between characters is specified in this field. The value is entered relative to the font height. 
Values between -100 and +100 are allowed.
Note that there is no "internal" character spacing for Tek Illustrator's own fonts. A character spacing of at 
least 0.1 should be used with Tek Illustrator fonts. On the other hand, if TrueType fonts are used, the value
should be left at 0.0.



If this check box is enabled, the specified character spacing is used for all objects. It changes 
automatically, as soon as the character spacing is changed.



The tab spacing for the font is entered in this field. The value is specified relative to the font height. 
Values between -100 and +100 are allowed.



If this check box is enabled, the specified tab spacing is applied to all objects. It changes automatically, as
soon as the tab spacing is changed.



The line spacing is entered here. The value is entered relative to the font height. Values between -100 and 
+100 are allowed.



If this check box is enabled, the specified line spacing is applied to all objects. It changes automatically, 
as soon as the line spacing is changed.



The X position of the text is entered here. The value is entered in the current length unit.
The X position, together with the Y position, describes the text's "fixed point". According to the text 
mode, this is the left, center or right point on the base line of the text.



If this check box is enabled, the specified X position is applied to all objects. It changes automatically, as 
soon as the X position is changed.



The Y position of the text is entered here. The value is entered in the current length unit.
The Y position, together with the X position, describes the text's "fixed point". According to the text 
mode, this is the left, center or right point on the base line of the text.



If this check box is enabled, the specified Y position is applied to all objects. It changes automatically, as 
soon as the Y position is changed.



This icon represents the text mode "Aligned Left".



This icon represents the text mode "Centered".



This icon represents the text mode "Aligned Right".



This icon represents the text mode "Justified".



If this check box is enabled, the specified text mode is applied to all objects. It changes automatically as 
soon as the text mode is changed.



The spacing between zags to be used is entered in this field. The value is entered in the current line unit.



If this check box is enabled, the specified spacing between zags is applied to all objects. It changes 
automatically, as soon as the spacing between the zags is changed.



This icon represents the arrow style "No Symbol". If the adjacent check box is enabled, no symbol is 
shown at the start of dimension lines.



This icon represents the arrow style "Filled Arrow". If the adjacent check box is enabled at the start of the 
dimension line a filled arrow with an opening angle of 20° is shown.



This icon represents the arrow style "Unfilled Arrow ". If the adjacent check box is enabled at the start of 
the dimension line an unfilled arrow with an opening angle of 20° is displayed/



This icon represents the arrow style "Open Arrow". If the adjacent check box is enabled at the start of the 
dimension line an open arrow with an opening angle of 60° is displayed.



This icon represents the arrow style "Sloping Line". If the adjacent check box is enabled at the start of the
dimension line a 45° sloping line is displayed.



This icon represents the arrow style "Point". If the adjacent check box is enabled at the start of the 
dimension line a filled circle is displayed.



This icon represents the arrow style "Circle". If the adjacent check box is enabled at the start of the 
dimension line an unfilled circle is displayed.



If this check box is enabled the arrow style specified for the start of dimension lines is applied to all 
objects. It changes automatically, as soon as the arrow style for the start of dimension lines is changed.



The orientation for the arrow at the start of dimension lines can be chosen from this list. There are three 
possibilities:
Not Rotated

The arrow is not rotated, i.e. it points from inside to outside. The dimension line ends at the extension 
line.

Rotated
The arrow is rotated, i.e. it points from outside to inside. The dimension line runs over the extension 
lines.

Automatic
The arrow is normally shown unrotated. However, if the dimension line is shorter than 5 mm, the 
arrow is automatically rotated.



If this check box is enabled the specified dimension line arrow orientation is applied to all objects. It 
changes automatically as soon as the orientation of the dimension line arrow is changed.



This icon represents the arrow style "No Symbol". If the adjacent check box is enabled, no symbol is 
shown at the end of the dimension line.



This icon represents the arrow style "Filled Arrow". If the adjacent check box is enabled a filled arrow 
with an opening angle of 20° is shown at the end of the dimension line.



This icon represents the arrow style "Unfilled Arrow ". If the adjacent check box is enabled an unfilled 
arrow with an opening angle of 20° is shown at the end of the dimension line.



This icon represents the arrow style "Open Arrow ". If the adjacent check box is enabled an open arrow 
with an opening angle of 60° is shown at the end of the dimension line.



This icon represents the arrow style "Sloping Line". If the adjacent check box is enabled an arrow sloping
at 45° is shown at the end of the dimension line.



This icon represents the arrow style "Point". If the adjacent check box is enabled a filled circle is shown at
the end of the dimension line.



This icon represents the arrow style "Circle". If the adjacent check box is enabled an unfilled circle is 
shown at the end of the dimension line.



If this check box is enabled, the specified arrow type for the ends of dimension lines is applied to all 
objects. It changes automatically, as soon as the arrow style for the end of dimension lines is changed.



The orientation for the arrow at the end of dimension lines can be chosen from this list. There are three 
possibilities:
Not Rotated

The arrow is not rotated, i.e. it points from inside to outside. The dimension line ends at the extension 
line.

Rotated
The arrow is rotated, i.e. it points from outside to inside. The dimension line runs over the extension 
lines.

Automatic
The arrow is normally shown unrotated. However, if the dimension line is shorter than 5 mm, the 
arrow is automatically rotated.



If this check box is enabled the specified orientation of the arrow at the end of the dimension line is 
applied to all objects. It changes automatically as soon as the orientation of the arrow at the end of the 
dimension line is changed.



The font to be used is chosen from this list. All available TrueType fonts and all loaded Tek Illustrator 
fonts are shown. If the Adobe Type Manager is present and active, all available PostScript and device 
fonts will also be listed.



The font style to be used is chosen from this list. Various styles are available, according to the font 
selected. Tek Illustrator fonts do not have any special styles.



If this check box is enabled, the specified font parameters (name and style) are applied to all objects. It 
changes automatically, as soon as the font parameters are changed.



This list is used to select the desired coordinate system. It lists all coordinate systems that are currently 
defined.
If the selected coordinate system uses a distorted display for isometric or dimetric design, all dimensions 
based on this coordinate system will be adapted accordingly. See also Coordinate Systems>Edit.



If this check box is enabled, the specified coordinate system is applied to all objects. It changes 
automatically, as soon as a coordinate system is selected.



The font size for the main dimension is entered in this field. The value is entered in the current line unit. 
Note that a unit can be specified immediately after the value, e.g. 10pt.



If this check box is enabled, the specified font size for the main dimension is applied to all objects. It 
changes automatically as soon as the font size for the main dimension is changed.



The font size for the tolerances is entered in this field. The value is entered in the current line unit. Note 
that a unit can be specified immediately after the value, e.g. 10pt.



If this check box is enabled, the font size specified for the tolerances is applied to all objects. It changes 
automatically as soon as the font size for the tolerances is changed.



The accuracy for measurement display is entered in this field. Values between 0 and 9 are allowed.
The accuracy value determines the maximum number of decimal places if floating point decimals are in 
use (e.g. if "3" is entered, 1/3 is shown as 1.333 and 1,0002 is shown as 1.0 ). With fractions the 
value shows the maximum negative power to which the fractions are shown (e.g. if "4" is entered, 
fractions up to 1/16 are shown accurately; 7/3 is shown as 2 5/16 and 7/2 is shown as 3 1/2 ).



If this check box is enabled, the specified accuracy is applied to all objects. It changes automatically as 
soon as the accuracy is changed.



Clicking on this button calls the Dimension Parameters Options dialog, in which some system-wide 
dimension options can be specified. The changes made here affect all the dimensions in the drawing.



If this check box is enabled an extension line is drawn at the start of the dimension. The extension line 
begins at the start point of the dimension and extends about 1 mm over the dimension line.



If this check box is enabled the dimension line display setting is for the start of dimensions is applied to 
all objects. It changes automatically as soon as the dimension line display setting is changed.



If this check box is enabled an extension line is drawn at the end of the dimension line. The extension line
begins at the end point of the dimension and runs about 1 mm over the end of the dimension line.



If this check box is enabled the extension line display settings for the end of the dimension line are 
applied to all objects.



If this check box is enabled, dimension lines, the arrows at their ends and (if present) extension lines are 
drawn. Otherwise, only the dimension itself is shown.



If this check box is enabled, the dimension line display setting is applied to all objects. It changes 
automatically as soon as the dimension line display settings are changed.



This icon represents "Full Length, Right Angled" dimension line mode. This means that all dimension 
lines are full length and that arrows and extension lines can be shown at both ends. The extension lines 
are at right angles to the dimension line.



This icon represents "Full Length, Random" dimension line mode. den Maßlinienmodus "Volle Länge, 
beliebig". This means that a;; dimension lines are full length and that arrows and extension lines can be 
shown at both ends. The angle between the dimension line and the extension line is determined by the 
dimension line's position details.

Note: This mode can only be recommended, if the dimension line is displayed parallel to the dimension. 
In all other cases, sloping extension lines lead to visually dreadful results.



This icon represents "Partial Length, Right Angled" dimension line mode. This means that the dimension 
line does not extend the full length and that an arrow and extension line can only be shown at one end (the
start of the dimension line). The extension line is always at right angles to the dimension line.



If this check box is enabled, the dimension line mode setting is applied to all objects. It changes 
automatically, as soon as the dimension line mode is changed.



This icon represents "Parallel" dimension line direction mode. The dimension line runs in the same 
direction as the length being measured. The dimension line therefore runs parallel to the length being 
measured.

Note: If a dimension which is parallel is to be repositioned, it should not be done by changing this setting,
but by using the command Edit Dimension Line>Rotate.



This icon represents "Horizontal" dimension direction mode. This means that the dimension is calculated 
horizontally. This means that the dimension line also runs horizontally. If the dimension is rotated 
afterwards, the dimension direction is also rotated, i.e. does not necessarily remain horizontal.

Note: If a dimension which is parallel is to be repositioned, it should not be done by changing this setting,
but by using the command Edit Dimension Line>Rotate.



This icon represents "Vertical" dimension direction mode. This means that the dimension direction is 
calculated vertically. This means that the dimension line runs vertically. If it is rotated afterwards, the 
dimension direction is rotated accordingly and does not necessarily remain vertical.

Note: If a dimension which is parallel is to be repositioned, it should not be done by changing this setting,
but by using the command Edit Dimension Line>Rotate.



This icon represents "Any" dimension direction mode. This means that the dimension can be calculated in
any direction and the dimension line will then run in that direction. This direction is determined by 
entering a point. If the dimension is rotated later, then the dimension direction is rotated correspondingly

Note: If a dimension which is parallel is to be repositioned, it should not be done by changing this setting,
but by using the command Edit Dimension Line>Rotate.



If this check box is enabled, the dimension direction mode setting is applied to all objects. It changes 
automatically as soon as the dimension direction mode is changed.



This icon represents "Any" dimension line spacing mode. This means that any value can be entered for 
the spacing between the object and the dimension line.

Note: If a dimension line which is currently a fixed or multiple distance from the object is to be 
repositioned, it should not be done by changing this setting, but by using the command Edit Dimension 
Line>Position.



This icon represents "Fixed Distance" dimension line spacing mode. This means that the dimension line's 
distance from the measurement object should be entered in the lower field. When the measurement is 
made, the only thing which can be specified is which side of the object the dimension line should be 
placed on.

Note: If a dimension line which is currently a fixed or multiple distance from the object is to be 
repositioned, it should not be done by changing this setting, but by using the command Edit Dimension 
Line>Position.



This icon represents "Multiple Spacing" dimension line spacing mode. This means that the distance 
between the measurement object and the dimension line is always a multiple of the value entered in the 
lower field. When carrying out the measurement, only the factor to be used and the side on which to place
the dimension line can be chosen.

Note: If a dimension line which is currently a fixed or multiple distance from the measurement object is 
to be repositioned, it should not be done by changing this setting, but by using the command Edit 
Dimension Line>Position.



If this check box is enabled, the dimension line spacing mode is applied to all objects. It changes 
automatically, as soon as the dimension line spacing mode is changed.



The dimension line spacing to be used is entered in this field. The value is entered in the current line unit. 
The dimension line spacing is affected by the dimension line spacing mode



If this check box is enabled, the dimension line spacing setting is applied to all objects. It changes 
automatically, as soon as the dimension line spacing is changed.



If this check box is enabled, the dimension is automatically updated as soon as either the measurement 
object or the underlying coordinate system are changed.

Note: If dimensions are to be updated when automatic updating is not enabled, the command Edit 
Dimension>Update can be used.



If this check box is enabled, the setting for updating dimensions is applied to all objects. It changes 
automatically as soon as the update setting is altered



If this check box is enabled the dimension is placed at the center of the dimension line. The only thing 
that can be specified is its distance from the dimension line.

Note: Repositioning a centered dimension should not be done by changing this setting, but by using the 
command Edit Dimension>Position.



If this check box is enabled the dimension centering setting is applied to all objects. It changes 
automatically as soon as the dimension centering setting is changed.



If this check box is enabled the dimension is automatically placed close to the dimension line. Its position 
on the dimension line can still be determined.

Note: If a closely positioned dimension is to be repositioned , it should not be done by changing this 
setting, but by using the command Edit Dimension>Position.



If this check box is enabled, the setting for the distance between dimensions and objects is applied to all 
objects. It changes automatically as soon as the dimension is changed.



If this check box is enabled, the dimension can be shown rotated. The angle of rotation to be used is 
determined by entering a point. Otherwise, the dimension runs parallel to the dimension line.

Note: If a dimension which is not currently rotated is to be rotated, it should not be done by changing this
setting, but by using the command Edit Dimension>Rotate.



If this check box is enabled, the dimension rotation setting is applied to all objects. It changes 
automatically, as soon as the dimension's rotation is changed.



If this check box is enabled a dialog appears after the dimension has been entered, where extra dimension 
text and the tolerances can be edited.
The dimension text and tolerances of an existing dimension can be viewed and changed using Edit Text.



Clicking on this button calls the General Dimension Parameters dialog, in which further dimension 
parameters can be specified. The changes made in this dialog affect all subsequently generated 
dimensions.



The color is displayed in its dithered variant in this color field. This means that it is visible, if no palette is
used for output.



The color is displayed in its solid variant in this color field. This means that it is visible if a palette is used
for output.



The red portion (in RGB mode) or cyan portion (in CMY mode) is entered as a percentage in this field. 
The mouse can be used to change the value by clicking on the arrow. The change can then be seen in the 
adjacent color field.



The green portion (in RGB mode) or magenta portion (in CMY mode) is entered as a percentage in this 
field. The mouse can be used to change the value by clicking on the arrow. The change can then be seen 
in the adjacent color field.



The blue portion (in RGB mode) or yellow portion (in CMY mode) is entered as a percentage in this field.
The mouse can be used to change the value by clicking on the arrow. The change can then be seen in the 
adjacent color field.



If this check box is enabled, the above values are interpreted as the color proportions of an RGB color. 
This is the usual way of displaying color as far as computers are concerned.



If this check box is enabled, the above values are interpreted as the color proportions of a CMY color. 
This is the usual way of mixing colors in printing.



These color fields contain 32 standard colors. They can be changed by clicking in the color field, which 
avoids the difficult process of entering the color proportions as figures.



The name of the current color is shown in this field. To define a new color, the color is first defined in the 
field above. The name to be used is then entered here and the "Apply" button clicked on.



This list contains the names of all currently defined colors. If a color which is already defined is specified 
in the field above, the appropriate entry is specified.



A new color can be defined, or an existing one redefined, with this button. To define a new color, first set 
it up in the fields above. Then enter its name and click on this button. If a color with this name already 
exists, it redefined. Colors whose names begin with a * cannot be redefined.



This button can be used to rename the color selected in the list. A dialog appears, in which the name can 
be changed. Colors, whose name begins with a * cannot be changed.



With this button, the color selected from the list can be deleted. Colors, whose name begins with a * 
cannot be deleted.



This text shows the path of the directory whose contents are shown in the file list. This path is always 
shown in front of the file name in the "Name" field.



The name of the file to be used is entered in this field. If there is a file in the list whose name begins with 
the character entered, this file is put at the top of the list.



The extension for the files to be displayed can be selected from this list. There are usually only two or 
three file extensions available. If a standard ending (e.g. T3G or T3L) is chosen, it is forced. This means 
that the chosen ending is applied to all files.
For example, if a drawing file called MYFILE is entered, the extension T3G will be used, the resulting 
file will be called MYFILE.T3G.

Note: The ending specified here does not show the file format to be read or written. For example, if the 
command Save Drawing as has been used to select the ending *.* the drawing will still be saved in TVG 
3.0 format, but with the selected extension.



All the files in the current directory with the specified extension are shown in this list. Clicking once on a 
filename puts that name in the "Name" field, where it can be changed. Double-clicking on a file name 
selects that file and closes the dialog as if the "OK" button had been clicked on



All the sub-directories in the current directory are shown in this list. Double-clicking on a directory name 
will open or close that directory.



All available disk drives are shown in this list. Selecting a disk drive name makes that drive the active 
drive, and the path shows current root directory of that drive.



Clicking on this button displays brief information about the file whose name is in the "Name" field. If the 
program recognizes the file format, the file details are shown (see also the Details dialog). Otherwise, 
only the name, size and creation date are shown.



Clicking on this button changes the current path to the default path for the file type. See System 
Configuration>Paths.



Clicking on this button display the help text for this dialog window.



Clicking on this button accepts the current file name. If a standard ending has been chosen from the list of
extensions (e.g. T3G or T3L) this is forced. This means that the file will use the selected extension, 
whichever extension is entered.
The program checks whether the file already exists. If the file to be loaded does not exist, then an error 
message appears and the dialog remains open. If a file with the same name as the one to be saved already 
exists, a message appears and you can choose whether or not to overwrite the existing file.



Clicking on this button will close the dialog, without loading or saving a file.



These color fields contain 32 standard colors. A color can be chosen by simply clicking in a color field.



This list shows the names of the 32 standard colors. A color can be chosen by simply clicking in the list.



This text shows the current printer. Next to the printer name, the port to which it is connected is shown.



The number of copies to be made - between 1 and 250 - is shown in this field. If a multi-page document is
printed, all copies of one page are printed together, as this is quicker.



The scaling for the printed output can be entered here. All the drawing objects are scaled by this factor. 
This also affects the line widths and the length of dashes in lines. Dimensions are not however changed.



The text for a header to be printed on each page can be entered in this field. Control characters can be 
used within the text to print variable data. Control characters always begin with the percent character '%'. 
To print a single percentage character, two percent symbols must be entered one after another. The 
following control characters are available:
%Z or %z Drawing File Name
%P or %p Page Number (if printing on several pages)
%D or %d Current Date
%T or %t Current Time
%A or %a Name of the Author
%N or %n Name of the Change Author

The form in which the date and time are output can be changed with the command Settings>Time Format.



The horizontal position for the header can be specified in this list. It is always in the upper line of the 
page's printable area.



The text for a footer to be printed on each page can be entered in this field. Control characters can be used
within the text to print variable data. Control characters always begin with the percent character '%'. To 
print a single percentage character, two percent symbols must be entered one after another. The following 
control characters are available::
%Z or %z Drawing File Name
%P or %p Page Number (if printing on several pages)
%D or %d Current Date
%T or %t Current Time
%A or %a Name of the Author
%N or %n Name of the Change Author

The form in which the date and time are output can be changed with the command Settings>Time Format.



The horizontal position for the footer can be specified in this list. It is always in the lower line of the 
page's printable area.



The distance of the upper margin of the printable area from the edge of the page can be entered here. The 
value is entered in the current line unit.
Most printers cannot print in an area between 5 and 20 mm from the edge of the page. If a smaller value is
entered here, then the smallest possible margin is used.



The distance of the lower margin of the printable area from the edge of the page can be entered here. The 
value is entered in the current line unit.
Most printers cannot print in an area between 5 and 20 mm from the edge of the page. If a smaller value is
entered here, then the smallest possible margin is used.



The distance of the left margin of the printable area from the edge of the page can be entered here. The 
value is entered in the current line unit.
Most printers cannot print in an area between 5 and 20 mm from the edge of the page. If a smaller value is
entered here, then the smallest possible margin is used.



The distance of the right margin of the printable area from the edge of the page can be entered here. The 
value is entered in the current line unit.
Most printers cannot print in an area between 5 and 20 mm from the edge of the page. If a smaller value is
entered here, then the smallest possible margin is used.



If this check box is enabled, crop marks to make it easier to cut the pages are printed in each corner of the
page. This is particularly important if a drawing is printed on several sheets which are then cut up and 
aligned.



The options for how many pages to print on are chosen from this list. There are three options:
Single Page

The drawing is printed on a single page. If the drawing is larger than the page, then it is chopped off 
at the edges. The center of the current drawing is printed at the center of the page.

Multiple Pages
The drawing is printed on multiple pages. As many pages as are needed for the whole drawing are 
printed. The print-outs overlap by one printer point. Empty pages within the drawing are output as 
well.

Fit to Page
The drawing is printed on one page, scaled proportionally to fit the page. The print-out is 
automatically centered on the page. The scaling also affects the line width and the length of the 
dashes in dashed lines, but not the dimension values.



If this check box is enabled the print-out is centered with respect to all the pages. Otherwise its position is
not changed.



If this check box is enabled, only those objects and instances which are currently selected are printed.



If this check box is enabled, the print-out is in draft mode. The exact effect depends on the printer and 
driver used. In general, draft mode delivers a poorer quality print out at a higher speed.



This icon represents a portrait page. If the adjacent check box is enabled, portrait pages are used for 
printing. This setting can be changed independent of the current drawing's page format. This can reduce 
the number of pages needed when printing on multiple pages.



This icon represents a landscape page. If the adjacent check box is enabled, the print-out is done on 
landscape pages. This setting can be changed independent of the current drawing's page format. This can 
reduce the number of pages needed when printing on multiple pages.



A rough preview of the printed result is shown in this area. The colored area represents the objects to be 
printed or the drawing. The rectangles show the number of pages required. All changes to the settings are 
reflected in this preview.



The number of pages needed for the print-out are shown in this area. Empty pages are included in the 
calculation.



Clicking on this button, calls a dialog in which a different printer can be selected.



Clicking on this button calls a dialog, in which the selected printer's setup can be viewed and changed. 
The functionality of this dialog depends on the selected printer. Note that the page orientation, print 
quality and margin settings are over ridden by Tek Illustrator.



This button can be used to call dialogs, in which output options can be specified. The following dialogs 
are available:

Output
Plotter

When the button is activated, a small menu appears from which the correct dialog can be chosen.



If this check box is enabled, the page format is passed on. This does not change the appearance of the 
drawing otherwise.



If this check box is enabled, the defaults are changed. The drawing's appearance is not changed, but new 
objects use the new defaults.



If this check box is enabled, the zoom areas are changed. The drawing's appearance is not changed by 
this.
Whether the old zoom areas are replaced by or added to the new ones depends on the settings of the check
boxes "Add" and "Replace".



If this check box is enabled, then the coordinate systems are changed. This can change the appearance of 
the drawing. In particular, dimensions are changed because of changed scales.
Whether the old coordinate systems will be extended or replaced by the new ones, depends on the settings
of the "Add" and "Replace" radio buttons. With the "Add" setting, the existing coordinate systems remain 
unchanged.



If this check box is enabled, the line patterns are changed. This can change the appearance of the drawing.
Whether the new line patterns are added to the existing ones or replace them, depends on the settings of 
the "Add" and "Replace" radio buttons. If "Add" is enabled, the existing Line patterns remain unchanged.



If this check box is enabled, the pens are changed. This can change the appearance of the drawing.
Whether the new pens are added to the old ones or whether they replace them depends on the settings of 
the "Add" and "Replace" radio buttons. If "Add" is enabled, the existing pens remain unchanged.



If this check box is enabled, the layers are changed. This can change the appearance of the drawing. 
Above all, only those layers can be hidden or shown which were previously not hidden or shown.
Whether the new layers are added to the old ones or replace them depends on the settings of the "Add" 
and "Replace" radio buttons. If "Add" is enabled, the existing layers remain unchanged.



If this check box is enabled the objects and instances are changed. This can change the appearance of the 
drawing.
This check box is only available when the "Add" radio button is selected.



If this check box is enabled, the geometry is changed. This can change the appearance of the drawing. 
This check box is only available if the "Add" radio button is enabled.



If this check box is enabled the blocks are changed. This can change the appearance of the drawing.
This check box is only available if the "Add" radio button is enabled.



If this radio button is selected, the elements affected by this setting are added. This means that the new 
elements are added to the existing ones, which remain unchanged.
This almost always results in a renumbering of the new elements. However, their names remain the same.



If this radio button is selected, then the elements which are affected by this setting are replaced. This 
means the existing elements are deleted and replaced by the new ones.



If this check box is enabled, the objects and instances in the current drawing are saved.



If this check box is enabled, only the currently selected objects and instances will be saved.



If this check box is enabled, the current drawing's geometry will be changed.



If this check box is enabled, the blocks from the current drawing will be saved.



If this radio button is selected, the drawing will be saved as a duplicate. A file with the same name as the 
current drawing, but with the extension DUP.



If this radio button is selected, the drawing is saved to the current drawing file. Be careful when using this
command, as it is very easy to overwrite existing files.



The interval between autosaves can be entered in this field. The time is entered in minutes. Times 
between 1 and 60 minutes are allowed.



If this check box is enabled, autosave is on. The other settings are only effective when autosave is on.



The height and width of the bitmap graphic (in screen points) is shown in this area.



The color depth of the bitmap graphic, in Bits per Pixel is shown in this area. This is the original color 
depth, even if your monitor/graphics card can not display it.



The memory needed by the bitmap graphic is shown in this area (in KB). A color graphic is in memory 
twice once in the original color depth, used for output, and once in the color depth used to display it on 
screen. Monochrome graphics only have one copy in memory.



In diesem Eingabefeld wird die X-Koordinate der oberen linken Ecke der Rastergrafik eingegeben. The 
value is entered in the current length unit.



The Y coordinate of the upper left corner of the bitmap graphic is entered in this field. The value is 
entered in the current length unit.



The horizontal resolution which the bitmap is to be shown at is entered in this field. The value is entered 
in the current unit (points per millimeter or points per inch).
Initially, when a bitmap is loaded the value stored as a default in the bitmap is shown.



The vertical resolution which the bitmap is to be shown at is entered in this field. The value is entered in 
the current unit (points per millimeter or points per inch).
Initially, when a bitmap is loaded the value stored as a default in the bitmap is shown.



If this radio button is selected, the adjacent resolutions are displayed in points per inch (2.54 cm). This is 
the usual method of displaying the resolution of bitmap graphics.



If this radio button is selected, the adjacent resolutions are given in points per millimeter.



If this check box is enabled, the bitmap graphic is shown on screen. This setting has no effect on the 
output of bitmaps to a printer, plotter, the clipboard, to a metafile or another bitmap.



The width and height of the resulting bitmap are shown here in pixels.



The memory requirement for the resulting bitmap is shown in this area (in KB). The memory requirement
depends on the height, width and color depth. Bitmaps are stored uncompressed.



The horizontal resolution to be used when creating the bitmap is entered here. The value is entered in the 
current unit (points per millimeter or points per inch).



The vertical resolution to be used when creating the bitmap is entered here. The value is entered in the 
current unit (points per millimeter or points per inch).



If this radio button is selected, the adjacent resolutions are shown in points per inch (2.54 cm). This is the 
usual method of displaying the resolution of bitmaps.



If this radio button is selected, the adjacent resolutions are shown in points per millimeter.



The color depth for the bitmap is chosen from this list. The color depth is shown in bits per pixel. The 
following color depths can be chosen.
1 Bit

Monochrome bitmap. Gray scales achieved by dithering.
4 Bit

16 color bitmap. The first 16 colors from the Windows color palette are used; other colors are 
achieved by dithering.

8 Bit
256 color bitmap. Either the standard colors from the Windows palette (with other colors achieved by 
dithering) or a special 256 color rainbow palette, containing all color combinations in 20% steps, can 
be used. In this case, dithered colors are not used.

It is not currently possible to use higher color depths, as the Microsoft-supplied driver DIB.DRV only 
supports 8 bit color depth at present.



If this check box is enabled (only possible if 8 bit color depth is chosen), the colors are shown as 
undithered colors from a rainbow palette. This gives a "shaper" appearance, but the colors can not be 
shown exactly.



If this check box is enabled, only currently selected objects and instances are exported to the bitmap.



Clicking on this button calls the Output Settings dialog, in which the options for bitmap export can be 
specified.



The color for the comment arrow can be specified from this color field. Clicking in this field with the left 
mouse button calls the Choose Color dialog, where the correct color can be chosen.



The background color for comment fields can be specified using this color field. Clicking in this field 
with the left mouse button calls the Choose Color dialog, where the correct color can be chosen.



The frame color for comment fields can be specified from this dialog. Clicking in this field with the left 
mouse button calls the Choose Color dialog, where the correct color can be chosen.



The text color for comments can be specified using this color field. Clicking in this field with the left 
mouse button calls the Choose Color dialog, where the correct color can be chosen.



The width (in pixels) of the comment field is specified in this field.



The height (in pixels) of the comment field is specified in this field.



The width (in pixels) of the comment arrow is specified in this field. The size of the arrowhead is worked 
out relative to this width.



If this check box is enabled, comments are shown on screen. Comments are drawn in the same order as 
other objects; they can be covered by objects or other comments.



The complete name of the file whose details are currently displayed (and can possibly be changed) are 
shown in this area.



The title of the file can be changed in this field. The title can be up to 63 characters long.

Important! This title serves to identify library and font files. If the title of a library is changed, all 
existing references to this library (and instances of symbols from it) become invalid. They may have to be
updated using the command Replace Symbol / Block oder Replace Library.



The theme of the file can be changed in this field. It can be up to 63 characters long.



The name of the file's author appears in this area. The name which appears here is that of the registered 
user who created the file.



The time at which the file was created is shown in this area. The format can be specified using the 
command Settings>Time Format.



The name of the change author can be changed in this field. It can be up to 63 characters long. Initially 
the name of the registered user is shown here.



The time when the file was last changed is shown here. The format can be changed using the command 
Settings>Time Format.



A comment about the drawing can be entered in this field. It can be up to 255 characters long.



The page format is chosen from this list. Several US and DIN / ISO formats are available.
Custom sizes can be added by entering the dimensions in the relevant fields.



This icon represents "Custom" page format. It is automatically activated if the values in the "Width" and 
"Height" fields are changed.



This icon represents "Portrait" page format. If the adjacent check box is enabled, a page of the size 
specified above in portrait format is used.



This icon represents "Landscape" page format. If the adjacent check box is enabled, a page of the size 
specified above in landscape format is used.



The page width can be entered in this field. The value is entered in the length unit. Note that a unit can be 
specified immediately after the value, e.g. 8.5in.
If the value in this field is changed, then the page format and the page orientation are both set to 
"custom".



The height of the page can be entered in this field. The value is entered in the length unit. Note that a unit 
can be specified immediately after the value, e.g. 14in.
If the value in this field is changed, then the page format and the page orientation are both set to 
"custom".



If this check box is enabled, layer inheritance settings are used for screen display.



If this check box is enabled, the layer inheritance settings are used for output to the printer or plotter, to 
metafiles and bitmaps.



The layer to be changed is chosen from this list. Any currently defined layer can be chosen.



Those properties of the layer chosen from the list to be inherited are shown here in text form. The 
inheritance information can be changed by clicking on the "Properties" button.



A new layer can be defined by clicking on this button. A dialog appears in which the name and number of 
the new layer can be entered. The number used here cannot already be in use and must be between 1 and 
300.
The new layer initially uses the same layer settings as the currently selected layer in the list. Therefore, a 
layer must be selected when a new one is defined.



Clicking on this button calls the Layer Properties dialog, in which the current layer settings can be 
changed.



Clicking on this button calls a dialog in which the name of the selected layer can be edited. The name of 
the "*Standard" layer cannot be changed.



Clicking on this button deletes the selected layer. This action has to be confirmed. The "*Standard" Layer 
cannot be deleted.



If this radio button is selected, the layer currently selected in the list is displayed, i.e. all objects and 
instances in that layer are displayed and can be selected.

If the radio button is not selected, the layer is not displayed, i.e. the objects and instances in that layer are 
not displayed and consequently can not be selected and changed.

Note: If an instance lies in a hidden layer the symbol to which that instance refers is completely invisible 
even if individual objects of the symbol are in visible layers.
On the other hand, if an instance is in a visible layer, and some objects of the symbol to which the 
instance refers are in hidden layers, only those objects are invisible.



If this radio button is selected, the layer which is currently selected from the list is frozen, that is, the 
objects and instances in the layer can not be selected and consequently can not be changed.

If the radio button is not selected, the layer is not frozen. that is the objects and instances in that layer can 
be selected and changed.

Note: Objects and Instances in frozen layers are ignored by operations which alter the whole drawing 
(see, for example, Delete Drawing).



If this check box is enabled, the specified pen is inherited by all objects in the layer. It changes 
automatically, as soon as a pen is selected.



If this check box is enabled, the selected line pattern is inherited by all objects in the layer. It changes 
automatically, as soon as a line pattern is selected.



If this check box is enabled, the selected line width is inherited by all objects in the layer. It changes 
automatically, as soon as the line width is changed.



If this check box is enabled, the selected line color is inherited by all objects in the layer. It changes 
automatically, as soon as the line color is changed.



If this check box is enabled, the specified fill mode is inherited by all objects in the layer. It changes 
automatically, as soon as the fill mode is changed.



If this check box is enabled, the selected fill color is inherited by all objects in the layer. It changes 
automatically, as soon as the fill color is changed.



The layer to which all markings generated from now on are to be assigned can be chosen from this list. As
well as all currently defined layers, the entry "Current" can be chosen. If this is chosen, then the markings 
are assigned to the current layer.



The layer to which newly generated surfaces are to be assigned (see Trim Surface>Generate Surface) can 
be chosen from this list. As well as all currently defined layers, the entry "Current" can be chosen. If this 
is chosen, then the newly generated surfaces are assigned to the current layer.



The layer to which all newly generated dimensions are to be assigned can be chosen from this list. As 
well as all currently defined layers, the entry "Current" can be chosen. If this is chosen, then the 
dimensions are assigned to the current layer.



The layer to which all newly generated texts are to be assigned can be chosen from this list. As well as all 
currently defined layers, the entry "Current" can be chosen. If this is chosen, then texts are assigned to the
current layer.



The layer to which hatchings generated from this point on are to be allocated can be chosen from this list. 
As well as all currently defined layers, the entry "Current" can be chosen. If this is chosen, then the 
hatchings are assigned to the current layer.



The layer to which all instances (references to blocks and symbols) generated from this point should be 
assigned can be chosen from this list. As well as all currently defined layers, the entry "Current" can be 
chosen. If this is chosen, then instances are assigned to the current layer.



The coordinate system to be changed can be selected from this list. All currently defined coordinate 
systems are included in the list.



The current settings of the coordinate system selected from the list are shown in text form in this area.



Clicking on this button calls the Coordinate System View dialog in which the view settings for the 
selected coordinate system can be changed.



Clicking on this button calls the Coordinate System Origin dialog, in which the selected coordinate 
system's origin settings can be changed.



Clicking on this button calls the Coordinate System Units dialog, in which the unit settings of the current 
coordinate system can be changed.



Clicking on this button calls the Coordinate System Numbers dialog, in which the selected coordinate 
system's numbering can be changed.



Clicking on this button calls the Coordinate System Display Grid dialog, in which the selected coordinate 
system's display grid settings can be changed.



Clicking on this button calls the Coordinate System Position Grid dialog in which the selected coordinate 
system's position grid settings can be changed.



A new coordinate system can be defined by clicking on this button. This calls a dialog in which the 
number and name of the new coordinate system are entered. The number used here cannot already be in 
use and must be between 1 and 40.
Initially, the new coordinate system uses the same settings as the one currently selected from the list. A 
coordinate system must therefore be selected when a new one is defined.



Clicking on this button calls a dialog in which the name of the selected coordinate system can be edited. 
The name of the coordinate system called "*Standard" cannot be changed.



Clicking on this button deletes the selected coordinate system. This command must be confirmed with the
dialog which then appears. The coordinate system called "*Standard" cannot be deleted.



The coordinate display mode is chosen from this list. This determines whether the objects should be 
displayed "normally" or "distorted". These options are available:
Cartesian

The objects and instances are shown undistorted. The aspect ratios and angles used on screen are the 
same as those used for output.

Isometric, Left View
The objects and instances in the drawing are distorted (by 30° vertically and scaled horizontally by 
1/cos(30°)) so that the left view of an isometric representation appears undistorted. Both the aspect 
ratios and the angles used on the screen differ from those used for output.

Isometric, Right View
The objects and instances in the drawing are distorted (by -30° vertically and scaled horizontally by 
1/cos(30°)) so that the right view of an isometric representation appears undistorted. Both the aspect 
ratios and the angles used on the screen differ from those used for output.

Isometric, Plan View
The objects and instances in the drawing are distorted (rotated by 30°, distorted by 30° vertically and 
scaled horizontally by 1/cos(30°)) so that the plan view of an isometric representation appears 
undistorted. Both the aspect ratios and the angles used on the screen differ from those used for output.

Dimetric 1, Left View
Dimetric 1, Right View
Dimetric 1, Plan View

Similar to isometric representation, but for dimetric representation with the axes -7° and 41.5°.
Dimetric 2, Left View
Dimetric 2, Right View
Dimetric 2, Plan View

Similar to isometric representation, but for dimetric representation with the axes 7° and 41.5°.

This mode works in a similar way when calculating dimensions. Dimensions are calculated according to 
the representation mode of their reference coordinate systems. This means that correct dimensions can be 
calculated when working in isometric or dimetric view.

Note: DIN standard 5 uses an angle of 42° instead of the 41.5° shown here. Using    42° does not give an 
even line grating, which you can easily check mathematically. An angle of 41.5° gives a perfect line grid.



The rotation angle for the coordinate system, in the angle unit, can be entered in this field.

Note: Rotation of the coordinate system gives the rotation angle in a positive sense relative to the position
of the page. Because the coordinate system is always displayed unrotated, with a rotation angle of 30° the 
screen display will be rotated by-30°.



This button sets the scale to 50:1.



This button sets the scale to 20:1.



This button sets the scale to 10:1.



This button sets the scale to 5:1.



This button sets the scale to 2:1.



This button sets the scale to 1:1.



This button sets the scale to 1:2.



This button sets the scale to 1:5.



This button sets the scale to 1:10.



This button sets the scale to 1:20.



This button sets the scale to 1:50.



The scale to be used can be entered in these fields. Neither value may be 0 or negative.



The position of the origin can be chosen from this list. As well as some positions which are always shown
relative to the page, the entry "Defined Position" can be chosen, and the values in the fields will be used.



The X coordinate of the origin can be entered here. The value is entered in the length unit.
Changing the value in this field automatically changes the coordinate position entry to "defined position".



The Y coordinate of the origin can be entered here. The value is entered in the length unit.
Changing the value in this field automatically changes the coordinate position entry to "defined position".



The length unit to be used can be chosen from this list. Both the full description and the abbreviation for 
the unit are shown.
The length unit is used for all dimension-related input and output. These are coordinates, lengths, radii 
and surfaces. In particular it is used for the calculation and display of length-related dimensions.
When entering values, the current unit can be overridden by entering a different specific unit.



The line unit to be used can be chosen from this list. Both the full name and the abbreviation for the unit 
are shown.
The line unit is used for all inputs and outputs which are not dependent on the scale. Above all, these are 
line widths and text sizes, but also the origin position or dimension line spacing.
When entering values, the current unit can be overridden by entering a different specific unit.



The angle unit to be used can be chosen from this list. Both the full name and the abbreviation of each 
unit are shown.
The angle unit is used for all angle input and output, including those implied in a term (e.g. sin(45) ).
When entering values, the current unit can be overridden by entering a different specific unit.



The form in which numeric values are to be shown is chosen from this list. There are numerous 
possibilities:
Standard (Floating Point)

The numbers are shown as usual with a floating decimal separator and decimal fractions, e.g. 10.75. 
Zeroes at the end of the number are suppressed down to one 0 after the separator.

Standard (Fraction)
Numbers are displayed as a mixed fraction, e.g. 10 3/4 (10.75). The fraction is reduced 
automatically.

Foot Inch (Floating Point)
All length measurements are given in feet and inches, which means that the origin must be present in 
inches. The number of feet is always a whole number and the number of inches is given as a decimal 
fraction. 170.75 is therefore output as 14'2.75". Zeroes at the end of the number are suppressed 
down to one 0 after the separator.

Foot Inch (Fraction)
All length measurements are given in feet and inches, which means that the origin must be present in 
inches. The number of feet is always a whole number and the number of inches is given as a mixed 
fraction. 170.75 is therefore output as 14'2 3/4". The fraction is reduced automatically.

Yard Foot Inch (Floating Point)
All length measurements are given in yards, feet and inches, which means that the origin must be 
present in inches. The number of yards and feet is always a whole number and the number of inches is
given as a decimal fraction. 170.75 is therefore output as 4yd2'2.75". Zeroes at the end of the 
number are suppressed down to one 0 after the separator.

Yard Foot Inch (Fraction)
All length measurements are given in yards, feet and inches, which means that the origin must be 
present in inches. The number of yard and feet is always a whole number and the number of inches is 
given as a mixed fraction. 170.75 is therefore output as 4yd2'2 3/4". The fraction is reduced 
automatically.

Note: Division into yards, feet and inches, as well as displaying the value as a mixed fraction are only 
carried out when displaying lengths and sizes. Other values like angles or scaling factors are always 
displayed as standard floating point numbers.
Numbers have to be entered a form understood by the program. To enter 170.75 in Yard Foot Inch 
(Fraction) mode, enter: -(4yd+2ft+(2+3/4)in).



The accuracy to be used for output can be entered in this field. Values between 0 and 9 are allowed.
This value shows the maximum number of decimal places to be shown if floating point display is in use 
(e.g. "3" would mean that 1/3 is output as 1.333 , 1.0002 as 1.0 ).
With fractional display it shows the maximum power to which the fraction should be shown (e.g. "4" 
means that fractions up to 1/16 are output precisely, i.e. 7/3 is shown as 2 5/16, and 7/2 is shown as 
3 1/2 ).



This icon represents "No Grid" grid type. If the adjacent check box is enabled, the display grid will be 
inactive regardless of the spacing specified.



This icon represents "Cartesian" grid type. If the adjacent check box is enabled, a cartesian display grid is 
used. The horizontal and vertical grid point spacing is as entered below.



This icon represents "Isometric" grid type. If the adjacent check box is enabled, an isometric display grid 
is used. The "horizontal" spacing is shown on the right axis, and the "vertical" spacing on the left axis.
If this grid type is active, two straight lines are added to the cross hair which shows the isometric view 
axes (30° and -30°) It helps with orientation.



This icon represents "Dimetric 1" grid type. If the adjacent check box is enabled, a dimetric display grid is
used. The "horizontal" spacing is shown on the left axis, the "vertical" spacing on the right axis.
If this grid type is active, two straight lines which show the dimetric axes (-7° and 41.5°). They help 
orientation.



This icon represents "Dimetric 2" grid type. If the adjacent check box is enabled,    a dimetric display grid 
is used. The "horizontal" spacing is shown on the right axis, and the "vertical" spacing on the left axis.
If this grid type is active, two straight lines which show the dimetric axes (7° and -41.5°). They help 
orientation.



The horizontal spacing between grid points can be entered in this field. The value is entered in the length 
unit.



This button sets the horizontal grid point spacing to 0.0 units, this means that the horizontal grid is no 
longer active.



This button sets the horizontal grid point spacing to 0.01 units.



This button sets the horizontal grid point spacing to 0.05 units.



This button sets the horizontal grid point spacing to 0.1 units.



This button sets the horizontal grid point spacing to 0.25 units.



This button sets the horizontal grid point spacing to 0.5 units.



This button sets the horizontal grid point spacing to 1,0 units.



This button sets the horizontal grid point spacing to 2,0 units.



This button sets the horizontal grid point spacing to 2,5 units.



This button sets the horizontal grid point spacing to 5,0 units.



This button sets the horizontal grid point spacing to 10.0 units.



The vertical grid point spacing can be entered in this field. The value is entered in the length unit.



This button sets the vertical grid point spacing to 0.0 units, this means that the vertical grid is no longer 
active.



This button sets the vertical grid point spacing to 0.01 units.



This button sets the vertical grid point spacing to 0.05 units.



This button sets the vertical grid point spacing to 0.1 units.



This button sets the vertical grid point spacing to 0.25 units.



This button sets the vertical grid point spacing to 0.5 units.



This button sets the vertical grid point spacing to 1,0 units.



This button sets the vertical grid point spacing to 2,0 units.



This button sets the vertical grid point spacing to 2,5 units.



This button sets the vertical grid point spacing to 5,0 units.



This button sets the vertical grid point spacing to 10.0 units.



This icon represents "No Grid" grid type. If the adjacent check box is enabled, the position grid is not 
active, independent of the specified spacing.



This icon represents "Cartesian" grid type. If the adjacent check box is enabled, a cartesian position grid 
is used. The horizontal and vertical grid point spacing is as entered below.



This icon represents "Isometric" grid type. If the adjacent check box is enabled, an isometric position grid
is used. The "horizontal" spacing is shown on the right axis, and the "vertical" spacing on the left axis.



This icon represents "Dimetric 1" grid type. If the adjacent check box is enabled, a dimetric grid is used 
for the position grid. The "horizontal" spacing is shown on the left axis, the "vertical" spacing on the right
axis.



This icon represents "Dimetric 2" grid type. If the adjacent check box is enabled, a dimetric grid is used 
for the position grid. The "horizontal" spacing is shown on the right axis, and the "vertical" spacing on the
left axis.



The pen to be changed can be chosen from this list. All the currently defined pens are included in the list.



The current settings of the pen selected from the list are shown in this area.



Clicking on this button calls the Concrete Properties dialog in which the pen output properties (printer, 
plotter, clipboard, metafile and bitmap) can be specified.



Clicking on this button calls the Concrete Properties dialog, in which the pen output and screen display 
properties can be specified at the same time. These settings are based on the pen's current output 
properties.



Clicking on this button calls the Concrete Properties dialog, in which the screen display properties for the 
pen can be specified.



Clicking on this button, calls a dialog in which a layer can be selected. This layer is then set as the current
layer if the pen is chosen.



A new pen can be defined by clicking on this button. This calls a dialog in which the number and name of
the new pen e number used here cannot already be in use and must be between 1 and 40.
The new pen initially has the same properties as the pen selected from the list. Therefore, a pen must be 
selected before defining a new one.



Clicking on this button calls a dialog in which the name of the selected pen can be edited.    The name of 
the pen "*Standard" cannot be changed.



Clicking on this button deletes the selected pen. This command must be confirmed with the dialog which 
then appears. The pen named "*Standard" cannot be deleted.



The pen to be used from this point for dimension lines can be chosen from this list. As well as all the 
currently defined pens, the entry "*Current" is offered. If this is selected, then whichever pen is selected 
at that time is used for dimension lines.



The pen to be used from now on for all dimension texts can be selected from this list. As well as all the 
currently defined pens, the entry "*Current" is offered. If it is selected, whichever pen is currently 
selected is used.



The pen to be used for all text objects created from this point. As well as all the currently defined pens, 
the entry "*Current" is offered. If it is selected, whichever pen is currently selected is used.



The line pattern to be changed can be selected from this list. All currently defined line patterns are 
included in the list.



An example of the current line pattern is displayed here.



A new line pattern can be defined by clicking on this button. This calls a dialog in which the number and 
name of the new line pattern are entered. The number used here cannot already be in use and must be 
between 1 and 40.
The new line pattern initially uses the same settings as the line pattern currently selected from the list. 
Therefore a line pattern must be selected when a new one is defined.



Clicking on this button calls the Edit Line Pattern dialog in which the currently selected line pattern can 
be edited.



Clicking on this button calls a dialog in which the name of the selected line pattern can be edited. The 
name of the "*Standard" line pattern cannot be changed.



Clicking on this button deletes the selected line pattern. This command must be confirmed with the dialog
which then appears. The "*Standard" line pattern cannot be deleted.



The current line pattern is shown in this field. The display adapts to all the changes made in this dialog.



The dash lengths of the current line pattern are shown in this field.



The new or changed dash length is entered in this field. The value entered here must be between 100 and 
10000.



If this radio button is selected, the dash lengths are given in 1/100 of the line width i.e. dependent on the 
line width. This is, for example, required by line patterns according to DIN 15.



If this radio button is selected, the dash lengths are given in 1/100 mm units. This means that they are 
independent of the line width in use.



The current number of dash pairs is shown in this area. If the number is odd, three plus symbols    ("+++")
appear after the number. They show that the last value was used, but has not (yet) been used. When 
another value is entered so that the number of dashes is even again, all the values are used.



Clicking on this button adds the value in the field to the end of the list of dash lengths. Up to 16 line 
lengths per line pattern can be entered.



Clicking on this button inserts the value from the field into the list before the currently selected entry in 
the list of dash lengths. Up to 16 line lengths per line pattern can be entered.



Clicking on this button replaces the currently selected entry in the list of line lengths with the value from 
the field.



Clicking on this button deletes the current entry from the list of dash lengths.



The zoom area is selected from this list. All currently defined zoom areas are included in the list.



The name of the zoom area to be activated or changed can be entered in this field.



Clicking on this button closes the dialog and activates the dialog whose name is in the field. All changes 
made in the dialog are saved.



Clicking on this button closes the dialog without activating a zoom area. All changes made in the dialog 
are saved.



A new zoom area can be defined by clicking on this button. This has the name in the field and contains 
the zoom section visible in the active drawing window.



Clicking on this button deletes the zoom area whose name appears in the field. This command must be 
confirmed with the dialog which then appears.



The name of the current user is shown in this area. If multi-user mode is active (see System 
Configuration>Multi-User Mode), the name of the current user is shown here. Otherwise "All Users" is 
displayed.



This value shows how much of the memory shown is still available. After a long session working with the
program, the memory available can be fragmented so that parts of it are not available any more.
If this figure sinks much below 90%, after saving all changed files, the program should be closed and 
restarted. We are not however aware of any case where this has been necessary.



This value shows in KB how much of the reserved memory is currently unused.



This number shows how many objects and instances are in the current drawing.



This value shows the memory required for the current drawing's objects and instances (in KB). This 
includes the memory required for the undo information.



This number shows the number of blocks in the current drawing.



This value shows the memory required (in KB) for the blocks in the current drawing.



This number shows the number of geometry objects in the current drawing.



This value shows the memory required for the current drawing's geometry objects (in KB). This includes 
the memory required for the undo information.



This number shows the number of symbols currently in the symbol cache.



This value shows the amount of memory (in KB) required for the symbols currently in the symbol cache.



This number shows the number of font characters currently in memory.



This value shows the amount of memory (in KB) required for the font characters in the symbol cache.



This area shows whether or not there is useable graphic information on the Clipboard. Windows Metafile 
(WMF) and Tek Illustrator (TVG 3.0) formats are supported. If both formats are available, Tek 
Illustrator's own format, which is more precise, will be used.



This value shows the horizontal screen resolution in pixels.



This value shows the useable width (in mm) of the screen area, as specified with the command System 
Configuration>Memory and Monitor.



This value shows the useable width (in inches) of the screen area, as specified with the command System 
Configuration>Memory and Monitor.



This value shows the vertical screen resolution in pixels.



This value shows the height (in mm) of the useable screen area as specified with the command System 
Configuration>Memory and Monitor.



This value shows the height (in inches) of the useable screen area as specified with the command System 
Configuration>Memory and Monitor.



This value shows the color depth (in bits per pixel) used for screen display. It determines how many 
colors can be displayed at the same time.



This value shows how many colors can be shown on screen at the same time.



A standard monitor size can be chosen from this list. This automatically sets the "Height" and "Width" 
values.



The width of the useable screen area can be entered in this field. The value is entered in either mm or 
inches (see the adjacent radio button).
This value is used to display the drawing at its original size. In most cases, it is sufficient to click on one 
of the above buttons to match this value to the size of monitor size being used.



The height of the useable screen area can be entered in this field. The value is entered in either mm or 
inches (see the adjacent radio button).
This value is used to display the drawing at its original size. In most cases, it is sufficient to click on one 
of the above buttons to match this value to the size of monitor size being used.



If this radio button is selected, the values in the adjacent field are in mm.



If this radio button is selected, the values in the adjacent field are in inches.



This icon represents buttons in the panel using a font size of 10 pixels. If the adjacent check box is 
enabled, a font size of 10 pixels is used when drawing the panel. The button size is adjusted accordingly.



This icon represents buttons in the panel using a font size of 12 pixels. If the adjacent check box is 
enabled, a font size of 12 pixels is used when drawing the panel. The button size is adjusted accordingly.



This icon represents buttons in the panel using a font size of 14 pixels. If the adjacent check box is 
enabled, a font size of 14 pixels is used when drawing the panel. The button size is adjusted accordingly.



The amount of reserved object memory can be entered (in KB) in this field. Values between 64 and 16384
are allowed.
Object memory is used to hold objects, instances, geometry objects, blocks and for the symbol cache. 
Undo information is also stored there.
If this value is changed, when the dialog is closed the memory is reorganized. To do this the contents of 
the memory are temporarily stored on the hard disk.



The size of steps for memory enlargement (in KB) can be entered in this field. Values between 64 and 
16384 are allowed.
The object memory is increased by this amount if, during an operation, the relevant dialog appears and 
permission is given to increase the memory.
If this value is changed, when the dialog is closed the memory is reorganized. To do this the contents of 
the memory are temporarily stored on the hard disk.



The size of system memory (in KB) to reserve can be entered in this field. Values between 64 and 1536 
are allowed.
System memory is used for internal calculations, e.g. when hatching, generating surfaces or creating 
equidistants.
If this value is changed, when the dialog is closed the memory is reorganized. To do this the contents of 
the memory are temporarily stored on the hard disk.



Clicking on this button sets the values in the above fields to the smallest possible values.



Clicking on this button sets the above fields to medium values. These values are based on the amount of 
physical memory available, not including a swap file if there is one.
This setting is recommended for smaller projects and if another program is running as well as Tek 
Illustrator.



Clicking on this button sets the above fields to high values. These values are based on the amount of 
physical memory available, not including a swap file if there is one.
This setting is recommended for large projects, and if Tek Illustrator is the only program running.



The maximum number of undo levels can be entered in this field. Values between 1 and 100 are allowed.

Note: The maximum number of undoable actions has a large effect on the amount of memory required. 
We recommend values between 3 and 5. This allows a reasonable number of operations to be undone (it is
in any case difficult to remember more than 5 operations) and keeps the memory requirement within 
reasonable limits.



The current default path for settings files is shown here. These files usually end in INF.
The default path serves a "starting value" for all filing dialogs, from which settings files are selected. It 
can be reset by clicking on the "Standard" button in the File Selection Dialog.



Clicking on this button calls a File Selection Dialog, in which the default path for settings files can be 
changed.



The current default path for symbol list files is shown here. These files usually end in SYM.
The default path serves a "starting value" for all filing dialogs, from which symbol list files are selected. It
can be reset by clicking on the "Standard" button in the File Selection Dialog.



Clicking on this button calls a File Selection Dialog, in which the default path for symbol list files can be 
changed.



The current default path for drawing files is shown here. These files usually end in T3G.
The default path serves a "starting value" for all filing dialogs, from which drawing files are selected. It 
can be reset by clicking on the "Standard" button in the File Selection Dialog.



Clicking on this button calls a File Selection Dialog, in which the default path for Drawing files can be 
changed.



The current default path for library files is shown here. These files usually have the ending T3L.
The default path serves a "starting value" for all filing dialogs, from which library files are selected. It can
be reset by clicking on the "Standard" button in the File Selection Dialog.



Clicking on this button calls a File Selection Dialog, in which the default path for library files can be 
changed.



The current default path for font files is shown here. These files usually end in T3L.
The default path serves a "starting value" for all filing dialogs, from which font files are selected. It can 
be reset by clicking on the "Standard" button in the File Selection Dialog.



Clicking on this button calls a File Selection Dialog, in which the default path for font files can be 
changed.



The current default path for Windows Metafile files is shown here. These files usually end in WMF.
The default path serves a "starting value" for all filing dialogs, from which Windows Metafile files can be
selected. It can be reset by clicking on the "Standard" button in the File Selection Dialog.



Clicking on this button calls a File Selection Dialog, where the default path for Windows Metafile files 
can be specified. 



The current default path for Windows bitmap files is shown in this area. These files normally have the 
ending BMP.
The default path is a "Starting point" for all filing operations in which Windows bitmap files are selected. 
It can be reset at any time by clicking on the "Defaults" button in the relevant File Selection Dialog.



Clicking on this button calls the File Selection Dialog, dialog where the default path for Windows bitmap 
files can be specified.



The user's contraction is entered into this field. The contraction can be up to six characters long. If a user 
is chosen from the list, their contraction appears here. 
If the field is empty, then no user is identified and the program will use the general settings with the user 
name set to "All Users".



A specific user can be chosen from this list. For a user to be listed, the user-specific INF and T3G files 
must be present.



Clicking on this button starts Tek Illustrator with the chosen user's settings. 



Clicking on this button calls a dialog where a name and contraction for a new user can be entered. The 
contraction is optional, but may not be more than six characters long and may not contain spaces, special 
characters or periods. 
To start with, the new user has the same settings as the user selected when it was created. Therefore, an 
existing user must be selected when a new one is created. 



Clicking on this button calls a dialog in which the selected user name can be edited. The "All Users" user 
name cannot be edited



Clicking on this button removes the selected user. A warning dialog appears first. The user entry "All 
Users" cannot be deleted.



Clicking on this button closes Tek Illustrator again without starting.





If this radio button is selected, all lines and object edges are drawn through and displayed with a width of 
one pixel



If this radio button is selected, all lines and object outlines are shown with their own line patterns, but 
always with a width of one pixel.



If this radio button is selected, all lines and object outlines are displayed with their own line patterns and 
original line widths. The line width is calculated independently of the zoom, i.e. it is always shown as if 
the current zoom factor was 100%.

Note: This setting has proved to be the best compromise between quick redraws and recognizability of 
the line width.



If this radio button is selected, all lines and object outlines are shown with their own line pattern and their 
original line width. The line width is adapted to the current zoom factor.



If this check box is enabled, all objects and instances in the drawing are displayed. Otherwise, only the 
geometry (if selected) is displayed. 



If this check box is enabled all objects in the drawing are displayed. Otherwise, only instances are shown.



If this check box is enabled all object outlines are shown. Otherwise, only fillings are shown.



If this check box is enabled all object fillings are shown. Otherwise, only object outlines are shown.



If this check box is enabled text and dimension text are shown in the selected font. Otherwise text is 
displayed in a small font which shows the name of the text and the text itself in the form 
[Font Name]Text. This can drastically reduce redraw time when using complicated fonts.



If this check box is enabled instances are displayed completely. Otherwise, just a text in a small font with 
the name of the library and the symbol/block in the form (Library Name)Symbol Name is shown.
This setting also affects groups, as they are displayed via instances.



If this check box is enabled, erasers are displayed in color to make them easier to localize. Otherwise, 
they are visible only indirectly, because of their effect.



If this check box is enabled a rectangular frame appears around selected objects.



If this check box is enabled the outlines of selected objects are displayed as dashed lines.



If this check box is enabled, selected objects are shown by a colored square.



If this check box is enabled the definition points of selected objects are shown by a small colored square.



If this check box is enabled, all definition points in the drawing are shown by a small colored square. This
also applies to definition points within symbols and blocks.



If this radio button is selected, a comma is used as the decimal separator for floating point numbers. In 
this case 7/4 is shown as 1,75 .
Either a point or a comma can be used as the separator when entering numbers, i.e. you can enter 1,75 
or 1.75 .



If this radio button is selected, a point is used as the decimal separator for floating point numbers. In this 
case 7/4 is shown as 1.75 .
Only points can be used as the separator when entering numbers, i.e. you can only enter 1.75 . Entering
1,75 causes an error.



This icon represents the screen layout "One drawing window". If the adjacent radio button is selected, a 
single drawing window which fills the whole screen is shown.



This icon represents the screen layout "Two drawing windows, side by side". If the adjacent radio button 
is selected, two equally sized drawing windows are shown next to each other, filling the whole working 
area.



This icon represents the screen layout "Two drawing windows, above one another". If the adjacent radio 
button is selected, two equally sized drawing windows are shown one above another, filling the whole 
working area.



This icon represents the screen layout "One plus two drawing windows, next to one another". If the 
adjacent radio button is selected, one large drawing window and next to it two small drawing windows are
shown, filling the whole working area.



This icon represents the screen layout "One plus two drawing windows, above one another". If the 
adjacent radio button is selected, one large drawing window is shown with two small drawing windows 
underneath it, filling the whole working area.



This icon represents the screen layout "Four drawing windows". If the adjacent radio button is selected, 
for equally sized drawing windows are shown, filling the whole working area.



This icon represents the screen layout "One plus three drawing windows, next to one another". If the 
adjacent radio button is selected, one large drawing window and three small windows next to it are 
shown, filling the whole working area.



This icon represents the screen layout "One plus three drawing windows, above one another". If the 
adjacent radio button is selected, one large drawing window is shown with three small drawing windows 
underneath it filling the whole working area.



Clicking on this button, sets the screen display of the drawing to a low value.



Clicking on this button, sets the screen display of the drawing to a medium value.



Clicking on this button, sets the screen display of the drawing to a high value.



The accuracy for the screen display of the drawing can be entered in this field, using the current line units.
The accuracy indicates the average line length which should be used when transforming circles, ellipses, 
splines and Bézier curves to polylines. The smaller the number, the larger the number of lines and the 
higher the accuracy.



Clicking on this button sets the output accuracy for the drawing to a low value.



Clicking on this button sets the output accuracy for the drawing to a medium value.



Clicking on this button sets the output accuracy for the drawing to a high value.



The accuracy for the output of the drawing can be entered in this field, using the current line units.
The accuracy indicates the average line length which should be used when transforming circles, ellipses, 
splines and Bézier curves to polylines. The smaller the number, the larger the number of lines and the 
higher the accuracy.



Clicking on this button sets the accuracy for object transformation to a low value.



Clicking on this button sets the accuracy for object transformation to a medium value.



Clicking on this button sets the accuracy for object transformation to a high value.



The accuracy to be used when transforming objects can be entered in this field, using the current line 
units.
The accuracy indicates the average line length which should be used when transforming circles, ellipses, 
splines and Bézier curves to polylines. The smaller the number, the larger the number of lines and the 
higher the accuracy.



A value for the display size of TrueType fonts can be entered here. The value is given in screen pixels. If a
font on screen is smaller than the given value, it is displayed as a filled box.



If this check box is enabled a Ruler is shown in all the drawing windows. Otherwise, just a small field is 
shown in the upper left of each drawing window.



If this check box is enabled then the Panel is shown to the left of the drawing window.



If this check box is enabled the scroll bars are shown in all the drawing windows.



If this check box is enabled the full menu names are used in the menu bar. Otherwise, shortened menu 
names are used.



If this check box is enabled a dashed line is shown in all the drawing windows to indicate the edge of the 
page.



If this check box is enabled a page symbol showing the position of the area on screen relative to the page 
is shown at the lower left corner of each drawing window. In addition the current scale and zoom factor 
are shown underneath the page symbol.



If this check box is enabled and 8-bit color screen display is used, a special rainbow color palette is used. 
The colors, in this case, are not dithered.



If this check box is enabled, TrueType-fonts are converted to surfaces for display purposes. This may be 
necessary with some older video card drivers which do not fully support TrueType-fonts.



If this check box is enabled then the output properties, rather than the specified screen display properties, 
are used to display pens on screen. This can be used to give a kind of preview of the output.

Note: This check box should not normally be enabled, as otherwise the advantages of the pen concept are 
lost.



If this radio button is selected, the page margin is used as the basis for calculating the area to be entered.



If this radio button is selected, the frame around all objects and instances to be output is used to calculate 
the size.



A value can be entered into this field to show how much the output area should deviate from the page 
margin. The value is entered in the current length unit
If a positive value is entered, then the area is enlarged in every direction by the value. If a negative value 
is entered, then the area is reduced. The value only has an effect if the "Page margin" check box is 
enabled.



The value by which the output area should vary from the object frame can be entered in this field.
If a positive value is entered, the area is enlarged in every direction by this amount, if a negative value is 
entered, the area is reduced. This is only effective if the "Object Frame" check box is enabled.



If this check box is enabled the output area is output as a rectangle. The properties set with the adjacent 
"Properties" button are used.



Clicking on this button calls the Output Properties dialog, in which the properties to be used if the area is 
output can be specified.



If this check box is enabled the geometry is output as well. The properties set with the "Properties" button
are used. This setting is independent of the screen display of the geometry.



Clicking on this button calls the Output Properties dialog, in which the properties to be used if the 
geometry is to be output can be specified.



If this check box is enabled the display grid is included in output. The properties specified with the help 
of the "Properties" button are used. The form of the individual grid points is determined with the help of 
the three marking fields "90° Cross", " 45° Cross" and "Circle", the size in the "Size" field.



Clicking on this button calls the Output Properties dialog, in which the properties to be used if the display
grid is to be output.



If this check box is enabled grid points a.o. are shown by a cross with the angles 0° and 90°.



If this check box is enabled grid points a.o. are shown by a cross with the angles 45° and 135°.



If this check box is enabled grid points a.o. are shown by a cross.



The size for the grid points can be entered here. The value is in the line unit. With circles, this value 
shows the diameter, with crosses the half line lengths.



If this check box is enabled markings are included in the output. The properties specified with the help of 
the "Properties" button are used. The form of the individual markings is determined with the help of the 
three marking fields "90° Cross", " 45° Cross" and "Circle", the size in the "Size" field.



Clicking on this button calls the Output Properties dialog, in which the properties to be used if the 
markings are output can be specified.



If this check box is enabled markings a.o. are shown by a line cross with the angles 0° and 90°.



If this check box is enabled markings a.o. are shown by a line cross with the angles 45° and 135°.



If this check box is enabled markings a.o. are shown by a circle.



The size of the markings can be entered in this field. The value is in the line unit. With circles, this value 
gives the diameter; with crosses the half line length.



If this check box is enabled imported bitmaps are output. This is independent of the bitmap screen 
display.



If this check box is enabled TrueType fonts are converted to surfaces for output. This is necessary with 
some older printer drivers which may not support TrueType fonts properly.



If this check box is enabled the screen display properties are used for output instead of the usual output 
properties. This can be used, for example, to export the drawing as shown on screen to a bitmap or 
metafile.

Note: This check box should normally be cleared, as the advantages of the pen concept are lost otherwise.



In this area, the color used for selection frames can be chosen.
The color can be altered by clicking in this area. This calls the Select Standard Color dialog in which a 
default color can be chosen.



In this area, the color used for the display of selected objects can be chosen.
The color can be changed by clicking in this area. This calls the Select Standard Color dialog, from which
another standard color can be chosen.



In this area, the color used to show possible results during variant choice.
The color can be changed by clicking in this area. This calls the Select Standard Color dialog, from which
another standard color can be chosen.



In this area, the color used to show selected points.
The color can be changed by clicking in this area. This calls the Select Standard Color dialog, from which
another standard color can be chosen.



In this area, the color used to draw displayed but unsolicited definition points.
The color can be changed by clicking in this area. This calls the Select Standard Color dialog, from which
another standard color can be chosen.



In this area, the color used to show markings can be chosen.
The color can be changed by clicking in this area. This calls the Select Standard Color dialog, from which
another standard color can be chosen.



In this area, the color used to show objects while they are being drawn. This color is also used to draw the
frame when selecting objects in an area.
The color can be changed by clicking in this area. This calls the Select Standard Color dialog, from which
another standard color can be chosen.



In this area, the background color for the drawing window and display areas in dialogs can be chosen.
The color can be changed by clicking in this area. This calls the Select Standard Color dialog, from which
another standard color can be chosen.



In this area, the color used to show the large crosshair in the active window can be chosen. The color 
displayed is linked with the drawing window's background color so the crosshair is only shown in this 
color if the window background is white.
The color can be changed by clicking in this area. This calls the Select Standard Color dialog, from which
another standard color can be chosen.



In this area, the color used to show the small crosshair in the inactive drawing windows can be chosen. 
The color displayed is linked with the drawing window's background color so the crosshair is only shown 
in this color if the window background is white.
The color can be changed by clicking in this area. This calls the Select Standard Color dialog, from which
another standard color can be chosen.



In this area, the color used to display the page frame and page symbol can be chosen.
The color can be changed by clicking in this area. This calls the Select Standard Color dialog, from which
another standard color can be chosen.



In this area, the color used to show symbol names and text displayed in a small font can be chosen. For 
example, this is the case if an instance cannot be resolved or a particular font is unavailable.
The color can be changed by clicking in this area. This calls the Select Standard Color dialog, from which
another standard color can be chosen.



In this area, the color used to show erasers can be chosen. If erasers are displayed, they are filled with the 
background color and outlined and hatched in the color chosen here.
The color can be changed by clicking in this area. This calls the Select Standard Color dialog, from which
another standard color can be chosen.



In this area, the color used for normal text can be chosen. This is used for the text in buttons as well as the
names of the fields in the status window and text in the active window's ruler.
The color can be changed by clicking in this area. This calls the Select Standard Color dialog, from which
another standard color can be chosen.



In this area, the color used for colored text can be chosen. Colored text is used for the text in the status 
window fields.
The color can be changed by clicking in this area. This calls the Select Standard Color dialog, from which
another standard color can be chosen.



In this area, the color used for inactive text can be chosen. Inactive text is used for the text in inactive 
(unavailable) buttons and the rulers in inactive windows.
The color can be changed by clicking in this area. This calls the Select Standard Color dialog, from which
another standard color can be chosen.



In this area, the color used for the background of screen elements. These are the outer, unused areas of the
panel and the status window.
The color can be changed by clicking in this area. This calls the Select Standard Color dialog, from which
another standard color can be chosen.



In this area, the color used for the background of unpressed buttons and fields in the status window. This 
color is also used as the background color for the ruler.
The color can be changed by clicking in this area. This calls the Select Standard Color dialog, from which
another standard color can be chosen.



In this area, the color used for the background of pressed (active) buttons can be chosen.
The color can be changed by clicking in this area. This calls the Select Standard Color dialog, from which
another standard color can be chosen.



In this area, the color used for the shading below and to the right of a raised button.
The color can be changed by clicking in this area. This calls the Select Standard Color dialog, from which
another standard color can be chosen.



In this area, the color used for the upper and left surfaces of a raised button or the upper and right sides of 
a field in the status window.
The color can be changed by clicking in this area. This calls the Select Standard Color dialog, from which
another standard color can be chosen.



In this area, the color used for the upper and left surfaces of a pressed in button can be chosen.
The color can be changed by clicking in this area. This calls the Select Standard Color dialog, from which
another standard color can be chosen.



In this area, the color used for the icons symbolizing sub-menus in the Pop Up Menu, toolbox and status 
window.
The color can be changed by clicking in this area. This calls the Select Standard Color dialog, from which
another standard color can be chosen.



In this area, the color used to display the icons symbolizing commands in the pop up menu, the toolbox 
and the status window.
The color can be changed by clicking in this area. This calls the Select Standard Color dialog, from which
another standard color can be chosen.



Clicking on this button resets all colors to their defaults. These are the colors which you see in this 
illustration. These colors are matched to each other and meant for use with a white background. They are 
also suitable for use with a black background.



This list shows all the keys which have commands assigned to them with descriptions of the commands.



Clicking on this button restores the Standard Key Assignments.



Clicking on this button deletes the key assignment shown in the list.



If this radio button is selected, clicking the middle mouse button calls the pop up menu which appears at 
the current mouse position.



If this radio button is selected, clicking the middle mouse button in a drawing window calls the standard 
menu in text form, which appears at the current mouse position.

Note: If the menu bar is active (see Main Window), the standard menu can not be used at the same time 
because this would cause problems with the Windows system resources.



If this radio button is selected, the middle mouse button mimics the SHIFT key. It controls the snapping 
function and when selecting objects with the middle mouse button pressed an area can be entered.



If this radio button is selected, the middle mouse button mimics the CONTROL key. It therefore controls 
the duplicate function, and also enables several objects to be selected one after another.



If this radio button is selected, clicking the right mouse button calls the pop up menu, which appears at 
the current mouse position.



If this radio button is selected, clicking the right mouse button in a drawing window calls the standard 
menu, which appears at the current mouse position

Note: If the menu bar is active (see Main Window), the standard menu can not be used at the same time 
because this would cause problems with the Windows system resources.



A description of the command chosen is displayed in this area. This command can only be assigned to one
button.



These buttons symbolize the keyboard keys which can have commands assigned to them. Pressing a 
button assigns the command shown above to the button and the dialog is closed.
If the "Shift" check box is enabled at this time, then the command is assigned to the key combination 
SHIFT+CHOSEN KEY.
If the "Info Mode" check box is enabled at this time, the assignment is not changed; instead the command 
currently assigned to the key is shown. The dialog is not closed.



If this checkbox is enabled when a key is selected, the command is not assigned to the key itself, but to 
the key combination SHIFT+SELECTED KEY.



If this check box is enabled when the key is selected, the submenu containing the command is assigned to
the key. This check box is only available if the selected command is contained in a submenu.



If this checkbox is enabled when a key is selected, no command is assigned to the key; instead, the 
command currently assigned to that key is shown.



The number of sections for linear division is entered here. It can be between 2 and 999.



If this radio button is selected, the length chosen is divided into multiple sections of equal length. 
Markings are placed at the start and end points of the chosen length (see graphic).



The decade number for logarithmic division is entered here. It can be between 1 and 99.



If this radio button is selected, the selected length is divided logartihmically into multiple decades. 
Markings are placed at the start and end points of the length (see graphic).

The logarithmic division always begins at the start point, i.e. the start point is the zero point. If, for 
example, a logarithmic ruler is to be created, then the origin of the ruler must be specified as the start 
point of the length to be divided up.



The number of divisions for division using the golden section is entered here. It can be between 1 and 
999.



If this radio button is selected, the selected length is divided into multiple sections according to the golden
section. Markings are placed at the start and end points of the length. (see graphic).

Division according to the golden section begins at the start point, i.e. the rest of the first division is at the 
start point, then the rest of the second division and so on. The rest of the last division lies at the end point.



The length of the first section in the geometric progression is entered here. The value entered is in the 
current length unit.



If this radio button is selected, the geometric progression is calculated with a fixed factor. It is 
automatically set, as soon as the factor is altered.



A fixed factor for the geometric progression can be entered here.



If this radio button is selected, the geometric progression is calculated with a fixed number of sections. It 
is automatically set as soon as the fixed number is altered.



A fixed number of sections for the geometric progression can be entered here. It can be between 1 and 
999.



If this radio button is selected, the selected length is divided according to a geometric progression. The 
way in which the length is divided depends on whether a fixed factor or number of sections has been 
entered (see graphic).

Note: If a fixed factor is entered, the selected length can not be used fully in most cases. In these cases the
rest of the length to the end point remains unused.

Note: If a fixed number is entered, an unending geometric progression is used as the basis for the 
calculation as the calculation would otherwise be too complex. Because of this, the length, especially with
small numbers of sections, is only partly used.



The length of the first section in the arithmetic progression is entered here. The value entered is in the 
current length unit.



If this radio button is selected, the arithmetic progression is calculated using a fixed summand. It is 
automatically set as soon as the fixed summand is altered.



The fixed summand for the arithmetic progression can be entered here. The value entered is in the current 
length unit.



If this radio button is selected, the arithmetic progression is calculated using a fixed number of sections. It
is automatically enabled, as soon as the fixed number is changed.



A fixed number of sections for the arithmetic progression can be entered here. It can be between 1 and 
999.



If this radio button is selected, the selected length is divided according to an arithmetic progression. 
Exactly how it is divided depends on whether a fixed summand or a fixed number of sections have been 
specified (see graphics).

Note: If a fixed, negative summand is entered, at some stage the steps will become negative. If this 
happens before the end point is reached, then the progression is broken. In addition, the specified length 
can not usually be fully used. In both cases, the rest of the length to the endpoint remains unused.

Note: If a fixed number of steps is entered, it is usually only possible to divide the length up completely if
the sections become negative towards the end, i.e. the progression runs slightly beyond the end point. In 
this case, only the sections which lie on the length are used. This means that the number of sections can 
be less than desired.



A value can be entered into this field, which will be transferred to the underlying list.



All the figures used during division on the basis of relationships between figures are listed here.



The sum of all the numeric values in the list is shown here. This makes it easier to fill up to a particular 
value (e.g. 100 if percentages are used).



Clicking on this button deletes the currently selected value from the list.



Clicking on this button, transfers the value from the above field into the list, above the currently selected 
value. The list can hold up to 20 numbers.



Clicking on this button puts the value in the above field into the list instead of the current value.



Clicking on this button adds the value in the above field to the list of values. The list can contain a 
maximum of 20 numbers.



If this radio button is selected, the length is divided up according to the relationship of the numbers in the 
list (see graphic).



If this check box is enabled the objects to be copied during a multiple copying operation are rotated 
according to their position relative to the reference object. This checkbox is not available for all multiple 
copying operations.



The substitute font can be chosen from this list. This font is used as a substitute for any of Tek Illustrator's
own fonts which are unavailable. Any TrueType font installed on the system or any available Tek 
Illustrator font can be used.



This list shows the name of all currently available Tek Illustrator fonts are shown. The fonts shown here 
are automatically loaded when the program is next started.
The fonts may be marked by letters in front of their names. The letters show operations which are carried 
out when the dialog is closed by clicking on "OK". The following letters may occur:
O stands for Open. A font marked like this is loaded into memory and made available. See the "Open" 

button.
R stands for Remove. A font marked like this is removed from memory and is then no longer available. 

See the "Remove" button.



Clicking on this button enables a new Tek Illustrator font to be added to the list. A File Selection Dialog 
in which the font to be used can be selected.
After selecting the font file, the title of the font is placed in the list. It is then marked with an O (for 
Open). The font itself is loaded when the dialog is closed by clicking on "OK".



Clicking on this button, marks the currently selected font in the list with an R (for Remove). It is 
removed from memory when the dialog is closed by clicking on "OK". If the button is clicked again the 
marking is removed and the font is not removed from memory.



Clicking on this button allows the details of the currently selected font to be viewed. To do this, the 
Details dialog appears.



This icon symbolizes "Frame" filling mode. An object which has this fill mode assigned to it is only 
shown in outline.
If the adjacent radio button is selected, all subsequently generated text objects will use "Frame" filling 
mode. This is particularly a good idea if the text is to be output on a plotter.



This icon symbolizes "Filling" fill mode. An object to which this fill mode is assigned only has its filling 
drawn. If the object can not in principle be filled -e.g. a line -, then it will not be visible.
If the adjacent radio button is selected, then filling fill mode is applied to all subsequently generated 
objects. This is particularly a good idea when using TrueType fonts and output on a dot matrix, inkjet or 
laser printer.



This icon symbolizes "Both" fill mode. An object to which this fill mode is assigned, has both its filling 
and outline drawn. If the object cannot in principle be filled (e.g. a line) only its outline is drawn.
If the adjacent radio button is selected, all subsequently drawn text objects have this fill mode assigned to 
them.



If this radio button is selected, subsequently generated text objects do not have a particular fill mode 
assigned to them, but instead use the fill mode determined by the pen used to draw them.



Clicking on this button closes the dialog and carries out all specified changes. All operations which are 
displayed with a letter in the font list are carried out at this time, i.e. the fonts are either loaded into or 
removed from memory.



The library name to be used can be entered in this field. It can be up to 63 characters long.



If this check box is enabled, the specified library is transferred to all instances. It is automatically reset as 
soon as the library name is changed or the "Select" button is used to choose a symbol.



The name of the block to be used is entered into this field.    It can be up to 63 characters long. If the 
blocks are in folders, the folder names, separated by the \  character must be entered.



If this check box is enabled the specified block name is used for all instances. It is reset automatically as 
soon as the block name is altered or the "Select" button is used to choose a symbol.



The value to be used for the matrix element M11 can be entered in this field. Together with the elements 
M12, M21 and M22 this determines the size, direction and rotation of the symbol or block which the 
instance refers to.



If this check box is enabled the specified matrix element M11 is used for the display matrix of all 
instances. It is automatically reset as soon as the matrix element M11 is changed.



The value to be used for the matrix element M12 can be entered in this field. Together with the elements 
M11, M21 and M22 this determines the size, direction and rotation of the symbol or block which the 
instance refers to.



If this check box is enabled the specified matrix element M12 is used for the display matrix of all 
instances. It is automatically reset as soon as the matrix element M12 is changed.



The value to be used for the matrix element M21 can be entered in this field. Together with the elements 
M11, M12 and M22 this determines the size, direction and rotation of the symbol or block which the 
instance refers to.



If this check box is enabled the specified matrix element M21 is used for the display matrix of all 
instances. It is automatically reset as soon as the matrix element M21 is changed.



The value to be used for the matrix element M22 can be entered in this field. Together with the elements 
M11, M12 and M21 this determines the size, direction and rotation of the symbol or block which the 
instance refers to.



If this check box is enabled the specified matrix element M22 is used for the display matrix of all 
instances. It is automatically reset as soon as the matrix element M22 is changed.



A value for the matrix element M31 can be entered here. This determines the X coordinates for the 
position of the symbol or block's insertion point. The value entered is in the current length unit.



If this check box is enabled then the specified matrix element M31 is used for the display matrices of all 
instances. It is reset as soon as the matrix element M31 is altered.



A value for the matrix element M32 can be entered here. This determines the Y coordinates for the 
position of the symbol or block's insertion point. The value entered is in the current length unit.



If this check box is enabled the matrix element M32 is applied to the display matrices of all instances. It is
automatically reset as soon as the matrix element M32 is altered.



Clicking on this button calls the Select Symbol / Block dialog, where the library name and the block name
can be chosen.



A single line of text can be entered in this field. It can have up to 250 characters. Tab spaces can be 
entered with the TAB key.



Clicking on this button inserts a tab space into the above text. It is shown by a '¬' symbol.



Multiple line text can be entered into this field. It can contain up to 8000 characters. A paragraph end can 
be entered by pressing the ENTER key. A tab space can be entered by using the "Tab" button.



If this check box is enabled, geometry objects are shown. This setting can also be changed using the 
command Function Keys>Geometry (F9), with the F9 key or the corresponding button in the panel.

Note: Geometry objects can only be used for snapping and can only be identified if they are displayed. If 
a new geometry object is drawn, then the geometry will be turned on, if this is not already the case.



If this check box is enabled geometry objects are shown as dashed lines. This makes it easier to 
distinguish them from "normal" objects.

Note: Many graphics card drivers are noticeably slower when displaying dashed lines than solid lines. If 
you have a complex geometry, this can affect the speed of work. Try it for yourself.



If this radio button is selected the geometry objects are shown in the background, i.e. under the drawing 
objects.
The drawing itself remains fully visible, but parts of the geometry are covered by the drawing.



If this radio button is selected the geometry objects are displayed in the foreground, i.e. in front of the 
drawing objects.
All parts of the geometry remain visible, but they cover parts of the drawing.



Clicking on this color field calls the Choose Color dialog, in which the display color for the geometry can
be chosen. A pale color which is not used in the drawing itself should be chosen, to make it as easy as 
possible to distinguish geometry objects.



Clicking on this button adds lines to the previously-specified curve. Their end points can be positioned 
anywhere.

1. Enter end point
Several points can be entered one after another. The curve is extended from the end with a series of 
lines through all subsequently entered points. These points can be entered with the mouse by clicking 
anywhere in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute, 
relative or polar coordinates can now be entered. For further information on coordinate entry, see 
Function Keys>Direct Input (F8).



Clicking on this button adds one line to the previously-specified curve. The length and angle are added 
numerically.

1. Enter length and angle
A dialog in which a length and an angle can be entered appears. After clicking on "OK" a line with 
the specified length, running at the specified angle, is added to the curve.
Clicking on the "Cancel" button reverts to the previous dialog.



Clicking on this button adds Bézier curves to the specified curve. The Bézier curve direction is fully 
independent of the current curve direction.

1. Enter angel point 1
The first angel point determines, through its position relative to the current curve endpoint, the initial 
steepness of the Bézier curve, and by its spacing the size and curvature of the Bézier curve. The angel
point can be entered with the mouse by clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute, 
relative or polar coordinates can now be entered. Relative values relate to the curve's current end 
point. For further information on coordinate entry, see Function Keys>Direct Input (F8).

2. Enter curve end point
The end point of the Bézier curve can be specified with the mouse by clicking anywhere in the 
drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute, 
relative or polar coordinates can now be entered. Relative values relate to the curve's current end 
point. For further information on coordinate entry, see Function Keys>Direct Input (F8).

3. Enter angel point 2
The second angel point determines, through its position relative to the end point of the Bézier curve, 
the final gradient of the Bézier curve and, by its distance, the size and curvature of the Bézier curve. 
The angel point can be entered with the mouse by clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute, 
relative or polar coordinates can now be entered. Relative values relate to the end point of the Bézier 
curve. For further information on coordinate entry, see Function Keys>Direct Input (F8).



Clicking on this button appends Bézier curves to the previously specified curve. The Bézier curve starts at
the previous curve's end point which ensures a smooth transition.

1. Enter angel point 1
The first angel point determines, by its distance from the current end point of the curve, the size and 
curvature of the Bézier curve. The angel point can be entered with the mouse by clicking anywhere in
the drawing. A perpendicular is dropped from this point to a straight line running in the current 
direction of the curve, to determine the final angel point.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute, 
relative or polar coordinates can now be entered. Relative values relate to the curve's current end 
point. For further information on coordinate entry, see Function Keys>Direct Input (F8).

2. Enter curve end point
The end point of the Bézier curve can be specified with the mouse by clicking anywhere in the 
drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute, 
relative or polar coordinates can now be entered. Relative values relate to the curve's current end 
point. For further information on coordinate entry, see Function Keys>Direct Input (F8).

3. Enter angel point 2
The second angel point determines, by its position relative to the end point of the Bézier curve, the 
final gradient of the Bézier curve and, by its distance, the size and curvature of the Bézier curve. The 
angel point can be entered with the mouse by clicking anywhere in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute, 
relative or polar coordinates can now be entered. Relative values relate to the previously specified end
point of the Bézier curve. For further information on coordinate entry, see Function Keys>Direct 
Input (F8).



Clicking on this button adds a circular arc to the previously identified curve. The circular arc is 
determined by two end point and a point through which it should run.

1. Enter arc end point
The end of the circular arc can be entered with the mouse by clicking at any point in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute, 
relative or polar coordinates can now be entered. Relative values relate to the curve's current end 
point. For further information on coordinate entry, see Function Keys>Direct Input (F8).

2. Enter point on arc
The point through which the circular arc should run, can be entered with the mouse by clicking 
anywhere in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute, 
relative or polar coordinates can now be entered. Relative values relate to the previously specified arc 
end point For further information on coordinate entry, see Function Keys>Direct Input (F8).



Clicking on this button adds a circular arc to the previously entered curve. The circular arc begins 
tangential to the specified curve and ends at a specified point.

1. Enter arc end point
The end of the circular arc can be entered with the mouse by clicking at any point in the drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute, 
relative or polar coordinates can now be entered. Relative values relate to the curve's current end 
point. For further information on coordinate entry, see Function Keys>Direct Input (F8).



Clicking on this button attaches circular arcs to the previously specified curve. They are determined by 
specifying a center point and the end angle.

1. Enter center point
The center point of the circular arc can be entered with the mouse by clicking anywhere in the 
drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute, 
relative or polar coordinates can now be entered. Relative values relate to the curve's current end 
point. For further information on coordinate entry, see Function Keys>Direct Input (F8).

2. Enter end angle
The end angle can be entered with the mouse, by clicking anywhere in the drawing. The position 
clicked on, relative to the center point, determines the end angle.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute, 
relative or polar coordinates can now be entered.
In addition, you can enter an angle. This shows the arc's end angle. For further information on 
coordinate entry, see Function Keys>Direct Input (F8).

The appearance of the arc is determined by the current arc direction setting. This can be changed 
using the command Function Keys>Arc Direction (F2), with the F2 key or the button in the panel. If 
the arc direction is positive, then the arc is drawn from the current curve end point to the end angle in 
a mathematically positive (I.e. anticlockwise) direction. If the arc direction is negative, then the arc is 
drawn from the current curve end point to the end angle in a mathematically negative (i.e. clockwise) 
direction (see graphic).

The final appearance of the arc is shown while it is being drawn, and alters instantly if the arc 
direction is changed while it is being entered.

The arc direction of existing arcs is unaffected. To change the arc direction of a circular arc within a 
curve, use the command. Trim Curve>Edit.



Clicking on this button attaches one circular arc to the previously specified curve. The position of the 
center point relative to the previous curve and the arc angle of the circle are then entered directly.

1. Enter angle, length and arc angle
A dialog appears, in which a length, an angle and an arc angle can be entered. After clicking on the 
"OK" button an arc whose center lies at the specified position relative to the previous curve and 
whose arc angle is the same as that entered is attached to the curve.
If the arc angle is positive, the arc is drawn in a mathematically positive sense (i.e. anticlockwise), 
otherwise in a mathematically negative (i.e. clockwise) sense.
Clicking on the "Cancel" button reverts to the previous dialog.



Clicking on this button begins a new outline. Before this, the last-entered outline is closed with a line 
from its start point to its end point.

1. Enter start point
The start point of the new outline can be entered with the mouse, by clicking anywhere in the 
drawing.

Optionally, specific coordinates can be entered. To do this, press the F8 key or ENTER. Absolute or 
polar coordinates can now be entered For further information on coordinate entry, see Function 
Keys>Direct Input (F8).

This button is not available when entering a curve, as a curve can consist of multiple outlines.



The current curve direction, i.e. the gradient to the current endpoint of the curve, is shown here. This 
value is used as a basis, if following curve parts are to be entered tangentialy or relatively polar.
For example, if a Bézier curve is to be rotated by exactly 90 degrees relative to the previous end, this 
value can be increased by 90 degrees (e.g. by entering +90 after it), in order to attach the Bézier curve 
using the operations "Bézier Curve, Tangential Tangents".



Clicking on this button inserts the curve drawn up to this point in the drawing.



Clicking on this button returns to curve entry, as if this dialog had not been called.
If the dialog is closed immediately after entering the start point, the specified start point is ignored, i.e. the
process must be started again.



Clicking on this button cancels curve entry, discarding all the entered points.



If this check box is enabled only objects assigned to the specified layer are used. It is automatically 
enabled as soon as a layer is selected.



If this check box is enabled., only the objects assigned to the specified pen are used. It is automatically 
enabled as soon as a pen is selected.



If this check box is enabled, only objects which have the specified line pattern are used. It is 
automatically enabled as soon as a line pattern is selected.



If this check box is enabled, only objects with the specified line width are used. It is automatically 
enabled as soon as a line width is selected.



If this check box is enabled, only the objects with the specified line color are used. It is automatically 
enabled as soon as the line color is changed.



If this check box is enabled, only objects with the specified fill mode are used. It is automatically enabled 
as soon as the fill mode is changed.



If this check box is enabled, only objects with the specified fill color are used. It is automatically enabled 
as soon as the fill color is changed.



The object types to be used can be chosen from this list. Several object types can be selected by holding 
down the CONTROL key while selecting object types. If the SHIFT key is held down, then areas can be 
selected.



If this check box is enabled, only objects of the types selected in the list are used. It is automatically set as
soon as object types are selected in the list.



The prefix text is entered in this field. This text is output, without a space, in front of the dimension. For 
example, here the letter R is put in front of a radius measurement.



In this field, the dimension itself can be altered. This alteration is only permanent if the "Adapt 
Dimension" check box is not enabled. Otherwise the dimension is recalculated and overwritten when the 
dialog is closed.



The suffix is entered in this field. It appears after the dimension (before any tolerances) without a space 
between it and the number. For example, measurement units can be shown here.



The upper tolerance is entered in this field. This tolerance appears after the suffix, raised by about half a 
line.



The lower tolerance is entered in this field. This tolerance appears after the suffix, lowered by about half a
line.



Clicking on this button inserts the surface symbol (Ansi 128) into the current field. This symbol is only 
available with Tek Illustrator's own fonts. In TrueType fonts, Ansi 128 is usually unassigned.



Clicking on this button inserts the degree symbol ° (Ansi 176) into the current field.



Clicking on this button inserts the Plus / Minus character ± (Ansi 177) in to the current field. 



Clicking on this button inserts the diameter symbol Ø (Ansi 216) in to the current field.



If this check box is enabled the measurement is updated automatically, adapting to changes in the 
measurement position, movement of individual definition points or changes in scale.
If the measurement is to be set "by hand", then this check box must be cleared so that the measurement is 
not immediately overwritten.



The prefix is entered in this field. This prefix appears, without a space, in front of the X coordinates. For 
example, this is where the opening bracket is placed.



The X coordinate can be changed in this field. This change is only permanent if the "Adapt Dimension" 
check box is not enabled. Otherwise the X coordinate is automatically recalculated when the dialog is 
closed.



The mid text can be entered in this field. This text appears, without spaces, between the two coordinates. 
For example a slash \ may be entered here.



The Y coordinate can be changed in this field. This change is only permanent if the "Adapt Dimension" 
check box is not enabled. Otherwise the Y coordinate is automatically recalculated when the dialog is 
closed.



The suffix is entered in this field. This suffix appears, without a space, after the X coordinates. For 
example, this is where the closing bracket is placed.



If this check box is enabled the coordinates are automatically updated. They adapt themselves 
automatically to changes in the position of the dimension or changes in the scale.
If the coordinates are to be set "by hand", then this check box must be cleared so that the coordinates are 
not immediately overwritten.



The hatching type to be used is chosen from this list. You can choose any currently defined hatching type.



Clicking on this button enables a new hatching type to be defined. A dialog appears in which the name of 
the new hatching type can be entered. The name entered here must not already be in use.
The new hatching type initially has the same settings as the hatching type currently chosen from the list. 
Therefore a hatching type must be selected before a new one can be defined.



Clicking on this button calls the Edit Hatching Type dialog, from which the selected hatching type can be 
edited.



Clicking on this button calls a dialog in which the name of the selected hatching type can be edited. The 
name of the "*Standard" hatching type can not be changed.



Clicking on this button deletes the selected hatching type. This choice must be confirmed. The 
"*Standard" hatching type can not be deleted.



If this check box is enabled the appropriate part line is used. The "Distance" and "Properties" details are 
only applied to the hatching if this check box is enabled.



The distance between this part line and the next part line is entered into this dialog. The value is entered 
in the current length unit.



Clicking on this button calls the Output Properties dialog, in which the properties for the part line can be 
chosen.
Only those properties which are inherited are used in the future. Other properties are replaced by the 
current pen's properties when generating the hatching.



The rotation angle for all part lines is entered in this field. The value is entered in the current angle unit.



Clicking on this button calls the Output Properties dialog, in which the properties of all part lines can be 
specified. The properties of the first part line are used as the basis.
Only those properties which are inherited are used further. Other properties are replaced by those of the 
current pen when generating the hatching.



If this check box is enabled the specified layer is inherited. It is automatically enabled as soon as a layer is
selected.



If this check box is enabled the specified pen is inherited. It is automatically enabled as soon as a pen is 
selected.



If this check box is enabled the specified line pattern is inherited. It is automatically enabled as soon as a 
line pattern is selected.



If this check box is enabled the specified line width is inherited. It is automatically enabled as soon as the 
line width is changed.



If this check box is enabled the specified line color is inherited. It is automatically set, as soon as the line 
color is changed.



If this check box is enabled the specified fill mode is inherited. It is automatically enabled as soon as the 
fill mode is changed.



If this check box is enabled the specified fill color is inherited. It is automatically enabled as soon as the 
fill color is changed.



The distance of the extension line from the measured object's edge is entered in this field. The value is 
entered in the current length unit. Negative values result in extension lines which cross the object.



The minimum size for the end symbol on the dimension line is entered in this field. As the size of the end 
symbol is worked out from the width of the dimension line, the minimum line width which should be 
used as the basis of the calculation should be entered here. The value is entered in the current length unit.

Note: If all end symbols (regardless of the dimension line width) should be the same size, the "Minimum 
size" can be set to the corresponding line width (e.g.  0.25mm ) and the "Size factor" to 0 .



The size factor for the end symbols of dimension lines can be entered in this field. The standard size 
(which is independent of the dimension line width) is multiplied by this factor.

Note: If all end symbols (regardless of the dimension line width) should be the same size, the "Minimum 
size" can be set to the corresponding line width (e.g.  0.25mm ) and the "Size factor" to 0 .



This icon symbolizes "Minimum Number of Places" display mode. If the adjacent radio button is 
selected, only as many decimal places will be displayed as absolutely needed. Whole numbers are shown 
without decimal places.



This icon symbolizes "At least one place" number display mode. If the adjacent radio button is selected, 
only as many decimal places as needed, but at least one decimal place, are displayed after dimensions. 
Whole numbers are displayed with one zero after the decimal point.



This icon symbolizes the "Display all places" number display mode. If the adjacent radio button is 
selected, dimension numbers are always shown with as many decimal places as specified in the accuracy 
setting. Whole number are shown with however many decimal places as specified.



This area shows the current path. Analog to paths, this path shows nested folders using a \' symbol as a 
divider.



The library to be used can be chosen from this list. All known libraries (see Libraries) as well as the 
pseudo-library "*" are listed. The pseudo-library "*" contains all the blocks and groups from the current 
drawing. These are always saved with the drawing, and do not form a library.



A folder can be opened or closed from this list. Double-clicking on a folder name opens that folder. 
Double-clicking on the entry [..] closes the current folder and returns to the one above it.
If an order is to be deleted or renamed, it can be selected by simply clicking on it in the list.



The symbol or block to be used can be selected from this list. All the symbols and blocks in the selected 
folder from the library are shown, also those which are not yet in memory.



The name of the symbol or block to be used is entered in this field. The name of the symbol or block 
selected in the list is automatically inserted here.
If a name is entered, the program searches for a symbol in the list whose name matches the characters 
entered. If a match    is found, it is highlighted and selected in the list.
The symbol name and folder name together can be a maximum of 63 characters.



If this check box is enabled the currently selected symbol is displayed. This is only possible if the selected
symbol is already in memory.



The currently selected symbol is displayed in this area. This only happens if the "Display" check box is 
enabled and the chosen symbol is in memory.

Three special elements are shown next to the symbol:
A small square in the color of a selected definition point (usually Blue) shows the 

symbol's insertion point. This point is positioned with the mouse when the symbol is inserted.
A crossed-through rectangle in the selection color (usually Red) shows the frame around 

the symbol.
A hatched rectangle in the color of the page margin (usually Violet) shows the "symbol 

frame" which shows the character cell of text symbols. With other symbols this is usually identical to the 
surrounding frame.



If this check box is enabled when a symbol or block is inserted, then all the symbol's default local 
attributes are inherited by instances of that object.



If this check box is enabled the Define Attributes dialog appears after inserting the symbol or block and 
can be used to edit the attributes of the generated instances.



The scaling factor of the symbol relative to its original size can be entered in this field.



The rotation angle of the symbol, relative to its original position, can be entered in this field. The value is 
entered in the current angle unit.



Clicking on this button sets the symbol's rotation angle to 0°.



Clicking on this button sets the symbol's rotation angle to 45°.



Clicking on this button sets the symbol's rotation angle to 90°.



Clicking on this button sets the symbol's rotation angle to 135°.



Clicking on this button sets the symbol's rotation angle to 180°.



Clicking on this button sets the symbol's rotation angle to 225°.



Clicking on this button sets the symbol's rotation angle to 270°.



Clicking on this button sets the symbol's rotation angle to 315°.



The number of symbols/blocks contained in the current library folder is shown here. A folder can have up 
to 1000 sub-folders and 1000 symbols; i.e. the whole library can hold 1,000,000 symbols.



Clicking on this button removes the assigned symbol from the current symbol button, i.e. sets it to 
(UNDEFINED). This button is only visible when the allocation of a symbol window button is edited from
this dialog.



If this check box is enabled the objects from which the symbol is made up are deleted and replaced by an 
instance of the newly created symbol or block.



If this check box is enabled the standard attributes for the library are applied to the newly generated 
symbol or block. These attributes can be defined with the Libraries command or with the "Attributes" 
button.



If this check box is enabled the Define Attributes dialog appears after the symbol is created; the local and 
global attributes of the newly generated symbol or block can be edited from this dialog.



If this check box is enabled the Output Properties dialog appears after the symbol or block is generated in 
which the output properties of the new symbol or block can be edited.



Clicking on this button enables the name of the currently selected symbol to be altered. A dialog appears 
in which the name can be edited. This button is only available if the selected library can be changed and 
the selected symbol is in memory.

Note: If the name of a symbol is changed, all instances which refer to this symbol will become invalid 
because they will now refer to an undefined symbol name. You can either replace the instances with the 
command Replace Symbol / Block or use the command Edit Properties to change the symbol name in the 
instances to match the new symbol name.



Clicking on this button deletes the currently selected symbol. This operation must be confirmed. This 
button is only available if the selected library can be changed and the selected symbol is in memory.



Clicking on this button calls the Define Attributes dialog, in which the local and global attributes of the 
selected symbol can be edited. This button is only available if the selected library can be changed and the 
selected symbol is in memory.



Clicking on this button calls the Output Properties dialog, in which the output properties of the currently 
selected symbol can be edited. This button is only available if the selected library can be changed and the 
selected symbol is in memory.



Clicking on this button enables the name of the current folder to be changed. A dialog appears in which 
the name can be edited. This button is only available if the selected library can be altered and is fully 
loaded into memory (i.e. the cache is not in use).

Note: If the name of a folder is changed, all instances which refer to symbols in that folder will no longer 
be valid, as they will contain a symbol name which is no longer defined. You can either replace the 
instances with the command Replace Symbol / Block or use the command Edit Properties to change the 
symbol name in the instances to match the new symbol name.



Clicking on this button deletes all symbols and sub-folders from the current folder. This command must 
be confirmed. This button is only available if the selected library can be altered and is fully in memory 
(i.e. the cache is not used).



Clicking on this button calls the Edit Properties dialog, in which either individual or multiple properties of
all the symbols in the current library can be altered. This button is only available if the selected library 
can be altered and is fully in memory (i.e. the cache is not used).



Clicking on this button calls the Copy Symbol / Block dialog, where individual symbols or whole folders 
can be copied.



The name of the library from which the symbol or folder is to be copied is shown in this area.



The name of the library to which the symbol or folder is to be copied is shown in this area.



The name of the symbol or folder is to be copied is shown in this area.



The name of the symbol or folder is to be created is shown in this area.



Clicking on this button calls the Select Symbol / Block dialog in which the symbol or folder to be copied 
can be selected.



Clicking on this button calls the Select Symbol / Block dialog in which the name of the copy (symbol or 
folder) can be specified.



The symbol to be copied is shown in this area. This only happens if the "Display" check box is enabled 
and the symbol is already in memory.

Three special elements are shown next to the symbol:
A small square in the color of a selected definition point (usually Blue) shows the 

symbol's insertion point. This point is positioned with the mouse when the symbol is inserted.
A crossed-through rectangle in the selection color (usually Red) shows the frame around 

the symbol.
A hatched rectangle in the color of the page margin (usually Violet) shows the "symbol 

frame" which shows the character cell of text symbols. With other symbols this is usually identical to the 
surrounding frame.



The symbol to be replaced is shown in this area. This only happens if the "Display" check box is enabled 
and the symbol is already in memory.

Three special elements are shown next to the symbol:
A small square in the color of a selected definition point (usually Blue) shows the 

symbol's insertion point. This point is positioned with the mouse when the symbol is inserted.
A crossed-through rectangle in the selection color (usually Red) shows the frame around 

the symbol.
A hatched rectangle in the color of the page margin (usually Violet) shows the "symbol 

frame" which shows the character cell of text symbols. With other symbols this is usually identical to the 
surrounding frame.



If this check box is enabled the symbol which is to be copied is shown. This is only possible if the symbol
is already in memory.



If this check box is enabled then the symbol to be replaced is shown. This is only possible if the symbol is
already in memory.



Clicking on this button copies an individual symbol. If the target symbol already exists, a dialog appears 
which asks whether it should be replaced or not.
This button is only available if the source symbol is in memory, and the target library can be changed.



Clicking on this button copies all the symbols (but not the sub-folders) in the current folder. If symbols 
with the same name already exist in the target folder, then you are prompted as to whether they should be 
overwritten or if only the other symbols should be copied.
This button is available if the source library is completely in memory (i.e. the cache is not being used) and
the target library can be altered.



The name of the library from which the symbol whose attributes are to be altered comes or which the 
instance refers to.



The name of the symbol or block whose attributes are to be edited are displayed in this area. If the local 
attributes of an instance are edited, the name of the symbol to which the instance refers is shown here.
If the standard attributes of a library are altered, the words "Standard Attributes" appear here.



All currently defined local and global attributes of the symbol or instance with names and content are 
shown here.
The attributes are marked by letters in front of the attribute names. These letters show the attribute types:
G stands for global attribute. Global attributes can only be defined in symbols or blocks, not instances. 

If the attributes of an instance are edited, the attributes of the symbol to which the instance refers 
shown, but they cannot be changed.

L stands for local attribute. Local attributes can be defined in symbols, blocks and instances.
T stands for text attribute. Text attributes can contain any text, up to a maximum of 250 characters.
Z stands for number attribute. Number attributes may be empty or contain text which shows a valid 

number. They can be up to 250 characters long.



Clicking on this button enables a new attribute to be defined. First of all, a dialog appears where the name
of the new attribute can be entered. The name entered here must not already be in use.
If no attribute is selected, then the new attribute initially uses the same settings as the selected attribute. 
Otherwise the new attribute uses the settings "Local attribute" and "Text attribute".



Clicking on this button calls the Edit Attributes dialog where the selected attributes can be changed.



Clicking on this button calls a dialog in which the name of the selected attribute can be edited.



Clicking on this button deletes the selected attribute. This must be confirmed from the dialog which 
appears.



The contents of the attribute can be edited from this field. The maximum length of the attribute is 250 
characters. If the attribute is a "Number attribute" then the content must be either a valid number or it 
must be empty.



If this radio button is selected, the attribute is a global attribute. Global attributes can only be defined in 
symbols and blocks, not in instances. They are valid for all instances which refer to the symbol or block.
Global attributes are used for information which is the same whenever the symbol is used. These are 
mostly details like article numbers, descriptions, prices, weights and so on.



If this radio button is selected, the attribute is a local attribute. Local attributes can be contained in 
symbols, blocks and instances. In symbols and blocks, they serve as defaults, i.e. they show which local 
attributes an instance of the symbol or block should have.
Local attributes are used for information which varies according to the use of the symbol. These are 
things like color, size, etc.



If this radio button is selected, the attribute is a text attribute. Text attributes can contain any text, up to a 
maximum length of 250 characters.



If this radio button is selected, the attribute is a number attribute. Number attributes may only contain text
which shows a valid number or they must be empty. The maximum length is 250 characters.



If this radio button is selected the part list for all instances of symbols from the selected library is 
generated.



If this radio button is selected the parts list for all instances in the drawing is generated.



If this radio button is selected the part list for all currently selected instances in the drawing is generated.



The library for whose instances a parts list should be generated can be selected from this list. The list 
contains all libraries from which at least one symbol is referenced by an instance in the drawing.



If this radio button is selected a data entry is created for every instance of a symbol. If there are several 
instances of a symbol, then an entry is created for each instance.
Local attributes and implicit attributes such as position, rotation angle and scaling are only available if 
this setting is selected.



If this radio button is selected only one data entry is created for all instances of a symbol. If several 
instances of the same symbol exist, they are counted and the total is available as an implicit attribute.
Local attributes and implicit attributes such as position, rotation angle and scaling are not available if this 
setting is selected.



The name of the file to which the parts list should be written can be entered in this area. It can be changed
by clicking on the "Select" button.



If this radio button is selected the parts lists are generated using Ansi characters, which are used by all 
Windows programs.



If this radio button is selected the parts lists are generated using the extended ASCII characters, which are 
used by most DOS programs.

Note: Bear in mind that if the ASCII character set is used, then conversion of the attribute data is needed. 
This usually causes no problems, but some special characters may not be converted correctly.



Clicking on this button enables a parts list file to be selected. This is done from a File Selection Dialog, in
which the file can be specified. This file does not already have to exist.



The characters to be used as record delimiters can be chosen from this list. This is output after each "line" 
of the parts list.
Control characters are shown in the list in pointed brackets. The following control characters (in various 
combinations) are available:
<TAB> Tabulator Ansi 9
<LF> Line feed Ansi 10
<CR> Carriage return Ansi 13



The characters to be used as field delimiters can be chosen from this list. This is output after each 
"column" of the parts list.
Control characters are shown in the list in pointed brackets. The following control characters (in various 
combinations) are available:
<TAB> Tabulator Ansi 9
<LF> Line feed Ansi 10
<CR> Carriage return Ansi 13



The characters to be used as the text delimiter can be chosen from this list. This is output before and after 
each text attribute. If None is chosen, no text delimiter will be output as well as the data field delimiter.



A text can be entered in this field which will be output in the parts list if a text attribute does not exist in a 
specified symbol
Useful substitute texts are, apart from a blank, the texts "-" and "N/A". The substitute texts should be 
entered without quotes or similar delimiters, as a text delimiter is always output before and after it.



A number can be entered in this field to be output when a particular number attribute is not available in a 
specified symbol.
Useful substitute numbers, are, apart from a blank, "0" and "0.0".



Clicking on this button calculates all the attributes available for the parts list with the chosen settings. The
Parts List Attributes dialog appears, in which the attributes to be included in the parts list can be selected.



All the attributes available for output in the parts list are included in this list. These are all global (and, if 
the relevant check box in the previous dialog was enabled) local attributes present in one of the affected 
symbols or instances.
Some implicit attributes, amongst others those which are products of the display matrix, are listed. The 
following implicit attributes are possible:
*0 Symbol Name

The name of the symbol or block, including all folder names (Text type).
*1 Library Name

The name of the library, with a block are group this is "*" (Text type).
*2 Position

Position in the list, beginning with 1 (Number type).
*3 Number

Gives the number of instances of the same symbol/block. If "Equal instances together" is enabled, this
value is always 1. (Number type).

*4 Coordinate x
Shows the X coordinate of the instance's insertion point in mm relative to the center of the page 
(Number type).

*5 Coordinate y
Shows the Y coordinate of the instance's insertion point in mm relative to the center of the page 
(Number type).

*6 Rotation
Shows the instance's rotation angle in degrees (Number type).

*7 Scaling h
Shows the instance's horizontal scaling (Number type).

*8 Scaling v
Shows the instance's vertical scaling (Number type).

*9 Distortion h
Shows the horizontal distortion of the instance in degrees (Number type).

If two or more attributes in different symbols have the same names, they are only shown once. If these 
identically named attributes are of different types, the general type (Global or Text) is shown.

This attribute list can have up to 200 attributes and so some of the local attributes may not be available.



This list shows the order in which the attributes should be output in the parts list. The order is the same as 
the output order, and so this list is not sorted.

Note: Attributes which are not available in all of the affected symbols, blocks or instances can also be 
output. In this case, the values defined as substitute texts or substitute numbers are output.



If this check box is enabled a heading is included as the first line of the parts list. Instead of the content of
the attributes this contains their names. As these names are text, a text delimiter is output before and after 
each name.



Clicking on this button adds the attribute selected in the upper list to the lower list. The lower list can hold
up to 200 attributes.



Clicking on this button inserts the attribute selected in the upper list into the lower list before the 
highlighted attribute. The lower list can hold up to 200 attributes.



Clicking on this button replaces the attribute highlighted in the lower list with the attribute selected in the 
upper list.



Clicking on this button deletes the highlighted attribute from the lower list.



If this radio button is selected all symbols from the current library of which instances exist in the drawing 
are transformed to blocks.



If this radio button is selected all the symbols of which instances exist are converted to blocks.



If this radio button is selected all symbols of which instances exist in the drawing are transformed to 
blocks.



The library whose symbols should be converted to blocks if instances of them exist can be chosen from 
this list. The list contains all the libraries from which at least one symbol is instanced in the drawing.



The path to the target folder to which the symbols within the library "*" should be copied is shown here. 
It is a good idea to specify a separate folder for each library to avoid name duplication problems.



Clicking on this button calls the Select Symbol / Block dialog in which the target folder in the "*" library 
can be chosen.



If this check box is enabled all affected instances in the drawing are adapted automatically, i.e. the 
reference is diverted from the original library to the "*" library.



The name of the library where the symbol whose instances are to be changed is located is shown in this 
area.



The name of the library from which the symbol comes and to which the instances will later refer, is 
shown in this area.



The name of the symbols whose instances should be altered is shown in this area.



The name of the symbol to which instances should later refer is shown in this area.



Clicking on this button calls the Select Symbol / Block dialog in which the symbol whose instances are to
be changed can be chosen.



Clicking on this button calls the Select Symbol / Block dialog in which the symbol to which the instances 
should later refer can be selected.



If this check box is enabled only those instances of the chosen symbol which are currently selected are 
altered.



The library where the symbols whose instances are to be altered are chosen from this list. The list 
contains all the libraries from which at least one symbol is instanced in the drawing.



The library to which the instances should refer is selected from this list. The symbol names within the 
instances remain unchanged, and must therefore be the same as the ones in the original library
All currently recognized libraries (see Libraries) as well as the pseudo-library "*", which contains blocks 
and groups, are shown in the list.



If this check box is enabled only those instances from the selected libraries which are currently selected 
are changed.



If this check box is enabled the library chosen from the list is managed with the help of the symbol cache. 
This means that symbols are only loaded into memory if they are actually needed. Especially with large 
libraries, this can cut down memory use, reducing the load on the program. This check box is only 
enabled when exactly one library is selected in the list.

Note: If automatic loading is not turned on, and the cache is used, the library can be used (it is included in
all the library lists) but its symbols will not be loaded into memory and consequently will not be 
displayed. If the symbols are required in memory later, either automatic loading can be turned off or the 
library can be updated (see the "Update" button).



If this check box is enabled symbols from the library selected in the list (if working with the cache) are 
automatically loaded as soon as they are needed. The check box is only available if exactly one library is 
selected from the list.

Note: If automatic loading is not turned on, and the cache is used, the library can be used (it is included in
all the library lists) but its symbols will not be loaded into memory and consequently will not be 
displayed. If the symbols are required in memory later, either automatic loading can be turned off or the 
library can be updated (see the "Update" button).



If this check box is enabled the library selected from the list can be altered; otherwise it cannot be 
changed. This setting is not file level write protection but is exclusively a restriction for the program. The 
checkbox is only available if exactly one library is selected from the list.



The names of all the currently available (i.e. in memory or at least in the cache) libraries. These libraries 
are automatically loaded the next time the program is started.
The libraries may have a letter in front of their names. These letters show the operations which will be 

carried out when the dialog is closed by clicking on "OK". The following letters are used:
N stands for New. A library marked like this is created, i.e. it does not already exist. See the "New" 

button.
O stands for Open. A library marked like this is loaded into the cache or memory and becomes available.

See the "Open" button.
R stands for Remove. A library marked like this is removed from memory and made unavailable See the

"Remove" button.
U stands for Update. A library marked like this is removed from memory and then reloaded. If the cache

is used, only those symbols which are actually required are loaded into memory again. See the 
"Update" button.

S stands for Save. A library marked like this is saved, i.e. all changes carried out in memory are written 
to the appropriate library file. See the "Save" button.



Clicking on this button closes the dialog and saves the changes. All the operations shown by letters in the 
library list are carried out at this time, i.e. the libraries are created, loaded, saved, updated and so on.



Clicking on this button enables a new library to be created. A File Selection Dialog appears from which 
the library file to be used can be specified.
The Details dialog then appears, in which the details of the library file can be specified. The title of the 
new library must be entered in the "Title" field. This title is used later to identify the library. It can in 
theory be changed later, but this leads to a lot of extra work as all the drawings which use symbols from 
this library have to be adapted.
After entering the title of the new library, it appears in the list. It is marked with an N (for New). The 
library itself is created when the dialog is closed by clicking on OK. A newly created library is initially 
editable and is automatically loaded. The cache is not used.
The library list can hold up to 50 libraries.



Clicking on this button places an existing library in the library list. A File Selection Dialog appears, in 
which the library file to be included in the list can be specified.
After selecting the library file, its name appears in the list. It is marked with an O (for Open). The library
itself is loaded when the dialog is closed by clicking on OK. A newly opened library will be automatically
loaded and will use the cache, but cannot be edited.
The library list can hold up to 50 libraries.



Clicking on this button marks the library which is currently highlighted in the list with an R (for 
Remove). When the dialog is closed by clicking on OK, the library is removed from memory. Clicking 
again on the button removes the marking, so that the library is not removed.

If the marked libraries include libraries which have been altered, a question appears, asking whether or 
not the alterations should be saved before removing the libraries from memory. If this question is 
answered with "Yes", then all the altered libraries are marked with an S (for Save). See the "Save" 
button.



Clicking on this button enables the details of the library which is currently selected in the list to be edited.
This is done from the Details dialog. Only the details of libraries which are already in memory can be 
edited. The other details can only be viewed.

Note: The title of the library is used to identify it. It can in theory be changed later, but this leads to a lot 
of extra work as all the drawings which use symbols from this library have to be adapted.



Clicking on this button enables the standard attributes of the library currently selected in the list to be 
edited. This is done from the Define Attributes dialog. Only the standard attributes of libraries which are 
already in memory can be altered.



Clicking on this button marks the currently selected libraries in the list with a U (for Update). They are 
removed from memory when you click on "OK" and reloaded immediately. Clicking on this button again 
removes the marking and the libraries are then not updated.

Note: If a library which uses the cache and is not automatically loaded, then all the required symbols will 
nonetheless be loaded into memory. Automatic loading is unaffected by this.



Clicking on this button marks all the currently selected libraries from the list with an S (for Save). They 
are saved when the dialog is closed by clicking on "OK", i.e. all the changes are written to the library file.
If this button is clicked on again, the markings are removed and the changes are not saved.

Note: If a library which is using the cache is saved, this is done by creating a new library file from the old
library file and the symbols in memory. During copying the library file is held twice on the storage 
medium and the original file is deleted when the save process is over. This can lead to storage capacity 
problems, especially when working with floppy disks.



Clicking on this button generates a copy of the library selected in the list. A File Selection Dialog appears 
in which the library file to be copied can be selected. After this, the Details dialog appears in which the 
details for the library file can be specified. The title of the copied library must be entered under "Title". 
The title of the library is used to identify it. It can in theory be changed later, but this leads to a lot of extra
work as all the drawings which use symbols from this library have to be adapted.

The copy is created immediately, i.e. while the dialog is still open. The copied library can therefore be 
loaded into the list using the "Open" button.



Clicking on this button returns the dialog to the state it was in originally. All the markings are removed, 
libraries to be created are removed from the list and the library settings are reset to their original values.
Alterations to the details and settings of the libraries are not affected by this, i.e. changes remain in effect.



The text "Altered" is shown whenever the library selected from the list has been altered since the last 
save. This also applies to newly generated libraries.



The sort mode for the symbol window buttons can be selected from this list. The following modes are 
available:
No Sort

The buttons are not sorted, that is each button keeps its assignment until it is explicitly altered. This 
setting should always be used when the symbol window is to be shown on a digitizer.

Pack Tight
The buttons are tightly packed, i.e. gaps are filled by shuffling the buttons.

Library / Symbol
The buttons are sorted first according to library name and then within libraries according to symbol 
names. Gaps are always filled.

Symbol / Library
The buttons are sorted first according to symbol names and if there are any, identically named 
symbols are sorted according to library names as well. Gaps are always filled.



If this check box is enabled the button's number is shown (1.100).



If this check box is enabled the scaling of the symbol relative to 1.0 is shown.



If this check box is enabled the rotation angle of the symbol is shown in degrees.



If this check box is enabled the library name of the symbol is shown.



If this check box is enabled the name of the symbol including folders is shown.



If this check box is enabled the symbol itself is shown in a small field inside the button.

Three special elements are shown next to the symbol:
A small square in the color of a selected definition point (usually Blue) shows the 

symbol's insertion point. This point is positioned with the mouse when the symbol is inserted.
A crossed-through rectangle in the selection color (usually Red) shows the frame around 

the symbol.
A hatched rectangle in the color of the page margin (usually Violet) shows the "symbol 

frame" which shows the character cell of text symbols. With other symbols this is usually identical to the 
surrounding frame.



The number of pens available to the plotter is entered in this field. Values between 1 and 8 are allowed, 
normal values are 2, 6 or 8.



All available pens are shown in this list. The line width and color of the selected pens are shown and can 
be altered from the fields to the right of the list.



The width of the pen selected from the adjacent list can be changed here. The width is entered in the 
current length unit.
If the pen width is set to 0.0, the pen is not used. A value of 0.0 should be entered if the corresponding pen
is not to be used, e.g. there is no pen in this position in the plotter's pen carousel.

Note: The exact pen width, not the approximate pen width, which should be assigned to the pen in the 
plotter driver settings



The color of the pen selected in the adjacent list can be selected from this color field. To do this, click the 
left mouse button in this field to call the Choose Color dialog where the color can be specified.

Note: The actual pen color should be entered here and not the standard color assigned to the pen by the 
plotter driver settings.



Clicking on this button sets the width of the pen which is currently selected in the adjacent list to 0.0. In 
addition its color is set to black.
If the pen width is set to 0.0, the pen is not used. A value of 0.0 should be entered if the corresponding pen
is not to be used, e.g. there is no pen in this position in the plotter's pen carousel.



The lower limit for using the pens can be entered in this field. The value is relative to the pen width and 
can be between 0.0 and 1.0. A pen is used to draw lines whose width lies between the two limits for that 
pen



The upper limit for using the pens can be entered in this field. The value is relative to the pen width and 
can be between 1.0 and 10^6. A pen is used to draw lines whose width lies between the two limits for that 
pen



If this check box is enabled pen adaptation is active for output to a printer or plotter.

Note: This check box must be cleared and reset if you wish to use a device other than a plotter for output.



Clicking on this button inserts a line. It is inserted at the intersection closest to the ID point. The line 
initially has a length of 1 mm and runs from the insertion point to the right.



Clicking on this button converts the element nearest to the ID point to a line. Its start and end points 
remain unchanged.



Clicking on this button converts the element which lies closest to the ID point in to a Bézier curve. Its 
start and end points remain unaltered. The two angel points are placed at 1/4 and 3/4 of the distance 
between the start and end points.
If an element which is already a Bézier curve, the angel points are still moved as described.



Clicking on this button transforms the element nearest to the ID point into a circular arc. Its start and end 
points remain unchanged. The circular arc's radius is entered numerically.

1. Enter radius
A dialog appears, in which the radius can be entered. After clicking on "OK", the element is converted
into a circular arc with the specified radius.

The appearance of the circular arc is determined by the current arc direction. This is set with the 
command Function Keys>Arc direction (F2), with the F2 key or using the button in the panel. In 
addition it is influenced by the "direction" in which the curve runs, i.e. which of the two end points 
was entered first. Finding the correct arc direction for the current curve may be a process of trial and 
error.

To get the correct result, it may be necessary to click on the new circular arc and use the "Invert 
Circular Arc" function to invert it.

If the radius entered is to small to draw a suitable circular arc between the two end points, an error 
message appears.
If an element which is already a circular arc is clicked on, the radius is still reentered and redrawn as 
described. This makes it possible to change the radius and arc direction of a circular arc within an existing
curve.



Clicking on this button inverts the element nearest to the ID point, if it is a circular arc. Otherwise an 
error message appears.



Clicking on this button deletes the element which lies nearest to the ID point. The start point of the next 
element is placed at the start point of the deleted element. Which end of the element is the "start" and 
which is the "end" depends which "direction" the curve runs in, i.e. which of the two end points was 
entered first.

Note: If an element should be cut from a curve so that two curves result, the curve must first be cut at one
end using the command Edit Curve>Cut. The element can then be deleted.



The message is shown here. It is different from case to case. The size of the dialog adapts itself to the 
amount of text.



This icon draws attention to something, which is why it is a loud color. It has no other meaning.



Up to three buttons can be visible at once. The text in the buttons and their functions depend on the text 
above them.
One of the buttons is framed. This button is activated when the ENTER key is pressed. If the ESC key is 
pressed, then, if there is one, the "Cancel" button is activated.



Clicking on this button selects the currently marked object or result. The dialog is closed and the 
operation is carried out.



Clicking on this button marks the next possible object or result.



Clicking on this button marks the previous possible object or result.



Clicking on this button cancels the selection and closes the dialog.

If this dialog appears during identification, the identification can be carried out again. If this dialog 
appears during selection of a result, the selection and therefore the whole operation is canceled.



A whole number can be entered into this field. This value lies in a narrow range. If a value outside the 
range is entered, an error message showing the permitted range appears when the "OK" key is clicked on.



A text, a series of characters, can be entered in this field. The maximum number of characters is usually 
limited, e.g. to 31 or 63 characters. If you try to enter more characters they will not be accepted.

Note: This field, like every text field, can be used with the clipboard. You can copy a marked area to the 
clipboard with the key combination CONTROL+INSERT. Text can be pasted from the clipboard into this 
field using the keyboard combination SHIFT+INSERT.



A floating point number can be entered in this field. This value is normally restricted to a relatively large 
range, e.g. 10^-10 to 10^10. The value is usually entered in a given unit, which is shown after the field.

Note: In a similar way to coordinate entry, calculations can be carried out in this field. The basic 
mathematical functions are available. For further information on entering terms, see Direct Input (F8).



The unit for the value is generally shown after the field where floating point numbers are entered.

Note: This unit can be overridden by entering another one in the number entry field, e.g. 30cm . For 
further information on entering terms, see Direct Input (F8).



The function whose key assignment is to be changed can be chosen from this list. The following functions
are available:
Capture Coordinates

This function takes coordinates straight from the digitizer, for example to trace points from a template
into the drawing.
An input button device which is not used as a mouse key should be used for this function. In this case 
it is possible to accept tracing from the whole digitizer surface, regardless of where the screen area ; 
lies.

Select Command Layer 1
Select Command Layer 2
Select Command Layer 3
Select Command Layer 4

These functions can be used to select command fields on the digitizer, which start specified 
commands. Each command field can be divided into four layers, each of which can be chosen with a 
different button.

Note: The program does not check whether all the specified buttons are available on the current input 
device. If a button is assigned to several layers, the button for the layer with the smaller number is used. 
The other layer, which the button is also assigned to, will not then be accessible.



If this radio button is selected, the function chosen from the above list is always carried out, if the left 
mouse button is pressed. This is only possible, if the input device is outside the digitizer's screen area.

Note: If a button is assigned to several layers, the button for the layer with the smaller number is used. 
The other layer, which the button is also assigned to, will not then be accessible.



If this radio button is selected, the function chosen from the above list is always carried out, if the middle 
mouse button is pressed. This is only possible, if the input device is outside the digitizer's screen area.
Note: If a button is assigned to several layers, the button for the layer with the smaller number is used. 
The other layer, which the button is also assigned to, will not then be accessible.



If this radio button is selected, the function chosen from the above list is always carried out, if the right 
mouse button is pressed. This is only possible, if the input device is outside the digitizer's screen area.

Note: If a button is assigned to several layers, the button for the layer with the smaller number is used. 
The other layer, which the button is also assigned to, will not then be accessible.



If this radio button is selected, the function chosen from the above list is always carried out, if the input 
device button specified in the field is pressed. This is also possible if the input device is inside the screen 
area of the digitizer. The button numbering runs from 0 to a maximum of 15.

If an input device button is used as a mouse button, then it cannot be accessed in Tek Illustrator by a 
shortcut key.

Note: The program does not check whether the specified button is available on the current input device. If
a button is assigned to several layers, the button for the layer with the smaller number is used. The other 
layer, which the button is also assigned to, will not then be accessible.



If this radio button is selected, the function chosen from the above list is deactivated; if a key allocation 
exists it is erased. The function remains unavailable until a new key allocation is made. 





Using the Reference (Information)
TommySoftware® Tek Illustrator does not have a printed reference, but an electronic one in the form of a 
help file. The Reference is installed, unless specifically not selected, together with the program by the 
installation routine.

The Reference contains comprehensive descriptions of all the Tek Illustrator commands and dialog boxes.
In addition, there is a description of all screen elements and settings.

There are several ways of working with the Reference. If you allowed the installation routine to create a 
Program Manager group for Tek Illustrator, that group will contain two book icons, one of which is titled 
"Tek Reference". Double-click on this icon.

Two windows appear on screen. The larger left-hand window (the "Reference Window") shows the 
"Using the Reference" topic (this topic). The smaller right-hand window shows the index to the 
Reference. Any topic chosen in the Index Window will be displayed in the Reference Window.

You can also call the Reference from within Tek Illustrator by choosing the Index command from the 
Help menu.

In addition, you can press the F1 Key at any time in Tek Illustrator. This displays the Reference topic 
relevant to the current command or dialog In the Reference Window. As usual, the Index Window appears
to the right.

This ensures that you get the required information quickly and easily, without time consuming page 
turning and searching indexes and tables of contents - just a simple keypress!

Functional Elements of the Reference
Some words in the reference are double-underlined in a different color. These are "Jumps" which you can 
use to move about the reference. When you click on a jump, you go automatically to another topic related 
to that word or phrase.

If a cross-reference ends with the > symbol (only the case for some entries in the index window), then 
clicking on that cross-reference displays the titles of more topics in the Topic. This "folding out" of a 
Topic can be reversed by clicking on the " ^ ^ ^ " button at the top of the index window.

If a dialog box is shown in a topic, you can get information on the dialog's elements by clicking on the 
relevant part of the picture with the mouse. A further window with information about the dialog element 
appears. If this window contains jumps, they can be selected as usual. To close this window, click again 
with the mouse or press the enter key.

To return to the previous topic, click on the "Back" button in the Reference Window's button bar.

Clicking on the "Index" button displays the Index Window again if you have previously closed it. You can
then choose a new topic to be displayed In the reference window.

You can get help and practice the use of every part of the Windows Help System which is used to display 
the Reference.

To Get Help on Using the Help System 



Choose the How to use Help command from the Help Menu. This can be done from the 
Tek Illustrator menu or from the Reference Window. Choose a theme from the list to see information 
about it.

Finding Information
There are various ways of finding information in the Reference.

Use the Help systems "Search" function. For example, to find information on printing a 
drawing, search for "Printing". This displays a list of all related topics. You can choose a topic from the 
list and read its contents.

Press the F1 key in Tek Illustrator. For example, if the "Print Drawing" dialog is open and
you require information about the settings in this dialog, press the F1 key to display the information.

Use the Reference's Index. Choose the Index command from the Tek Illustrator. Help 
menu. This calls a window with the Reference's index. You can choose the command or dialog which you 
want information on.

To Get Information on a Dialog Box 
In Tek Illustrator, open the dialog by choosing the relevant command and click on the F1 

key.

To Get Information on a Dialog Box Element
Move the mouse pointer over the part of the dialog's picture in the Reference which you 

want information on - it will change to a hand. Click the left mouse button.
Press the Tab key (if need be, several times), to highlight the dialog window element. 

Press the Enter key.

A further window with information about the dialog element appears after choosing the element. If this 
window contains jumps, they can be selected as usual. To close this window, click again with the mouse 
or press the enter key.

To Get Information on a Command
In Tek Illustrator, select the relevant menu and use the arrow keys to highlight the 

command. Press the F1 key.
In Tek Illustrator, call the Popup Menu and position the mouse pointer over the relevant 

command icon. Press the F1 key.
In Tek Illustrator activate a command from the menu, toolbox or by using a keyboard 

combination and press the F1 key.
Use the Reference's Index. Choose the Index command from the Tek Illustrator Help 

menu. This calls a window with the Reference's index. In the list of Menu Commands, click on the menu 
with the command you want information about. Next, click on the command you want information about.

Using a Cross Reference
Move the mouse pointer above a differently colored, double underlined term - the pointer

changes to a hand. Click the left mouse button.
Press the Tab key (if need be, several times), to highlight the differently colored, double 

underlined term and press the Enter key.

To Close the Reference Window (Leaving the Index Window Open)



Activate the Reference window by clicking on it and press ALT+F4.
Click on the Reference window's "Close" button.

To Close the Reference (Closing Both Windows)
Choose the Exit command from the Reference window's File menu or press Alt+F4 

twice.
Click on the Index window's "Exit" button.

Marking Frequently-Used Topics
In exactly the same way as you place a bookmark in various places in a book, you can place electronic 
bookmarks into the Reference. If you have marked a Topic with a bookmark, you can go to it quickly by 
choosing the relevant bookmark from the Reference window's Bookmark menu.

Placing a Bookmark Into a Topic
Go to the Topic which you wish to mark. Choose the Define command from the 

Reference window's Bookmark menu.
Click on the "OK" button to use the name of the Topic as the name of the bookmark, or enter your

own bookmark name and then click on the "OK" button.

The new bookmark name now appears in the Reference window's Bookmark menu.

Going to a Marked Topic
Choose the Bookmark menu from the Reference window and select the name of the 

bookmark you wish to view.
If you have defined more than nine Bookmarks, you can choose the menu entry More to see a list

of all your defined Bookmarks.

Removing a Bookmark
Choose Define from the Reference window's Bookmark menu. Choose the Bookmark 

which you want to remove. Click on the "Delete" button and then on "OK".

Annotating a Topic
You can add your own comments - Annotations - to each Topic in the Reference. Annotations can be up to
2000 characters long and can include any valid character. If you have added an annotation to a Topic, then
a paperclip symbol will be placed to the left of the Topic title, which reminds you that you have added a 
comment to the Topic.

Annotations are not printed if you print a Topic out.

How to Add an Annotation to a Topic
Go to the Topic you wish to annotate. Choose the command Annotate from the Edit 

menu. Enter the text of your comment and click on the "OK" button when you have finished entering 
your text.

Going to an Annotation
Go to the Topic with the annotation you want to view. Click on the paperclip symbol (or 



press the Tab key until the paperclip is highlighted and press Enter).
Click on the "Cancel" key when you have finished reading the annotation.

Removing an Annotation
Go to the Topic with the annotation to be removed. Click on the paperclip symbol (or 

press the Tab key until the paperclip is highlighted and press Enter).
Click on the "Delete" key to remove the annotation.

Printing a Topic
You can print individual Topics from the Reference at any time. Doing this prints the whole Topic 
including any embedded graphics. This may require several pages. Annotations (if you have added any) 
will not be printed.

To Set Up Your Printer
Choose the Printer Setup command from the Reference Window's File menu. This calls 

a dialog where you can choose the printer to be used to print the Topic.
To set up the chosen printer, click on the "Setup" button in this dialog.

To Print a Topic
Go to the Topic which you wish to print. Choose Print Topic from the Reference 

Window's File menu. The Topic is printed on the current printer.
Alternatively, click on the "Print" button in the Reference Window's button bar.

You can find further help on using the Tek Illustrator in the electronic tutorial which is included with the 
full version of the Tek Illustrator.

North America, Inc. Germany
130 Barrow Street Selchower Straße 32
New York, NY 10014 D-12049 Berlin
U. S. A. Germany

Phone (212) 807 9720 Phone +49 30 621 5931
Fax (212) 807 8149 Fax +49 30 621 4064
CompuServe 100020,3647 CompuServe 100142,3665
America Online "TSNA"
Prodigy "JULE73A"

Note: All of the vector graphics and tables used in this Help file were generated with the Tek Illustrator 
and either exported via the Clipboard or imported into Word for Windows as a Windows Metafile. 
Markings are output as crosses, in order to generate the point markings quickly and easily.

Tek Illustrator Reference - Version 3.11e - Copyright 1995 TommySoftware®



Installing TrueType Fonts (Information)
One of the TommySoftware® Tek Illustrator installation diskettes might contain TrueType fonts licensed 
from FontShop, which you can install on your system.

Please note that these fonts are subject to the same license conditions as the Tek Illustrator. This means 
that if you do not have a multiple-user license you may only install them on one PC. The fonts may not be
distributed, e.g. not even "lent" to a service bureau for use with an imagesetter.

To install the fonts, put disk 1 into the disk drive and carry out the following steps.
1. Start the Control Panel from the Main group of Program Manager by double-clicking on its icon. This

opens a window containing several icons. Double-click on the "Fonts" icon to open the Fonts dialog.
2. Click on the "Add…" button. The "Add Fonts" dialog appears. It contains a (probably empty) List of 

Fonts and combo boxes for choosing the disk drive and directory. From the Drives list choose the disk
in which you have placed Disk 1. The program will then read the disk. The TrueType fonts on Disk 1 
should then appear in the list of fonts. If the list remains empty, check whether or not the Enable 
TrueType fonts option has been enabled. 

3. To do this, click on the "Cancel" button and click on the TrueType button in the Fonts dialog. The 
Enable TrueType Fonts check box should be enabled. If this is not the case, enable the check box and 
then click on the "OK" button, and repeat step 2.

4. Select all the fonts in the list by clicking on the "Select All" button. Enable the "Copy Fonts to 
Windows Directory" checkbox and then click on "OK". The fonts will now be copied on to the PCs 
hard disk.

5. Click on the "Close" button to close the Fonts dialog and then close the Control Panel, for example by
using the keyboard combination Alt+F4.

These fonts should now be available to all Windows programs which support them. Some programs may 
not recognize the fonts until you have changed the active printer. You do not have to install these fonts to 
use Tek Illustrator. However, the fonts only take up a small amount of hard disk space and we recommend
that you do install them.

More fonts can be obtained from FontShop in Berlin. Please note that Tek Illustrator can only offer the 
full variety of text functions when using TrueType fonts. In coorporation with the Adobe Type Manager, 
Tek Illustrator can also use PostScript fonts, but texts using PostScript fonts cannot be distorted or 
converted to surfaces.

For further information, contact FontShop at one these addresses:

FontShop America FontShop UK FontShop Germany
47 West Polk Street 65-69 East Road Bergmannstraße 102
Chicago, Illinois 60605 London N1 6AH D-10691 Berlin
U.S.A. England Germany

Phone 1-800-36-FONTS Phone (071) 490 5390 Phone (030) 69 58 95
Phone 1-800-46-FONTS Phone (071) 490 2002 Fax (030) 692 88 65
Fax 416-593-4318 Fax (071) 490 5391

You can find out the contact details for your local FontShop branch from these addresses.



Service Information (Information)
No large software package is completely bug free, and in spite of comprehensive descriptions of 
procedures and commands, misunderstandings can arise.

If you experience problems with the TommySoftware® Tek Illustrator, there can be many causes. Before 
you approach us with your problem, try the troubleshooting hints which follow. These may assist you to 
eliminate the problem without our help.

Output Problems
1. Some printer drivers are not able to print TrueType fonts correctly in all situations. This problem is 

especially common with rotated text. In this case, enable the "TrueType as Surface" checkbox in the 
Settings>Output.
Most printer drivers also have a setting determining how TrueType fonts are handled. Usually, there is
a "Print TrueType as Graphic" check box in the printer setup Options… dialog; try printing with the 
box enabled and disabled.

Memory Problems
1. If you often get the message "Execution impossible, not enough object memory available. Reserve 

more object memory?" after a short time, you should use the command System 
Configuration>Memory and Monitor to increase object memory. This change remains active next 
time you run the program, so that more memory is available later.
Information about "optimal" memory size can be found in the description of the command described 
above.

2. Insufficient memory also causes the message "The operation is too complex or not enough system 
memory reserved." to appear. The system memory is used for temporary files during complex 
calculations (e.g. hatching, or generating Surfaces.
If this message appears although the calculation is relatively simple, you should use the command 
System Configuration>Memory and Monitor to increase the amount of system memory.

3. Memory problems can also occur when several applications are running at the same time. you should 
therefore make sure that only those applications which you actually need are running. If memory is 
used up unnecessarily, it can lead to a slowing down of all applications.
The speed at which most programs work drops off as soon as Windows starts using virtual memory 
on the swapfile. If you notice a sudden drastic reduction in program speed, then this is probably what 
is happening and you should close at least one application.

If the troubleshooting hints do not get rid of the problem, then please contact us. We offer two support 
methods:

Support via CompuServe
TommySoftware® offers two sections in forums of the CompuServe online service where your question 
can be posted. In these sections, you may also establish links to other users of TommySoftware® 
applications.

For English support, join the "CADD/CAM/CAE Vendor Forum" ( GO TOSOENG ). For German support, 
join the "PC Industrie Forum" ( GO TOSOGER ). In both forums you will find a TommySoftware® message
and library
section. This is also a good place to look for new releases and support files.



Internet users that do not have access to CompuServe forums can post their mails to the Internet address 
100273.1143@compuserve.com, they will automatically be routed to us.



Advice for Plotter Output (Information)
This section contains important information for TommySoftware® Tek Illustrator users who wish to 
output their drawings on an HPGL plotter using the HPPLOT.DRV plotter driver supplied with Windows 
3.1 or obtained from Hewlett Packard. If this applies to you, it is essential to read this section completely.

The plotter driver HPPLOT.DRV (in the version 2.30 of March 27 1990) has many weaknesses. In 
particular this is evident in the way in which the optimal pen is chosen for the current purpose. When 
working with differing line widths it is not always possible to see how the choice has been made.

We have carried out extensive tests (using other programs as well) and have come to the conclusion that 
using this plotter driver will mostly give unusable results.

The resulting output may look correct (the driver, according to Hewlett Packard, is "correct") but the way 
in which the drawing is produced consists of drawing operations which contradict the plotter's principles. 
The reason for this lies with a non-optimal choice of pen and its consequences.

We have, because of this odd behavior, added an extra control structure which tells the plotter driver 
which pen to use. Because this cannot be done in a direct manner (in Windows, a command like Choose 
Pen 5 can only be used conditionally), pen choice is governed exclusively by color. The plotter driver is 
deliberately given false information, to which it reacts in a known manner. This behavior is utilized.

In order to drive your plotter from TommySoftware® Tek Illustrator, proceed as follows.

1. If you have not already done so, install the plotter driver for an HP plotter (e.g. the HP 7550A). 
Instructions for installing a plotter driver can be found in your Windows documentation or Help files.

2. After installing the driver, start its setup dialog. A window with a menu bar should appear. 
3. In the Device list, choose the plotter type which you wish to use for output. If you have an HP 

compatible plotter from another manufacturer, check in its documentation to see which plotter type 
you should use.

4. At the right of the window appear descriptions of various pens. Note the number of pens which 
appear here. According to the plotter type, there should be two, six or eight pens.

5. Click on the "Reset" button. The first eight pens should appear in the list with the following colors:
1 Black p.3
2 Red p.3
3 Green p.3
4 Yellow p.3
5 Blue p.3
6 Red-Violet p.3
7 Aqua p.3
8 Orange p.3

If the plotter has less than eight pens, a correspondingly lower number of pens, whose colors should 
agree with the first of the listed colors, will be shown.

6. If the color allocations do not agree, please alter them accordingly. Do this by choosing a pen from 
the menu and then choosing the required color from the "Pen Color" menu.

7 In the same way, set the actual pen width (or at least an approximate value) and type for each pen in 
the Type menu. The pen colors must remain unchanged even if they do not agree with the actual color
of the pens you are using. Clear the "Draft" check box and enable the "Save" check box. End the 
plotter setup process by clicking on "OK".

8. Start TommySoftware® Tek Illustrator if it is not already running and choose the 
Settings>Plotter.command from the "Config" menu. Enter the value obtained in step 4 into the 



Number field. A maximum of 8 pens can be administered. After this, set the actual width and color 
for each pen.

9. Enable the "Pen Adaptation Active" check box. Note that you must clear and then re-enable this check
box if you print out on another device in between printing out on the plotter.

10 If you have used TrueType fonts in your drawing, choose the command Settings>Output from the 
"Config" menu and enable the "TrueType as Surface" check box.

Note that output of filled surfaces (or characters) takes a long time on a plotter. It is a good idea to use 
outline fonts where possible. By using the "Fonts" command it is possible to force all subsequently-
entered text to be output as outlines.

11. If all the settings altered above are to be saved, choose the Settings>Save As or Settings>Save as 
Default commands from the "Config" menu.

After carrying out these steps, TommySoftware® Tek Illustrator will have been optimized for plotter 
output. TommySoftware® Tek Illustrator always selects the optimal pen.
The procedure for choosing a pen ensures that the optimal pen color is always used, the optimal width is 
chosen next. If a required pen width is not available, then the next pen with a width within a certain 
tolerance is used. If no such pen is found, then the program attempts to draw the line by making several 
passes with a narrower pen.

Note: The functionality described here makes deliberate use of weaknesses in the HPPLOT.DRV 2.30 
Plotter Driver. We cannot guarantee that it will work with other similar Plotter Drivers. However, if you 
can carry out the steps described above (especially regarding color allocation), then it will probably be 
successful.

Although you can use the procedure described here to obtain (in our opinion) better control over an HP 
plotter, we will keep pressing for improvements to the HPPLOT.DRV plotter driver. If and when a driver 
becomes available which can perform optimal pen selection on its own, we will let registered users know.

Affected Command:
Print Drawing



Using Digitizers (Information)
Using Digitizers
Working with TommySoftware® Tek Illustrator can be made a lot easier by using a digitizer (also known 
as "Graphics tablets" or "Digitizing tablets"). A digitizer enables faster and more accurate input than is 
possible with a conventional mouse or trackball, and areas on a digitizer can be used for some commands.

All of the major digitizer manufacturers now offer drivers for Windows 3.1 which enable the digitizer to 
be used instead of a mouse. Particularly interesting are products which offer an "absolute" mode.

Most digitizers offer a choice of input via a "Puck" (resembling a mouse with a magnifier) or a "Stylus". 
In addition there is a bewildering array of other input devices, either wired or wireless.

Which Input Device?
The question of which input device is best depends on the application. If you often input dimensions from
templates, then you should obtain a puck which can be positioned with great precision. On the other hand,
if you do a lot of freehand drawing and enter precise dimensions using a dialog, then a 3-button stylus is 
preferable as it offers a quicker and more natural way of working.

Which Size?
When working with TommySoftware® Tek Illustrator, a 12"×12" (305×305mm) digitizer is usually 
sufficient. Smaller digitizers can be used, but they scarcely leave space outside the working area for 
command fields.

Which Manufacturer?
In principle, you can use any digitizer which has a Windows 3.1 driver. However, we recommend the 
CalComp® range (DrawingBoard, DrawingBoard II or DrawingPad) as they come with an especially 
good driver for Windows 3.1. These devices also offer a range of extra features, explained below.

Special Functions for CalComp® Digitizers
In order to use these extra functions, the CalComp® Tablet Manager must be active. The special functions 
work with the digitizer and are not visible in the TommySoftware® Tek Illustrator menus.

Important!
Before starting TommySoftware® Tek Illustrator, you should select one of the *.DGM files from the 
TSTEK3\SYSTEM directory using the Area Mapping function. Choose the file whose name matches your
screen resolution (e.g. 1024x768.DGM if you are working with a screen resolution of 1024 × 768 
pixels). If you cannot find a file matching your screen resolution, load the file 1280x1K.DGM , as this 
sets the largest available working area on the tablet.

Next you must define the input device's key allocations. Choose the Tablet Manager's "Button macros" 
option. Click on the "Next" button until the input device which you are using is highlighted.

Next, choose the "DEFAULT" entry from the list and click on the "Setup" button. Now you can, amongst 
other things, set the button settings for your input device. We recommend the following settings: 

4-Button-Puck:



Button 0 Left Mouse Button
Button 1 No function (used for tracing in Tek Illustrator)
Button 2 Middle Mouse Button
Button 3 Right Mouse Button

3-Button-Stylus
Button 0 (tip) Left Mouse Button
Button 1 No function (used for tracing in Tek Illustrator)
Button 2 Right Mouse Button

The extra functions are automatically activated if a digitizer is attached and the Tablet Manager is running
when TommySoftware® Tek Illustrator is started. When the program is started, the file CALCOMP.DIG 
which contains information about the digitizer's key and command functions and calibration, is read. 
Whilst the file is being read a window containing information about the driver version and the size of the 
digitizer.

After this, as well as its primary use as a mouse substitute, the digitizer can be used to choose commands 
or trace templates.

Choosing Commands With the Digitizer
TommySoftware® Tek Illustrator normally uses only a small area in the center of the digitizer to represent
the screen. The remaining area is divided into small square fields, each of which is linked to a command. 
If a field is clicked in, the associated command is carried out as if it had been selected from a menu.

If you want to use this function, you should print out the function template. It is exactly the same size as 
the working area of your digitizer and can be placed ander the transparent plastic cover of the digitizer.

If you work with a 12"×12" digitizer you should load the file DIG12X12.T3G from the TSTEK3\
SYSTEM directory If you work with an 18"×12" digitizer, then you should load the file DIG18X12.T3G
. Print these pages with the "Multiple Pages" and "Center Print-Out" options enabled. If possible, print out
on A3 or US Legal (8.5"×14") paper, which will require 2 sheets of paper, as opposed to A4 when 4 
sheets are needed.

Trim the sheets, and fasten them together with sticky tape. Place the function template under the plastic 
cover in the lower left corner of the digitizer. Use the command Calibrate Digitizer to check the exact 
position of the command template.

Altering the Command Allocation
If you wish to change or delete the preset command positions, you can do so by using the Define Digitizer
Command Field or Delete Digitizer Command Field commands. These commands are called by clicking 
on the digitizer.

Tracing Templates
A common use for digitizers is tracing templates. If a puck is used, it is possible to trace with an accuracy 
of up to 1/250" (± 0.1mm).

TommySoftware® Tek Illustrator can be used for tracing by reserving a button on the input device for it. 
Using the Calibrate Digitizer and Set Origin commands the digitizer can be set up accurately for this.



This enables dimensions from a template to be transferred accurately and easily to a drawing simply by 
clicking on the corresponding points. 

Affected commands:
Change Key Assignments
Calibrate Digitizer
Set Origin
Load Assignments...
Save Assignment as...
Define Digitizer Command Field
Delete Digitizer Command Field



Main Window (Screen Elements)
The TommySoftware® Tek Illustrator main window serves as a background for the other screen elements. 
Its main function is to display the menu bar, which provides access to all available commands.

The name of the program and of the current drawing are shown In the main window's title bar. If 
(UNTITLED) is shown here, then the drawing is as yet unnamed.

An asterisk after the drawing name (e.g. MYFILE* ) indicates that the drawing has been changed since it
was last saved.

The size of the Drawing Window changes automatically whenever the size of the main window is altered.

Control Menu

The main window has a control menu from which certain settings relating to the main window can be 
changed. As well as the usual commands for moving and closing the window and altering its size, the 
following commands are available:

Display Menu Bar
This command determines whether or not the menu bar is displayed. If the menu entry has a tick against 
it, the menu bar is displayed.

If the menu bar is not displayed, then pressing the ALT key displays a "flying menu" menu at the current 
mouse position. It can be used like the normal menu bar.
Turning the menu bar off has the advantage of increasing the available work space on the screen.

If the menu bar is active, the standard menu cannot be used at the same time (see Settings>Mouse Button 
Usage), as this would exhaust Windows" system resources.

Save Position
If this menu entry has a tick against it, then the position of the main window is saved when leaving the 
program. The next time that the program is started, it appears in the same place on the screen. The 
position is saved relative to the whole screen.



Panel (Screen Elements)
The Panel is located on the left of the TommySoftware® Tek Illustrator main window. It is made up of 
many buttons with which various functions can be activated. In addition, the buttons show the status of 
the corresponding functions.

In general the setting can be changed by clicking on the button with the left mouse button. Clicking on 
most of the buttons with with the right mouse button calls a dialog box where you can alter the parameters
which apply to the function.

The Panel can be turned off to increase the available work space. This is done with the command 
Settings>Screen.

The Panel consists of the following elements:

Snapping functions and Snapping radius (see Function Keys>Snap (F6) and Snap Modes>Radius)

Snap Mode "Midpoint" (see Snap Modes>Center)

Snap Mode "Quadrant" (see Snap Modes>Quadrant)

Snap Mode "Edge" (see Snap Modes>Edge)

Snap Mode "Corner / End-Point" (see Snap Modes>Corner / End-Point)

Snap Mode "Intersection" (see Snap Modes>Intersection)

Snap Mode "Geometry" (see Snap Modes>Geometry)

Snap Mode "Marking" (see Snap Modes>Marking)

Snap Mode "Other Point" (see Snap Modes>Other Point)

Current arc direction (see Function Keys>Arc Direction (F2))

Current area mode (see Function Keys>Area Mode (F5))

Duplicate function (see Function Keys>Duplicate (F7))

Geometry (see Function Keys>Geometry (F9))

Display grid (see Function Keys>Display Grid (F3))

Position grid (see Function Keys>Position Grid (F4))

Move view (see Control Keys>Edit Step…)



Pen Number 0

Move Pen Display

Pen Numbers 1 to 40 (see Pens>Edit)

Pen Button Display
The buttons with which you select pens display a lot of information. At the left of the button is the pen's 
number. This number always refers to the same pen. A pen can almost always be chosen by its number.

The area on the right of the button displays the properties assigned to the button. With pen 0, these are the
current "Line Color" and "Line Pattern". "Line Width" is displayed as well for all other pens.

The smaller, left hand area of the colored field shows the color use on screen for the pen (not the one used
for output). The larger area on the right of the button shows the pen width. This area uses the color coding
for pen widths in technical drawings laid down by DIN (Deutsche Industrienormen, the German 
Industrial Standards). The following colors are used:

This area is left in the button color for any other width. The color used is based on the output width. 
Lastly, the output line pattern is shown ander the color field.



Drawing Window (Screen Elements)
TommySoftware® Tek Illustrator can work with up to four drawing windows open at the same time. A 
different view of the same drawing can be displayed in each window. To do this, a separate coordinate 
system can be allocated to each drawing window (see Coordinate Systems>Edit).

The drawing windows are the program's actual work space. All point entry is carried out in drawing 
windows. Many commands and keyboard commands are only available when the mouse pointer is within 
a drawing window.

The mouse position in a drawing window is indicated by a cross hair and not by a pointer. The crosshair 
makes it easier to recognize horizontal and vertical movement.

The intersection of the crosshair's lines is the current drawing position. The coordinates of this point are 
shown in the Status Window if it is turned on. In addition, the mouse position can be read from both 
Rulers.

The number of drawing windows is controlled with the command Settings>Screen. Several layouts are 
available which all have one thing in common. All drawing windows in a layout have the same 
height/width relationship. This has the advantage that the contents of two windows can easily be 
swapped. (e.g. see Enlarge Window 2).

The size of the drawing windows changes automatically if the size of the nain window is altered. 
Individual drawing windows cannot be resized.

If several drawing windows are visible, then one of them will always be "active". Which window is active
can be seen by the way the rulers are displayed. A window is activated by clicking on its rulers with the 
left mouse button. Many commands which modify window-specific settings (e.g. Zoom>Section) always 
relate to the active window.

If only one drawing window is displayed, it is automatically the active window.

The page symbol is shown in the lower left corner of each window. This is made up of several elements. 
The outline rectangle shows the whole page and the colored area shows the part of the page which is 
currently visible. In the example shown on the left, the upper left section of a landscape page can be seen. 

Two values are shown anderneath the page symbol. The first value is the current scale, determined by the 
current coordinate system, in this case 1:1. 

The second value shows the current zoom factor, the factor by which the display is larger or smaller than 
actual size, in this case the scaling is 150%, so the zoom factor is 1.5.

The page symbol and the dashed page border can be turned on and off using the command 
Settings>Screen.





Ruler (Screen Elements)
Usually each drawing window has a ruler, which runs along the left and upper edge of the eindow. It 
fulfils several purposes.

Above all, it serves the purpose of orientation when working with coordinates. You can read from the 
ruler the current position of the origin and the coordinates of the crosshair. 

When working with more than one drawing window, the ruler also shows which window is "active" ist. 
The ruler of the active window is displayed normally, but the ruler of an inactive window is shown, like 
unavailable buttons, in a different color. 

A drawing window can be acitated by clicking on its ruler with the left mouse button. Clicking with the 
right mouse button calls the Define Coordinate Systems dialog, in which the coordinate system for that 
window can be set up. 

In the upper left corner of each window at the rulers" intersection, the number of the window is shown. 

If ruler display is turned off using Settings>Screen, a small field in the upper left corner of the window 
remains active. This field shows which window is active. Clicking on this field with the left or right 
mouse button has the same effect as clicking on the ruler. 

Tne window number is shown in this field. 



Status Window (Screen Elements)
The Status window can be placed anywhere on the screen. It has two functions: to display coordinates and
other details for the current operation, and the direct entry of coordinates.

Its appearance depends upon where the mouse pointdr is, and at what stage a command is.

The currently active command's Icon is always shown at the left of the status window. The expected input
is shown in the title bar.

Clicking the mouse button in the status window calls direct coordinate entry (see Function Keys>Direct 
Input (F8)).

The way in which the status window functions depends on the position of the mouse pointer or crosshair 
and the stage of command input.

Inside a Drawing Window
Point Entry without Reference Point

x and y Current crosshair position
Free Unused portion of currently reserved memory in KB
Layer Name of the current drawing layer

Point Entry with Reference Point

x and y Current crosshair position
dx and dy Difference between the current crosshair position and the position of the reference point
w Angle of the current crosshair position relative to the reference point
l Distance of the current crosshair position to the reference point

Identification of Objects

x and y Current crosshair position



Usage Memory requirement for all currently selected objects in KB
Count Number of currently selected objects

Above the Rulers

System Name of the current window's coordinate system
Layer Name of the current drawing layer

Above the Panel

Command Description of the currently active command
Button Description of the button ander the mouse pointer

During Coordinate Entry

For more information on direct coordinate input, see Function Keys>Direct Input (F8).

Control Menu

The status window has a control menu from which certain settings relating to it can be changed. Apart 
from the usual commands for moving and closing the window the following commands are available.

Rearrange
Pushes the window into one of the four corners of the workspace. The status window is normally in the 
lower right corner of the drawing window.

Save Position
If this menu entry has a tick against it, then the status window position is saved when leaving the 
program. The next time that the program is started, it appears in the same place on the screen. The 
position is saved relative to the whole screen.





Symbol Window (Screen Elements)
The symbol window contains 100 buttons which can have Blocks and Symbols allocated to them. This 
makes it easy to access frequently used Symbols rapidly.

Left-clicking on a button allows the Symbol associated with that button to be placed in the drawing. It 
hangs from the crosshair and drops into the drawing at the position of the crosshair when the left mouse 
button is clicked again. This operation can be repeated until the right mouse button is clicked, ending the 
command sequence. 

Right-clicking allows the button allocation to be changed. It calls the Insert Symbol / Block. dialog , in 
which the Library and Symbol name as well as other parameters like scaling and rotation can be 
specified. In addition, the button's Symbol allocation can be cleared.

The values specified here are saved separately for each button, so the same Symbol may be saved several 
times with different parameters (for example, rotated by 0° - 90° - 180° - 270°).

The content and form of the buttons in the symbol window can be changed using the command Symbol 
Window>Display Parameters. The content and display parameters can be saved in a file using the 
command Symbol Window>Save As. This enables you to save different symbol window allocations for 
different applications.

By using the command Save Symbol Window on Exit you can ensure that the symbol window's contents 
are saved when the program is closed and reloaded the next time the program is started. The default 
symbol window contents can be saved at any time using the command Symbol Window>Save As Default.

Control Menu

The symbol window has a control menu from which certain settings relating to it can be changed. Apart 
from the usual commands for moving and closing the window the following commands are available.

Rearrange
Pushes the window into one of the four corners of the workspace. The symbol window is normally in the 
lower right corner of the drawing window.



Save Position
If this menu entry has a tick against it, then the symbol window position is saved when leaving the 
program. The next time that the program is started, it appears in the same place on the screen. The 
position is saved relative to the whole screen.



Toolbox (Screen Elements)
The tool window contains 6, 10 or 14 buttons which can have program command assigned to them. This 
enables frequently-used commands to be accessed easily.

Clicking briefly on one of the buttons with the left mouse button chooses the command associated with 
that button.

Clicking and holding down (for ½ second or more) the left mouse button on a tool window button calls a 
sub menu. This submenu contains all the commands from the same submenu as the one the button's 
command is located in. Another command can be chosen from this submenu; this command will be 
allocated to the button and immediately carried out.
This only works, naturally, enough, for commands which appear in a submenu. If the command appears in
a menu, holding down the mouse button has no effect and the command is carried out immediately.

Clicking the right mouse button on a tool window button calls the Popup Menu with which the command 
allocated to the button can be changed.

The tool window allocations can be saved together with the other settings using the command 
Settings>Save As.

The command Save Settings on Exit can also be used to specify whether or not the settings (including the 
tool window assignments) should be saved when the program is exited and loaded when it is restarted. 
The default settings can also be saved with the command Settings>Save As Default.

Control Menu

 The symbol window has a control menu from which certain settings relating to it can be changed. Apart 
from the usual commands for moving and closing the window the following commands are available.

Rearrange
Pushes the window into one of the four corners of the workspace. The tool window is normally in the 



lower left corner of the drawing window.

Save Position
If this menu entry has a tick against it, then the tool window position is saved when leaving the program. 
The next time that the program is started, it appears in the same place on the screen. The position is saved 
relative to the whole screen.

6 Buttons
10 Buttons
14 Buttons
These commands can be used to specify the size of the tool window. If the size of the window is changed,
the buttons automatically change to their default size.



Selection Window (Screen Elements)
To access an explanation of an individual element in the dialog box shown below, click the left mouse 
button on the element. Explanations are available whenever the mouse pointer changes from an arrow (

) to a hand (
).

The dialog appears whenver an identification was not conclusive or when a calculation produces more 
than one result and the user must choose which one to use.

The title bar of the dialog always shows the object type of the currently highlighted object, which makes 
the process of choosing easier.

Control Menu

 The symbol window has a control menu from which certain settings relating to it can be changed. Apart 
from the usual commands for moving and closing the window the following commands are available.

Rearrange
The window is moved to one of three possible positions in the workspace. It is usually at the bottom of 
the drawing window.

Save Position
If this menu entry has a tick against it, then the window position is saved when leaving the program. The 
next time that the program is started, it appears in the same place on the screen. The position is saved 
relative to the whole screen.



Popup Menu (Screen Elements)
The Popup Menu is a graphical menu which uses icons to represent commands instead of text 
descriptions. It always appears at the position of the mouse pointer. The Popup Menu is structured in the 
same way as the normal menus; it has the same menus, submenus and menu entries as the normal menus.

Choosing a command can follow the same procedure as using the text menus. Firstly, the menu is chosen 
from the upper area ; the menu entries and submenus from that menu appear in the central area. Choosing 
a menu entry carries out that command, or in the case of a submenu entry, the commands from the 
submenu appear in the lower arrea. 

Commands which can be chosen directly are shown in red. Submenus are shown in blue. In addition there
is a small solid triangle in the lower right corner of submenu icons to help distinguish them. Submenu 
icons always show the "most important" command from that submenu.

A command, menu or submenu is chosen by clicking on its icon with the left mose button. The choice of 
command can be cancelled by pressing ESC or clicking the right mouse button in the Popup Menu.

The title bar of the Popup Menu shows the description of the command or menu ander the mouse pointer. 
Help on this command can be called by pressing the Key F1.

The Popup Menu is a little smarter than the normal menu bar. It remembers which menu or submenu the 
last command was chosen from and this information can be recalled by double-clicking on the menu or 
submenu icon.

Example: Line>Standard was the last command chosen from the Draw menu. Double-clicking on the 
Draw menu's icon chooses Line>Standard again. The same happens if the Line> submenu icon is clicked 
on.

The icons used in the Popup Menu are the same as those used in the Toolbox and to display the current 
command in the Status Window.



Keyboard Assignments (General)
TommySoftware® Tek Illustrator is delivered with predefined keyboard assignments which can be partly 
changed by the user.

After installing the program, you can open and print out the drawing KEYBOARD.T3G from the 
DRAWING directory. The only font used in the drawing is ARIAL® which is part of every Windows 3.1 
installation.

In addition, the full version of the program comes with a keyboard reference card. If you only have the 
demo version or have mislaid the card, here is a table showing the keyboard assignments, arranged in 
command groups.

View and Zoom
Selection and Identification
Clipboard
Settings
Point Entry
Object Identification

Clicking on the "Standard" button in the Settings>Display Key Assignments dialog restores the default 
keyboard assignment. This contains a few more key definitions than described above.

Default Assignment

In general, only the permanent key assignments are referred to in this Help file and the Tutorial, in order 
to avoid possible errors caused by using different key assignments.

If several users wish to work with different key assignments (these can be saved along with other settings 
using the command Settings>Save As Default), the System Configuration>Multi-User Mode setting 
should be activated. This allows different settings to be saved for different users and avoids conflicting 
settings and consequent errors.



Keyboard Assignments for View and Zoom (General)

The keys in the right column are the default installation. Thhey can be changed by the user at any time 
using the command Settings>Change Key Assignment. The defaults can be restored using the "Defaults" 
button in the dialog called by the command Settings>Display Key Assignments.



Keyboard Assignments for Selection and Identification (General)

The keys in the right column are the default installation. Thhey can be changed by the user at any time 
using the command Settings>Change Key Assignment. The defaults can be restored using the "Defaults" 
button in the dialog called by the command Settings>Display Key Assignments.



Keyboard Assignments for Clipboard (General)

The keys in the right column are the default installation. Thhey can be changed by the user at any time 
using the command Settings>Change Key Assignment. The defaults can be restored using the "Defaults" 
button in the dialog called by the command Settings>Display Key Assignments.



Keyboard Assignments for Settings (General)

The keys in the right column are the default installation. Thhey can be changed by the user at any time 
using the command Settings>Change Key Assignment. The defaults can be restored using the "Defaults" 
button in the dialog called by the command Settings>Display Key Assignments.



Keyboard Assignments for Point Entry (General)

The keys in the right column are the default installation. Thhey can be changed by the user at any time 
using the command Settings>Change Key Assignment. The defaults can be restored using the "Defaults" 
button in the dialog called by the command Settings>Display Key Assignments.



Keyboard Assignments for Object Identification (Allgemeines)

The keys in the right column are the default installation. Thhey can be changed by the user at any time 
using the command Settings>Change Key Assignment. The defaults can be restored using the "Defaults" 
button in the dialog called by the command Settings>Display Key Assignments.



Default Assignments (General)
Normal keys, when pressed withhout the SHIFT key, are always used to call active commands or the 
submenus which contain these commands.

Bear in mind that complete submenus are assigned to some keys. They allow quick access to a whole 
range of commands without having to use a key sequence for each individual command.

Keys pressed together with SHIFT, are used to alter the system onfiguration and to choose setting-related 
commands.



Command Identifiers (General)
Every command available from the TommySoftware® Tek Illustrator menus has an internal reference 
number. The commands can also be called using these numbers. To do this, the TAB key is used.

For example, the command Line>Standard has the reference number 501. The command can be called 
using this key sequence:

TAB 5 0 1 TAB

This has the same effect as choosing the command from a menu or with a defined key.

This can be used to automate certain operations using Window's Recorder or similar utilities. In addition 
if you are using a graphics tablet, you may be able to allocate key sequences to certain parts of the tablet. 
Custom commands are easy to create using this function.

Menu Start Numbers
The command numbers can be worked out from their positions in the menus. Each menu begins on a 
multiple of 100.

File Menu 100
Edit Menu 200
Configuration Menu 300
Shape Menu 400
Draw Menu 500
Geometry Menu 600
Trim Menu 700
Dimension Menu 800
Library Menu 900
Extra Menu 1000
Help Menu 1100

Numbering Within a Menu
Each menu entry, submenu and submenu entry has a number. The numbering order corresponds to the 
order in which the commands and submenus appear. For example, this a section of the Dimension Menu:

Dimension Line Submenu 800
Straight Dimension Line 801
Curved Dimension Line 802

Dimension Submenu 803
Length, Point - Point 804
Length, Object 805
Distance, Object - Point 806
 ...  ...

Hatch Objects Submenu 834
Union (A=A+B) 835
Intersection (A=A×B) 836
Difference (A=A-B) 837
Hatching Type 838



If a submenu's command number is entered, then it appears on the screen and the required submenu entry 
can be chosen using the mouse or key combination.

Additional Commands
If a CalComp® Digitizer is connected and the CalComp® Tablet Manager is active, then the dollowing 
additional commands are available(see Using Digitizers):

Special Digitizer Menu 1200
Edit Key Assignments 1201
Calibrate Digitizer 1202
Set Origin 1203
Load Assignments... 1204
Save Assignments as... 1205
Define Digitizer Command Field 1206

The Symbol Window contains 100 buttons, to which Symbols can be assigned and inserted with a mouse 
click. These buttons can also be "pressed" using a key sequence.

Insert Symbol 1 .. 100 1300 .. 1399
Define Symbol 1 .. 100 1400 .. 1499

It is possible to use these commands even when the Symbol window is not displayed.

Entries from the drawing list can be called directly without choosing the Drawing List command.

Open Drawing 1 .. 14 from the list 1500 .. 1513

Important! All the command numbers shown as examples may be changed without warning when the 
program is updated! They will, however continue to use the same format, and so will be easily 
amendable.



WIN.INI and TSTEK3.INI (General)
TommySoftware® Tek Illustrator saves numerous settings in files with the ending INI. These files can be 
edited using any text editor. All the settings shown here can also be altered either during the installation 
process or from within the program.

The entries in the initialization files and their meanings are explained below.

WIN.INI
A section with three entries is inserted in WIN.INI, always foand in the main Windows directory.

[TommySoftware® Tek Illustrator English]
Debugging= This entry can have values between 0 and 231. If the value is greater than 0, the 

program starts in test mode. In test mode, numerous tests are carried out and 
detailed error messages appear. If test mode is on this is indicated in the tile bar.

Important! Only use test mode if asked to do so by our service staff. Its only 
function is to help locate problems. In test mode, many operations are a lot 
slower than normal!

The Debugging= entry is not usually included in WIN.INI and cannot be 
created from the program. The only way to do it is by manually altering 
WIN.INI, which should only be done with professional guidance!

Client= This entry can be set to 0 or 1. 1 indicates a client version of Tek Illustrator. This 
information is needed by the installation program if the uninstall option is used. It
has no effect on the functioning of the program.

Multiuser= This entry can be set to 0 or 1. If it is set to 1, a user name is requested when the 
program starts. This lets several people, each with their own customized 
configuration, work with the same copy of the program. For further information, 
see System Configuration>Multiuser.

EXE-path= This path shows the location of the program and all associated files. On a 
network installation, this path points to a global directory on the server. Tek 
Illustrator looks for all the global files like TSTEK3.EXE and TSTEK3.BLD in 
this directory.
This path is set by the installation program. A path name has to end with "\".

SYS-path= This entry shows the path to the program's own system files. On a network 
installation this entry points to a local directory and not to the server. Tek 
Illustrator looks here for local files such as TSTEK3.INI, TSTEK3.T3G, 
TSTEK3.SYM etc.
This path is set by the installation program. A path name has to end with "\".

CNV-path= This entry shows the path to the convertors. This is where Tek Illustrator looks 
for the converters when the command Convert Drawing… is chosen.
This path is set by the installation program. A path name has to end with "\".

TSTEK3.INI



The TSTEK3.INI file is located in the directory indicated by the "SYS-path=" line in WIN.INI.

If multiuser operation is enabled, then there are usually a series of files named ??????-.INI. They are the 
user-specific versions of the TSTEK3.INI file, where ?????? is replaced by the user's contraction. These 
files are constructed like TSTEK3.INI.

[Configuration]
Name= The "Name" entry gives the full name of the user to whom this settings file 

belongs. In the basic TSTEK3.INI ifile, "All Users" normally appears here. 
The name can contain up to 63 characters.

INF-path=
SYM-path=
T3G-path=
T3L-path=
FNT-path=
WMF-path=
BMP-path= These entries give the default path for the various files with which Tek 

Illustrator works. They can be changed with the command System 
Configuration>Paths.

SystemSize= Size (in KB) of the memory reserved for internal files. Values between 64 
and 1536 KB are allowed. See System Configuration>Memory and Monitor, 
Input field "Internal Files".

ObjectSize= Size (in KB) of the memory reserved for drawing files. Values between 64 
and 1536 KB are allowed. See System Configuration>Memory and Monitor, 
"Drawing file input field".

ObjectStep= Step size for enlarging the size of memory reserved for drawing files in KB. 
Values between 64 and 16384 KB are allowed. See System 
Configuration>Memory and Monitor, "Enlarge by" input field.

UndoSteps= Maximum number of undo levels, i.e. the number of commands which can be
"taken back". Values between 1 and 100.are allowed. See System 
Configuration>Memory and Monitor, "Undo Steps" input field.

MonitorWidth=
MonitorHeight= Size of the useable area of the monitor in millimeters. Values between 100 

and 1000 millimeters are allowed. See System Configuration>Memory and 
Monitor, "Height" and "Width" input fields.

FontSize= Font size in screen pixels used for the buttons in the panel. The size of the 
buttons adjusts itself to the text size specified here. Sizes of 10, 12 or 14 
pixels are allowed. See System Configuration>Memory and Monitor, "Panel 
Size" section.

SaveINF= If this entry is set to 1, then the settings are saved at the end of the session. 
See Save Settings on Exit.



SaveSYM= If this entry is set to 1, then the contents of the Symbol window are saved at 
the end of the session. See Save Symbol Window on Exit.

DisplayMenu= If this entry is set to 1, then the main window menu bar is displayed. If it is 
not displayed, pressing the ALT key displays the text menu at the current 
mouse position. See Main Window.

DisplayStatus= If this entry is set to 1, the status window is displayed. See Display Status 
Window.

DisplaySymbol= If this entry is set to 1, the symbol window is displayed. See Display Symbol 
Window.

DisplayToolbox= If this entry is set to 1, the toolbox is displayed. See Display Toolbox.

WindowMain= Position and size settings for the main window. If this entry is present then 
the main window will be placed at this position when the program is started. 
In this case the position is also saved when the program is exited. See Main 
Window.
The values are: X coordinate of the top left corner; Y coordinate of the top 
left corner; width of the window; height of the window. The values are in 
screen pixels.

WindowStatus= Position of the status window. If this entry is present, then the status window 
is displayed at this position when the program is started. In this case the 
position is also saved when the program is exited. See Status Window.
The values are: X coordinate of the top left corner; Y coordinate of the top 
left corner. The values are in screen pixels.

WindowSymbol= Position and size for the symbol window. If this entry is present, then the 
symbol window is displayed at this position when the program is started. In 
this case, the window's position is also saved when the program is exited. See
Symbol Window.
The values are: X coordinate of the top left corner; Y coordinate of the top 
left corner; width of the window; height of the window. The values are in 
screen pixels.

WindowToolbox= Position and size for the toolbox. If this entry is present, then the toolbox is 
displayed at this position when the program is started. In this case, the 
window's position is also saved when the program is exited. See Toolbox.
The values are: X coordinate of the top left corner; Y coordinate of the top 
left corner. The values are in screen pixels.

ToolboxNumber= Number of buttons in the toolbox. Permissible values: 6, 10 and 14. See 
Toolbox.

TrueTypeOnly= If this entry is set to 1, then font lists will not include device or PostScript 
fonts.

[Drawing X ]



File= Filename of drawing number X (Numbers 1 to 14 only). These drawings 
appear in the Drawing List.

[Library X ]
File= Filename of Library number X (Numbers 1 to 50). This Library is loaded 

when the program is started and appears in the Library list. See Libraries.

Caching= If this entry is set to 1, the library numbered X from the cache is used. In this 
case, no symbols are loaded from the library when the program is started, but
only details of the library.

Load= If this entry is set to 1, symbols from the library numbered X are loaded when
required. If the Caching= entry is set to 1, then this command has no effect.

Save= If this entry is set to 0, then the library numbered X cannot be altered. Note: 
the library files themselves are not write protected.

[Font X ]
File= Filename of font number X (numbers between 1 and 14 are allowed). This 

font is loaded when the program is started and therefore appears in the font 
list. See also Fonts.



Important File Endings (General)
When working with TommySoftware® Tek Illustrator the endings of file names usually have a particular 
meaning. They also show the file's type. They should be used carefully to avoid confusion by using the 
same ending for several file types.

At present, TommySoftware® Tek Illustrator and its associated file convertors recognize and use the 
following endings:

BMP The BMP format is used by Windows bitmap graphics, which can be either black and white or 
colored.
These files can be loaded using the command Bitmap>Display.

DXF The DXF format was first used by the AutoCAD® CAD system (registered trademark of 
AutoDesk). It has become a quasi-standard and can be read and/or written by most CAD and 
graphics programs.
DXF files cannot contain filled surfaces more complicated than rectangles! For this reason, most 
programs cannot export fillings, or have to laboriosly convert them to rectangles and triangles 
first.
The DXF-format changes with each new version of AutoCAD®. These changes can be 
significant. On one hand, they are important for the further development of the program, but on 
the other makes it almost impossible to keep up to date. However, we always try to deliver the 
most up to date converters possible for this important format.
[Available converters: DXF_MPG MPG_DXF

DXF_T2G T2G_DXF
DXF_T3G T3G_DXF]

MPG MPG 1.0 format is used by TommySoftware® graphics programs. It is relatively compact and 
easy to read. Complex surfaces including lines and Bézier curves can be modelled. The only 
restriction is that block definitions cannot be executed.
[Available converter: MPG_T2G]

T2G TVG 2.0 is used by TommySoftware® CAD/DRAW Professional 2. It is the succesor to the TVG 
format and includes block definitions and external references. In addition surfaces can now be 
boanded by circular arcs as well as Bézier curves and lines. In additio T2G files are more 
compact than TVG files (using about 70% of the space to store the same information).
These files can be loaded using the command. Open Drawing.
[Available converter: T2G_T3G]

T2L The TVL 2.0 format is also used by TommySoftware® CAD/DRAW Professional 2. Libraries and 
Fonts are saved in this format. The internal structure and capabilities are the same as T2G.
These files can be loaded using the commands Libraries or Fonts.
[Available converter: T2L_T3L]

T3G TVG 3.0 format is used by TommySoftware® Tek Illustrator. It is the successor to the TVG 2.0 
format and has been extended by erasers and groups. T3G files are also somewhat smaller than 
T2G files.
These files can be loaded using the command. Open Drawing.

T3L The TVL 3.0 format is also used by TommySoftware® Tek Illustrator. Libraries and Fonts are 
saved in this format. The internal structure and capabilities are the same as T3G.
These files can be loaded using the commands Libraries or Fonts.

TAX The TAX 3.0 format is used by TommySoftware® Tek Illustrator. It stores the same information as
TVG 3.0 and TVL 3.0, but in a text format, not a binary format. TAX 3.0 files can be viewed and 
edited using any text editor. A drawing or library in TAX format is somewhat larger than a T3G- 
or T3L file.



[Available converter: TAX_T3G T3G_TAX]
TVL The TVL 1.0 format is used by TommySoftware® graphics programs to store libraries and fonts. 

Internally, it is the same as MPG.
[Available converter: TVL_T2L]

VEK The VEK 1.0 format is used by MegaPaint® ST 2.3 and later on the Atari ST. Like MPG format,   
it can contain complex surfaces and graphics.
[Available converter: VEK_MPG]

WMF The WMF format is used to display Windows vector graphics (metafiles).
They can be loaded with the command Paste from File.

Not all these converters are included with Tek Illustrator. If you require a convertor not included in the 
basic package, contact us. We will send you the current convertor collection, including those not actually 
needed by Tek Illustrator.

The Tek Illustrator also uses the following endings for various program-specific files:

INF Files with this ending contain the settings (display and output parameters, keyboard assignments, 
hatching types, etc.). They are created with the command Settings>Save As.
Files named -??????-.INF appear if Multiuser Mode is active. They contain user-specific data for 
the user with the contraction ??????.

INI Files with this ending contain system configuration settings (Monitor and window settings, 
memory size, library list, font list, drawing list etc.). They are automatically updated by the 
program.
Files named -??????-.INI appear if Multiuser Mode is active. They contain user-specific data for 
the user with the contraction ??????.

SYM Files with this ending contain symbol lists, that is, a complete set of Symbol window button 
assignments. They are created using the Symbol Window>Save As command.
Files of the form -??????-.SYM are used when Multiuser Mode is active. They contain user-
specific data for the user with the contraction ??????.

A comprehensive description of INI file contents can be seen under WIN.INI and TSTEK3.INI.




